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Welcome

Welcome to Seagate Crystal Reports, the most powerful Windows 
reporting tool available today.

●   If you are new to the product, you will soon understand why more 
than one million users worldwide turn to Seagate Crystal Reports 
for all their reporting needs.

●   If you are upgrading, thanks for your vote of confidence. Every 
effort has been made to make this release the best ever, offering 
major improvements over earlier versions.

This manual has been designed to fit the way users say they work. The 
emphasis is on getting the job done in the easiest way possible. To 
eliminate confusion, a show-as-you-go style that uses pictures liberally to 
demonstrate procedures has been adopted.

This manual contains instructions for most of the typical reporting tasks 
and for some very sophisticated tasks as well. It also contains a great deal 
of conceptual information to help you better understand databases, 
reporting, and the program itself.

There are many topics in this manual that deal with general areas of 
interest such as placing fields, formatting your report, and sorting 
records, as well as, topics that deal with more specific areas of interest 
such as advanced formula creation and accessing different types of data.

In most chapters, the Hands-On topics flow from general to more specific 
areas of interest. Consult What you will find in this chapter... (found on the 
first page of each chapter) to target the information you need in a hurry.

Two kinds of Hands-On tutorials

Hands-On sections in this manual contain two types of tutorials:

1. Overview, and

2. Procedural.

Overview 
tutorials

Overview tutorials present an overall view of a process. They are 
designed to provide an understanding of the concepts involved and are 
cross-referenced to procedural tutorials for step-by-step instructions on 
completing core procedures contained within them. For example, a 
typical overview tutorial might discuss how to place three unrelated 
reports in a single report. One of the process steps is, “Create the first 
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subreport”. No details on how to do this are provided in the overview 
tutorial; a cross-reference is included to the procedural tutorial that will 
explain in a detailed fashion how to create a subreport.

Procedural 
tutorials

Procedural tutorials demonstrate core procedures that are used again and 
again. For example, even though you may use subreports in many 
different situations, the two detailed procedures you need to understand 
are:

1. how to insert a subreport, and

2. how to link a subreport to the data in the primary report.

Each of these is explained in a step-by-step fashion using detailed process 
tutorials.

Command, button, key, and control conventions

This manual uses the following conventions:

Commands and 
buttons

For easy recognition, command names and button names from the 
Standard, Supplementary, Analyzer, and Formatting toolbars are 
displayed in small caps. For example: NEW command, PRINT button, etc.

Key 
combinations

Keyboard shortcuts appear in the following forms:

●   Delete means the Del key (either the Delete key, or the Del key on 
your numeric keypad).

●   Enter means the Enter, Return, CR, or ↵ key, depending on which 
of these keys appears on your keyboard.

●   Ctrl-Key, Shift-Key, and Alt-Key are examples of the notation for 
two-key combinations. Press the first key in the combination 
(Control, Shift, or Alt), and, at the same time, press the second key 
in the combination (designated above as Key). For example: Ctrl-C 
means to hold the Control key down and then press the letter C on 
your keyboard (Ctrl-C is the Windows Copy command).

Dialog box 
controls

Buttons, lists, check boxes, and other dialog box elements are displayed 
in italics. For example, Suppress check box, OK button, etc.

Other 
conventions

●   Text enclosed in double brackets (for example, «information») is 
intended to expand or explain the information that it follows.

●   Computer type indicates data that you are to enter using the 
computer keyboard. It is also used to show example formulas.
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●   Field names appear in the following format:

    {file.FIELD}

   file represents the alias of the table the field comes from.

   FIELD represents the name of the field in that table.

●   Portions of underlined text within normal text require special 
attention.

●   NOTES are used to provide extra or special information regarding 
the preceding topic.

●   \WINDOWS\SYSTEM refers to the System subdirectory of the 
Windows directory on your computer or network server. By 
default, this directory is C:\WINDOWS\SYSTEM in Windows 3.1, 
Windows 95, and Windows 98 and C:\WINNT\SYSTEM32 in 
Windows NT 3.51 or later. This directory may be different on your 
system. If you are unsure, contact your network administrator, or 
refer to your Windows documentation.

●   Related Topics lists point to other topics in this manual and online 
Help systems that deal with related procedures, additional uses 
for the same command or dialog box, or alternative methods for 
accomplishing the same task.

●   Not all of the pictures used in the Hands-On tutorial sections 
reflect exactly what you will see on-screen.

   Some of the example reports have been designed to illustrate 
concepts only, not the actual look of a finished report.

   Some menus have been shortened by removing commands 
that are unrelated to the current discussion.

   The data in some lists has been abbreviated to focus attention 
on specific items of interest.

   In some cases, an individual screenshot illustrates both a 
before and after picture of a dialog box when such an 
illustration can be done without confusion.

●   In the Hands-On tutorial sections, be sure to pay attention to the 
callout text accompanying all screenshots and graphics. Often the 
callouts are steps necessary to complete the tutorial and to pass by 
one inadvertently may cause undesirable or incorrect results.
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Using Seagate Crystal Reports documentation

In addition to this User’s Guide, the product includes a comprehensive 
set of online and printed learning tools to help you when you are getting 
started with the program and when you need answers fast in your day-
to-day reporting.

Whether you are a beginner or an expert, this documentation will provide 
a clear and easy path to productivity. For a complete description of 
learning tools and suggested learning paths, see Learning Seagate Crystal 
Reports, Page 27.

PROFESSIONAL EDITION FEATURES

This User’s Guide is distributed with both the Standard and Professional 
Editions of the program. The following list identifies features and 
capabilities discussed in the User’s Guide but available only in the 
Professional Edition:

●   Crystal Web Report Server

●   Crystal Report Engine Automation Server

●   Crystal Report Engine Object Library

●   Active Data Driver

●   Crystal Data Object (CDO)

●   Crystal Dictionaries 

●   Crystal Query Designer

●   Crystal SQL Designer

●   Reading SQL databases

●   Reading Microsoft Exchange data files

●   Exporting to ODBC data sources

Seagate Crystal Reports online Help features

The online Help systems included with this program are full of useful 
information.

●    Seagate Crystal Reports online Help (CRW.HLP)
Seagate Crystal Reports online Help includes all the information 
included in the Seagate Crystal Reports User’s Guide, with special 
emphasis on helping the user understand the interface with 
hundreds of “How to” tutorials.
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●   Crystal Query Designer online Help (CRQUERY.HLP)
Crystal Query Designer online Help provides information about the 
Crystal Query Designer, a new tool that allows you to design and 
preview reports and queries from any Java enabled web browser.

●   Crystal SQL Designer online Help (CRSQL.HLP)
Crystal SQL Designer online Help includes all the information you 
need in order to create and edit SQL queries for use in creating 
reports.

●   Developer’s online Help (DEVELOPR.HLP)
Developer’s online Help includes descriptions of all functions and 
structures, conceptual information, and sample code for:

   ActiveX

   Crystal Report Engine Automation Server

   Active Data Driver

   NewEra

   PEPlus

   Report Designer Component

   Report Engine API

   Visual Basic API

   VBX

   VCL

   Web Report Server

●   Dictionary online Help (DICTN.HLP)
Dictionary online Help includes all the information you need in 
order to create, modify, and work with dictionaries.

●   Document Import Tool online Help (CRDIT.HLP)
Document Import Tool online Help includes all the information 
you need in order to convert text reports to Seagate Crystal 
Reports with the Document Import Tool.

●   Mapping online Help (CRMAP.HLP)
Mapping online Help includes all the information you need in 
order to place complex geographic maps in reports, for better data 
analysis and trend identification.

●   ReadMe online Help (README.HLP)
ReadMe Help includes topics such as the following:

   Installation Topics

   Configuration and Setup Topics
6 Seagate Crystal Reports User’s Guide



   Quick Start

   Worldwide Office Directory

●   Report Designer Component online Help (CRRDC.HLP)
This help file contains descriptions of all the functions and 
structures, conceptual information, and sample code for the 
Report Designer Component.

●   Reports at a Glance online Help (RPTGLANC.HLP)
Reports at a Glance online Help is a complete online help system 
for the Reports at a Glance application.

●   Runtime File Requirements online Help (RUNTIME.HLP)
Runtime Help including all the distributed DLLs and UFLs, 
including:

   the exact name,

   location, and

   description.

●   Web Report Server online Help (CRWEB.HLP)
Web Report Server online Help includes all the information you need 
to set up and view reports over an intranet or extranet.

Here is just a sampling of topics you will find in these help files:

●   Explanations of error messages and formula compiler errors. 
Search for Error Messages and Formula Compiler Warnings in Seagate 
Crystal Reports online Help.

●   Runtime information so you will know which files to include 
when using the Crystal Report Engine with your application. See 
Runtime File Requirements in Seagate Crystal Reports online Help.

●   Tips and Tricks
Dozens of helpful hints for working with Seagate Crystal Reports. 
Search for Tips and Tricks in Seagate Crystal Reports online Help.

●   Formulas for study
A series of complex formulas that showcase the use of Seagate 
Crystal Reports functions, operators, and the formatting language 
in solving a number of real-world reporting problems. Search for 
Formulas in Action Index in Seagate Crystal Reports online Help.
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●   Specialized formulas
A collection of formulas that address specific reporting needs. 
Search for Specialized Formulas in Seagate Crystal Reports online 
Help.

●   Sample formulas
A number of topics contain sample formulas that can be cut and 
pasted directly into the Formula Editor to save you time. Search 
for Copying formulas from online Help in Seagate Crystal Reports 
online Help.

●   Formula functions and operators
A complete and detailed list of all functions and operators you can 
use when creating formulas including specialized financial 
functions used to design sample reports. Search for Functions or 
Operators, or for an individual function or operator by name in 
Seagate Crystal Reports online Help.

●   Full documentation of the Report Engine API. Search for Report 
Engine Functions in Developer’s online Help.

●   Sample code for making calls to the Report Engine from your C, 
Visual Basic, or Delphi application. Use the Copy (Ctrl-C) and 
Paste (Ctrl-V) commands built into Windows Help to copy this 
code and paste it as ASCII text into any editor that supports 
Windows Copy and Paste procedures. Search for Copying code from 
online Help in Developer’s online Help.

●   Full documentation of the Report Engine Class Library, a C++ 
class library addition to the Microsoft Foundation Class Library. 
Use the class definition in the Report Engine Class Library to 
access the Crystal Report Engine from your C++ application. 
Search for Class Library Index in Developer’s online Help.

●   Full documentation for the Crystal Custom Control, the Crystal 
ActiveX control, and the Crystal VCL you can use when working 
with development environments that support them. Search for The 
Crystal Custom Control, The Crystal ActiveX Control, or The Crystal 
VCL in Developer’s online Help.

●   Breakdown of sample applications included with the program. 
Search for Sample Applications in Developer’s online Help.

Online Help is a warehouse of information that can make reporting more 
productive and enjoyable. A comprehensive indexing system and 
hundreds of search terms provide a variety of avenues for finding the 
help you need, right from your computer. Once you see what is in the 
help system, you will most definitely return to it often.
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If you need more 
help...

WEB SITE

http://www.seagatesoftware.com/

E-MAIL

E-mail address: support@webacd.seagatesoftware.com.

Send a blank e-mail first to obtain a support template and follow the 
instructions in the e-mail, or submit your questions by web browser at:

 http://webacd.seagatesoftware.com.

E-MAIL NOTIFICATION SERVICE

http://maillist.seagatesoftware.com/subscribe.asp

FAX SUPPORT

Fax Support (604) 681-7163

TELEPHONE SUPPORT

Telephone Number (604) 669-8379

For more information on these services, please see Product Support, Page 
625.
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1 Installation and Quick Start

What you will find in this chapter...

Installation Requirements, Page 12

16-bit version, Page 12

32-bit version, Page 12

Installation, Page 12

Windows 3.1 or NT 3.51, Page 12

Windows 95, Windows 98 or NT 4.0, Page 13

Installing on a network, Page 13

Upgrading from a previous version, Page 14

Windows 95, Windows 98 or NT 4.0, Page 13

Upgrading from a previous version, Page 14

Quick Start, Page 15
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Installation Requirements

16-bit version The 16-bit version of the program has the following installation 
requirements:

●   Microsoft Windows 3.1 or higher

●   Minimum RAM: 16 MB (32 MB for Windows NT 3.51 or higher)

●   Minimum hard drive space required: 10 MB (Full Install 120 MB)

●   Maximum hard drive space required:

   75 MB for the Standard Edition

   108 MB for the Professional Edition

32-bit version The 32-bit version of the program has the following installation 
requirements:

●   Microsoft Windows 95, Windows 98 or Microsoft Windows NT 
3.51 or higher

●   Minimum RAM: 16 MB (32 MB for Windows NT)

●   Recommended RAM: 32 MB

●   Minimum hard drive space required: 24 MB (Full Install 172 MB)

●   Maximum hard drive space required:

   90 MB for the Standard Edition

   148 MB for the Professional Edition

If your system does not meet these requirements, the program may not 
run correctly.

Installation

Insert the CD or diskette into the appropriate disk drive.

Windows 
3.1 or NT 3.51

1 Choose the RUN command from the File Menu.

2 When the Run dialog box appears, type:

x:\setup

«x represents the appropriate drive letter.»
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For example, if the CD is in drive D:, type:

D:\setup

3 Click OK or press Enter to activate the installation program. The 
Installation dialog box appears.

4 Follow the directions on the screen to set up the program.

During the installation procedure, you can choose a Typical or Custom 
installation.

●   If you select Typical, the program will be installed with the most 
common options.

●   If you select Custom, you will be given the opportunity to select 
which program files are installed to the hard drive.

Windows 95, 
Windows 98
or NT 4.0

1 Choose RUN from the Start Menu.

2 When the Run dialog box appears, type:

x:\setup

«x represents the appropriate drive letter.»

For example, if the CD is in drive D:, type:

D:\setup

3 Click OK or press Enter to activate the installation program. The 
Installation dialog box appears.

4 Follow the directions on the screen to set up the program.

During the installation procedure, you can choose a Typical or Custom 
installation.

●   If you select Typical, the program will be installed with the most 
common options.

●   If you select Custom, you will be given the opportunity to select 
which program files are installed on your hard drive.

Installing on a network 

To run Seagate Crystal Reports from a server you will need to install it to 
the server and then run a workstation setup application on each 
workstation that will run Seagate Crystal Reports.
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The workstation setup application is installed in the \CRW16\CLIENT16 
(16-bit) or \Program Files\Seagate Software\Crystal Reports (32-bit) 
directory on the network drive.

To install on the server:

1 Choose a Custom install.

2 When the Custom Installation Options dialog box appears, verify 
that the Workstation Setup option is checked.

To set up a workstation:

1 From the Program Manager, choose Run from the File Menu 
(Windows 3.x or NT 3.51), or choose Run from the Start Menu 
(Windows 95 and 98 or NT 4.0). The Run dialog box appears.

2 In the Run dialog box, highlight the network drive and directory in 
which the Workstation Setup resides and run the SETUP.EXE 
application.

3 Follow the directions on the screen to set up your workstation.

Upgrading from a previous version

If you are upgrading from a previous version, the installation routine 
ensures that there will be no conflict between different versions of the 
program running on the same machine. When the setup application finds 
a previous version of the program on a system, it:

●   installs the program to the specified directory,

●   installs the new CRPE.DLL into the \WINDOWS\SYSTEM 
directory,

●   renames DLLs installed by the previous version in the 
WINDOWS\CRYSTAL directory, with *.OLD extensions (if, for 
some reason, you need to use the older versions of the files later 
on, you only need to rename them back to a *.DLL extension),

●   installs the PD*.DLLs and UX*.DLLs (16-bit) or the P2*.DLLs and 
U2*.DLLs (32-bit), and several other DLL files required by the 
program into the WINDOWS\CRYSTAL and 
WINDOWS\SYSTEM directory and changes their extensions from 
*.DLL to *.OLD, and

●   installs any common third party DLLs such as CTL3DV2.DLL or 
WBTRCALL.DLL to the WINDOWS\SYSTEM directory.
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Quick Start 

If you are an experienced Windows user who wants to get right into the 
program, follow these steps to set up a report for the first time.

NOTE: If you are not an experienced user, please refer to Learning Seagate 
Crystal Reports, Page 27.

1 In Windows 3.1 and NT 3.51, start the program by double-clicking 
the Seagate Crystal Reports icon in the Program Manager.

●   In Windows 95, Windows 98 and NT 4.0, click Start, then select 
Seagate Crystal Reports from the Seagate Crystal Reports program 
folder.

2 Click the NEW button on the Standard toolbar. The Report Gallery 
appears.

3 To build the report:

●   select one of the eight Experts,

●   click Another Report to use a template, or

●   click Custom to build a custom report. If you click Custom, the 
Report Gallery expands, and you can then select a Report Type and 
Data Type for a custom report.

4 If you choose Custom and select:

●   Data File, the Choose Database File dialog box appears. Select the 
first database you want to activate for the report.

●   SQL/ODBC, the Log On Server dialog box appears. Highlight the 
data source you want, click OK, and when the Choose SQL Table 
dialog box appears, highlight the first table you want to use.

●   Dictionary, the File Open dialog box appears. Highlight the 
dictionary you want to use for the report.

The Design Tab appears with Report Header, Page Header, 
Details, Page Footer, and Report Footer areas. A report is created 
by inserting and formatting items in each of these areas.

NOTE: To use additional database tables for a report and match them up 
on a record-by-record basis, click the LINK EXPERT button on the 
Supplementary toolbar, select the table(s), and then set up the links in the 
Visual Linking Expert when it appears. Search for Visual Linking Expert in 
Seagate Crystal Reports online Help.
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5 Each of the default report areas contains a single section. To add 
additional sections, click the SECTION EXPERT button on the Standard 
toolbar and use the Section Expert to add the desired sections.

Once you have added sections to an area, you can move, merge, and 
delete them in the Section Expert. See How to add, delete, and move 
guidelines, Page 72.

6 To toggle the grid on and off, choose the OPTIONS command on the 
File Menu and make your changes in the Options dialog box when it 
appears. See How to turn the grid on/off, Page 76.

7 If you are working with the grid off and you want to use snap-to 
guidelines for positioning objects, click the top or left ruler wherever 
you want guidelines to appear.

●   Drag a field to a guideline until it snaps to the guideline.

●   Drag the guideline arrow to move the guideline (and any objects 
that are snapped to it).

●   Drag the guideline arrow away from the ruler to remove the 
guideline. See How to add, delete, and move guidelines, Page 72, and 
How to move and position objects using guidelines, Page 73.

8 If the Insert Fields dialog box is not visible, click the INSERT FIELDS 
button on the Standard toolbar. The Insert Fields dialog box appears 
with the Database Tab active, and displays a list of the fields in the 
active database table(s). To speed the entry of multiple fields, the box 
remains on-screen until you click Close. This dialog box can be 
moved to a new location or resized, if you wish. See How to insert 
database fields, Page 105.

9 Select the field(s) you want to appear on the report. You can select 
and place them one at a time, or you can use the Shift-click 
combination to select a number of contiguous fields, or the Ctrl-click 
combination to select fields from the list at random. Drag and drop is 
also active. Place the fields in the Details section where you want 
them to appear.

10 When you place multiple fields, they will appear in the same order 
that they appear in the Insert Fields dialog box. The program marks 
the position of each field with a rectangular frame. The characters in 
the frame indicate whether the field is text (xxx...), number (555...), 
currency ($555...), date (12/31/99), time (00:00:00), dateTime (12/31/
99 00:00:00), or Boolean (T/F).

NOTE: The field names and field types can be viewed by toggling the Show 
Field Names check box on in the Options dialog box (Layout Tab). Search 
for Setting up Seagate Crystal Reports in Seagate Crystal Reports online 
Help.
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NOTE: The program automatically places field titles in the Page Header 
section unless the Insert Detail Field Titles check box is toggled off in the 
Options dialog box (Layout Tab). Search for Configuring Seagate Crystal 
Reports in Seagate Crystal Reports online Help.

NOTE: If additional Details sections are added to the report, please note 
that field titles will only be placed in the Page Header section for fields in 
the Details A (the original) section of your report.

11 Once the objects are in place, you may want to adjust the report 
sections somewhat. To do this, right-click the shaded area to the left of 
the section ruler and use the shortcut menu that appears.

●   To expand a section to accommodate an additional line, choose the 
INSERT LINE command.

●   To have the program automatically align the objects in the section 
horizontally, choose the ARRANGE LINES command.

●   To reduce the size of a section to eliminate unnecessary white 
space above and below objects, choose the FIT SECTION command. 
See How to add/delete white space between rows, Page 218.

12 To create a report title, you must first enter the title in the Document 
Properties dialog box. Choose the SUMMARY INFO command from the 
File Menu. Enter a title in the Title text box of the Document 
Properties dialog box. Click OK.

13 Choose the REPORT TITLE command from the Insert|Special Fields 
Menu. A rectangular placement frame appears when you move the 
cursor over your report. Click once in the Report Header (RH) 
section to place the report title. The report title field contains the text 
that you typed in the Title text box of the Document Properties dialog 
box. See How to add a title page to the report, Page 117.

14 To see how the results will print, click the PRINT PREVIEW button on 
the Standard toolbar.

To speed processing time while building a report, you can preview 
the report using only a small subset of the available data. To do this, 
choose the PREVIEW SAMPLE command from the File|Print Menu. See 
Preview Tab, Page 61.

In either case, the program takes you to the Preview Tab. You can fine-
tune a report in the Preview Tab while viewing the results as actual 
report data. You can also close the Preview Tab and continue working 
on the report in the Design Tab.
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15 If you want to:

●   format a field,

●   change the placement or width of a field, or

●   insert a subtotal or grand total,

click the field to select it. Handles appear on the top, bottom, and sides 
of each selected field.

●   To change the placement of the field(s), use the mouse to drag the 
field placement frame to its new position.

●   To change the width of the field, use the mouse to drag the right or 
left handle.

●   Right-click the field to format font, alignment within field, 
number, currency, date display, border, color, indentation, or to 
summarize the field. A shortcut menu appears listing various 
commands for formatting and summarizing the field.

NOTE: To apply formatting only under certain conditions, click Conditional 
Formula next to the formatting property in the Format Editor, and create a 
formula that defines those conditions. See Conditional formatting, Page 212.

NOTE: Many of the font and formatting options are available on the 
formatting toolbar. See Status bar, Page 51, for more information on the 
options available.

16 To create a formula that makes data calculations or comparisons, 
click the INSERT FIELDS button on the Standard toolbar. When the 
Insert Fields dialog box appears, click the Formula Tab to activate it.

17 Click New. The Formula Name dialog box appears. Enter a name for 
the formula and click OK. The Formula Editor appears.

18 Enter the formula in the Formula Editor. Enter fields, operators, and 
functions by selecting them from their respective scroll lists or by 
typing them in. You can check the formula syntax by clicking Check. 

19 When you are finished editing, click Close to return to the Insert 
Fields dialog box. Click Insert to place the formula just like you 
would a database field. See Introduction to Formulas, Page 291, and 
Advanced Formulas, Page 315, or search for Functions and Operators and 
Variables in Seagate Crystal Reports online Help.

20 To insert a subreport (a report within a report), click the INSERT 
SUBREPORT button on the Supplementary toolbar and choose an 
existing report to import as a subreport or use the Create Report Expert 
to create a new subreport. See How to insert a subreport, Page 419.

●   If you want the records in a subreport to match up with the 
records in a primary report, click the Link Tab of the Insert 
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Subreport dialog box and specify the link in the Subreport Links 
dialog box when it appears. See How to link a subreport to the data in 
the primary report, Page 421.

21 To insert a cross-tab object in a report, click the INSERT CROSS-TAB 
button on the Supplementary toolbar and set up the cross-tab in the 
Cross-Tab dialog box when it appears. See Cross-Tab Objects, Page 
443.

22 To create a parameter field (a field that prompts you for a value 
whenever you retrieve data for a report), click the INSERT FIELDS 
button on the Standard toolbar, then click the Parameter Tab in the 
Insert Fields dialog box when it appears. Click New to set up a 
parameter field. Once created, you can insert the parameter field in a 
report like a database field or select it from the Fields list in the 
Formula Editor.

Parameter fields can be used in reports (as title or label prompts), in 
selection formulas (as selection criteria prompts), and in formulas (for 
a variety of purposes including specifying sort fields). See Parameter 
Fields, Page 351.

23 To add a chart, click the INSERT CHART button on the Standard 
toolbar. See Charting, Page 369.

24 To insert a spreadsheet, picture, or other OLE object that you can edit 
from within Seagate Crystal Reports using the tools from the object’s 
native application, choose the OBJECT command from the Insert 
menu. See OLE, Page 403, and How to insert a graphic/picture as an OLE 
object, Page 414.

25 To change the record sort order, click the SORT ORDER button on the 
Standard toolbar. The Record Sort Order dialog box appears. Select 
the field(s) you want to use for sorting the report data and the sort 
direction. See How to do a single field sort, Page 253.

26 To limit the report to specific records (for example, the records of 
California customers who have year-to-date sales greater than 
$10,000), click the first field on which you want your selection to be 
based and then click the SELECT RECORDS button on the Standard 
toolbar. When the Select Expert appears, set up the record selection 
criteria.

27 To print the report, click the PRINT button on the Standard toolbar.

That’s it! It is that easy to build a report. To practice concepts introduced 
in this Quick Start, proceed to Tutorial - Customer List, Page 147.
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2 What’s New

What you will find in this chapter...

New Crystal Query Designer provides greater power and speed, Page 22

Report Designer Component, Page 22

Map Expert helps identify trends, Page 22

Enhanced charting capabilities help you analyze data, Page 23

Enhanced cross-tab features make cross-tab reports more powerful than ever, 
Page 23

Server-side processing saves time and memory, Page 23

Running totals -- one field is all you need, Page 24

Document Import Tool converts old text reports, Page 24

Entering SQL expressions directly helps you create reports faster, Page 24

Highlighting Expert makes formatting faster and easier, Page 25

Field Mapping provides more database control, Page 25

Enhanced Formula Editor makes creating formulas easy, Page 25

Enhanced exporting capabilities, Page 26

New and better parameter fields provide greater flexibility, Page 26

On-Demand subreports increase report organization, Page 26
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New Crystal Query Designer provides greater power and speed

With an easy-to-use interface and web-enabled design capabilities, 
Seagate Crystal Reports new Crystal Query Designer allows you to 
quickly design and preview ad hoc reports. The Query Designer gives 
you the basic formatting and charting capabilities of Seagate Crystal 
Reports, but does not burden you with the more advanced features. Plus, 
the tool uses page-on-demand technology. Now you can create ad hoc 
reports quickly and easily, letting the program do most of the work for 
you. The Crystal Query Designer is a 100% Java client. You don’t need 
any plug-ins to install and maintain it. For more information, see Crystal 
Query Designer online Help (CRQUERY.HLP).

Report Designer Component

Seagate Crystal Reports now includes the Report Designer Component, a 
powerful ActiveX designer for Visual Basic. The Report Designer 
Component allows you to design reports using all of the advanced 
reporting features of Seagate Crystal Reports all within the Visual Basic 
development environment. The Report Designer Component also 
provides a complete object model, allowing you to design custom 
interfaces for user input that controls report data. For more information, 
see the Report Designer Component online Help (CRRDC.HLP).

Map Expert helps identify trends

This version of Seagate Crystal Reports provides a new Map Expert that 
allows you to insert geographic maps into your reports. A map is a 
powerful analysis tool. You can map on summary fields, subtotal fields, 
and cross-tab summaries, then drill-down on the map to view organized 
sets of data (such as sales by state). Seagate Crystal Reports provides four 
map layouts and five map types. The program also offers a new view 
called the Analyzer Tab, which allows you to set the properties for an 
individual instance of a map, independently of the rest of the report. This 
new mapping feature makes it easier than ever to identify trends in data. 
For more information about the Map Expert, see Mapping, Page 385.
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Enhanced charting capabilities help you analyze data

The Chart Expert is now much more powerful, providing maximum 
charting flexibility by offering 11 chart types and 47 chart templates (as 
well as an editor for creating custom charts). Now you can create Bubble 
charts, Radar charts, and XYZ Scatter charts, among others. The program 
also offers a new view called the Analyzer Tab, which allows you to set 
the properties for an individual instance of a chart, independently of the 
rest of the report. This new charting feature makes it easier than ever to 
organize and analyze data. For more information about the Chart Expert, 
see Charting, Page 369.

Enhanced cross-tab features make cross-tab reports more 
powerful than ever

Many advanced options have been added to cross-tabs in this version. 
With these advanced options, you can:

●   Suppress empty rows and columns,

●   Suppress subtotals and grand totals,

●   Split wide cross-tabs over page breaks and repeat the row labels,

●   Specify separate background colors for row and column grand totals,

●   Conditionally format the contents of individual cross-tab cells, and

●   Specify order grouping for rows and columns.

For more information about advanced cross-tab options, see Cross-Tab 
Objects, Page 443.

Server-side processing saves time and memory

You can now choose to have the program perform its grouping on the 
server. In this event, Seagate Crystal Reports pushes as much of the report 
processing as possible to the server. The benefits of this functionality 
include:

●   less time connected to the server,

●   less memory needed to process the report on your computer, and

●   lower transfer time from the server to the client.
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In short, server-side processing is the newest feature in quick, expedient 
reporting. For more information, see Server-side processing, Page 542.

Running totals -- one field is all you need

You no longer need to bother with cumbersome running total formulas: 
Seagate Crystal Reports offers an easy-to-use dialog box for creating 
running totals quickly. The program will take care of all the formulas, all 
you need to do is tell it which field to total, when to total it, and when to 
reset. Then simply place the running total on the report and you’re set to 
go. For more information, see Running Totals, Page 341.

Document Import Tool converts old text reports

Have you ever wished you could use Seagate Crystal Reports formatting 
and grouping abilities in old text reports? Well, now you can. With the 
Document Import Tool, Seagate Crystal Reports offers a powerful new 
reporting functionality. By simply highlighting the various sections of a 
report and then compiling, you can easily convert a plain ASCII text 
report to  Seagate Crystal Reports.

With this new tool, you can:

●   convert old ASCII text reports into Seagate Crystal Reports,

●   map the report fields to the original database, and then

●   generate the report whenever you want, from within Seagate 
Crystal Reports.

Now you can use Seagate Crystal Reports for all your reporting needs. 
For more information, see Document Import Tool, Page 433.

 Entering SQL expressions directly helps you create reports faster

SQL expressions are a means of querying databases for specific data. 
These requests are written in Structured Query Language (SQL). Seagate 
Crystal Reports lets you enter SQL expressions directly from the Insert 
Fields dialog box. From there, the program provides an editor much like 
the Formula Editor, allowing you to create new SQL expressions quickly 
and easily. Then you can insert the SQL expressions into a report just like 
database fields. For more information, see How to create an SQL expression 
field, Page 107.
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Highlighting Expert makes formatting faster and easier

With the Highlighting Expert, Seagate Crystal Reports offers powerful 
highlighting functionality that allows you to quickly apply conditional 
formatting to currency and number fields. From just one dialog box, you 
can apply:

●   font color,

●   background color, and

●   border style.

You can also specify multiple sets of formatting specifications, each one 
dependent on a separate condition. For more information, see How to Use 
the Highlighting Expert, Page 224.

Field Mapping provides more database control

Seagate Crystal Reports provides a dialog box for mapping altered 
database fields. If the database is edited or changed, and causes errors in 
a report, you no longer need to delete and replace the affected fields. 
Now, you can remap them. This lets you get your reports up and running 
again in a very short amount of time.

The program will automatically generate the Map Fields dialog box when 
you need it. For more information about mapping altered database fields, 
see Working With Databases, Page 507.

Enhanced Formula Editor makes creating formulas easy

The Formula Editor has been updated to include advanced features, 
including bookmarks (which allow you to navigate through long 
formulas), search and replace (also useful for long formulas), and the 
ability to edit more than one formula before closing the editor. Plus, you 
can rearrange the elements of the Formula Editor so that you can work 
more efficiently. In short, the Formula Editor has an entirely new look, 
allowing for faster manipulation of your formulas. For more information, 
see How formulas are created: an introduction to the Formula Editor, Page 296.
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Enhanced exporting capabilities

This version of Seagate Crystal Reports allows you to export reports to 
applications, such as MS Word and MS Excel. When a report is exported 
to an application, Seagate Crystal Reports saves the report as a temp file 
and will automatically open it in the appropriate application. This new 
feature extends the range of reporting capabilities. For more information, 
see How to export reports, Page 133.

New and better parameter fields provide greater flexibility

Seagate Crystal Reports includes new functionality that lets you create 
even more powerful parameter fields than before. With multiple default 
prompting values, you can allow for a wide range of options when 
entering parameter values. With range limiting, you can specify a 
minimum/maximum range for parameter values. With edit masks, you 
can limit the values entered to certain characters. For more information, 
see Parameter Fields, Page 351.

On-Demand subreports increase report organization

Seagate Crystal Reports now allows you to create on-demand subreports, 
where the subreport data remains hidden until the user requests it. The 
subreport is represented on the report by an object frame, but the actual 
data remains hidden until the user drills-down on the frame. This way, 
the user will not be burdened with extraneous data. The user can choose 
when and if they want to drill-down and view the subreport. This feature 
can be especially useful if you want to include several subreports in the 
same primary report, but you don’t want all the data displayed at once. 
In this case, you can specify that the subreports are on-demand so that 
only an object frame will appear for each subreport. This makes the 
subreports much more manageable. For more information about on-
demand subreports, see Subreports, Page 415.
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3 Learning Seagate Crystal Reports

What you will find in this chapter...

Learning Seagate Crystal Reports, Page 28

User’s Guide, Page 28

Online Help, Page 34

Books Online, Page 34

Sample Reports, Page 35

Glossary, Page 35

Sample Data - xtreme.mdb, Page 35

Suggested learning paths, Page 37
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Learning Seagate Crystal Reports

Seagate Crystal Reports comes with a wide variety of tools and a 
comprehensive sample database to help you learn the program and use it 
efficiently.

The purpose of this chapter is to:

●   explore the various learning sections in this manual,

●   introduce the other tools that come with the program, and

●   suggest learning paths based on your background.

User’s Guide

The following is a short description of each chapter in this manual for 
easy reference. It is recommended that you read through these brief 
descriptions in order to familiarize yourself with the content and design 
of the manual. This will make locating information later more efficient.

CHAPTER I, INSTALLATION AND QUICK START

Installation and Quick Start, Page 11, includes everything you need to get 
up and running with Seagate Crystal Reports. Intended for experienced 
users and new users who like to “learn by doing”, the Quick Start covers 
all the key elements of working with the program in a few short pages.

CHAPTER 2, WHAT’S NEW

Seagate Crystal Reports has been enhanced for this release. What’s New, 
Page 21, identifies and describes the new features, and points you to those 
sections of the manual where they are discussed in depth. Users who are 
familiar with earlier versions of Seagate Crystal Reports will benefit the 
most from this chapter.

CHAPTER 3, LEARNING SEAGATE CRYSTAL REPORTS

Learning Seagate Crystal Reports, Page 27, introduces you to the various 
tools available for learning Seagate Crystal Reports. It also suggests 
learning paths that you might follow based on your background.

CHAPTER 4, GETTING TO KNOW SEAGATE CRYSTAL REPORTS

Getting to Know Seagate Crystal Reports, Page 41, introduces you to Seagate 
Crystal Reports. In this chapter you will learn about the tools, pointers, 
and tabs used to design, preview, and analyze reports. This chapter 
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explains what to do, then shows how to do it. Users at all levels will 
benefit from reading this chapter.

CHAPTER 5, INTRODUCTION TO REPORTING

Introduction to Reporting, Page 85, concentrates on the basic concepts of 
report design, and then explains, in simple terms, the concepts you 
should understand in order to:

●   select database tables,

●   select fields,

●   place objects on a report,

●   sort, group, and total data, and

●   select records to be included in a report.

This chapter is written for users new to reporting, but also contains 
background information that users at all skill levels may find useful. 
Armed with this kind of information, you will be well-prepared to create 
powerful reports that run efficiently and provide exactly the information 
you need.

CHAPTER 6, PRINTING, VIEWING, AND EXPORTING

Printing, Viewing, and Exporting, Page 121, details the ways finished reports 
can be viewed, printed, and exported. It shows how to use report viewers 
(including the ActiveX and Java viewers that work in web browsers), 
introduces a number of printing considerations, and explains how to 
export reports in various formats to a variety of destinations, such as e-
mail, Lotus Notes, and Microsoft Exchange.

CHAPTER 7, TUTORIAL - CUSTOMER LIST

Tutorial - Customer List, Page 147, is the primary tutorial for Seagate 
Crystal Reports. It is a product introduction that leads you step-by-step 
through the process of creating a report, while at the same time 
introducing many of the key features of the program. This tutorial has 
been written for the new user. No prior knowledge of reporting is 
necessary. By the time you finish this tutorial, you should have enough 
understanding of the program to feel comfortable getting started on your 
own report.

CHAPTER 8, REPORTING ON OLAP DATA

Reporting on OLAP data, Page 171, demonstrates how to create reports 
with OLAP data. Although the procedures are similar to working with 
PC and SQL data, there are several additional tools in Seagate Crystal 
Reports for working with multi-dimensional data sources.
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CHAPTER 9, MULTIPLE SECTION REPORTS

Multiple Section Reports, Page 195, introduces the various types of 
sophisticated reporting available when using the multiple section 
reporting capabilities in Seagate Crystal Reports. These capabilities 
enable you to create reports that treat individual values differently based 
on sets of criteria you establish. With multiple-section reports, you can:

●   format objects and sections differently based on field values,

●   put conditional messages in form letters,

●   add blank lines automatically when certain conditions are met, 
and

●   perform many other reporting tasks.

CHAPTER 10, FORMATTING

Formatting, Page 209, leads you through the steps that are necessary to 
format a report. Formatting refers to those things that are done to change 
the layout and design of a report, as well as the appearance of text, 
objects, or entire report sections. Using the formatting tools in Seagate 
Crystal Reports, you can:

●   call attention to certain data,

●   change the presentation of dates, numbers, and other values,

●   hide unwanted sections, and

●   perform a variety of other formatting tasks to give a report a 
professional appearance.

CHAPTER 11, RECORD AND GROUP SELECTION

Record and Group Selection, Page 227, shows you how to filter which 
records and groups of records you want to be included in a report. Using 
the record and group selection tools included in Seagate Crystal Reports, 
you can do such things as include records for a specific group of 
customers only, a specific range of account numbers, or records that fall 
within a particular date range.

CHAPTER 12, SORTING, GROUPING, AND TOTALING

No other program has the sorting, grouping, and totaling capabilities of 
Seagate Crystal Reports. Sorting, Grouping, and Totaling, Page 245, 
describes and demonstrates the types of sorting, grouping, and totaling 
you can do within a report. This chapter is an excellent overview for both 
beginners, who may not understand sorting, grouping, and totaling, and 
advanced users, who may want to know more about these options.
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CHAPTER 13, INTRODUCTION TO FORMULAS

Seagate Crystal Reports is equipped with a powerful formula language. 
Once you become comfortable working with formulas, your reporting 
capabilities are virtually endless. Introduction to Formulas, Page 291, gets 
you started creating simple formulas. It familiarizes you with the tools of 
the Formula Editor and leads you step-by-step through the formula 
creation process. This chapter has been written for people who are 
inexperienced with formulas and demonstrates exactly how to perform 
each step. It is a chapter intended to get you beyond the mystery of 
formulas and into using them for your everyday reporting needs.

CHAPTER 14, ADVANCED FORMULAS

Advanced Formulas, Page 315, gets into the realm of “what is possible” with 
Seagate Crystal Reports. It shows you how to create and use variables, 
how to “tweak” formula evaluation times so the formula is evaluated 
against the “right” data, and how to perform complex conversions. 
Written for the advanced user, this chapter shows how to use Seagate 
Crystal Reports to create customized formulas for all your reporting 
needs.

CHAPTER 15, RUNNING TOTALS

Running Totals, Page 341, introduces the Running Total field.  Seagate 
Crystal Reports, always a leader in sorting, grouping, and totaling, 
includes a special Running Total field that enables you to perform 
sophisticated running total activities with ease. The tutorials included in 
this chapter demonstrate techniques that use Running Total fields to 
produce reports that total running amounts in a list, groups, and other 
special cases.

CHAPTER 16, PARAMETER FIELDS

Parameter Fields, Page 351, shows how to use parameter fields effectively 
for formulas, record selection formulas, and other reporting needs. 
Parameter fields are fields that prompt you to specify a value each time 
the data is refreshed in a report. When a value is supplied, the program 
runs the report using that value. By using parameter fields in formulas, 
selection formulas, and in the report itself, you can create one report that 
can be modified quickly as your needs change.

CHAPTER 17, CHARTING

Seagate Crystal Reports enables you to present summarized data in 
colorful, easy-to-read charts and graphs. Charting, Page 369, demonstrates 
how to create charts and how to use them in reports to make report data 
more meaningful and easier to digest quickly. Users can even drill-down 
to see the details behind the graphical summaries.
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CHAPTER 18, MAPPING

Seagate Crystal Reports allows professional geographic maps to be 
inserted into reports. Mapping, Page 385, demonstrates how to create 
maps and how to use them in reports to make it even easier to view and 
analyze data. Mapping makes reports more dynamic. You can even drill-
down to see the details behind the various geographic areas, or launch the 
Analyzer Tab to customize and rearrange the appearance of a map.

CHAPTER 19, OLE

Often when a graphic, spreadsheet, or some other object is inserted into a 
report, it may be necessary later to change that object. Normally, to make 
any changes, you have to go through a number of steps, including saving 
files, opening additional applications, etc. All of these steps can be 
avoided using Object Linking and Embedding (OLE). OLE allows OLE 
objects to be inserted into a report from other OLE server applications, 
and then allows those applications to be used from within Seagate Crystal 
Reports to edit the objects, as needed. OLE, Page 403, shows what is 
possible with OLE in Seagate Crystal Reports and how to implement it.

CHAPTER 20, SUBREPORTS

A subreport is a report within a report. With subreports, unrelated 
reports can be combined into a single report, coordinate data that can’t be 
otherwise linked, and present different views of the same data in a single 
report. Subreports, Page 415, shows what can be done with subreports in 
Seagate Crystal Reports, and demonstrates how to create them.

CHAPTER 21, DOCUMENT IMPORT TOOL

The Document Import Tool is a conversion utility that allows old ASCII 
text reports to be converted into Seagate Crystal Reports. You can 
accomplish this by highlighting the various report sections (headers, 
footers, Details section, etc.) from within the Seagate Document Import 
Tool. You can then generate the report within Seagate Crystal Reports. 
Document Import Tool, Page 433, leads you step-by-step through the 
conversion process.

CHAPTER 22, CROSS-TAB OBJECTS

A cross-tab is an object that summarizes data and then presents the 
summaries in a compact row and column format that makes it easy to 
perform comparisons and identify trends. For reports that use the word 
“by” in the report description (sales by state, orders by customers, etc.), 
cross-tabs generally present data in a more compact easier-to-understand 
form than other reporting methods. Cross-Tab Objects, Page 443, 
introduces the cross-tab reporting tools, and shows how to create cross-
tab reports quickly and easily.
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CHAPTER 23, QUERIES

The Crystal SQL Designer, Page 465, shows how to create queries that can 
be used for ad-hoc analysis or result sets for creating reports. The Crystal 
SQL Designer can be used to create, modify, and optimize complex SQL 
queries with ease.

CHAPTER 24, DICTIONARIES

Dictionaries are structured and simplified views of data that can be 
created for some or all of the individuals in an organization. When 
working with Dictionaries, users see only the information they need and 
that you want them to see. They reduce support costs and time, increase 
user productivity, and reduce data misuse, loss, and damage. Dictionaries, 
Page 487, shows how to set up and use Dictionaries to improve 
organizational efficiency and security.

CHAPTER 25, WORKING WITH DATABASES

Understanding database concepts, relational database design, and 
performance considerations can help you get the most out of Seagate 
Crystal Reports. Working With Databases, Page 507, leads you through the 
basics and provides a detailed explanation of the way the program 
accesses linked data. The information in this chapter will help you 
optimize reporting for maximum efficiency. This chapter contains 
information for both the beginner and the advanced user.

CHAPTER 26, DATA SOURCES

Seagate Crystal Reports works with all kinds of data, from simple text 
files to advanced client-server SQL databases. Data Sources, Page 579, 
shows how the program connects to various data sources and what files 
have to be in place in order to make the connection. This is an in-depth 
chapter for advanced users who need to know how Seagate Crystal 
Reports operates beneath the surface.

APPENDIX A, REPORT PROCESSING MODEL

Seagate Crystal Reports uses a sophisticated multi-pass reporting model 
for processing reports. Understanding when different parts of the 
reporting process take place can help you design more efficient reports 
and solve reporting problems. Report Processing Model, Page 621, is written 
for the advanced user.

APPENDIX B, PRODUCT SUPPORT

Product Support, Page 625, introduces the various methods for obtaining 
product support.
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APPENDIX C, SEAGATE SOFTWARE INTERNATIONAL OFFICE 
DIRECTORY

Seagate Software International Office Directory, Page 633, lists the contact 
information for Sales, Product Support, and Product Registration at each 
Seagate Software office, worldwide.

Online Help

Online Help includes all of the information from the manual, as well as a 
description of each command, dialog box, formula function, and operator 
included with the program. Sample formulas, sample records, group 
selection formulas, and hundreds of topics on virtually anything related 
to reporting - online Help has it all.

In learning to use menu commands, for example, online Help gives an 
explanation of what the command does, a thorough explanation of any 
dialog boxes the menu command activates, and finally, tutorials for 
performing tasks using the menu command. By working through the 
topics for any menu command, you can find out why you would use it 
and become an expert in its use.

The Contents Tab can be used to navigate through online Help, the Search 
facility can look up topics by keywords, or the full-text Find facility can 
be used to pinpoint topics that contain the word of interest. It is suggested 
that you take advantage of the online Help often while learning Seagate 
Crystal Reports.

For more information on the help systems, see Using Seagate Crystal 
Reports documentation, Page 5.

Books Online

Books Online are hypertext documents with hundreds of jumps that go 
directly to topics of interest, related topics, and technical information.   
Books Online contains the full text of this manual and several other 
documents and can be found on the Crystal Reports CD under the \Docs 
folder. These documents have been created with Adobe Acrobat. Acrobat 
Reader has a full text search capability, allowing you to find any topic of 
interest if you can think of just one unique word it might contain. With 
electronic search and jump capabilities, Books Online provides the tools 
needed to find information in a hurry.

Books Online can be set up in a variety of ways to suit your needs. 
Consult the Acrobat Reader Help System for a complete explanation of 
the available options.
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Sample Reports

Seagate Crystal Reports comes with two kinds of professionally designed 
sample reports:

1. General departmental reports cover a wide range of reporting needs 
for many of the departments in an organization.

2. Financial reports address the specific needs of financial institutions 
and corporate finance departments. Financial reports are available 
with the Professional edition only.

The sample reports are valuable learning tools.

●   By studying the content of the reports, you can see the kind of 
information that is needed and how it is presented.

●   By studying the layout and design of the reports, you can see how 
the information is arranged for clarity.

Glossary

This manual comes with a comprehensive glossary explaining basic 
database and reporting concepts, as well as, issues specific to the program. 
Unlike some glossaries which offer little substance, this glossary gives in-
depth explanations of terms used by Seagate Crystal Reports.

Reading the glossary is an excellent warm-up before you start working 
with the other training aids.

Sample Data - xtreme.mdb

Seagate Crystal Reports comes with xtreme.mdb, a sample database you 
can use when learning the program. Xtreme.mdb is a Microsoft Access 
database and all of the necessary drivers are included. You should be able 
to open the database directly and begin designing reports. Virtually all of 
the examples in this manual are based on xtreme.mdb data.

Xtreme.mdb is a database that contains data for Xtreme Mountain Bikes, 
a fictitious manufacturer of mountain bikes and accessories. The database 
includes the following tables:

●   Xtreme Info
Company data for the Xtreme Mountain Bike company, including 
the company logo.
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●   Credit
Information from customer credit memos, such as credit 
authorization IDs and amounts.

●   Customer
Data for the customers served by the company.

●   Employee
Company-oriented data for the employees of Xtreme Mountain 
Bikes.

●   Employee Addresses
Personal data for Xtreme Mountain Bikes employees.

●   Financials
Financial data for Xtreme Mountain Bikes.

●   Orders
Identifying and tracking data for orders.

●   Orders Detail
Line item data for orders.

●   Product
Descriptive data for Xtreme Mountain Bike products.

●   Product Type
Category data for Xtreme Mountain Bike products, including 
product pictures.

●   Purchases
Identifying and tracking data for product purchases.

●   Supplier
Data for suppliers who serve Xtreme Mountain Bikes.
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The links (relationships) between the tables are as follows: 

Xtreme.mdb also includes:

●   a query (Top Customers),

●   a parameter query (Credit_Limits) that you can use to learn how to 
report on those kinds of data sets, and

●   the Xtreme Info table which is not linked to any other table. This table 
contains company information for Xtreme Mountain Bikes.

NOTE: The sample data has been designed to illustrate various reporting 
concepts in a training environment, not to teach database design. While 
there are alternative ways of designing a database, this design was 
selected to keep the tutorials and examples focused on reporting, not on 
data manipulation.

Suggested learning paths

There is no correct learning path for everyone; you have your own needs, 
and will learn in your own way, at your own speed. What follows are 
simply suggested learning paths for several kinds of users.

The order of the elements in each path is one that has been carefully 
structured to speed the learning process. To get the best results, locate the 
category that best describes your reporting experience and follow the path 
from start to finish.
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New user 
(business)

The following learning path is suggested for new users who expect to use 
Seagate Crystal Reports on a casual basis.

●   Give the Glossary, Page 647, a quick read.

●   Read Getting to Know Seagate Crystal Reports, Page 41.

●   Read Introduction to Reporting, Page 85.

●   Read Printing, Viewing, and Exporting, Page 121.

●   Work through Tutorial - Customer List, Page 147.

●   Read Record and Group Selection, Page 227.

●   Scan Sorting, Grouping, and Totaling, Page 245.

●   Read Introduction to Formulas, Page 291.

●   Review Sample Reports, Page 35.

●   Refer to online Help and the Hands-On tutorials, as needed.

Business user 
upgrading from 
an earlier 
version

The following learning path is suggested for users who are upgrading 
from an earlier version of Seagate Crystal Reports.

●   Scan the Glossary, Page 647, for new terms.

●   Read Installation and Quick Start, Page 11.

●   Read What’s New, Page 21.

●   Read Getting to Know Seagate Crystal Reports, Page 41.

●   Scan Introduction to Reporting, Page 85.

●   Scan Printing, Viewing, and Exporting, Page 121.

●   Scan Multiple Section Reports, Page 195.

●   Scan Record and Group Selection, Page 227.

●   If you have limited formula experience, read Introduction to 
Formulas, Page 291.

●   If you have a working knowledge of formulas, read Advanced 
Formulas, Page 315.

●   Scan Subreports, Page 415.

●   Review Sample Reports, Page 35.

●   Refer to Hands-On tutorials, as needed.

New power user The following learning path is suggested for new users who expect to use 
many of the sophisticated features of Seagate Crystal Reports.

●   Read Installation and Quick Start, Page 11.
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●   Read What’s New, Page 21.

●   Read Getting to Know Seagate Crystal Reports, Page 41.

●   Scan Introduction to Reporting, Page 85.

●   Scan Printing, Viewing, and Exporting, Page 121.

●   Read Multiple Section Reports, Page 195.

●   Scan Record and Group Selection, Page 227.

●   Scan Sorting, Grouping, and Totaling, Page 245.

●   Scan Introduction to Formulas, Page 291.

●   Read Advanced Formulas, Page 315.

●   Read Running Totals, Page 341.

●   Read Parameter Fields, Page 351.

●   Read Charting, Page 369.

●   Read Mapping, Page 385.

●   Read Subreports, Page 415.

●   Read Performance considerations for all reports, Page 520.

●   Read Report Processing Model, Page 621.

●   Review Specialized Formulas in online Help.

●   Refer to the Glossary, Page 647, and Hands-On tutorials, as needed.

Power user 
upgrading from 
an earlier 
version

The following learning path is suggested for power users who are 
upgrading from an earlier version of the program.

●   Read What’s New, Page 21.

●   Read Getting to Know Seagate Crystal Reports, Page 41.

●   Read Advanced Formulas, Page 315.

●   Read Charting, Page 369.

●   Read Mapping, Page 385.

●   Read Performance considerations for all reports, Page 520.

●   Read Report Processing Model, Page 621.

●   Review Power Formulas in online Help.

●   Refer to the Glossary, Page 647, and Hands-On tutorials, as needed.

New MIS user The following learning path is suggested for Management Information 
Systems (MIS) professionals who are using Seagate Crystal Reports for 
the first time.
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●   Read Installation and Quick Start, Page 11.

●   Read What’s New, Page 21.

●   Read Getting to Know Seagate Crystal Reports, Page 41.

●   Read Multiple Section Reports, Page 195.

●   Read Advanced Formulas, Page 315.

●   Read Running Totals, Page 341.

●   Read Parameter Fields, Page 351.

●   Scan Subreports, Page 415.

●   Read Performance considerations for all reports, Page 520.

●   Read Report Processing Model, Page 621.

●   Review Power Formulas in online Help.

MIS user 
upgrading from 
an earlier 
version

The following learning path is suggested for MIS users who are 
upgrading from an earlier version of Seagate Crystal Reports.

●   Read What’s New, Page 21.

●   Read Getting to Know Seagate Crystal Reports, Page 41.

●   Read Multiple Section Reports, Page 195.

●   Scan Sorting, Grouping, and Totaling, Page 245.

●   Read Advanced Formulas, Page 315.

●   Read Running Totals, Page 341.

●   Read Parameter Fields, Page 351.

●   Read Subreports, Page 415.

●   Read Dictionaries, Page 487.

●   Read Performance considerations for all reports, Page 520.

●   Read Data Sources, Page 579.

●   Read Report Processing Model, Page 621.
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4 Getting to Know Seagate Crystal 
Reports

What you will find in this chapter...

The application window, Page 42

Menu bar, Page 42

Standard toolbar, Page 45

Formatting toolbar, Page 47

Supplementary toolbar, Page 49

Analyzer toolbar, Page 50

Status bar, Page 51

Shortcut menus, Page 53

Cursors, Page 54

Design Tab, Page 57

Preview Tab, Page 61

Analyzer Tab, Page 65

Other fundamentals, Page 66

HANDS-ON (Report Design Environment), Page 70

HANDS-ON (Sections and Areas), Page 79
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The application window

The application window is clear and easy to understand. 

●   The Title bar identifies the current report and contains the 
standard Windows buttons.

●   The Menu bar appears just below the title bar.

●   The Standard toolbar appears just below the menu bar.

●   The Formatting toolbar appears just below the standard toolbar.

●   If toggled on, the Analyzer toolbar appears just below the 
formatting toolbar.

●   If toggled on, the Supplementary toolbar appears just above the 
status bar.

●   The Status bar appears at the bottom of the window.

Menu bar

The Menu bar is the command center of Seagate Crystal Reports. Each 
option on the menu bar activates a drop-down list of commands used to 
create, modify, print, and save reports.
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The Menu bar contains the following menus:

●   File,

●   Edit,

●   View,

●   Insert,

●   Format,

●   Database,

●   Report,

●   Analyzer,

●   Window, and

●   Help Menu.

File Menu The File Menu includes commands used to open, close, and save files, 
save files under a different file name, create new reports, mailing labels, 
and cross-tabs, as well as several other kinds of reports. It also includes a 
command to exit the program. Additionally, it contains commands that 
enable you to change page margins, preview a report before printing, 
send a report to a printer, select a printer if you want the report to print 
on something other than the default printer, and export a report to a disk 
file in a variety of formats. You can also add summary information to help 
you identify a report, as well as, change the default settings so that the 
program works the way that is the most efficient for you. Search for File 
Menu Commands in online Help.

Edit Menu The Edit Menu includes commands used to modify aspects of a report. It 
includes commands to undo and redo actions, edit fields, formulas, 
summaries, subreport links, OLAP members, OLE objects and OLE links, 
to view a sample of the data in a selected field, and to cut, copy, and paste 
report and OLE objects. You can also use the Edit Menu commands to 
show, hide, move, merge, or delete report sections, delete groups, and 
convert static OLE objects into editable bitmaps. Search for Edit menu 
commands in online Help.

View Menu The View Menu includes commands used to modify the user interface of 
the program. View Menu commands enable you to show or hide the 
toolbars, zoom in and out on a report to view it at different 
magnifications, and to turn guidelines, the grid, and the rulers on and off. 
The Group Tree view can be toggled on and off from the View Menu. 
Search for View Menu commands in online Help.
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Insert Menu The Insert Menu includes commands used to insert database fields, text 
objects, formula fields, parameter fields, cross-tab objects, subtotals, 
grand totals, summaries (counts, averages, etc.), groups, and sections. 
This menu also includes commands that enable you to insert group name 
fields, subreports, graphics, lines, boxes, charts, and OLE objects into a 
report. Search for Insert Menu commands in online Help.

Format Menu The Format Menu includes commands used to change the look of the 
elements in a report. It includes commands for changing fonts and for 
adding field borders, background color, and drop shadows. The Format 
Menu has commands for formatting fields that are embedded in text 
objects, for formatting individual paragraphs in those text objects, and for 
entire sections of the report as well. There are also commands for 
formatting charts, as well as, formatting and pivoting cross-tabs. Finally, 
Format Menu commands can be used to have the program automatically 
arrange report objects, apply professionally-designed styles to the entire 
report, and move individual objects within a stack of objects forward and 
backward. Search for Format Menu commands in online Help.

Database Menu The Database Menu includes commands used to add and delete tables for 
use with reports, to change the alias used to identify a table, and to link 
and unlink tables. It has commands for logging on and off SQL and 
ODBC servers, for showing Essbase report scripts, showing and editing 
SQL queries, and modifying parameters for stored procedures. The 
Database Menu also has commands that direct the program to look for 
tables in new locations, change database drivers used in a report, remove 
tables from a report, and adapt reports appropriately if there are minor 
changes in table structure. Search for Database Menu commands in online 
Help.

Report Menu The Report Menu includes commands used to select the records or 
groups to be included in a report, select the order in which report data is 
to be sorted (by record or by group), specify subreport links, and specify 
a print date for a report. It has commands for updating the data used in a 
report and for gathering all the files needed for distributing reports. You 
can also use one of the Report Menu commands to create an executable 
version of the report, which you can share with others who do not have 
Seagate Crystal Reports. Search for Report Menu commands in online Help.

Analyzer Menu The Analyzer Menu includes commands used to launch the Analyzer Tab 
and customize your charts and maps. The menu includes commands for 
changing the group order, series order, and viewing angles for charts, for 
zooming, centering, and panning maps, for changing map and chart 
titles, for drilling-down on maps, and for changing the map style and the 
organization of the map layers. There is also a command for formatting 
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the field you are currently charting or mapping, and a command for 
restoring all the original settings for the modified chart or map. Search for 
Analyzer Menu commands in online Help.

Window Menu The Window Menu includes commands used to rearrange icons and 
windows. It also lists the report windows that are open and includes a 
command that closes all report windows at once, if desired. Search for 
Window Menu commands in online Help.

Help Menu The Help Menu includes commands used to access Seagate Crystal 
Reports online Help index and the search facility that provides context 
sensitive Help. It has commands for registering the program, accessing 
technical information about your computer system, and creating a 
technical support request. You can toggle the Welcome dialog box on and 
off, and if connected to the Internet, you can access several key pages of 
the Seagate web site using commands on the Help Menu. One other 
command provides information about the version of the program in use. 
Search for Help Menu commands in online Help.

Standard toolbar

Seagate Crystal Reports groups several commonly used commands on 
the Standard toolbar, which remains on-screen at all times (unless you 
decide to toggle it off in the Toolbars dialog box).

The Standard toolbar eliminates some of the steps needed to activate the 
commands and can thus greatly speed your work in creating reports. 
Each command available via the Standard toolbar is discussed in online 
Help (search for each command by name).

NOTE: In the 32-bit version of Seagate Crystal Reports, you can move the 
Standard toolbar to another fixed location within the window or set it up 
as a floating palette. See How to move and resize toolbars, Page 70.

If you are not sure about the function of a button on the Standard toolbar, 
place the pointer over the button and hold it there. A Tool Tip appears, 
providing a description of the button.

The buttons on the Standard toolbar perform the following functions:
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Creates a new report.

Opens an existing report.

Saves the report.

Sends the report to a printer.

Previews the report in the Preview Tab.

Exports the report to a file or e-mail.

Refreshes report data.

Cuts selected object/data to the Clipboard.

Copies the selected object/data to the Clipboard.

Pastes object/data from Clipboard to the report.

Undoes an action.

Repeats an action.

Inserts database, formula, parameter, running total and 
other group name fields.

Inserts a text object.

Inserts a summary.
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Formatting toolbar

The Formatting toolbar enables you to access many popular formatting 
options with the click of a button or a selection from a drop-down list. 
You simply select the data you want to format, then click the appropriate 
button or list option to format the data.

Two edit boxes with drop-down lists appear at the left side of the 
Formatting toolbar.
 

Use these drop-down lists to select new fonts and font sizes to use 
something other than the default font and font size.

The buttons on the Formatting toolbar perform the following functions: 

Activates the Report Expert.

Formats any section of the report.

Sets record/group selection criteria.

Sets record sort order.

Inserts a chart.

Inserts a Map.

Searches for a specific record.

Sets the magnification factor for viewing your report.

Activates context-sensitive Help.
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Increases the font size of the selected data one point each 
time the button is clicked.

Decreases the font size of the selected data one point each 
time the button is clicked.

Changes the selected data to boldface.

Italicizes the selected data.

Underlines the selected data.

Aligns the selected data flush left.

Centers the selected data.

Aligns the selected data flush right.

When a number field is selected, places a currency symbol 
with the number.1

When a number field is selected, places a thousands 
separator in the number.1

When a number field is selected, places a percentage sign 
with the number.1

When a number field is selected, adds one decimal place to 
the number.1

When a number field is selected, subtracts one decimal place 
from the number.1

Activates the Highlighting Expert. See Highlighting Expert in 
the online Help.

Toggles the Group Tree’s Smart Navigation on/off in the 
Preview Tab. See Group Tree view, Page 63.
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Supplementary toolbar

The Supplementary toolbar provides quick access to many advanced, 
report-enhancing experts and features. Activate the Supplementary 
toolbar by clicking the SUPPLEMENTARY TOOLBAR button, found on the 
far-right end of the Formatting toolbar.

NOTE: The Supplementary toolbar only appears in the 32-bit version of 
Seagate Crystal Reports.

The buttons on the Supplementary toolbar perform the following 
functions:

Toggles the Supplementary toolbar on/off. See 
Supplementary toolbar, Page 49.

�7KH�SURJUDP�UHIHUV�WR�WKH�VHWWLQJV�LQ�WKH�,QWHUQDWLRQDO�VHFWLRQ�RI�WKH

&RQWURO�3DQHO��:LQGRZV���[��DQG�:LQGRZV�17�������RU�LQ�WKH�5HJLRQDO

6HWWLQJV�VHFWLRQ�RI�WKH�&RQWURO�3DQHO��:LQGRZV�����:LQGRZV�����DQG

:LQ�17������

Inserts a line.

Inserts a box.

Inserts a picture.

Arranges report elements automatically to best fit the page.

Activates Style Expert to apply a professionally-designed 
style to a report.

Inserts a group.

Inserts a subreport.

Inserts a cross-tab object.
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Analyzer toolbar

The Analyzer toolbar allows you to quickly view and customize maps 
and charts on the Analyzer Tab. To activate this toolbar, choose the 
TOOLBARS command from the View menu and then toggle the Analyzer 
check box on in the Toolbars dialog box.

One drop-down list appears at the left-hand side of the Analyzer toolbar.

Use this drop-down list to change the color of a single data item on a chart 
(for example, to change the color of one of the bars on a bar chart).

The buttons on the Analyzer toolbar perform the following functions for 
maps:

Finds Top/Bottom N records or sorts on summary 
information.

Activates the Format Editor to modify object properties.

Compiles the report.

Activates the Report Distribution Expert.

Defines links between tables.

Activates the drill-down mode, and changes the cursor to a 
Drill-down cursor.

Activates the Zoom In mode, and changes the cursor to a 
Zoom cursor.

Activates the Zoom Out mode, and changes the cursor to a 
Zoom cursor.

Activates the Pan mode, and changes the cursor to a 
Panning cursor.
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Status bar

The status bar at the bottom of the application window displays valuable 
information to help users work with the program more efficiently.

TOOLBAR FUNCTIONS

When the cursor is over a toolbar button, the status bar displays a short 
description of the button’s function.

MENU COMMAND DESCRIPTIONS

When a menu command is highlighted, the status bar displays a short 
description of the command.

CURRENT SELECTIONS

When you highlight or place an object, the status bar displays the name 
of the object (or its object type) plus its location and sizing information.

To identify objects, the status bar displays:

●   the words OLE Object for a picture or other OLE object,

●   the alias and field name for a field,

●   the words Line for a line, Box for a box, and Text for a text object,

●   the field type for special fields (Print Date, Record Number, and so 
forth),

●   the summary name for a summary or subtotal,

●   the formula name for a formula,

●   the parameter field name for a parameter field, and

●   the running total field name for a running total field.

Centers the map on the Analyzer Tab.

Opens the Customize Map dialog box, for changing the style 
and appearance of the map on the Analyzer Tab.

Opens the Layer Control dialog box, for re-arranging the 
layers of the map on the Analyzer Tab.
Getting to Know Seagate Crystal Reports 51



The status bar also displays:

●   how far the object is from the left and top boundaries of a section, 
and

●   how big the object is.

With this information, you can easily move and resize objects with 
precision.

DATA RETRIEVAL INFORMATION

When you preview a report for the first time or refresh the data in the 
Preview Tab, the status bar displays four figures that describe the data 
retrieval processing.

1. The first number displays the number of records selected out of the 
number of records read.

2. The second number displays the number of records read. If a report:

●   has a selection formula, the records selected figure will typically be 
smaller than the records read figure.

●   does not have a selection formula, records selected will always be 
equal to records read.

3. The third number displays the total number of records that will be 
processed. If the report is based on:

●   a single table, the figure that is displayed should remain constant.

●   linked tables, and if any one-to-many situations exist, the figure 
will typically increase as the program identifies all the linked 
records.

4. The final number is the percentage of the total records that have been 
processed.
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Once the report has finished processing, the program displays only the 
number of records selected and the percentage processed.

Shortcut menus

When you are working in either the Design or Preview Tab, you can 
speed up your work considerably by using shortcut menus. When you 
right-click a report element (a picture, section, field, etc.), the program 
displays a shortcut menu next to the element. Unlike the program’s 
standard menus that group commands by function (editing, inserting, 
etc.), shortcut menus are element-specific; they contain only those 
commands that are available for use with the selected element.

Shortcut menus are useful because they:

●   display the name and source (alias) of the element at the top of the 
menu so you can identify the elements on your report with a 
single click,

●   make it easier to learn the program because they eliminate the 
need to remember where to find a command,

●   make working with the program more efficient because you are 
dealing with only a compact list of commands, which makes it 
easier to pick the right one, and

●   spotlight the things you can do with an element making the 
program more intuitive to use.
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Cursors

Seagate Crystal Reports uses a number of different cursors at different 
points in its operation: 

Right-click the gray area
of the Details section and
a menu like this appears.

Right-click a field and a 
menu like this appears.

Right-click the
Design Tab itself
and a menu like

this appears.

Right-click the gray
area of a toolbar and a
menu like this appears.

The Arrow cursor is the primary cursor, used for making 
menu choices, selecting options from dialog boxes, working 
with scroll bars, clicking buttons and objects, and so on.

The Hourglass or Background Processing cursor appears 
whenever the program is processing a command. Whenever 
the hourglass is visible, you can not choose any commands 
or proceed further with the report.
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The double-arrow Resizing cursor changes to one of a 
number of different double-arrow cursors whenever it is 
placed over a resizing handle on a bit-mapped graphic, 
graphic box, graphic line, or field.

The Move cursor appears whenever a single object is being 
dragged to another location in a report.

The single-unit Drag and Drop cursor appears whenever a 
single item is dragged over an area where it can be dropped.

The multi-unit Drag and Drop cursor appears whenever 
multiple items are dragged over an area where they can be 
dropped. It is also used to copy multiple items at one time.

The Stop cursor appears whenever a dragged item is over 
an area where it can not be dropped.

The Copy cursor appears whenever a single item is being 
copied.

The Section Sizing cursor changes from the Arrow cursor 
whenever it is positioned over the boundary of any report 
section. This cursor is used to drag a section boundary line 
in order to expand or reduce the size of a section.

The Section Splitting cursor appears when the pointer is 
positioned over the left boundary of a report section. Click, 
and a horizontal line appears, to position where the section 
should be split.

The Link cursor appears when links are manually created in 
the Visual Linking Expert. Search for Visual Linking Topics 
Index in Seagate Crystal Reports online Help.

The Drill-down cursor appears when the pointer is 
positioned over a summary value or a chart in the Preview 
Tab. Double-click a summary value or chart element with 
the Drill-down cursor, and the program displays the details 
behind the summary.

The Pencil cursor is a drawing cursor. It appears whenever 
boxes and lines are inserted. The point of the pencil marks 
the spot where the drawing begins and is used to define the 
size and shape of the object drawn.
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The Help cursor appears when the HELP button on the 
Standard toolbar is clicked. Use the Help cursor to access 
the online Help system. Simply click the report element or 
dialog box to bring up context-sensitive Help for that item.

The Tiny Hand cursor is available in the online Help 
system. The Arrow cursor changes to the Tiny Hand cursor 
whenever it is positioned over text or a graphic that jumps 
to another topic in online Help.

The 2-Dimensional Panning or Anchor cursor appears as an 
IntelliMouse feature for scrolling through your report in 
any direction in the Preview Tab.

The Scroll cursor appears as an Intellimouse feature for 
scrolling a report up/down in the Preview Tab.

The Pan cursor appears as an Intellimouse feature for 
panning a report right/left in the Preview Tab.

The North panning cursor appears as an Intellimouse 
feature for panning North (up) in a document.

The South panning cursor appears as an Intellimouse 
feature for panning South (down) in a document.

The East panning cursor appears as an Intellimouse feature 
for panning East (to the right) in a document.

The West panning cursor appears as an Intellimouse feature 
for panning West (to the left) in a document.

The Northeast panning cursor appears as an Intellimouse 
feature for panning Northeast (up and to the right) in a 
document.

The Northwest panning cursor appears as an Intellimouse 
feature for panning Northwest (up and to the left) in a 
document.

The Southeast panning cursor appears as an Intellimouse 
feature for panning Southeast (down and to the right) in a 
document.

The Southwest panning cursor appears as an Intellimouse 
feature for panning Southwest (down and to the left) in a 
document.
56 Seagate Crystal Reports User’s Guide



Design Tab

When working with Seagate Crystal Reports, you will probably use the 
Design Tab more than any other part of the program.

The Design Tab is the place you do most of the initial work when creating 
a report. It designates and labels the various sections of the report. You 
can place objects in these sections where you want them to appear, 
specify sorting, grouping, and totaling needs, do the initial formatting, 
and so forth. See Area printing characteristics, Page 59.

The Design Tab provides a very efficient environment for designing a 
report because you work in the tab with data representations, not with 
data itself. When a field is placed on the report, the program uses a frame 
to identify the field on the tab; it does not retrieve the data. Thus, you can 
add and delete fields and other objects, move them around, set up 
complex formulas, and more, without tying up the computer or network 
resources needed to gather the data.

The report created in the Design Tab is a kind of virtual report; it has the 
structure and instructions for creating the final report, but it is not the 
report itself. To turn the Design Tab report into a final report or into a 
report that you can fine-tune, you “just add data.” You do this whenever 
you preview the report, print it, or output it in any other way. The actual 
data will now appear in the report.

Design Tab 
Areas

When you first begin creating a report, Seagate Crystal Reports 
automatically creates five areas in the Design Tab.

1. Report Header
This section is generally used for the report title and other 
information you want to appear at the beginning of the report. It can 
also be used for charts and cross-tabs that include data for the entire 
report.
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2. Page Header
This section is generally used for information that you want to 
appear at the top of each page. This can include such things as 
chapter names, the name of the document, and other similar 
information. This section can also be used to display field titles above 
the fields on a report.

3. Details
This section is used for the body of the report, and is printed once per 
record. The bulk of the report data generally appears in this section.

4. Report Footer
This section is used for information you want to appear only once at 
the end of the report (such as grand totals) and for charts and cross-
tabs that include data for the entire report.

5. Page Footer
This section usually contains the page number and any other 
information you want to appear on the bottom of each page.

If a group, summary, or subtotal is added to the report, the program 
creates two additional sections:

1. Group Header
This section typically holds the group name field, and can be used to 
display charts or cross-tabs that include data specific to the group. It 
is printed once at the beginning of a group.

2. Group Footer
This section generally holds the summary value, if any, and can be used 
to display charts or cross-tabs. It is printed once at the end of a group.

When a group, summary, or subtotal is added, the Group Header area 
appears directly above the Details area and the Group Footer area 
appears directly below the Details area.

If you set up additional groups, the program creates new group areas 
between the Details area and the existing Group Header and Group 
Footer area(s).
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Like the original areas, each of these newly added areas can contain one 
or more sections. By default, they each contain a single section.

Area printing 
characteristics

Each report area has its own printing characteristics. It is important to 
understand these characteristics because they affect when and how often 
different report objects get printed.

WHEN AREAS PRINT

Areas print in the order they appear on the Design Tab (top to bottom). If 
there is more than one section in an area, the sections print in the order 
they appear within the area. Thus, if you have three Report Header 
sections, all three of those sections will print, in order, before the 
section(s) in the Page Header area begin to print.

HOW OFTEN OBJECTS PRINT

The decision on where to place objects on the Design Tab is made easier 
if you understand how often each of the areas prints. Once you 
understand this, most of your reporting decisions are straightforward. 
This information becomes most useful, however, when you are trying to 
decide where to place charts, cross-tabs, and formulas to get specific 
results.

Objects print in the following ways:

●   Objects placed in the Report Header area print once, at the 
beginning of the report.

   Charts and cross-tabs placed in this area contain data for the 
entire report.

   Formulas placed in this area are evaluated once, at the 
beginning of the report.
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●   Objects placed in the Page Header area print at the beginning of 
each new page.

   Charts or cross-tabs can not be placed in this section.

   Formulas placed in this area are evaluated once per page, at 
the beginning of each new page.

●   Objects placed in the Group Header area print at the beginning of 
each new group.

   Charts and cross-tabs placed in this area contain data just for 
the group.

   Formulas placed in this area are evaluated once for each 
group, at the beginning of the group.

●   Objects placed in the Details area print with each new record.

   Charts or cross-tabs can not be placed in this area.

   Formulas placed in this area are evaluated once for each 
record.

●   Objects placed in the Group Footer area print at the end of each 
group.

   Charts and cross-tabs placed in this area contain data just for 
the group.

   Formulas placed in this area are evaluated once for each 
group, at the end of the group.

●   Objects placed in the Report Footer area print once at the end of 
the report.

   Charts and cross-tabs placed in this area contain data for the 
entire report.

   Formulas placed in this area are evaluated once, at the end of 
the report.

●   Objects placed in the Page Footer area print at the bottom of each 
page.

   Cross-tabs and charts can not be placed in this area.

   Formulas placed in this area are evaluated once per page, at 
the beginning of each new page.

Identifying and 
working with 
areas and 
sections

By default, each area contains only a single section. The name for that 
section appears directly to the left of the section. If you have multiple 
sections in an area, the sections are designated as a, b, c, and so forth.
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NOTE: Initials, such as RH, PH, D, PF, RF, and so on, are used to identify 
each section if you have toggled the Show Short Section Names in Design 
check box on in the Options dialog box. Search for Options dialog box in 
Seagate Crystal Reports online Help.

NOTE: If you right-click the shaded area containing a section name, a 
shortcut menu appears with section-specific options. If you right-click the 
shaded area to the left of the section names, a shortcut menu appears 
with area-specific options.

The program displays a section ruler immediately to the left of each 
section. The section ruler is used to add, remove, and move guidelines, 
and to provide a visual reference when you are placing objects. See How 
to add, delete, and move guidelines, Page 72.

Whenever a new section is added, the program creates a ruler for that 
section. See How to add, delete, move, and merge sections, Page 79.

Other Design 
Tab capabilities

There are several other capabilities built into the Design Tab. With the 
Design Tab, you can:

●   resize a section by dragging its boundary. See How to split and resize 
sections, Page 82.

●   split a section (create two sections from one) by clicking its left 
boundary. See How to split and resize sections, Page 82.

●   add horizontal and vertical guidelines by clicking the rulers. See 
How to add, delete, and move guidelines, Page 72.

●   zoom in and out on a report at any magnification from 25% to 
400% of the original size. See How to zoom the report in and out, Page 
76.

Preview Tab

To preview a report before printing it, click the PRINT PREVIEW button on 
the Standard toolbar.

Section ruler.
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The program gathers the data, makes the necessary calculations, and 
displays the report in the Preview Tab on electronic “paper.” With the 
data in place, you can review the spacing and formatting of your report 
and see the actual results of all your summaries, formula calculations, 
and record and group selections.

In true WYSIWYG (What You See Is What You Get) fashion, you can 
work directly on this live data, fine-tuning it until the report has the exact 
look you want.

The program works with data in the following manner:

●   The first time the Preview Tab is used, it retrieves data from your 
underlying data source(s) and saves it with the report (unless you 
have set up the program not to save data).

●   From that point on, the program uses the saved data whenever 
you preview the report unless you specifically refresh it or add a 
field that requires the program to retrieve new data.

Seagate Crystal Reports provides two views for previewing a report:

1. Standard view, and

2. Group Tree view.

Standard view  

In standard view, the report is displayed a page at a time. Using the 
navigation buttons in the Preview Tab, you can move to the beginning or 
end of the report, or you can move backward and forward through the 
report one page at a time. For shorter reports or reports in which you're 
primarily interested in seeing the “bottom line” totals, standard view 
provides all of the functionality that you need.
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THE DATA AGE INDICATOR

The Data Age indicator indicates the date the data was last refreshed or 
initially retrieved, whichever is the most recent. If the data was initially 
retrieved or refreshed today, it indicates the time it happened. Search for 
Save Data with Report command in Seagate Crystal Reports online Help. 

Group Tree view

The Group Tree view can be toggled on/off using the TOGGLE GROUP 
TREE button on the Formatting toolbar.

The Group Tree view presents a split screen.

●   The right pane displays the report.

●   The left pane displays a high level outline of the report, showing 
the hierarchy of groups and subgroups in a familiar tree format.

When you click the tree node for the group that interests you, the 
program jumps immediately to the part of the report that contains the 
information for that group. For longer reports or reports in which you 
wish to jump back and forth between different groups, the Smart 
Navigation features of the Group Tree view make your work extremely 
efficient.

Similarities/
differences from 
Design Tab

You have the same formatting capabilities in the Preview Tab as you do 
in the Design Tab. Menus (both menu bar and shortcut menus), the 
standard and supplementary toolbars, rulers, and the Formatting toolbar 
remain active, giving you essentially the same functionality you have 
when working with a report in the Design Tab. However, when you are 
making numerous changes, it is quicker to make the changes in the 
Design Tab.
Getting to Know Seagate Crystal Reports 63



●   The Design Tab and Preview Tab are tied together internally. Any 
changes made in one are reflected in the other.

●   The Preview Tab has a single vertical ruler at the left of the tab 
rather than the individual section rulers seen in the Design Tab. 
The functionality of the ruler is the same.

●   The Preview Tab identifies report sections in the shaded area to 
the left of the data. With a quick look you can tell which report 
section the data is printing from. While section names appear only 
once in the Design Tab, they print each time a section prints in the 
Preview Tab.

●   The Record counter (see DATA RETRIEVAL INFORMATION, Page 
52, the Data Age indicator (see THE DATA AGE INDICATOR, Page 
63, and the Page Forward/Page Back controls (see Preview Tab, 
Page 61), are all active in the Preview Tab.

●   The Preview Tab highlights every value when you select a field; 
whereas, only the field frame is highlighted in the Design Tab.

A DIFFERENT FEEL

Working in the Preview Tab has a different feel from working in the 
Design Tab.

Each field in a database contains dozens, hundreds, or even thousands of 
values, depending on the number of records in the database. When you 
place a field in the Design Tab, a single field frame represents all those 
values. When you highlight the field, sizing handles appear on the frame 
and the frame changes color.

In the Preview Tab, however, you are working with the actual data. 
Instead of a field frame representing many field values, the values 
themselves appear.

●   When you highlight a field or formula field value, you are actually 
selecting every value in the field.

   The program places a sizing frame around the specific value 
you select.

   It highlights every other value in the field.

●   Likewise, when you select a summary value, you are actually 
selecting all the related summary values.

   The program places a sizing frame around the specific value 
you select.

   It highlights all the related summary values.
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Aside from the differences in appearance, the process of building and 
modifying a report is the same in both the Design Tab and the Preview 
Tab. You should find it easy to work with your reports in both places.

Analyzer Tab

The program provides a separate Analyzer Tab that allows you to 
examine your charts and maps independently of the main report. You can 
use this tab to rearrange chart and map elements, and to customize the 
appearance of the chart or map for more efficient analysis and trend 
identification.

To analyze a chart object or a map object in-depth, right-click the object in 
question and choose LAUNCH ANALYZER from the shortcut menu.

Working with 
charts

When viewing a chart on the Analyzer Tab, you can perform the 
following operations by using the commands on the shortcut menu:

●   change the title of the chart,

●   change the X-Axis title, Y-Axis title, and Z-Axis title,

●   reverse the order in which the series appear on the chart,

●   reverse the order in which the groups appear on the chart, as well 
as

●   any additional operations specific to the specific chart type.

Working with 
maps

When viewing a map on the Analyzer Tab, the shortcut menu can be used 
to perform the following operations:

●   center the map,

●   zoom in, zoom out, and pan the map,

●   change the map type and set options for the overall style of the 
map,

●   reorganize the layers of report elements (for example, you can 
display the major cities layer above the highways layer), and

●   change the map title.

NOTE: The Analyzer Tab’s centering, zooming, and panning capabilities 
are also available as commands on the shortcut menu of the Preview Tab 
(if you right-click the map object in the Preview Tab).
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Similarities/
differences from 
Preview Tab

The Analyzer Tab is similar to the Preview Tab in some ways, but it is 
much more focused. When you view a chart or map in the Analyzer Tab, 
you are looking at the actual chart or map and its features without 
viewing any of the underlying data. The purpose of the tab is simply to 
arrange and rearrange the appearance of the chart or map in such a way 
that you will be able to identify trends quickly and easily.

A DIFFERENT FEEL

While the Analyzer Tab and Preview Tab share some capabilities, the 
Analyzer Tab offers a much more focused and hands-on approach. It 
removes irrelevant data from the picture, showing you only the maps and 
charts you are analyzing. It provides commands for reversing series and 
groups on charts, and for zooming, panning, and centering maps, so that 
they can easily be adjusted.

With the Analyzer Tab, up to two objects can be viewed simultaneously. 
In this case, the Analyzer Tab becomes a split-screen tab, with each chart 
or map appearing in a separate section. To resize a section, move the 
cursor over the section boundary until the cursor becomes a Section 
Sizing cursor, and then drag the boundary line to expand or reduce the 
size of the section, as needed.

When two charts or maps are active in the Analyzer Tab, and you want 
to work with a third, right-click that third chart or map, and choose 
ANALYZER from the shortcut menu. A dialog box appears, reminding you 
that the Analyzer Tab is full, and asking whether you would like to 
replace one of the sections currently active in the Tab.

The Analyzer Tab can also be used to work with map and chart objects 
that have been placed within a subreport. The program opens a separate 
Analyzer Tab for each subreport that contains a map or chart object you 
are analyzing. You can view up to two objects from the same subreport 
simultaneously in an Analyzer Tab.

NOTE: You can also resize the map key displayed to the right of each 
map.

Other fundamentals

Seagate Crystal Reports’ reporting environment is extremely flexible.

●   You can turn on grid snap, set the grid to a maximum of one inch, 
and make the grid visible or invisible in the Design Tab, the 
Preview Tab, or both (see How to turn the grid on/off, Page 76).
66 Seagate Crystal Reports User’s Guide



●   You can also work without a grid, placing objects wherever you 
want them in a report (see Free form, Page 67 and Free form with 
guidelines, Page 67).

●   Finally, the guidelines can be used to align and resize objects (see 
How to move and position objects using guidelines, Page 73).

Set up the working environment so it works the way you work best.

Grid The grid is a series of row and column coordinates. When the grid is 
active, the program enables you to place objects only at these coordinates, 
not between them. In this way it makes it very easy for you to place and 
space data on your report and to align objects as needed. If you attempt 
to place an object between grid coordinates, the program “snaps” the 
object to the grid, that is, it moves the object automatically to the nearest 
set of row/column coordinates.

You activate the grid and specify its size and visibility properties using 
the Layout Tab in the Options dialog box. By default, the grid is not 
active. See How to turn the grid on/off, Page 76.

Free form You may also want to use Seagate Crystal Reports without a grid, in a free 
form environment similar to that of a drawing program. Free form means 
simply that you can place objects anywhere you want them to appear on 
your report. Your only restriction is that the program will not allow you 
to place chart and cross-tab objects in the Page Header, Page Footer, or 
Details sections. See Area printing characteristics, Page 59.

To work in a free form environment, toggle the Snap To Grid check box off 
using the Layout Tab of the Options dialog box. For more information, 
search for Options dialog box in Seagate Crystal Reports online Help.

Free form with 
guidelines

You may want to work in a free form environment while retaining the 
ability to align objects, or to move or resize them as a group. You can do 
this using guidelines.

Guidelines are lines that extend vertically or horizontally from the Design 
and Preview Tab rulers. Guidelines have a snap property; when you 
move an object within a guideline’s magnetic range, the object snaps, or 
attaches itself, to the guideline.

●   Once an object is snapped to a guideline, if the guideline is moved, 
the object moves too.

●   If you have several objects snapped to a guideline, they all move 
when the guideline is moved.

●   If you have several objects snapped to a guideline on two sides 
(right and left, or top and bottom) and one of the guidelines is 
moved, all of the objects resize similarly.
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Using guidelines in a free form environment provides flexibility with 
control. See How to add, delete, and move guidelines, Page 72, and How to 
move and position objects using guidelines, Page 73.

Overflow Field 
Representations

Seagate Crystal Reports uses Overflow Field Representation to assist 
users when working with numeric or currency values in report cells. 
Normally, if a numeric or currency value is larger than the field 
containing it, that value is truncated, or “clipped.” For example, values 
like 100,000,000 might appear on the report as 1,000, or as 000 (depending 
on the properties you have set). This could potentially cause confusion 
when the report is read.

When field clipping is disabled (activate Overflow Field Representation), 
numeric/currency field values that exceed the field size will be 
represented by number signs (######) in the Preview Tab, letting you 
know immediately when the field is too small. See How to disable field 
clipping, Page 78.

Sections and 
objects

Seagate Crystal Reports enables you to insert a variety of objects in a 
report:

●   Field objects
Fields from database tables and from the result sets returned by 
formulas, parameters, group names, queries, and stored 
procedures. See How to insert database fields, Page 105.

●   Text objects 
Characters, words, even entire documents. See How to insert text 
objects, Page 108.

●   Picture objects
Bitmaps (*.bmp, *.pcx, *.tif, *.tga, *jpeg). See How to insert a picture, 
Page 109.

●   Chart objects 
Charts that display summarized data. See Charting, Page 369.

●   Subreport objects 
Reports within reports, freestanding or bound to the data in the 
primary report. See How to insert a subreport, Page 419.

●   Cross-tab objects 
Spreadsheet-like reports that help identify trends. See Cross-Tab 
Objects, Page 443.

●   OLE objects
Pictures, spreadsheets, text, and other objects created in OLE 
server applications. See OLE Objects Overview, Page 404.
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●   Map objects
Geographic maps that can present data from groups, detail fields, 
cross-tab data, and OLAP grids. See Mapping, Page 385.

Objects are containers. They can hold data and, in some cases, other 
objects (for example, a text object can contain field objects as well as text, 
and labels in a cross-tab object are actually text objects). Each object has 
properties that define the way the object acts in a report.

For objects, fixed properties, conditional properties, or a combination of 
the two can be set.

●   Dialog box options are used to set fixed properties.

●   Special formulas are used to set conditional properties.

See Absolute formatting, Page 211 and Conditional formatting, Page 212. 

Most objects can be inserted into most report sections, but the program 
restricts placement of some objects in some sections because it does not 
make sense to place them there. For example, since a Details section prints 
with each record, a cross-tab object placed in a Details section would 
produce a cross-tab report for each record, not something that would be 
very useful. The program thus excludes cross-tab objects from the Details 
section. See Area printing characteristics, Page 59, for a summary of section/
object restrictions.

NOTE: See How to make an object underlay a following section(s), Page 111 
for information on printing objects in sections where they can not be 
physically placed.

You never have to worry about putting an object where it doesn’t belong; 
the program takes care of that for you. However, each situation requires 
some judgement on your part. For example, if you place a picture object 
in a:

●   Report Header section, it prints once at the beginning of the report.

●   Group Header section, it prints once with every group.

●   Details section, it prints once with every record.

Based on what you are trying to accomplish in the report, it clearly makes 
sense to place the object in one of the sections and not in the others. It is 
up to you to decide what is best for your report. For more information, 
see Area printing characteristics, Page 59.

You can also set fixed and conditional properties for sections, just as you 
can for objects. See Conditional formatting, Page 212.
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Underlaying 
objects

By default, when an object is placed in a section:

●   the section expands to accommodate the object, if necessary, and

●   the object prints in the section where it is placed, whenever that 
section prints.

However, when an object is placed in a section that has been set to 
underlay the following sections:

●   the object still prints when the section in which it is placed prints, 
but

●   it underlays the following section(s) as well.

NOTE: Objects placed in a section can underlay all sections up to (but not 
including) its “sister” section. For example, the Page Header section can 
underlay all sections up to (but not including) the Page Footer section.

This enables you to produce a number of interesting report effects. For 
example you can:

●   print an object so that it appears one time in the Details section 
beside a number of details (for example, a chart that compares 
sales figures by region alongside the details for the regions),

●   print a company watermark that is centered on the page, flowing 
through multiple sections, and

●   use a scanned bitmap of a form as a guide in setting up a report to 
print on preprinted forms.

Using the Underlay facility, you can produce stunning visual effects. For 
more information, see How to make an object underlay a following section(s), 
Page 111.

HANDS-ON (Report Design Environment)

How to move and resize toolbars

The 32-bit version of Seagate Crystal Reports includes several movable, 
resizeable toolbars.

You can move these toolbars into fixed positions or you can turn them 
into floating pallets if you wish. You move and resize these toolbars in the 
following ways:
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Moving To move the toolbars, click on the bar in a space where there is no button 
and drag the bar to a new position.

Resizing To resize the toolbars, position the pointer over an edge or a corner of the 
bar. When the resizing pointer appears, drag it inward or outward to 
resize the bar.

You can toggle the toolbars on and off using the Toolbars dialog box. You 
can also open the Toolbars dialog box from the View Menu (TOOLBARS 
command).

Drag the bar to the desired position.

Drag the 
cursor to 
create the 
desired size.

To go from 
this...

to this... 

The toolbar will be 
resized as specified.
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How to add, delete, and move guidelines

Seagate Crystal Reports provides guidelines to help you accurately place 
objects on your report. Guidelines are non-printing lines that you can 
place anywhere in the Design and Preview Tabs to aid in alignment. The 
visibility of the guidelines can be toggled on and off in two ways:

1. Using the two commands on the View Menu, GUIDELINES IN DESIGN 
and GUIDELINES IN PREVIEW. Search for Guidelines in Design command 
and Guidelines in Preview command in Seagate Crystal Reports online 
Help.

2. Using the two options, Show Guidelines in Design and Show Guidelines 
in Preview on the Layout Tab of the Options dialog box. Search for 
Options dialog box in Seagate Crystal Reports online Help.

Seagate Crystal Reports inserts guidelines automatically in some 
situations:

●   Whenever a field or formula field is inserted in a report, the 
program automatically creates a guideline at the left edge of the 
field frame and snaps the field and field title to it.

●   When a field is summarized, the program snaps the summary to 
the same guideline to assure proper alignment.

●   When you right-click the shaded areas to the left of a section and 
choose ARRANGE LINES from the shortcut menu, the program 
automatically creates one or more horizontal guidelines in the 
section and snaps the fields to them.

Toggle the check boxes on 
for the desired toolbars.
72 Seagate Crystal Reports User’s Guide



Adding 
guidelines

There may be times when you want to insert guidelines manually.

Moving 
guidelines

Each guideline is attached to an arrowhead on its originating ruler.

Deleting 
guidelines

Each guideline is attached to an arrowhead on its originating ruler.

NOTE: With the Snap to Grid option toggled on you will only be able to 
insert or move guidelines in grid increments. To get the full power of 
movement with guidelines, toggle the Snap to Grid option off using the 
Layout Tab in the Options dialog box. Search for Options dialog box in 
Seagate Crystal Reports online Help.

How to move and position objects using guidelines

Positioning 
objects with 
guidelines

Guidelines have a snap property that automatically snaps objects to them. 
That is, objects will connect to the guidelines as positioning devices.

An object can snap to a horizontal guideline on its top, bottom, or 
horizontal midline (the invisible line that bisects the object horizontally).

Click this ruler to activate 
a horizontal guideline.

Click this ruler to activate 
a vertical guideline.

Drag the guideline arrowhead 
to the desired position.

Drag the guideline arrowhead 
away from the ruler.
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An object can snap to a vertical guideline on its right or left side or on its 
vertical midline (the invisible line that bisects the object vertically).

When a guideline has its snap property toggled on and the guideline is 
moved, all objects snapped to the guideline are moved. The snap 
property can be toggled on/off from the Layout Tab of the Options dialog 
box, which can be opened from the File Menu (OPTIONS command).

NOTE: When a guideline is moved, any object that is snapped to it is 
moved as well. But if you move an object that is snapped to a guideline, 
the program does not to move the guideline.

Snap to the top.

Snap to the midline.

Snap to the bottom.

Snap to 
the left.

Snap to 
the right.Snap to the midline.

Drag the guideline to 
the desired position. 

The object moves
with the guideline.
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Resizing objects 
using guidelines

When one or more objects are snapped to guidelines on two sides (top 
and bottom, or right and left), the object(s) can be resized by dragging 
either or both of the guidelines. This can be especially helpful if you need 
to resize a number of objects similarly at the same time.

This is a two step process.

1 First, you have to snap the object(s) to two guidelines.

2 Then you have to drag a guideline to resize the object(s).

Snapping objects 
with two 
guidelines

You may have two or more objects that you want to resize and they are 
either the same size (height or width) or different sizes. The process for 
resizing with two guidelines is the same for either case.

1 Begin by creating a guideline and snapping one side of the object to 
that guideline.

3 Now click the object to activate the sizing handles.

5 Repeat Steps 2 through 4 for every additional object you want to 
snap to both guidelines.

6 If the objects are not yet the desired size, drag one or both of the 
guidelines until the objects are the correct size.

2 Create a second guideline to 
the right of the object. It should 
not be touching the object.

4 Drag the resizing handle 
over to the second guideline.

The object snaps to
the second guideline.
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How to turn the grid on/off 

The Design and Preview Tabs have an underlying grid structure that you 
can activate and resize in the Options dialog box. 

1 Choose the OPTIONS command from the File Menu. The Options 
dialog box appears with the Layout Tab active.

NOTE: By default, all of the grid options are toggled off.

How to zoom the report in and out

You can easily zoom in on a report. You can choose any magnification 
from 25% to 400%. This feature is active in both the Design and Preview 
Tabs. 

To zoom the report in or out, set the zoom level in the MAGNIFICATION 
FACTOR edit box found on the Standard toolbar. 

2 Set the Grid Size, Grid Options, and 
View Options in this dialog box.
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It is helpful to view reports at low magnifications in order to get an 
overall picture of the layout of your report. Views at higher 
magnifications work well for attention to the details of the report. 

How to undo/redo activities

Seagate Crystal Reports includes multiple levels of undo. With multiple 
levels of undo, you can undo several changes, a step at a time, until you 
have your report in the condition you want it. 

The program also has a redo feature that reverses an undo. If you move 
an object, for example, and do not like its new position, you can click 
UNDO to move it back to its original position. If you then change your 
mind, you can click REDO to restore it to the place where you moved it.

●   To undo an action, click the UNDO button on the Standard toolbar. 
The first time the button is clicked, it reverses the most recent 
change made to the report. Each additional time the button is 
clicked, it reverses the next most recent change.

●   To redo a change after you have undone it, click the REDO button 
on the Standard toolbar.

Set the desired magnification factor 
and click OK when finished.

25%

50%

100%
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The program disables the UNDO button and the UNDO/REDO commands 
whenever there is nothing to undo/redo or when you have made a 
change that can not be reversed.

NOTE: If you undo an action (Action A) and then perform some new 
action, you will no longer be able to redo action A.

How to drill-down on summarized data

You can drill-down on your data using the Drill-down cursor (to show 
the data behind individual groups). See Sorting, Grouping, and Totaling, 
Page 245.

Drill-down 
cursor 

Seagate Crystal Reports allows you to drill-down on group or summary 
information in the Preview Tab in both the Standard and the Group Tree 
view (See Standard view, Page 62 and Group Tree view, Page 63). When you 
position the cursor over any summary value that you can drill-down on, 
the program displays a Drill-down cursor.

If you then double-click, the program reveals the details behind that 
specific summary value. For example, if the Drill-down cursor becomes 
active over the city summary, you can double-click to see the details 
behind that summary. See Cursors, Page 54.

●   If you have only a single summary, you can look at the summary 
or at the data from the individual records that are summarized.

●   If you have multiple summaries, you can look at the summaries 
behind summaries (the city summaries that make up the region 
summaries, for example), or at the data from the individual 
records that are summarized.

How to disable field clipping

To disable field clipping:

1 Select the field and click the OBJECT PROPERTIES button on the 
Supplementary toolbar. The Format Editor appears with the Number 
Tab active.

2 Click the Number Tab.

3 To allow overflow field representation, toggle the Allow Field Clipping 
check box on. 
78 Seagate Crystal Reports User’s Guide



NOTE: You also have the option to click the Conditional Formula button to 
enter a formula in the Format Formula Editor. In the Format Formula 
Editor you can specifying that field clipping will be disabled only when 
certain conditions are met.

4 Click OK.

To view the results, refresh the report. If you disabled field clipping, any 
numeric/currency field values that are larger than the fields containing 
them will be represented by number signs (######).

HANDS-ON (Sections and Areas)

How to add, delete, move, and merge sections 

The Design Tab opens originally with a standard set of report sections, 
each in a standard size (see Design Tab Areas, Page 57). You can not delete 
any of these original sections but you can add to them. Once you have 
added sections, you can delete them, move them in relation to other 
similar sections, or merge related sections together.

While there are different ways to do this, the easiest way is to use the 
SECTION EXPERT button.

1 Click the SECTION EXPERT button on the Standard toolbar. The 
Section Expert appears with a list of all the sections in the report. 
When there are more than one of any kind of section, the sections are 
lettered A, B, C, and so on.
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Inserting a 
section

Click the Insert button. The program adds a new section immediately 
below the highlighted section.

NOTE: Sections can also be inserted by right-clicking the shaded area to 
the left of any section in the Design or Preview Tabs and choosing INSERT 
SECTION BELOW command from the shortcut menu.

2 Highlight the section you want 
to work with from this list.

Click Insert to insert 
a new section.

Click Delete to delete 
an existing section.

Click Merge to merge two 
sections.

Click the arrow buttons to 
move a section up or down 
in an area.
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Deleting a 
section

Click the Delete button. The program removes the highlighted section 
from the report.

Moving a section 1 Highlight the section you want to move.

2 Click the Up or Down arrow to move the section.

NOTE: You can only move a section up or down within an area.

NOTE: The letters that identify the sections describe their relative (as 
opposed to original) position. Thus, if you move a “C” section up, it 
becomes a “B” section. It loses its original “C” designation.

Merging two 
related sections

There may be times when you have placed objects in two sections (where 
they print sequentially) and you want to put them all in a single section 
(where they print simultaneously). You can merge the two sections and 
then rearrange the objects as needed in the new section.

1 Move the sections so the two sections you want to merge follow each 
other in the list.

2 Highlight the top section.

The data originally in Section (C) is 
moved to Section (A). The data in 
the other sections is moved down.

3 With Section (C) highlighted, 
click the up arrow twice.
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4 Rearrange the objects as needed.

How to split and resize sections

A section can be split into two or more sections and/or resized easily in 
the Design Tab.

Splitting a 
section

1 Move the pointer over the left boundary of the section you want to 
split.

2 When the pointer becomes a Section Splitting cursor, click the 
boundary. See Cursors, Page 54.

3 When a horizontal line appears, drag it up or down to split the 
section the way you want it.

3 With Section (B) highlighted, 
click the Merge button. Section (C) 
is merged with Section (B) into one.

4 When the Section Splitting cursor 
appears, drag the horizontal line to 
the desired position.

The section will split at the line.
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Resizing a 
section

Move the pointer over the bottom boundary of the section you want to 
resize and, when the pointer becomes a Resizing cursor, drag the 
boundary to make the section bigger or smaller as you wish.

If you have one or more objects in a section and you want to resize the 
section to remove unnecessary white space, right-click in the shaded area 
to the left of the section in the Design and Preview Tabs and choose FIT 
SECTION from the shortcut menu. The program automatically resizes the 
section, moving the bottom boundary of the section to the baseline of the 
bottom object in the section.

A section will automatically expand vertically in two instances:

1. when you place an object and the object is bigger (vertically) than the 
section you put it in, or

2. when you expand an object (vertically) so it becomes bigger than the 
section it resides in.

NOTE: You can not resize a section smaller than an object in the section.

Drag the Resizing
cursor up to make the
section above smaller.

Drag the Resizing cursor
down to make the

section above bigger.
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5 Introduction to Reporting

What you will find in this chapter...

Basic report design, Page 86

How to design a paper prototype, Page 93

Concepts in reporting, Page 93

Beyond basic reports, Page 100

HANDS-ON (Report Creation and Design), Page 101

HANDS-ON (Finishing Your Report), Page 117
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Basic report design

The purpose of this chapter is to suggest a structured approach to 
preparing reports with Seagate Crystal Reports. This approach includes 
the following elements:

●   deciding on the content of a report,

●   developing a prototype on paper,

●   using Seagate Crystal Reports to set up a prototype,

●   specifying the records/groups to be included in the report,

●   manipulating the data with formulas and functions,

●   grouping, summarizing, and sorting the data,

●   editing and formatting the data,

●   adding graphic enhancements and OLE objects, and

●   printing the finished report.

This section has been designed to provide a conceptual understanding of 
the reporting process.

Deciding on the 
content of the 
report 

Before you do anything else, you should outline the information you 
want the report to provide. Use the following list of questions as a guide 
in making that outline:

●   What is the overall purpose of the report?

●   Who is going to read the report?

●   What is the report title going to be?

●   What information do you need besides the title to identify the 
report?

   Where is that information to come from?

   If the information exists in a database table, what type of fields 
is the data stored in: number, text, etc.?

●   What identifying information do you want to appear at the bottom 
of each page? At the top of each page?

   Where will this information come from?

   If the information exists in a database table, what type of fields 
is the data stored in: number, text, etc.?
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●   What specific data should appear in the body of the report?

   Where will this data come from?

   Does this data exist in data fields, or does it need to be 
calculated from data field values?

   What type of fields is the data stored in: number, text, etc.?

   Do you want the data sorted?

   How?

   Do you want the data broken into groups?

   What kind of groups?

   Do you want the data summarized?

   Subtotaled? Averaged? Counted? or some other kind of 
summary value?

   What do you want to total?

   Do you want to show summaries for all the groups or just 
the top or bottom groups?

   Do you want the group summaries sorted in any special 
order?

   Do you want to add text labels to the summaries?

●   What information, if any, do you want flagged on the report?

   How do you want it flagged?

   By color?

   By a text flag?

●   Do you want any other information highlighted in some way so 
that it really stands out?

   How do you want it highlighted?

   Colored text?

   Special font or font size?

   Borders or background color?

   Do you want to label the highlighted information as well?

●   Do you want the report to be based on all records in the database 
or only on specific records? 

   Which records?
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Purpose What is the overall purpose of the report?

Reports are management tools. Their purpose is to help individuals 
quickly grasp the essential elements and relationships found in raw data, 
to help them make effective decisions. For a report to be effective, it has 
to present the correct data in a logical way. If it presents the wrong data, 
or if it presents the right data in a haphazard manner, the report may slow 
the decision making process or may even encourage incorrect decisions.

A good starting place in the development of a report is to write out the 
purpose of the report in a sentence or two. The purpose statement helps 
you focus on your primary needs, and it gives the report both a starting 
point and a goal. Here are some examples of purpose statements:

●   The purpose of this report is to show monthly and year-to-date 
sales by sales representative, compare this year's numbers to last 
year’s, and flag representatives whose sales figures do not meet 
company standards.

●   The purpose of this report is to show sales activity for each item in 
inventory, and to suggest reorder quantities based on that activity.

●   The purpose of this report is to calculate bowling averages and 
handicaps for each member of the bowling league.

Clarifying the purpose of the report before you start is a critical step in the 
overall process. A report without a clear purpose is like a meeting 
without a clear agenda; it rambles and accomplishes little. 

Readers Who is going to read the report?

A single report is often used by many individuals. A detailed, company-
wide sales report, for example, may be used by sales representatives, the 
regional sales manager, the national sales manager, and the Chief 
Operating Officer (COO). 

Each of these individuals will be interested in different aspects of the 
report. 

●   A sales representative will use the report to evaluate individual 
sales performance and compare this performance to that of other 
representatives in the region.

●   The regional sales manager will use the report to evaluate regional 
representatives and compare the region's performance to that of 
other regions.

●   The national sales manager will use the report to evaluate the 
performance of regional managers and compare overall sales to 
the current sales forecasts.
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●   The COO will use the report to evaluate the performance of the 
Vice President of Marketing and the sales department as a whole, 
and to project such things as manufacturing needs, warehouse 
locations, etc.

Since each user of the report has different interests, it is important to plan 
the report so it includes the information each of the users is looking for.

Title What is the report title going to be?

Write out a working title for the report. You may decide to change it later, 
but at least you will have a title to use when creating the prototype report.

Do you know the 
data you want to 
use in the 
report?

Do you know the type of database you are reporting from? Will you be 
reporting off a data file, SQL/ODBC, or a dictionary?

If you do not know, ask an internal source for the database type and 
location of the data and to set you up with access to that database if 
necessary. See Data Sources, Page 579.

Are you familiar enough with the data to find the necessary information? 
When looking for a Customer Contact name, can the field be found in a 
database table?

If not, your MIS professional, database administrator, or co-workers will 
have to help you become familiar with the data.

Header 
information

What information do you need besides the title to identify the report?

You may wish to include the current date, information on who prepared 
the report, a block of text to describe the purpose of the report, the range 
of data covered, or something similar. If you are going to include such 
information, write it down so you can use it in preparing your prototype.

Header 
information 
sources

Where will the header information come from?

The information can come from a variety of sources, depending on the 
kind of information you plan to use.

●   The current date can be inserted using the PRINT DATE FIELD 
command on the Insert|Special Field Menu.

●   Information on who prepared the report might be drawn from 
individual data fields in the database table(s) used. If it is to be 
drawn from a database table, what table? Or, what combination of 
tables?

●   A block of text can be created as a text object and placed anywhere 
on the report.

As you begin to think of where the information is to come from, you begin 
formally structuring the report.
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Data types in the 
header

If the information exists in a database, what types of fields contain the 
data: number, text, etc.?

Seagate Crystal Reports uses different rules for working with different 
types of data. You will find it helpful later if you note the data type of each 
piece of data you plan to draw from a database.

Footer 
information

What identifying information do you want to appear at the bottom of 
each page (page number, page n of N, report name, author's name, the 
word “Confidential”)? 

Footer data 
sources

Where will the footer information come from?

As with Report Header data, the information for a Report Footer can 
come from a variety of sources, depending on the kind of information you 
plan to use.

Data types in the 
footer

If the footer information exists in a database table, what type of fields is 
the data stored in: number, text, etc.?

Report body data What specific data should appear in the body of the report?

When you think of a report, it is probably the body of the report that first 
comes to mind. The body should contain all the data needed to fulfill the 
statement of purpose you wrote for the report. It should also contain all 
of the data needed by the various users that you have identified.

Body data 
sources

Where will the report body data come from?

This step requires you to look at the available database table(s). Seagate 
Crystal Reports allows you to combine data from different databases 
when you create reports, so you have a great deal of flexibility in your 
work.

●   Much of the data in a typical report is taken directly from data 
fields. Which data fields will be used, and where are they located?

●   Other data will be calculated based on data fields. Which data 
fields will be used in the calculations? 

●   Still other data will be placed directly into the report using text 
objects (headings, notes, labels, etc.).

Existing or 
calculated?

Does the data exist in data fields or does it need to be calculated from data 
field values?

Some report information can be drawn directly from data fields (sales 
information, for example); other information will have to be calculated 
based on data field values (for example, sales commission, based on the 
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relationship of sales to quota). In your planning, it can be helpful to 
segregate or flag data that needs to be calculated from that which can be 
used directly. See Introduction to Formulas, Page 291.

Data types in the 
body

What types of fields contain the data: number, text, etc.?

While it is important to understand data types for all the data you will be 
using, it is of critical importance that you know the data type for data 
fields that will be used in calculations. Functions and operators work 
with specific kinds of data, so it's important to know the data type to 
know which functions and operators you can use in your calculations. 
Search for Functions Index and Operators Index, or for the function or 
operator by name in Seagate Crystal Reports online Help. 

Record or group 
selection

Do you want the report to be based on all records or groups in the 
database or only on specific records or groups?

Seagate Crystal Reports gives you the opportunity to base a report on all 
records in a given database, or on a limited set of records from the 
database. Seagate Crystal Reports can be used to select records based on 
simple date ranges or comparisons, or to create complex formulas to 
identify the records to be included. Take a few minutes to determine the 
records needed for the report and list the criteria to be used for selecting 
those records. See Record and Group Selection, Page 227.

Groups Do you want the data organized into groups? How? By customer? By 
date? Or by other criteria? Seagate Crystal Reports provides several 
options for grouping data in a report. See How to group data, Page 258.

Group values Do you want to show a subtotal at the end of each group? A count? An 
average? Seagate Crystal Reports allows you to specify several kinds of 
group values. See How to summarize grouped data, Page 262, and How to 
subtotal grouped data, Page 264.

Group value 
positions 

Where should the group values appear? With the group data? With the 
group data, but on a page separate from other groups? Only at the bottom 
of the page?

Seagate Crystal Reports provides all of these options.

Grand totals, 
subtotals, 
averages, etc.

Do you want to total, average, count, or determine the maximum or 
minimum value included in all the values in any column on the report? 

Seagate Crystal Reports allows you to do this and also allows the grand 
total (or the grand total average, grand total count, etc.) to be placed at the 
bottom of the selected column.

Flags What information, if any, should be flagged on the report?
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You may want to call attention to some data by flagging it on the report. 
For example, non-moving inventory items are often flagged on inventory 
reports so they can be given special attention. You might want to flag each 
item that has shown no activity during the last month, during the last 
three months, or during some other defined period. So, to flag 
information, identify it and any conditions that will trigger the flagging.

Flag options How do you want it flagged?

You may want to flag items with an asterisk or some other symbol, or you 
may want a word to appear as a flag. In any case, you should write out 
flagging instructions so they are handy.

Highlights What information do you want highlighted in some way that makes it 
really stand out?

Seagate Crystal Reports gives you the opportunity to underline report 
elements, and change the font type, size, or color used for specific report 
items. It allows you to put borders around items and to draw lines and 
boxes (to break the report into sections), set off headings, etc. All of these 
formatting tools can be used to highlight key data on a report. If you have 
data that you want highlighted, you should write down highlighting 
instructions so they are handy too. See Formatting, Page 209.

Sorting Do you want the data sorted based on record or group values? 

Seagate Crystal Reports gives you both alternatives. See Sorting, 
Grouping, and Totaling, Page 245.

Developing a 
prototype on 
paper

Graphic designers generally begin working on a magazine cover, 
brochure, or display advertisement with a rough pencil sketch. They 
often use boxes, circles, or other symbols to represent the graphic 
elements they intend to include in the final product, and they often use 
lines or scribbles to represent text. Doing the rough design on paper helps 
them create a look for each page. It helps them find a balanced way of 
positioning the various elements before they begin working with 
sophisticated graphics tools. You will find a similar exercise helpful in 
designing reports. See How to design a paper prototype, Page 93.

While a paper prototype is useful regardless of your level of expertise 
with Seagate Crystal Reports, it is particularly valuable when you are first 
learning the program. With the paper prototype in hand, you can put 
your full effort into learning and using the commands, rather than into 
trying to design and learn at the same time.
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How to design a paper prototype

1 Get paper of the size you will be using for the finished report.

2 Position the title and other descriptive header information, using 
boxes or lines to represent report elements.

3 Position the footer information.

4 Review the page layout for balance.

5 Look at the information you intend to include in the body of the 
report.

   Count the number of fields being used and estimate the 
appropriate spacing between fields.

   Use rectangles to pencil in the fields within the estimated 
spacing.

   Change the spacing if you need to.

   Decide on a logical sequence for presenting the data in the 
body of the report.

   Label the fields to indicate that sequence.

6 Use small boxes to indicate group values and totals.

7 Place random flags in the column where you want flags to appear.

8 Darken any elements you want highlighted to make them stand out 
from the rest of the prototype.

9 Review the finished product for layout and balance, and make 
changes as needed.

Concepts in reporting

The purpose of this section is to give you a conceptual understanding of 
the tasks necessary to create a fairly standard report. Each topic is 
discussed in relation to the Tutorial; please refer to Tutorial - Customer 
List, Page 147, throughout for an illustration of these concepts.

The concepts are presented in the order you might use to create such a 
report and directions to sources of additional information will be 
provided.
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Report creation 
options

Each time you create a new report, you have four options:

1. use a Report Expert,

2. use another report as a template,

3. import a pre-existing report from another application, or

4. create a Custom Report from scratch.

You will probably use all the options at some time.

REPORT EXPERTS

The Report Experts help create reports as quickly as possible and many 
new users and developers alike prefer to create the majority of their 
reports using them. All you have to do is choose the Expert that most 
closely matches your report type. The Expert walks you through the 
process of creating reports step-by-step.

You can quickly create the report and see how it looks against the actual 
data. And best of all, if you then decide to make changes, you can get back 
to the Report Expert to further modify the report. Search for Experts Index 
in Seagate Crystal Reports online Help.

ANOTHER REPORT

To build a new report based on one that already exists, another report can 
be used as a template. The program makes a duplicate of the original 
report, which can be modified to create a new report. Use this option 
whenever you think templates can save time. Templates are useful to:

●   create a new report with a different grouping or different record 
selection than that of an existing report,

●   create a series of reports, each a little different than the last,

●   reconstruct a report based on an earlier time period using the same 
report structure used today, or

●   create an entirely new report based on a set of databases that are 
linked in another report. You can create a report and delete the 
fields without disturbing the underlying links. Then, without 
relinking, you can build all your new reports based on this report.

IMPORTED REPORT

With Seagate Crystal Reports, you now have the option of importing an 
ASCII text report and converting the text report into a Seagate Crystal 
Report. For example, you could import and convert a report created and 
saved as a text (.txt) file. You could then use Seagate Crystal Reports’ 
improved data manipulation and report generation capabilities to 
enhance the converted report. The importing process requires that the 
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original report be saved as an ASCII text file. For more information, see 
Document Import Tool, Page 433.

CUSTOM REPORT

The Custom option is used to create a report from scratch. This is useful 
when you want the full flexibility and control of building a report from 
the ground up, or when a report type is different from the many report 
types available in the Experts.

The Custom option was chosen for the Tutorial - Customer List, Page 147, 
because the process of creating a report from scratch most fully illustrates 
the basics of reporting.

Selecting the 
report data

The next step in creating a report is to select the data to use in the report. 
This is a two step process. The first step is to determine what type of data 
you want to work with and the second step is to actually select the data. 
See How to select data and begin creating a report, Page 101.

Seagate Crystal Reports provides four different data types:

1. data file,

2. SQL/ODBC,

3. dictionaries, and

4. queries.

DATA FILE

Choose the Data File option to report on any of the standard (not client-
server) PC databases. These are typically databases whose data and all 
software used to access that data are on a single machine. Seagate Crystal 
Reports can access many of the most common PC database formats 
directly; the program has built-in capabilities to directly open database 
files and tables designed in dBASE, FoxPro, Clipper, Btrieve, Paradox, 
and Microsoft Access, among others. Once the program is installed on 
your system, you can immediately begin creating reports based on these 
databases simply by selecting the appropriate file. See Data Sources, Page 
579.

The Data File option was chosen for the Tutorial - Customer List, Page 147, 
because the sample data, xtreme.mdb, is a Microsoft Access database.

SQL/ODBC

Choose the SQL/ODBC option to use SQL or ODBC data sources.

●   Structured Query Language (SQL) databases are perhaps the most 
popular and most powerful database formats. They usually work 
over a client/server network architecture and use:
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   an SQL server to create, store, and manipulate database files, 
tables, fields, and records, and 

   an SQL client interface, allowing workstation users to retrieve 
data.

See Using SQL and SQL databases, Page 535.

●   Open Database Connectivity (ODBC) is a standard developed by 
Microsoft through which many different types of data can be 
accessed by a single application. An application need only 
communicate with one set of files, ODBC, to instantly be able to 
work with any source of data that can be accessed by ODBC. For 
more information, see ODBC data sources, Page 601.

Seagate Crystal Reports provides direct drivers for many of the most 
popular SQL systems, and ODBC capabilities as well.

DICTIONARIES

In many large organizations, data is stored in a variety of places. It may 
be in different databases, on different servers, and so forth. IS 
departments often use naming schemes for tables and fields that are 
logical and predictable, but the names assigned may seem cryptic to non-
technical staff. Enabling staff to create reports themselves in such an 
environment can create extensive training and support problems and 
possibly compromise data integrity. Dictionaries provide a solution to 
these problems. They allow you to provide your staff with ready access 
to the data in a form that they can understand, but they also allow you to 
maintain complete control and security over your data resources.

A dictionary is a structured, simplified, and secure view of organizational 
data that you can create for some or all of the users in your organization.

A dictionary is an optional metalayer that you can place between the user 
and the data. Using the capabilities of the metalayer you can:

●   design a single, dynamic view of all the data that is necessary to 
create organizational reports and queries,

●   include multiple data sources, tables, and links,

●   organize the data and rename tables and fields to make it easier for 
users to understand the content and purpose of the data,

●   limit access to specific columns of data (for example, letting only 
executives see the salary column of the employee data files),

●   place restriction formulas on specific rows of data (for example, 
allowing managers to view employee information only for those 
employees with a salary under $40,000), and
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●   create complex data manipulation formulas that users can access 
without the need to understand formula concepts.

Dictionaries reduce support cost and time, increase user productivity, 
and enable you to add an additional layer of security between the user 
and the data.

NOTE: When a dictionary is used to create a report the only data used in 
the report is data accessed through the dictionary. You can not use a 
dictionary and some other data source in the same report. Because the 
dictionary is often used to impose data security, it would breach that 
security to allow unrestricted data access in a dictionary report.

NOTE: A subreport based on a different data source can be included in a 
primary report based on a dictionary.

NOTE: Dictionaries are an optional metalayer. Seagate Crystal Reports 
can be used without ever using dictionaries. See Dictionaries, Page 487.

QUERIES

A query is a request for specific information from a database. If you are 
requesting that information from an SQL database (or from a database 
that you access via ODBC), the query must be written using the 
Structured Query Language (SQL). The SQL language is not difficult to 
learn, but mastering the fine points of creating and retrieving data using 
SQL can take quite a while. Since the SQL Designer eliminates the need 
to understand SQL, it can get you building effective queries right away.

The SQL Designer has been designed to meet the needs of individuals 
with little or no query background as well as the needs of experienced 
SQL professionals.

●   If you are new to querying, you will enjoy the way the SQL 
Designer helps create queries, even if you have no knowledge of 
SQL whatsoever. By answering a few questions on a set of 
sequential tabs, you give the program all the information to 
generate a query that fits your needs.

●   If you are an SQL professional, you will appreciate the facility that 
enables you to fine-tune the queries that the SQL Designer 
generates. If you are more comfortable writing your own SQL 
queries, you will find it easy to enter your queries directly or even 
paste them in from another source.

The SQL Designer can be a powerful tool for many of your information 
gathering needs.

NOTE: The SQL Designer can only access data stored in an ODBC data 
source.
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Linking If the report contains data from two or more database tables, they need to 
be linked at this point when creating reports. Database tables are linked 
so records from one database match related records from another. For 
example, if you activate a Suppliers table and a Product table, the 
databases are linked so that each product (from the Product table) can be 
matched up with the supplier (from the Supplier table) that made the 
product.

The majority of reports will probably require data from two or more 
tables, so linking will be necessary. The process of linking is made easy 
with the Visual Linking Expert. See How to add and link multiple tables, Page 
104, and search for Visual Linking Topics Index in Seagate Crystal Reports 
online Help.

NOTE: It isn’t necessary to link tables in reports created from a query 
because any links required by the data have already been processed.

Placing data on 
the report

Placing data on a report is a very important task. You need to know what 
type of data should be placed on the report and where on the report it 
should be placed.

DATABASE FIELDS

Much of the data placed on a report are database fields, displaying data 
as it is stored in the database. For example, in Tutorial - Customer List, Page 
147, the Customer Name, City and Country fields are placed on the 
report. Normally, database fields will be placed in the Detail section, but 
under certain circumstances, they will be placed in other sections of the 
report. See How to insert database fields, Page 105.

TEXT OBJECTS

Text objects are used in reports for a multitude of purposes. They are a 
powerful way of inserting titles; labeling summaries and other data on 
your report; and of easily combining database fields. For example, in the 
Tutorial - Customer List, Page 147, text objects are used to easily display the 
two contact name database fields as one object, to insert a column 
heading for the concatenated contact name, and to insert a title in your 
report. For more information, see How to insert text objects, Page 108.

SPECIAL FIELDS

To display information such as Page Numbers, Print Date, and Report 
Comments use the commands on the Insert|Special Field Menu. See How 
to insert special fields, Page 106, and search for Special Field commands in 
Seagate Crystal Reports online Help.
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FORMULA FIELDS

To display data that is a calculated value, you need to create a formula field 
and place that formula field on the report. For example, if the database only 
stores the order dates and ship dates for orders but you need to display the 
number of days it takes to ship the order, you must create a formula field 
that will calculate the number of days between ordering and shipping. This 
is just one example of the use of formula fields. See Introduction to Formulas, 
Page 291, for an introduction to formulas.

RUNNING TOTAL FIELDS

To display a total that evaluates each record and provides a running sum 
of all the values in a field (or all the values in a certain set of values), a 
running total field needs to be created and placed in the report. If the first 
three values in a field were 2, 4, and 6, a running total would print 2, and 
then 6 (the sum of 2 + 4), and then 12 (the sum of 2 + 4 + 6). See Running 
Totals, Page 341, for an introduction to running totals.

SQL EXPRESSION FIELDS

SQL expressions are like formulas, but they are written in Structured 
Query Language (SQL), not in the Seagate Crystal Reports formula 
language. An SQL expression can be used to query the database for 
specific sets of data. You can sort, group, and select based on SQL 
expression fields. See The Crystal SQL Designer, Page 465, for an 
introduction to SQL expressions.

Formatting data At this point in creating a report, you may want to do some basic 
formatting. Perhaps you would like to change the font size and style of a 
text object used as a title. Or, if you have a number field, such as a sales 
figure, you might want to place a dollar sign before the number or change 
the number of decimal places displayed.

For example, in the Tutorial - Customer List, Page 147, you format the title, 
add a text object to identify the Contact Name information, and insert the 
company logo. See Formatting, Page 209.

Record selection Record selection, the task of paring down the data to include only the 
data required for your report, is a crucial step in report creation. You will 
rarely want a listing of all the information in a database. Most often you 
will be interested in only the sales in a given time period or for a certain 
product, etc. For example, a sales report may be designed to only include 
sales from one product line for the last calendar month.

The sample data used for the Tutorial - Customer List, Page 147, has 
information from both United States and international customers. Record 
selection is used to create a report listing only customers in the United 
States. See Record and Group Selection, Page 227.
Introduction to Reporting 99



Grouping, 
sorting, and 
summarizing 
data

Once a basic report is created, you will want to organize the data by 
grouping related information, sorting individual records, summarizing, 
subtotaling, and grand totaling.

GROUPING RECORDS

To organize the data, you may want to group related data together. For 
example, in the Tutorial - Customer List, Page 147, after grouping the 
Customer List by region, you will divide the list into regional groups. 
That way, a sales manager for the California region could quickly locate 
the California group and focus exclusively on the customers within that 
region. See How to group data, Page 258.

SORTING RECORDS

Seagate Crystal Reports allows you to specify the order in which you 
want the records on your report displayed. For example, after grouping 
in the Tutorial - Customer List, Page 147, you sort the records within each 
region in alphabetic order by Customer Name. Many of your reports will 
use some type of sorting. Depending on the report, you will sort the 
records in a list or sort in conjunction with grouping. See How to do a single 
field sort, Page 253, and How to sort records within groups, Page 260.

SUMMARIES, SUBTOTALS, AND GRAND TOTALS

Many reports use some sort of totaling. For example, in a North American 
sales report grouped by state, you might want to calculate the total dollar 
amount sold in each state. You do this by creating a subtotal on the sales 
field. Summaries are also used at the group level, allowing you to 
calculate averages, counts, and other group (aggregate) values. For 
example, in a sales report you may want to calculate an average of sales 
per state (average summary on the sales field) and calculate the number 
of products sold in the state (distinct count of the product name field).

Beyond basic reports

Once you are comfortable with the basics of reporting, you will be ready 
to investigate the more powerful reporting features of Seagate Crystal 
Reports, including:

●   charts (see Charting, Page 369),

●   OLE objects (see OLE, Page 403),

●   form letters (see How to create a form letter using a text object, Page 
200),

●   subreports (see Subreports, Page 415),
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●   cross-tabs (see Cross-Tab Objects, Page 443),

●   multi-section reports (see Multiple Section Reports, Page 195),

●   and much, much more.

HANDS-ON (Report Creation and Design)

How to select data and begin creating a report

Experts help you create reports as quickly as possible. When you click the 
NEW REPORT button on the Standard toolbar, the Report Gallery appears. 
In the Report Gallery you will find a series of buttons representing the 
different types of Experts that are at your disposal.
 

Click the icon for the type of report you want to create and follow the 
steps outlined on the tabs in the Expert that appears. 

●   To build a new report based upon one that already exists, click the 
Another Report button. You can select a report file to serve as a 
template for the new report. The program makes a duplicate of the 
original report, which you can modify however you please. For 
more information, see ANOTHER REPORT, Page 94.

●   To build a report based on an ASCII text report, click the Document 
Import Tool button. With this specialized reporting tool, you can 
easily convert a plain ASCII text report into a Seagate Crystal 
report. For more information, Document Import Tool, Page 433.

●   To build a report from scratch, click the Custom button. Several 
Report Type and Data Type icons appear at the bottom of the 
Report Gallery. Click the report and data type appropriate to your 
needs.

The program opens a dialog box that allows you to select the data you need.
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Since building reports from scratch is the easiest way to learn about all the 
powerful features of the program, this is the method discussed 
throughout the documentation.

NOTE: For the purposes of this tutorial, it is assumed that you are using 
the xtreme.mdb sample database provided with this version of Seagate 
Crystal Reports. If you are using another database, some of the dialog 
boxes shown here may differ from those that actually appear.

1 Use the File Name and Directories list 
boxes to select the desired file.

2 Click Open to add 
the file to your report.

If you choose Data File as 
your data source...
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Related Topics

Data Sources, Page 579

How to select a dictionary for a report, Page 504

1 Choose the Server 
Type from this list 
and click OK.

2 Use the SQL Tables and SQL Databases list
boxes to select the desired table and databases.

If you choose SQL/ODBC as 
your data source...

3 Click OK when you are finished.

1 Use the File Name and Directories 
list boxes to select the desired file.

2 Click Open to 
open the file 
and add it to 
your report.

If you choose 
Dictionary as your 
data source...
Introduction to Reporting 103



How to add and link multiple tables

After you have selected a database table to begin working on the report, 
you may need to select a second table and then link the tables so that the 
records in each table match up. For example, if you are using a Customers 
table and an Orders table for the report, you will need to link the tables so 
the records in the Orders table are matched up with the records of the 
customers who placed the orders.

1 Choose the ADD DATABASE TO REPORT command from the Database 
Menu. The Choose Database File dialog box appears.

2 Use the Directories, Drives, and File Name boxes to select the new 
database you want to use in the report.

3 Click OK when finished. The Visual Linking Expert appears and 
displays the databases currently available for linking. Search for 
Visual Linking Expert in Seagate Crystal Reports online Help.

NOTE: If the Auto-Smart Linking option is toggled on in the Database Tab 
of the Options dialog box, you will not need to manually create links 
between the tables. See Linking tables, Page 513, and search for Options 
dialog box in Seagate Crystal Reports online Help.

NOTE: If the primary database is either Access or Btreive, all tables 
contained in those databases will appear in the Visual Linking Expert. You 
do not have to manually add each table to your report.
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NOTE: When manually creating links, the field you are linking “to” must 
be an indexed field. For more information on indexed fields and tables, 
see Indexed tables, Page 511.

The Visual Linking Expert closes, and you are returned to your report. 
The linked databases are now available for use in your report. If you are 
not satisfied with the link, you can modify it using the Visual Linking 
Expert. Search for Visual Linking Topics Index in Seagate Crystal Reports 
online Help.

Related Topics

Working With Databases, Page 507

SQL join types (ODBC data sources), Page 527

How to insert database fields

1 Click the INSERT FIELDS button on the Standard toolbar. The Insert 
Fields dialog box appears with the Database Field Tab active, listing 
all the fields in the chosen database(s). To speed the report building 
process, this dialog box remains on-screen until you click CLOSE. You 
can move this dialog box wherever you wish.

Click Smart Linking to link
tables automatically.

To create links manually, drag a field from one table to a field in another 
table. If successful, a link line is created. If unsuccessful, a message is issued.

Click OK when finished. To specify tables,
click this button.
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How to insert special fields 

Seagate Crystal Reports allows you to easily insert Page Number, Record 
Number, Group Number, Print Date, and Total Page Count fields, among 
others, into your report.

There are two ways to insert special fields:

1. click the INSERT FIELDS button on the Standard toolbar and click on 
the Others Tab, or

2. choose the SPECIAL FIELD command from the Insert Menu. The Insert 
Fields dialog box appears with the Others Tab active. Search for 
Special Field commands in Seagate Crystal Reports online Help.

2 Select the field you want
to appear in the report.

3 Click Insert to place it in
the report.

4 Click Browse to review the 
values in the selected field.
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Each special field is inserted into the report as an object. An object frame 
appears. You can now place it on the report.

NOTE: To change the formatting of an inserted object, click the object to 
select it and click the OBJECT PROPERTIES button on the Supplementary 
toolbar. The Format Editor appears where you can make the desired 
changes. See Formatting, Page 209.

How to create an SQL expression field

An SQL Expression field is similar to a Formula field. An SQL Expression 
field uses the SQL syntax instead of the Crystal Reports Formula 
language used in a Formula field. SQL Expression fields can be used in 
much the same way as a Database field. It is possible to sort, group, and 
base record selection on them. SQL Expressions are always evaluated on 
the server.

When an SQL/ODBC data source is used to design a report, the program 
adds a sixth tab to the Insert Fields dialog box - the SQL Expressions Tab. 
This new tab allows SQL expressions to be entered in the Insert Fields 
dialog box and then inserted into a report quickly and efficiently.

1 With the SQL Expressions Tab active, click New. The SQL Expression 
Name dialog box appears.

2 Enter a name in the New Name text box, and then click OK. The SQL 
Expression Editor appears.

NOTE: The SQL Expression Editor functions in the same way as the 
Formula Editor. For a thorough discussion of these tools see How formulas 
are created: an introduction to the Formula Editor, Page 296. 
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3 Type the expression in the SQL Expression Editor.

4 Click OK.

How to insert text objects

1 Click the INSERT TEXT OBJECT button on the Standard toolbar. An 
empty object frame appears.

●   Click once on the border of the text object to select it for resizing 
and moving.

●   Double-click inside the text object to select it for editing. The 
Design Tab ruler changes to a text object ruler sized to the length 
of the selected object. To the left, a tab indicator appears.

The ruler allows you to add indents and align text within the text object. 
By clicking the tab indicator, you can cycle through the four tab options 
available.

NOTE: When you first insert the text object into the report, the object is 
automatically selected for editing.

How to use a database field in a text object

The primary function of a text object is to hold text. However, text objects 
can hold database fields as well, making them ideal for creating custom 
form letters.

2 Position the text object where 
you want it to appear in the report.

Left-aligned tab.

Right-aligned tab.

Center-aligned tab.

Decimal-aligned tab.
Once you have chosen the desired tab, 
click the position on the ruler where you 
want to insert it.

Drag to set the 
left margin.

Drag to set the
right margin.
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1 Insert a text object in the report.

3 Click the INSERT FIELDS button on the Standard toolbar. The Insert 
Fields dialog box appears with the Database Tab active.

4 Highlight the database field to be inserted and drag it into the text 
object. As you move the Drag and Drop cursor over the text object, 
the program displays a movable insertion point. See Cursors, Page 54.

How to insert a picture

When designing reports, there will be times when you want to include a 
picture. For example, you may wish to put a company logo in the report 
header.

1 Click the INSERT PICTURE button on the Supplementary toolbar. The 
Open dialog box appears.

2 Select the desired picture file from the file list and click Open to 
return to the report. An object frame appears with the picture inside, 
ready to be positioned.

2 Type in the text and 
spaces you want to 
appear before the first 
database field (if any).

5 Drag the object to the 
insertion point where you want 
the database field to appear, 
and then Drop the field.

3 Position the picture object at the 
point where you want it to appear 
in the report and right-click once.
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How to select, move, and resize objects

Selecting objects Select an object by clicking it once. An object must be selected in order to 
change the font, move the object, etc. When you select an object, sizing 
handles appear around it.

Moving and 
resizing objects

Once an object is selected, you can then tell the program what to do with 
it. For example, you can move or resize an object as follows:

Selecting 
multiple objects 

Seagate Crystal Reports allows you to select multiple objects using the 
marquee selection technique.

This frame indicates that 
the object is selected.

Press and hold the left mouse 
button to activate the Move 
cursor and drag the object to 
the desired position.

Drag the handles of 
the frame to change 
the size of the object.

To move an 
object...

To resize an 
object...
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NOTE: Objects can be moved over (across) other objects without 
affecting the placement of the objects beneath.

Fields can also be moved between sections, with the following exceptions:

●   grand totals can only be moved within the Report Footer section or 
to the Report Header section, and

●   a subtotal or summary can be moved only within its originating 
section or to the header of its originating section.

Related Topics

Formatting concepts, Page 210

How to make an object underlay a following section(s)

In this example you will make the Xtreme logo (Xtreme.bmp) underlay 
multiple sections. This is a procedure similar to the procedure for 
inserting a company watermark to serve as a report background.

To make an object underlay a following section, first place the object in 
the section above the section you want it to underlay. Then toggle the 
Underlay Following Sections option on in the Section Expert for the section 
in which the object was placed.

2 Drag the selection 
rectangle to the 
bottom right of the 
objects, surrounding 
them completely.

When the mouse
button is released, the

rectangle disappears
and object frames
appear around the

selected objects.

1 Position the mouse
pointer above and to
the left of the objects

you want to select.
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CREATING A SIMPLE REPORT

1 To get started, create a report using the Customer table in 
xtreme.mdb (located in the \CRW16 directory (16-bit), or \Program 
Files\Seagate Software\Crystal Reports,(32-bit), or the directory in 
which the program resides).

2 Place {customer.CUSTOMER NAME} and {customer.LAST YEAR’S 
SALES} side-by-side in the Details section of the report. To eliminate 
unnecessary objects in this example, delete the field titles that the 
program places in the Page Header section for each field.

3 Break the data into regional groups. To do this, choose the GROUP 
command from the Insert Menu and select {customer.REGION} as 
the sort and group by field.

INSERTING A PICTURE

1 Click the PICTURE button on the Supplementary toolbar.

2 Choose the picture file Xtreme.bmp (located in the \CRW16 
directory (16-bit), \Program Files\Seagate Software\Crystal Reports 
(32-bit), or the directory in which the program resides) and place it in 
the Page Header section, to the right of the report body.
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NOTE: In this example, the picture is placed to the right of the fields 
because it is not meant to underlay the text. When you are working with a 
watermark, a subdued picture designed to be nearly invisible, place it 
directly above the text.

3 Click the PRINT PREVIEW button on the Standard toolbar. Note that the 
picture prints first (entirely in the PH section) and then the body of the 
report follows. Return to the Design Tab when finished previewing.

UNDERLAYING THE FOLLOWING SECTION(S)

1 Click the SECTION EXPERT button on the Standard toolbar. The 
Section Expert appears.

2 Select the Page Header section and toggle the Underlay Following 
Sections check box on. See Types of formatting properties, Page 211.

3 Click OK and preview your work again. Note that now the picture 
prints in the Group Header and Details sections, next to (instead of 
above) the text in the body of the report.

NOTE: Placing the picture to the right of the body of the report, as you 
did here, is the same technique you would follow if you wanted a chart or 
an employee picture to print beside the details that pertain to the chart or 
to the employee.
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4 Return to the Design Tab and resize the object vertically so that it is 
two or three times bigger, and then preview the report again. The 
bitmap now underlays more sections.

The area the picture underlays is determined by:

●   its size,

●   the section in which it was placed originally, and

●   its position in the section.

By modifying size and placement of an object, you can create many 
stunning visual effects using the underlay capabilities.

Pre-printed 
forms

If you print on pre-printed forms, you may be able to:

●   scan a form,

●   place it in the report as a bitmap,

●   use the underlay capability to line up the bitmap and report and 
move objects anywhere you want them, and

●   eliminate the need to print the forms separately by printing your 
report and the form as a single unit.

How to hide parts of a report

There are a number of properties you can set to prevent particular parts 
of a report from printing.

Hiding sections Seagate Crystal Reports has three properties you can set in the Section 
Expert to hide report sections.
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1. Hide (Drill-down OK)
The Hide property hides a section whenever you run the report. For 
example, in a summary report, the Hide property can be used to 
display only the summaries, but not the details behind the 
summaries. When the Hide property is applied to a section, it 
becomes visible when the Drill-down cursor is used to drill-down on 
the section contents. This property is absolute; it can not be applied 
conditionally with a formula. For more information about drilling-
down, read about the Drill-down cursor in Cursors, Page 54). 

2. Suppress (No Drill-down)
The Suppress property also hides a section when you run the report. 
Unlike the Hide property, however, you can not apply the Suppress 
property and then drill-down to reveal the section contents. This 
property can be applied absolutely, or conditionally by using a 
formula. This can be useful for writing form letters. For example, in a 
form letter you might create two details sections - one to suppress when 
sales are over $X and one to suppress when sales are less than $X.

3. Suppress Blank Section
The Suppress Blank Section property hides a section whenever there is 
nothing in it. If something is placed within the section, then it 
remains visible.

Hiding objects Seagate Crystal Reports has three formatting options in the Format Editor 
for use in hiding individual objects.

1. Suppress If Duplicated (Common Tab)
The Suppress If Duplicated option prevents a field value from printing 
if it is identical to (a duplicate of) the value that comes immediately 
before it. The value does not print but the space in which it would 
have printed remains.

2. Suppress If Zero (Number Tab) 
The Suppress If Zero option prevents a value from printing if it is a 
zero value. The value does not print but the space in which it would 
have printed remains. To remove the blank space, toggle the Suppress 
Blank Section option on in the Section Expert.

Duplicated values 
are suppressed 
and do not print.
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NOTE: This will only work if there are no other objects in the section. 

NOTE: Use the Section Expert to eliminate blank lines in this situation, 
and toggle the Suppress Blank Section option off for the section that the 
field is in. This will eliminate the lines as long as there are no other 
objects in the section.

3. Suppress (Common Tab) 
The Suppress option hides an object when you run the report. It is 
common, for example, to apply this property to formulas that are 
needed to do some report calculations but that you do not want to 
print when you run the report. When this property is toggled on, the 
selected object will not print.

NOTE: You can click the Conditional Formula button for any of these 
properties and create a formula that will make the setting conditional on 
some event. See Conditional formatting, Page 212.

To set these properties, highlight the object, click the OBJECT PROPERTIES 
button on the Supplementary toolbar and set the property in the Format 
Editor when it appears.

The zero values 
are suppressed 
and do not print.

The object is invisible 
and will not print.
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HANDS-ON (Finishing Your Report)

How to use page headers and footers

You can use page headers and footers by placing the information in the 
Page Header or Page Footer sections of the Design Tab. 

●   Information to appear only on the first page of the report goes in 
the Report Header (RH).

●   Information to appear only on the last page of the report goes in 
the Report Footer (RF).

●   Information to appear at the top of every page goes in the Page 
Header (PH).

●   Information to appear at the bottom of every page goes in the Page 
Footer (PF).

Text, fields, or formulas can be used in these sections just as in the Details 
section.

Related Topics

How to create a footer that appears on all pages but the first, Page 221

How to add a title page to the report

Seagate Crystal Reports provides a quick, easy way to add a title page to 
a report by selecting Report Title on the Others Tab of the Insert Fields 
dialog box. In order to use this field, you must have a title entered in the 
Summary Tab of the Document Properties dialog box. See How to add 
summary information to the report, Page 119.
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1 Choose the INSERT SPECIAL FIELD command from the Insert Menu. 
The Insert Fields dialog box appears with the Others Tab active.

2 Select Report Title, and click Insert. An object frame appears when the 
cursor is moved over the report. 

4 With the report title highlighted, click the SECTION EXPERT button on 
the Standard toolbar. The Section Expert appears.

Now the title will appear on the first page and the report will begin on the 
second page.

3 Move the object frame to the 
Report Header section and click 
once to place the frame.

5 With the Report Header section highlighted... 

...toggle the New Page 
After option on.
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How to add summary information to the report

There may be times when you want to include non-printing comments 
with a report (a personal note to the report recipient, a note to explain 
more thoroughly the data on which the report is based, a report title, a 
comment about some particular data on the report, etc.).

The SUMMARY INFO command on the File Menu provides a facility for 
including anything from a short note to hundreds of lines of text with 
your report. The comments do not print with the report; they remain in 
the Summary Tab of the Document Properties dialog box where they can 
be reviewed on demand. Search for Document Properties dialog box in 
Seagate Crystal Reports online Help.

When you choose the SUMMARY INFO command, the Document 
Properties dialog box appears with the Summary Tab active.

Related Topics

How to add a title page to the report, Page 117.

Search for Report Title command in Seagate Crystal Reports online Help.

Search for Report Comments command in Seagate Crystal Reports online 
Help.

Search for Special field commands in Seagate Crystal Reports online Help.

Enter the desired 
information and click 
OK when finished to 
return to your report.
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6 Printing, Viewing, and Exporting

What you will find in this chapter...

Printing considerations, Page 122

Design solutions for printing/distributing, Page 123

Report creation checklist for distributed reports, Page 131

Updating printer drivers, Page 131

Report distribution, Page 132

Compiled reports, Page 132

HANDS-ON (Exporting a Report), Page 133

HANDS-ON (Viewing reports with a web browser), Page 141
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Printing considerations

When printing, inconsistencies may occur if different printer drivers are 
used to create and print your reports. These inconsistencies are a result of 
the varied methods that individual printer drivers use to measure text 
metrics, such as font size. When printed, text-based objects may be 
misaligned, cut-off, or overprint each other. Examples of text-based 
objects include string or character fields, text objects, memo fields, 
numeric fields, and formula fields.

Problems such as these may arise when you have:

●   Two identical printers, but each one is using a different printer 
driver,

●   Two different printers using the same printer driver,

●   Two different printers using different printer drivers,

●   One printer driver that uses the TrueType font and a second 
printer driver that maps TrueType fonts to PostScript fonts,

●   Two identical printers using the same printer driver, but each one 
is printing from a different version of Microsoft Windows,

●   Two identical printers using the same printer driver, but the 
printer drivers are different versions, or

●   Two identical printers, two identical printer drivers, and two 
identical operating systems, but the resolution of the video 
drivers are different.

Therefore, while a document using one printer driver may require six full 
lines to display a block of text:

●   using a second printer driver that measures fonts narrower could 
result in the same block of text requiring less than six full lines, or

●   using a third printer driver that measures fonts wider could 
require more than six full lines.

For the most part, this situation can’t be avoided. The goal of the report 
distributor is to design reports that accommodate printer driver 
dependency and still print consistently using different printer drivers. To 
do this, Seagate Crystal Reports provides several design solutions. If 
taken into account when creating your report, these solutions can ensure 
proper printing and distribution for your report in almost any 
environment.
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Design solutions for printing/distributing

NOTE: Before using the techniques outlined in this section to reformat a 
report, please read Updating printer drivers, Page 131.

There are several things to keep in mind when designing reports that will 
be distributed in different environments. For the best results, consider the 
following:

●   Spacing within text-based objects, Page 123

●   Placing text-based objects, Page 124

●   Placing multi-line, text-based objects, Page 126

●   Section characteristics, Page 127

●   TrueType fonts, Page 127

●   Video resolution, Page 128

●   Specific margins, Page 128

●   Default printer, Page 128

●   Free form placement, Page 129

Spacing within 
text-based 
objects

While it is recommended that you have the Free Form Placement option 
toggled on (see Free form placement, Page 129), spacing text-based objects 
evenly in the free form environment can be somewhat tricky.

To align text objects, there are two features to assist you:

1. the grid, and

2. the guidelines.

USING THE GRID

Each section of a report contains a design grid. It can be toggled on/off 
and set to different sizes as needed (see How to turn the grid on/off, Page 76). 
Once set, the grid remains the same size for all sections. It is measured 
from the upper left hand corner of each section and continues down and 
to the right until the end of the section. A new grid of the same size then 
begins from the upper left hand corner of the next section, and so on, 
through the end of the report.

Seagate Crystal Reports gives you the option of snapping objects to the 
grid. When you toggle the Snap to Grid option on using the Layout Tab of 
the Options dialog box:

●   The upper left corner of all newly placed text-based and OLE 
objects will snap to a grid point.
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●   Objects placed before enabling Snap to Grid will not snap to the 
nearest grid point. They will remain where they are. 

●   If you resize an object, the side (or sides) that you are resizing snap 
to the closest grid point.

USING GUIDELINES

Guidelines are used to line up objects. They too have a snap property that 
automatically snaps objects to them (see How to move and position objects 
using guidelines, Page 73). However, the snap property of guidelines 
works differently for text-based objects than other objects (OLE objects, 
for example). When a text-based object snaps to a guideline, it is the 
baseline of the text and not the object frame that snaps to the guideline. 
You can find the baseline of a text-based object by locating the special 
indicators positioned on either side of the object directly at the baseline.

To place several text objects of different font sizes on one line and have 
their baselines line up, snap them to a guideline at the baseline indicator.

Becoming familiar with the properties and functionality of the grid and 
guidelines will require some experimentation. 

NOTE: If Free Form Placement is toggled off and you enable Snap To Grid:

●  all objects will snap to the guidelines for vertical placement, and

●  the left boundary will snap to both vertical guidelines and grid 
points.

Placing text-
based objects

When a text-based object is placed on a report, the object is represented 
by an object frame. The height of the object frame is based on the height 
of the font. The width however, is determined differently depending on 
the text-based object you are working with.

●   For database fields that are not memo fields, the width is initially 
determined by the width of the field as defined in the database, 
and by the average character width as provided by the selected 
font and font size.

Baseline indicator.
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For example, you have a database field called {customer.LAST 
NAME} and your database defines this field as a text field with a 
length of 35 characters. When you place this field on your report, 
the width of the boundary will be 35 times the average character 
width of the font and font size that the text-based database field is 
formatted to. Remember that this is the initial default boundary 
width. The width can always be resized to increase or decrease as 
you see fit.

●   For text objects, the default width is approximately 17 average 
character widths wide. Text objects are different from database 
fields in that their width will automatically expand as you enter in 
text and/or database fields into the text object. Again, as with all 
other text-based objects, the width can be resized by the user.

●   For different number fields (double, single, integer, long integer, 
and byte) the default widths are all different. Once again, as with 
all other text-based objects, the width can be resized by the user.

Whether the default widths are accepted or the text-based objects are 
resized, a problem could arise if the text inside the object prints right to 
the edge of the object frame. While the report may look fine on the 
machine it was designed on, when the report is printed using another 
printer driver that measures the font wider, the length of the text grows 
but the object frame remains fixed. This results in the text being truncated 
or cut off.

There are several ways to prevent text from being truncated:

1. Select the object and click the OBJECT PROPERTIES button on the 
Supplementary toolbar. Use the Common Tab of the Format Editor 
to toggle the Can Grow option on. The object is then formatted to 
print on multiple lines, so if the text prints wider than the object, the 
text will wrap onto additional lines.

NOTE: This is not an effective solution for strings of text that do not 
contain spaces (such as single words) because, though the line will wrap, 
the text string will break at the edge of the object frame and then wrap 
(as in the screenshot below).
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2. Expand the object frame so that it is a little wider than the widest 
block of text that the object will contain. There are many times when 
the actual text in a database field is far less than the maximum 
amount the field can contain.

For example, a {table.LAST NAME} field is designed with a field size 
of 80 and the longest name in the database is 28 characters. In this 
case, when you first place the field in your report, the field will be 80 
times the average character width. Reduce the width of the field, but 
not so much that it is just long enough to accommodate the longest 
string of text. Instead, make it a little wider in order to allow for 
growth.

While each of these options offers an effective solution when dealing with 
a single text-based object in a section, there are still design considerations 
to take into account when placing more than one text-based object in a 
section. When sizing one object, you must consider its placement with 
regard to other objects in the section.

Avoid designing reports where the space between each object is very 
tight. Leave room for growth by expanding the width of the object by 
approximately 5%. Alternatively, you may consider reducing the size of 
the font.

Placing multi-
line, text-based 
objects

While text-based objects that are formatted to print on multiple lines 
follow the same design rules as other objects, they have one additional 
characteristic that must be considered. If the printer driver expands or 
contracts the spacing of the text, word wrapping may differ, thus 
changing the number of lines necessary to print the object, in order to 
accommodate growth or shrinkage.

When placing multi-line, text-based objects, you could encounter 
problems if other objects in the same section are placed directly below 
them.

Unlike single-line, text-based objects, expanding the object frame of a 
multi-line, text-based object to accommodate possible growth is not a 
viable option. When you do this, the line width simply increases 
according to the expanded boundaries.
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So, when possible, place multi-line, text-based objects at the bottom of a 
section. If they require more lines to print, the section will expand 
downward to accommodate the growth and they will not endanger other 
objects.

Section 
characteristics

A report consists of several sections, including the Report Header, Page 
Header, Group Header, Details, Group Footer, Page Footer, and Report 
Footer (see Design Tab Areas, Page 57).

Each report section is made up of a series of lines. When a text-based 
object is placed in a section, it is placed on a line in such a way that the 
text is aligned to the baseline. The line’s height is then adjusted by the 
printer driver so that it is high enough to accommodate the object.

●   If another text-based object is placed on the same line and its font 
size is larger than that of the first object, the line’s height is 
extended to accommodate the second object.

●   If another text-based object is placed on the same line and its font 
size is even larger, the line’s height is extended once again to 
accommodate the third object.

A line’s height will be determined by the text-based object with the 
largest font on the line.

As text-based objects are added to a report, either in the same section or 
other sections, line height is adjusted to accommodate the various fonts. 
Because this vertical (inter-line) spacing is determined by the printer 
driver, it becomes difficult to create reports designed for pre-printed 
forms when they may be printed in various environments.

It is recommended that you follow these guidelines when designing 
reports:

●   always print a test page,

●   keep all font sizes the same, and

●   be sure to print pre-printed forms on the same machine.

TrueType fonts Designing your report using printer-specific fonts may lead to problems 
when using different printers. The fonts may not be supported by the 
other printers or, while they are supported, they may not be installed on 
the printers.

When printing, if printer-specific fonts are encountered that the printer 
driver does not recognize, Seagate Crystal Reports substitutes the fonts, 
creating inconsistent results. In order to avoid this situation, it is 
recommended that only common TrueType fonts be used when 
designing reports.
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Video resolution If you have two identical printers, two identical printer drivers, and two 
identical operating systems, but the resolution of the video driver varies 
between machines, then the pagination of documents will be different.

Unfortunately, there is no way to create Windows documents that are 
immune to changing video driver resolutions. However, it is best to set 
your video resolution to 640 x 480 pixels when designing reports. A 
report designed using a coarse resolution (640 x 480 pixels) and printed 
on a finer resolution will not encounter as many formatting changes as a 
report designed using a finer resolution (800 x 600 pixels) that is printed 
on a coarser resolution (640 x 480 pixels).

Developing reports with your video resolution set at the most common 
and coarsest resolution will ensure that your reports will be the least 
sensitive to video driver settings.

Specific margins Seagate Crystal Reports has the option of setting specific margins or 
using the printer’s default margins (see How to change margins, Page 217).

Problems may arise if you choose to design your reporting using the 
default margins.

●   When a report is printed in another environment where the 
printer’s default margins are greater than its setting, the report 
objects on the right side of the report will print off the page.

●   When a report is printed in another environment where the 
printer’s default margins are smaller (allowing a larger printing 
area), the entire report will be moved to the left of the page.

It is recommended that you always set your own margins. Even if the 
margins you want to use are the same as the default margins, be sure that 
the Use Default Margins option in the Page Setup dialog box is toggled off, 
and you set your margins manually using the PRINTER SETUP COMMAND.

Default printer In general, it is a good idea not to choose a specific printer. Even though 
the printer may be identical to the default printer, how the printer is 
recognized can still vary for different operating systems.

Consider the following example:

An HP Laser III printer is being installed on three different operating 
systems.

●   With Windows 95 and Windows 98, the printer name can be 
changed so that HP Laser III is Front Reception Printer, but the 
printer driver will be listed as HPPCL5MS.DRV.

●   With Windows NT, the printer name is also referenced and can be 
changed by the user, but the printer driver is always WINSPOOL.
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●   With Windows 3.x, the printer is recognized by the printer name, 
in this case HP Laser III, and the printer driver is 
HPPCL5MS.DRV.

If you select a specific printer, Seagate Crystal Reports will look for that 
printer by name. If the printer you selected can’t be found, the default 
printer will be chosen, resulting in the possibility of printing 
inconsistencies.

When selecting a specific printer, such as a label printer or a printer 
dedicated to printing invoices, the printer name must be the same as the 
name of the printer the report was designed on. Be aware that anyone 
printing the report must use that same printer or they could encounter 
problems.

NOTE: If your report is part of an application that you are distributing, you 
can provide a Select Printer dialog box. Using this dialog box, users of your 
report can choose the correct printer or rename the printer accordingly. 

Free form 
placement

FREE FORM PLACEMENT ON

In order to create dynamic reports and reduce printer driver dependency 
as much as possible, it is recommended that all sections of the reports be 
formatted with the Free Form Placement option toggled on. This is 
especially true if your report includes OLE objects such as charts, boxes, 
lines, and bitmapped images (such as company logos).

When a section is formatted with Free Form Placement, all objects can be 
placed anywhere in that section. Seagate Crystal Reports places objects 
within a section based on their absolute coordinates. These absolute 
coordinates determine the vertical placement of objects in your report. 
This means that you control the vertical placement of single-line objects 
rather than the printer driver. In so doing, you can better protect your 
reports from printing inconsistencies caused by using different printer 
drivers.

However, while the printer driver no longer controls the vertical spacing 
of text-based objects within the sections, it still determines horizontal 
spacing of text within the text-based objects, as well as the inter-line 
spacing of multi-line text objects. So, while Free Form Placement allows 
you better control, you must still take into account these considerations 
when designing your reports (see Placing multi-line, text-based objects, Page 
126).

FREE FORM PLACEMENT OFF

If a section has the Free Form Placement option toggled off, the program no 
longer references the object’s absolute coordinates to determine where it 
prints, except:
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●   The absolute x coordinate is still referenced to determine where 
each object begins printing horizontally (left/right placement).

●   The y coordinate is still referenced for vertical placement of the 
object but the coordinates may be adjusted by Seagate Crystal 
Reports when the printer driver changes.

So, if the report is printed using a printer driver that measures inter-line 
spacing greater than the original printer driver, the y coordinate will be 
increased and the text-based object will be printed farther down the page. 
With Free Form Placement toggled off, the user no longer controls the 
vertical placement of text-based objects; the printer driver determines 
that instead.

However, the placement of OLE objects (such as graphics, boxes, and 
lines) is not controlled by the printer driver. Thus, Seagate Crystal 
Reports always references these objects’ absolute coordinates when placing 
and printing. Due to these varied methods of placement, problems can 
arise when both text-based objects and OLE objects are placed in a report.

Consider the following example:

A box (OLE object) is placed around a database string field (text-based 
object). Everything looks great and everything is aligned as it should 
be. However, if the report is printed using a printer with an especially 
high measurement for inter-line spacing, then:

●   the placement of the box will not change relative to the section in 
which it is placed (the x and y coordinates will not change), but

●   the vertical placement of the text-based object will change because 
the y coordinate will be adjusted upward.

NOTE: The value is a measurement from the section’s upper left corner; 
so, the greater the value, the farther down the page the object will print.

If you are distributing reports that have sections formatted with Free Form 
Placement toggled off, and you want the objects in those sections to be 
surrounded by a border or formatted with lines, it is better to modify the 
objects’ border properties than to insert lines and boxes. This way, the 
borders will always stay with the objects. Simply right-click the object 
and select the CHANGE BORDER command from the shortcut menu (see 
How to add color, shading, and borders, Page 215).

Remember, any section can be formatted with Free Form Placement 
toggled on or off. While it is better to toggle the option on in some cases 
and not in others, it is highly recommended that every section in your 
report be formatted in the same manner.
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Report creation checklist for distributed reports

●   To accommodate possible growth caused by varying font 
measurements of different printer drivers:

   do not place objects extremely close to each other, and

   either increase the width of text-based objects by 
approximately 5% or reduce the size of the fonts.

●   Because the number of lines necessary to print a text-based object 
vary, consider where and how you place multi-line, text-based 
objects when using different printer drivers.

●   Use Windows TrueType fonts where possible. Being the most 
common fonts they are readily available on all versions of 
Microsoft Windows and can be recognized by most printers.

●   It is recommended to use the most common and coarsest video 
driver settings and set your video driver resolution to 640 x 480 
pixels.

●   Set specific page margins.

●   Use the default printer unless your application or compiled report 
requires a specific printer.

●   After the report is completed and you are happy with the results, 
remove all guidelines and format every section to have Free Form 
Placement toggled on.

By adhering to this checklist, your report will be the least sensitive to 
changing printer drivers.

Updating printer drivers

In order to maintain performance, Seagate Crystal Reports queries the 
printer driver for each of the font elements (font metrics), such as average 
character height, character width, height of the ascenders and 
descenders, internal leading, etc. A problem may develop if using an 
older printer driver that does not return the font metrics accurately. If you 
are experiencing problems when printing (missing fields, incorrect 
formatting, etc.), it is recommended that you obtain and install the most 
recently updated drivers for your printer. In many cases, these newer 
printer drivers will provide the accurate font metrics and printing issues 
will be remedied.
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Report distribution

There are many ways to distribute reports.

●   You can print the report and send it out by hand.

●   You can choose to export reports in Seagate Crystal Reports format 
(.RPT). You can export to a disk file or to an application (such as 
MS Excel or Word). See How to export reports, Page 133.

●   If you want to e-mail a report to someone who does not have 
Seagate Crystal Reports, you can export it in MS Word or Excel 
format directly to an Exchange folder (search for Exchange Data 
Access in Seagate Crystal Reports online Help), as well as to many 
other e-mail systems.

●   You can even publish the report on the Internet by exporting it to 
HTML. See How to export reports, Page 133.

Compiled reports

There may be times when you need to compile reports and distribute 
them to users who do not have Seagate Crystal Reports. Fortunately, 
Seagate Crystal Reports makes compiling and distributing an easy 
process.

After compiling reports into executable (.exe) files, use the Report 
Distribution Expert to distribute them. The Report Distribution Expert:

●   allows users to view, print, and export reports, and

●   compresses and distributes the selected compiled reports, 
dependent files, a Setup.exe file that installs the distributed 
reports, and any databases and DLLs specified. 

For more information, see How to compile a report, Page 138 and How to 
distribute a compiled report, Page 139.

When distributing a report, specify the DLLs and databases you want 
distributed with the report. The Report Distribution Expert will 
automatically list the databases and DLLs used by the report. Next, add 
or remove these files to better suit the end users’ needs. For example, 
users in Marketing and users in Human Resources might need access to 
very different reporting operations. Search for Report Distribution Expert 
in the Seagate Crystal Reports online help.

For more information, see How to distribute a compiled report, Page 139 and 
How to use a compiled report, Page 140.
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NOTE: You can also include third-party DLLs, if needed. These are files 
that are included with Seagate Crystal Reports but are not Seagate Crystal 
Reports components. Most commonly, these DLLs will be database 
drivers, supplied for accessing certain databases.

HANDS-ON (Exporting a Report)

How to export reports

Finished reports can be exported to a number of popular spreadsheet and 
word processor formats, as well as to HTML, ODBC, and common data 
interchange formats. This makes the distribution of information easier. 
For example, you may want to use report data to project trends in a 
spreadsheet package, or you may want to enhance the presentation of 
data in a desktop publishing package.

NOTE: When you export a report to a file format other than Seagate 
Crystal Reports format (.RPT), you may lose some or all of the formatting 
that appears in your report. However, the program attempts to preserve 
as much formatting as the export format allows.

1 With the report you want exported active, click the EXPORT button on 
the Standard toolbar. The Export dialog box appears.

4 Click OK, and the export process begins.

When a report is exported to a disk file or to an application, a sequence of 
dialog boxes prompting you for formatting details appear, depending on 
the format you specified in the Export dialog box. After you supply these 
details and click OK, the Choose Export File dialog box appears. Use the 
controls in this dialog box to select a path and file name for the file to 
which the report is being exported.

2 Select the format to export the 
report in from this drop-down list.

3 Select a destination for your 
file from this drop-down list.
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NOTE: Although the program assigns the native extension to all files you 
export in a specific word processor, database, or spreadsheet format, it 
automatically assigns the extension *.TXT for all files you export in one of 
the common data interchange formats. The program in which you want 
to use the data, however, may look for specific extensions other than 
*.TXT. Consult the manual for that program to determine the correct file 
extension, and change the extension accordingly in the File Name edit 
box.

5 Click Save. The program exports the report to a disk file in the format 
specified.

Exporting 
to an application

If you export to an application, the program saves the report in a temp file 
and then opens the file in the appropriate application (unless you are 
exporting in HTML format, in which case you will need to specify a file 
path).

Keep in mind:

●   When exporting in ODBC format, “Application” and “Disk file” 
are the same.

●   You may not be able to export properly to an application if you are 
working with 16-bit Seagate Crystal Reports on an NT or 
Windows 95 and Windows 98 platform, with the application 
residing in a long path location (such as c:/Program Files/Office/
Excel.exe).

●   The file name of the report and the file name of the temp file may 
not be the same.

1 With the report you want exported active, click the EXPORT button on 
the Standard toolbar. The Export dialog box appears.

2 Select the desired export file format from the Format drop-down list.

3 Select Application (from the Destination drop-down list) as the export 
destination and click OK.

The program now saves the report and opens it in the appropriate 
application. For example, if the report was exported in a Word for 
Windows document format, the program opens the report in Microsoft 
Word.

NOTE: If you export in the Excel 5.0 Extended format, the Format 
Options dialog box will appear, allowing you to specify the column and 
row formatting for the report.

Exporting to 
Lotus Notes

Lotus Notes is a powerful groupware application that promotes 
communication and information sharing between different departments 
in an organization.
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NOTE: You must have version 3.0 or later of the Lotus Notes Windows 
client. Seagate Crystal Reports will not export to a Lotus Notes OS/2 
client.

1 With the report you want exported active, click the EXPORT button on 
the Standard toolbar. The Export dialog box appears.

2 Select an export file format, select Lotus Notes Database as the export 
destination, and click OK. The Select Database dialog box appears.

3 In the Select Database dialog box, highlight the Lotus Notes server 
from the Servers list box, and select the database to which the report 
will be exported.

4 Verify that the file name in the File name text box is correct, and click 
OK. The Comments dialog box appears.

5 Type in any comments that are to appear when another user selects 
your report from the Lotus Notes Desktop.

6 Click OK, and the export process begins.

The next time a user with access to the Lotus Notes database that you 
selected logs on to Lotus Notes, your report will be listed in the Lotus 
Notes Desktop. The user can double-click the report file name to display 
the comments you wrote, and can double-click the report icon that 
appears in order to view the report.

Exporting to
an Exchange 
Folder

Seagate Crystal Reports lets you export a report file to an Exchange 
folder. You select the folder, and the report is stored there in the format 
that you specify. An Exchange folder can contain standard notes (mail), 
files, and instances of Exchange forms. For more information, search for 
Exchange Data Access in Seagate Crystal Reports online Help.

1 With the report you want exported active, click the EXPORT button on 
the standard toolbar. The Export dialog box appears.

2 Select the desired export file format from the Format drop-down list.

3 Select Exchange Folder as the export destination, from the Destination 
drop-down list and click OK. The Choose Profile dialog box appears.

4 Select the desired profile from the Profile Name drop-down list. If the 
profile is not listed, click the New button to create it. 

5 Click OK when finished.

6 When the Select a Folder dialog box appears, highlight the folder in 
your profile in which you want the report to appear, and click OK.

The report is exported to the Exchange folder you selected. The exported 
report can be accessed through the Microsoft Exchange client.
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Exporting to 
HTML

Providing support for the Internet and corporate intranets becomes more 
important with every passing day. Seagate Crystal Reports recognizes 
this importance and provides World Wide Web support. Although 
incorporated as an export format, HTML represents a whole new export 
destination for reports as well.

By exporting reports in HTML format, Seagate Crystal Reports provides 
you with a new option for rapid, convenient distribution of important 
company data. Once exported, your reports become accessible with many 
of the most popular web browsers, including Netscape and Microsoft 
Internet Explorer.

1 With the report you want exported active, click the EXPORT button on 
the Standard toolbar. The Export dialog box appears. 

2 From the Format drop-down list, select one of the HTML formats 
listed.

●   If Netscape is your browser, select HTML 3.2 (Standard) format.

●   If using Microsoft Internet Explorer as your browser, select HTML 
3.0 (Draft Standard) format.

●   The third HTML option, HTML 3.2 (Extended), is a new form of 
HTML 

3 Select a destination from the Destination drop-down list. The rest of 
this section assumes you select Disk file to store the HTML document 
in a directory on a web server.

4 Click OK. The Export To Directory dialog box appears. When 
exported to HTML format, a report may create more than one HTML 
file. For this reason, the program asks you for the name of a directory 
for an export destination, and uses default names for the HTML files. 
The initial HTML page will be saved as DEFAULT.HTM. This is the 
file you open if you want to view your report through your web 
browser.

5 Select an existing directory, or create a new directory for your report.

6 Click OK. The program exports the report to HTML format.

Exporting to an 
ODBC data 
source

Seagate Crystal Reports allows you to export reports to any ODBC data 
source. If you have an ODBC data source set up for a database or data 
format, you can export your report to that data format through ODBC.

For instance, you may have an ODBC data source set up through ODBC 
Administrator that you normally use to access database tables designed 
in Microsoft SQL Server. Using the Export dialog box, however, you can 
select your SQL Server data source and export your report as a new SQL 
Server database table.
136 Seagate Crystal Reports User’s Guide



NOTE: You must have an ODBC data source set up through ODBC 
Administrator in order for the program to export to a particular ODBC 
database format. See How to set up an ODBC data source, Page 556.

Exporting to an ODBC data source lets you:

●   change data from a centralized database format into a format 
compatible with a local DBMS application,

●   change data from a local database format into a format compatible 
with a centralized database,

●   create a new database table that can be used as a separate data set 
in future reporting,

●   create a mini data-warehouse, and

●   manipulate database data by filtering records, adding formulas, 
and removing fields to create a new database table that provides 
the data you need most for your work.

1 With the report you want exported active, click the EXPORT button on 
the Standard toolbar. The Export dialog box appears.

2 From the Format drop-down box, select the ODBC data source for the 
format in which you want to export your report. For example, ODBC 
- CRSS allows you to export your report to a Microsoft SQL Server 
database.

3 Destination is ignored when you are exporting a report to an ODBC 
data source. You do not need to make any changes to the Destination 
drop-down box. Simply click OK in the Export dialog box.

4 If your ODBC data source specifies a particular database, the report 
will be exported to that database. Otherwise, the Select Database 
dialog box appears. Select the database to which this report will be 
added as a new table, and then click OK.

5 If the ODBC data source you selected requires a Logon ID and 
password, the Login or SQL Server Login dialog box appears. Enter 
your ID and Password, and then click OK. The Enter ODBC Table 
Name dialog box appears.

6 Enter the name you want to give to the new table in the database, 
and then click OK. The program exports the report as a new table in 
the database you specified.

NOTE: If your report contains a binary field, you will be unable to export 
it to an ODBC data source successfully.

Search for Export format and destination files in Runtime File Requirements 
online Help (RUNTIME.HLP).
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How to fax a report

Many fax applications, such as Microsoft Fax and Delrina WinFax, allow 
you to set up a printer driver that will fax documents over a modem. 
When using one of these applications, you can fax a report from Seagate 
Crystal Reports.

1 Choose the PRINTER SETUP command from the File Menu. The Print 
Setup dialog box appears.

2 Select a fax driver from the Name drop-down list.

3 Click OK when finished.

4 Choose the PRINTER command from the File|Print Menu. The Print 
dialog box appears.

5 Click OK to fax the report. Your fax application will appear, allowing 
you to select a cover page and to fill in the appropriate fax 
information.

HANDS-ON (Compiled Reports)

How to compile a report

Note: You must save the report before compiling.

1 With the report active, choose COMPILE REPORT from the Report 
Menu or click the COMPILE button on the Supplementary toolbar. The 
Compile Report dialog box appears.

2 Enter a file path for the compiled report in the Compiled File Name text 
box, or click Browse to search for a file name. The default is the report 
file name with an .exe extension.

3 Specify whether you want to create a program item for this 
executable file. The program will display this item in a window after 
the report has been compiled. If you click Yes, enter the name of the 
program group in the Program Group text box.

4 Specify whether you want to distribute the report after compiling. 
See How to distribute a compiled report, Page 139.

●   If you chose to distribute the report after compiling, the Report 
Distribution Expert appears, and the window for the specified 
program group appears, with shortcuts to the compiled report 
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files present in that program group. For more information, see 
How to distribute a compiled report, Page 139.

●   If you chose not to distribute the report immediately, the window 
for the specified program group appears, with shortcuts to the 
compiled report files present in that program group.

5 Click OK.

How to distribute a compiled report

Compiled reports, along with related databases and DLLs, can be 
distributed to users who do not have Seagate Crystal Reports. More than 
one report can be distributed at once, and can be distributed to:

●   an installation disk, or

●   a directory of files.

There are two distinct processes involved in distributing; this section 
looks at both. The first is the actual distribution; the second is the 
installation of the distributed executable files (this is the task of the end 
user).

DISTRIBUTING

1 Choose REPORT DISTRIBUTION EXPERT from the Report Menu, or click 
the DISTRIBUTION EXPERT button on the Supplementary toolbar. The 
Report Distribution Expert appears.

2 Complete the REPORT DISTRIBUTION EXPERT. Click Build to distribute 
the specified reports. Search for Report Distribution Expert in the 
Seagate Crystal Reports online Help.

RECEIVING AND INSTALLING

The Report Distribution Expert Setup makes it easy for end users to 
quickly install and view, print, and export distributed reports.

1 Run Setup.exe.

2 Report Distribution Expert Setup opens, and the Introduction dialog 
box appears. Click Continue to decompress the distribution files to a 
temporary location. The program decompresses the files, and the 
Options dialog box appears.
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3 Enter a directory path for the report in the Directory text box or click 
Set location to search for a path.

4 Click Continue. The program will now proceed to Set up the 
distribution files in the specified directory.

5 If you already have an existing Seagate Crystal Reports program 
group, a message box will appear asking whether you would like to 
add the new report items to that group. Click Yes or No, as desired. 
Setup closes.

How to use a compiled report

1 Open the compiled report by double-clicking the program item. A 
Print Options dialog box appears with the report file name displayed 
on the title bar.

2 In the Print Options dialog box, use the Report drop-down list to 
specify the print destination (Print the report to a window, Export 
the report, or Print the report to a printer) and the time of printing.

3 Set the time (hour and minutes) and the date (month, date, and year) 
in the Time and Date text boxes, and click either AM or PM.

4 The center section of the dialog box is dynamic, and the message and 
the button appearing there are determined by the selection from the 
Report (print destination) drop-down list:

●   If you are printing the report to a window, click Window Styles to 
determine the appearance of the window. The Window Style 
Options dialog box appears. Use this dialog box to specify the 
style options (you can specify drill-down ability, the appearance of 
Close and Refresh buttons, etc.) If you toggle the Has Zoom Box with 
Default Level check box on, select the default zoom level from the 
adjacent drop-down list. Then click OK to return to the previous 
dialog box.

●   If you are exporting the report, click Export Options. The Export 
dialog box appears. Select the export format from the Format drop-
down list, and select the export destination from the Destination 
drop-down list. Click OK. (With certain export formats, the 
Character-Separated Values dialog box will then appear. Enter the 
separator and the delimiter in the appropriate text boxes, and then 
click OK. With some export formats, the Number and Date Format 
dialog box will then appear. Toggle the Same number format as in 
report and the Same date format as in report check boxes on/off as 
desired, and then click OK.) The Choose Export File dialog box 
appears. Select an export file and then click Save.
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●   If you are printing the report to a printer, click Printer Options. The 
Print dialog box appears. Specify the printing options, and then 
click OK.

5 Click either Use Saved Data or Refresh Data. If you click Refresh Data, 
the two check boxes in the lower section of the dialog box will 
become active. Toggle the [Modify selection formula] and the [Modify 
stored procedure parameters] check boxes on/off as desired.

6 Click Print.

Repeat Steps 2-6 for each additional printing or exporting task. Click Done 
when finished.

HANDS-ON (Viewing reports with a web browser)

How to view reports in a web browser

Your Systems Administrator or IS Manager will have set up an intranet/
extranet where you can view your reports in a browser. Contact your web 
administrator to ask for the URL. The administrator can also tell you 
which viewer your company uses. There are four Crystal Smart Viewers:

1. The Crystal Smart Viewer for Java

2. The Crystal Smart Viewer for ActiveX

3. The Crystal Smart Viewer for HTML (Plain)

4. The Crystal Smart Viewer for HTML (Frames)

Using the appropriate viewer, you can easily view, print, and export your 
reports from a web browser.

USING THE CRYSTAL SMART VIEWER FOR JAVA

1 Open your report in the Crystal Smart Viewer for Java. The first page 
of the requested report will appear inside the viewer. A Smart 
Navigation Group Tree is generated based on the groups in the report.

NOTE: You may not have access to Smart Navigation with the Group 
Tree. Smart Navigation may be disabled for the report or for the Crystal 
Smart Viewer itself. If Smart Navigation is available, you can use the 
Smart Navigation button in the Crystal Smart Viewer to turn on and off 
the Group Tree. This button will be disabled if Smart Navigation is 
unavailable.
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2 Use the page controls to scroll through the report page by page.

3 Use the Smart Navigation features of the Group Tree, if it is 
available, to navigate through the report by group.

4 Click the Refresh button to refresh the report data.

The first time a report is requested, the Crystal Web Report Server 
generates the report and saves it in a directory cache. If someone else 
requests the same report, the Crystal Web Report Server can send 
them the existing report rather than regenerate the data, a time 
consuming process.

If the data that the report is dependent on changes, though, due to 
updates in the database, the cached report will no longer reflect 
accurate data. Use the Refresh button to force the Crystal Web Report 
Server to connect to the database and update the report.

5 To search for a specific value within the report, type the value into 
the Text to search for text box and click the Find Next button.

The Crystal Smart Viewer will locate the first matching value in the 
report, if it exists, and highlight that value for you. If you need to find 
the next instance of that value in the report, simply click the Find Next 
button again.

6 Click the Print Report button to print the report to a printer available 
from your machine.

7 Click the Export Report button to export the report. The Export dialog 
box appears.

8 Select the export format from the Export Format drop-down list. You 
can export in any of the following formats: Crystal Reports, MS 
Word, MS Excel, or HTML.

9 Enter the export destination in the Save To text box, or click Browse to 
search for an already existing destination file name.

10 Click OK when finished.

NOTE: You may experience minor problems scrolling through reports in 
the Crystal Smart Viewer for Java. Such problems are a result of the Java 
virtual machine implemented in certain web browsers and can not be 
accounted for by the Crystal Smart Viewer for Java. If you experience 
problems, click repeatedly on the scroll buttons to scroll. Do not hold the 
scroll buttons down.

USING THE CRYSTAL SMART VIEWER FOR ACTIVEX

1 Open your report in the Crystal Smart Viewer for ActiveX. The first 
page of the requested report will appear inside the viewer. A Smart 
Navigation Group Tree is generated based on the groups in the report.
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NOTE: You may not have access to Smart Navigation with the Group 
Tree. Smart Navigation may be disabled for the report or for the Crystal 
Smart Viewer itself. If Smart Navigation is available, you can use the 
Smart Navigation button in the Crystal Smart Viewer to turn on and off 
the Group Tree. This button will be disabled if Smart Navigation is 
unavailable.

2 Use the page controls to scroll through the report page by page.

3 Use the Zoom drop-down list to specify a zoom level for the report.

4 Use the Smart Navigation features of the Group Tree, if it is 
available, to navigate through the report by groups.

5 Click the Refresh button to refresh the report data.

To improve performance, reports are often cached by the web server. 
This means that the first time a report is requested, the Crystal Web 
Report Server generates the report and saves it. If someone else 
requests the same report, the Crystal Web Report Server will simply 
send them the saved report rather than regenerate the data.

However, the data that the report is dependent on may change while 
the report file is stored in the cache. If so, use the Refresh button to 
force the Crystal Web Report Server to update the report.

6 To search for a specific value within the report, type the value into 
the Text to search for text box and click the Find Next button.

The Crystal Smart Viewer will locate the first matching value in the 
report, if it exists, and highlight that value for you. If you need to find 
the next instance of that value in the report, simply click the Find Next 
button again.

7 Click the Print Report button to print the report to a printer available 
from your machine.

8 Click the Export Report button to export the report. The Export Report 
dialog box appears. The Export Report dialog box works like the 
Save As dialog box in Seagate Crystal Reports.

9 Select a directory from the Save in drop-down list and list box. The 
report will be saved in that directory.

10 Enter a file name in the File name text box. The report will be saved 
with this file name.

11 Select an export format from the Save as type drop-down list. The 
report can be saved as a Crystal Report, an HTML document, a Word 
document, or as an Excel document.

12 Click Save when finished.
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NOTE: If the report has been created using different printer settings than 
those available from your system, you may experience formatting 
problems when attempting to print a report displayed by the Crystal 
Smart Viewer for ActiveX. The Crystal Smart Viewer Print button uses 
printer settings saved with the report file. If you experience problems 
printing a report, contact your web server administrator.

USING THE CRYSTAL SMART VIEWER FOR HTML (PLAIN)

1 Open your report in the Crystal Smart Viewer for HTML (Plain). The 
first page of the requested report will appear as a standard HTML 
page inside the viewer.

2 To page through the report, use the page controls at the top or 
bottom of the report page.

3 Click the Refresh button to refresh the report data.

The Crystal Web Report Server can store HTML pages for the 
requested report in a cache directory to improve response time for 
future requests. If someone else requests the same report, the Crystal 
Web Report Server will simply send them the saved HTML pages 
rather than regenerating the pages from the original report.

If database data changes, report data reflected in the HTML pages will 
no longer be accurate. Use the Refresh button to force the Crystal Web 
Report Server to update the report data and generate new HTML 
pages.

4 To search for a specific value in the report, type the value into the 
Search text box, and click the Search button.

The Crystal Smart Viewer will locate the first matching value in the 
report, if it exists, and highlight it for you. Continue to click the Search 
button to find successive matching values in the report.

USING THE CRYSTAL SMART VIEWER FOR HTML (FRAMES)

1 Open your report in the Crystal Smart Viewer for Plain HTML. The 
first page of the requested report will appear inside the viewer. A 
Smart Navigation Group Tree is generated based on the groups in 
the report.

NOTE: You may not have access to Smart Navigation with the Group Tree. 
Smart Navigation may be disabled for the report or for the Crystal Smart 
Viewer itself. If Smart Navigation is available, you can use the Smart 
Navigation button in the Crystal Smart Viewer to turn the Group Tree on or 
off. This button will be disabled if Smart Navigation is unavailable.

2 Use the page controls at the top of the Preview Tab to page through 
the report.
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3 Use the Smart Navigation features of the Group Tree, if it is 
available, to navigate through the report by groups.

4 Click the Refresh button to refresh the report data.

The Crystal Web Report Server can store requested reports in a cache 
directory to improve response time for future requests. If someone 
else requests the same report, the Crystal Web Report Server will 
simply send them the saved report rather than regenerate the data for 
the report.

When report data becomes old, no longer reflecting accurate data 
from the database, the cached report must be updated. Use the Refresh 
button to force the Crystal Web Report Server to update the report.

5 To search for a specific value within the report, type the value into 
the Text to search for text box and click the Find Next button.

The Crystal Smart Viewer will locate the first matching value in the 
report, if it exists, and highlight that value for you. If you need to find 
the next instance of that value in the report, simply click the Find next 
button again.

Related Topics

How to drill-down on summarized data, Page 78

Sorting, Grouping, and Totaling, Page 245
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7 Tutorial - Customer List

What you will find in this chapter...

Overview, Page 148

Getting started, Page 149

Record Selection, Page 162

Grouping and sorting, Page 165

Completing the report, Page 169
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Overview

The following tutorial has been designed to give you confidence when 
creating your first report.

You begin by learning the basic concepts: calling up a database, placing 
some fields on the report, and then selecting specific records to be 
included. You will then learn how to: 

●   insert and move database fields,

●   add and format a title,

●   display a report in the Preview Tab so you can fine-tune your 
work,

●   use the Select Expert to ensure the report includes only the data 
you need,

●   move objects,

●   group and sort data,

●   insert pictures, and

●   print a report.

Before you begin This tutorial assumes you are familiar with Microsoft Windows and uses 
conventional terms and procedures common to the Windows 
environment. If you are not familiar with Windows, you may have 
trouble understanding basic procedures such as scrolling and clicking. 
Please refer to the documentation that came with Microsoft Windows for 
further explanation of these procedures. Also, see Command, button, key, 
and control conventions, Page 3, for a description of the conventions used in 
this manual.

The default font for all report sections in the program is set to Times New 
Roman, 10 point. If you have changed the default font, or if your printer 
does not support this font, the field size, field spacing, and screen shots 
will look different than those included in this tutorial. 

This tutorial has been designed using Microsoft Windows 95, Windows 98 
and Win NT 4.0. Screen shots may vary slightly if you are using Windows 
3.1, or NT 3.51.

If you are not familiar with Seagate Crystal Reports environment, please 
review the following sections before beginning this tutorial:

●   Getting to Know Seagate Crystal Reports, Page 41, which explains the 
main application window, the Design and Preview Tabs, the Menu 
bar, Standard and Supplementary toolbars, Formatting toolbar, and 
Status bar, as well as many other features of the program.
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●   How to add, delete, and move guidelines, Page 72, and How to move and 
position objects using guidelines, Page 73.

●   Other fundamentals, Page 66, which describes working with the 
grid, free form placement of objects using guidelines, and also 
how to work with sections and objects.

Getting started

In this tutorial, you will get an introduction to the program as you create 
a Customer List report. The Customer List is one of the most basic 
business reports and typically has information such as Customer Name, 
City, Region, and Contact Name.

Creating the 
report

1 Click the NEW button on the Standard toolbar. The Report Gallery 
appears.

The Report Gallery contains a number of buttons. These buttons open 
the Experts that guide you through the creation of specific types of 
reports. Since you will be learning reporting concepts here, you can 
skip the Experts and build your report from scratch. After you have 
completed this tutorial, you may want to build some reports using the 
Experts to decide which method of report construction you are most 
comfortable with.

The Report Gallery expands to reveal several custom report options.

2 Click Custom.
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The Choose Database File dialog box appears.

NOTE: You can also create reports based on SQL/ODBC data sources, 
dictionary files, or query files. See The Crystal SQL Designer, Page 465, and 
Dictionaries, Page 487, for more information.

Selecting a 
database to use 

The next step in creating a report is to select a database. Select the 
xtreme.mdb sample database for this tutorial.

1 In the Choose Database File dialog box, select the xtreme.mdb file 
from the File Name list box. This file was installed in the \CRW16 
directory (16-bit), or \Program Files\Seagate Software\Crystal 
Reports (32-bit), or the directory in which the program resides.

2 Click Open. The Select Tables dialog box appears.

3 Click Custom Report. 4 Click Data File.
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3 Because you are only dealing with customers in this tutorial, you will 
only need to select the Customer table. Highlight Customer and click 
OK.

The Insert Fields dialog box appears with the Database Tab active.

NOTE: If more than one table is selected in the Select Tables dialog box, 
the Visual Linking Expert appears. For more information on linking, see 
How to add and link multiple tables, Page 104, and search for Visual Linking 
Topics Index in Seagate Crystal Reports online Help.

Report sections The Design Tab is divided into five sections: Report Header (RH), Page 
Header (PH), Details (D), Report Footer (RF), and Page Footer (PF). If at any 
time you are unsure of the report section in which you are working, 
simply look at the shaded area to the left of the report which always 
displays either the section names or the initials that designate the names. 
See Design Tab, Page 57.
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●   If the Short Section Names in Design check box in the Options dialog 
box is toggled on, then the Report Header, Page Header, Details, 
Report Footer and Page Footer section names will appear as RH, PH, 
D, RF and PF respectively.If this check box is not toggled on, 
follow these steps:

1 Choose the OPTIONS command on the File Menu. The Options dialog 
box appears with the Layout Tab active.

2 Toggle the Show Short Section Names in Design check box on.

3 Click OK to return to the report.

Inserting a field The Insert Fields dialog box appears automatically with the Database Tab 
active, since it is almost certain you will want to insert database fields 
when you create a new report. 
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This dialog box is set to remain on-screen until you click the Close button. 
All the tables available for use are listed in this box.

You can move the dialog box to another location on the screen by clicking 
on its title bar and dragging it to a new location. You can also resize the 
dialog box by dragging any of its edges with the Resizing cursor. See 
Cursors, Page 54.

You will now start placing objects on the report by inserting the Customer 
Name field.

First, familiarize yourself with the Database Tab of the Insert Fields 
dialog box.

1 Highlight a field name in the dialog box by clicking the name once. 
When you highlight a field name, you can review the values for that 
field as well as the field type and size, by clicking the Browse button. 
The Browse dialog box appears listing the field name, type, length, 
and a subset of field values.

The Customer table.

The fields in the 
Customer table.
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3 Click the Customer Name field and drag it into the Details section of 
the report.

An object frame appears with the Arrow cursor as you drag the field 
onto the report.

●   The object frame represents the object you have just selected for 
placement.

●   The size of the object frame approximates the size of the data in the 
field selected.

4 Move the object frame as far to the left as you can in the Details 
section. If you move the field too far to the left, the Arrow cursor 
turns into a Stop cursor, indicating that you can not drag the field 
that far. See Cursors, Page 54. Keep in mind that you can not place any 
objects outside the page margin.

The Design Tab should look similar to this:

Understanding 
fields

Before going any further, take a look at the field you just placed in the 
Details section.

2 When finished reviewing the 
data, click this button to return 
to the Insert Fields dialog box.
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●   First of all, the object frame indicates that when the report is 
printed, a field value will appear where the box is positioned.

●   The X's in the object frame indicate that the database field contains 
a text string. Other data types have different character 
representations. For example, a currency data type is represented 
by $55,555.56.

●   The number of X’s in the object frame is the data width, the 
maximum number of characters in the field as defined by the 
database. The width of the object frame is the field width (the 
amount of space allocated to the field for printing). Initially it is set 
to the width needed to display the maximum number of characters 
in the field (using the fond selected for the field). You can change 
this width by resizing the field.

●   The size of the X’s indicates the point size selected for the 
characters in the field.

●   The font and style (Bold, Underline, etc.) used in displaying the X’s 
indicate the font and style selected for the characters in the field. 
Later in this tutorial you will learn how to make changes to these 
properties.

●   The line spacing is adjusted to the point size selected for the 
characters in the field.

Selecting fields When a field is selected, the object frame appears with a handle (box) on 
its right, left, top, and bottom edge. These handles indicate that the field 
is selected, and therefore active. To do anything with a field (change the 
font, move it, etc.), you first have to select it.

●   Position the cursor inside the object frame and click once. The 
handles appear, indicating the object is selected.

●   Move the cursor away from the object frame and click in an empty 
part of the window. The handles disappear.

That’s all it takes to select and deselect objects.

Resizing fields To resize the field, follow these steps:

1 Click the Customer Name field to select it.

2 Press the Ctrl key and click the field heading to select both objects.

3 Move the cursor over the resizing handle on the right edge of the 
fields until the cursor turns into a Resizing cursor. See Cursors, Page 
54.

4 Resize the fields to the left until they are approximately two inches in 
length.
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Adding 
additional fields

Next, you will insert two additional fields in the report. This time, however, 
you will use the Ctrl-click combination to add them at the same time.

1 Highlight the City field in the Insert Fields dialog box, press the Ctrl 
key on your keyboard, and then highlight the Country field. Release 
the Ctrl key. If you scroll through the field list, you will notice that 
both fields remain selected.

NOTE: Using the Ctrl-click combination allows you to select a non-
continuous range of fields. The Shift-click combination can be used to 
select several fields from the list that are continuous.

2 Click the Insert button to place the fields.

3 As the cursor is moved over the report, an object frame appears 
along with the Arrow cursor.

4 Place the fields to the right of the Customer Name field. Click once to 
insert the fields. Both fields appear in the Details section of the report 
in the same order in which they are listed in the Insert Fields dialog 
box.

Reviewing your 
work

Now let’s see how the report looks with three fields placed and positioned.

1 Click the PRINT PREVIEW button on the Standard toolbar to activate 
the Preview Tab.

The screen should look similar to this: 

NOTE: The first time you preview a report, you must click the PREVIEW 
button on the Standard toolbar to activate the Preview Tab. The Preview 
Tab appears to the right of the Design Tab. You can then switch between 
designing and previewing the report by clicking the corresponding tab.
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You have the beginnings of a customer list report, but you still have 
several fields to add.

2 When you are finished reviewing the report, return to the Design 
Tab by clicking it.

Displaying field 
names

Field pictures (object frames containing character representations) have 
been discussed, but there may be times when you want to see the field 
names in the Design Tab.

1 Choose the OPTIONS command from the File Menu. The Options 
dialog box appears with the Layout Tab active.

Now in the Design Tab you will see the actual field names instead of 
character representations (X, $, #, etc.).

Combining 
database fields in 
a text object

Instead of adding the Contact First Name and Contact Last Name fields 
as separate objects, you can insert both fields in a text object. This allows 
you to control the formatting of both fields by making changes to only 
one object. When you insert fields in a text object, the fields are 
automatically trimmed (they do not have any extra white space on either 
side). This is important because a field is a fixed size but the data in the 
fields can vary in size, leaving various amount of unwanted white space.

1 Click the INSERT TEXT OBJECT button on the Standard toolbar. As you 
move the cursor over the report, an object frame appears next to it.

2 Toggle this 
check box on 
and click OK.
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2 Insert the field to the right of the fields in the Details section. As you 
drag the field, the Design Tab automatically scrolls to the right, if 
necessary. When you click to place the object, a text object appears 
and the horizontal ruler of the Design Tab changes to a ruler/tab 
selector that is used for editing the text object. If you click an empty 
area of the report or a field object, the standard Design Tab ruler 
appears.

3 Click once on the border of the text object to select it for resizing. 
Handles appear on all sides of the object.

4 Move the cursor over the right sizing handle of the text object and 
increase the width by about 1 inch. You may need to scroll to the 
right and continue resizing.

5 Double-click inside the text object to select it for editing. Notice the 
insertion point is now flashing within the text object.

6 Highlight the Contact Last Name field in the Insert Fields dialog box. 
Remember, you can move the Insert Fields dialog box by dragging 
and dropping it by its title bar.

7 Click Insert.

8 Move the cursor over the text object until the cursor becomes a Drag 
and Drop cursor. See Cursors, Page 54.

9 Click once to place the field in the text object. The cursor now 
appears after the Contact Last Name field, within the text object.

10 Type a comma and a space after the Contact Last Name. 

11 In the Insert Fields dialog box, highlight the Contact First Name 
field.

12 Click Insert.

13 Move the cursor over the text object until the cursor becomes a Drag 
and Drop cursor. Move the cursor to the right of the comma and 
space you just typed, and click once. The field will be inserted to the 
right of the comma and space.

14 You are finished inserting fields, so click Close in the Insert Fields 
dialog box.

15 Click the Preview Tab to look at the fields you just placed.
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The report should now look similar to this: 

Adding summary 
information

The next step is to add summary information to your report. Adding 
summary information allows you to specify the author, title, and subject 
of the report, as well as any keywords or comments related to the report. 
If a template is used when creating the report, you can specify that as 
well. When you add summary information, users can find information 
related to the report quickly. Summary information will also appear in 
the Reports at a Glance application. Choose Reports at a Glance from 
Seagate Crystal Reports program menu.

1 Choose the SUMMARY INFO command on the File Menu. The 
Document Properties dialog box appears with the Summary Tab 
active.
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2 Enter information about your report in the text boxes provided. Be 
sure to enter the title “Customer List” in the Title text box. This 
information will be used in the next section of the tutorial.

3 Click OK when finished.

Adding a title As you can see, the report looks incomplete without a title. Although you 
can add a title using a text object, you can also tell the program to take the 
title information directly from the Title text box in the Document 
Properties dialog box.

1 Click the Design Tab to activate it.

2 Choose the REPORT TITLE command from the Insert|Special Field 
Menu.

3 Move the cursor over the report. An object frame appears.

4 Position the object frame in the upper left-hand corner of the Page 
Header (PH) section of the report and click once to place the object.

5 Click the Preview Tab to review your changes.

The report title object now displays the title that you entered in the Title 
text box of the Document Properties dialog box.

Formatting 
objects

Now you can format the report title. This time, however, you will remain 
in the Preview Tab to do the work. This will make it easier to see your 
work while you are formatting the title.

1 To center the title, you will first need to expand the title field box so 
that it's about the same width as the data in your report. To do this, 
select the object.

2 Position the cursor on the right edge of the object until the cursor 
turns into a Resizing cursor. Drag the right edge of the field box until 
it is even with the right edge of the data in the Contact Name field 
object.

You have created a large field that extends from the left edge to the 
right edge of the report.

3 With the report title object still selected, click the CENTER ALIGNMENT 
button on the Formatting toolbar. The title is centered within the 
object.

4 Right-click the object and choose CHANGE FONT from the shortcut 
menu. The Format Editor appears with the Font Tab active. Search 
for Format Editor in Seagate Crystal Reports online Help.

5 Set the report title to a larger, bolder version of the active font by 
choosing Bold from the Style drop-down list and 16 (or a point size 
suitable to the font you are using) from the Size drop-down list.
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6 Change the color of the text by choosing Maroon from the Color 
drop-down list. Notice that the Sample box shows an example of how 
the text will look.

7 Click OK when finished.

8 Resize the report title object vertically to accommodate the increased 
size of the title.

The title is now formatted to stand out on the report. 

Adding a field 
heading

As you can see, the Contact Name field is the only field without a 
heading. In this section you will create a heading using a text field.

1 Return to the Design Tab.

2 Click the INSERT TEXT OBJECT button on the Standard toolbar. As you 
move the cursor over the report, an object frame appears next to it.

3 Place the object in the Page Header (PH) section, above the contact 
name object.

4 Type “Contact Name” (without the quotation marks) in the text 
object edit box.

5 While the text object is still in edit mode, highlight the field heading.

6 Click the UNDERLINE button on the Formatting toolbar.

The Contact Name field now has a heading that looks just like the other 
field titles.

Saving the report 1 Click the SAVE button on the Standard toolbar to save your work. 
Since this is the first time you are saving the report, the File Save As 
dialog box appears displaying the default directory where the 
database resides.
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2 Type CUSTLIST.RPT in the Filename edit box and click Save. Your 
report is saved to the default directory in which the program resides.

3 Click the Preview Tab to view the report.

The report should now look similar to the following: 

Congratulations! You have just created a basic listing report. You will 
continue to refine this report throughout the rest of this tutorial.

Record Selection

Seagate Crystal Reports allows you to limit or restrict the records that are 
to be included in a report. In this section you will learn how to:

●   select the records you want included in the report, and

●   save a report, including the selection criteria.

For example, it may be useful to have a customer list that only lists 
customers from the USA. The sample data contains records from the 
United States and International customers. It is easy to restrict lists like 
this using the Select Expert. See Record and Group Selection, Page 227.

Entering the 
selection criteria

When you scroll through the report, you will see that it contains 
information for customers from many different countries. In this step, 
you will limit the number of countries displayed to the USA.

1 To begin, click the Design Tab to return to design mode.

2 Click an empty area of the report to make sure all fields are 
deselected.
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3 Click the SELECT EXPERT button on the Standard toolbar. The Choose 
Field dialog box appears.

This dialog box lists all the fields currently in the report in the Report 
Fields section and then lists all fields that are available from each table 
in the Database Fields section.

4 Since you are going to base record selection on the country field, 
choose {customer.COUNTRY} from the Fields list box and click OK. 
The Select Expert appears.

Your job in this dialog box is to imagine that you are completing the 
following sentence:

Select all records where a customer’s COUNTRY is

You complete the sentence with the condition you want the program 
to use when selecting records for your report. Right now the condition 
is any value, clearly not a restrictive condition.

5 Click the arrow on the right drop-down list to see what other options 
you have. Since you want only those records where the Country is 
USA, select the equal to condition. A new list box appears on the 
right. The dialog box sentence now reads:
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Select all records where a customer’s Country is 
equal to

All that you need to complete the sentence is the value USA.

6 Click the arrow on the drop-down list. A list of all the country values 
appears. Select USA from the list.

The sentence now reads:

Select all records where a customer’s Country is 
equal to USA

7 Click OK to return to the Design Tab.

8 Click the Preview Tab to review the results of your work.

9 Save this version of the report without overwriting the original 
report by choosing the SAVE AS command from the File Menu and 
giving the new report the name USA.RPT.

Congratulations! You have started formatting your report and have 
added selection criteria to it. More than that, you have learned how to 
manipulate your data. By now, you have a good idea of the powerful 
kinds of reports you can prepare. As you can see, it is an easy program to 
use.

Deleting a field Now that the report only contains records from the USA, displaying the 
Country field in the body of the report is not necessary. You will quickly 
delete this before continuing.

1 Select the Country field and the Country column heading using the 
Ctrl-click combination.

2 Press the DELETE button on your keyboard. That is all it takes to 
delete fields from the report.

The report should now look similar to this: 
164 Seagate Crystal Reports User’s Guide



Balancing field 
spacing

Now that the Country field has been deleted, there is a large amount of 
white space between the City and Contact Name fields. You might be 
satisfied with the spacing as it stands, but it might be more readable if the 
columns were better balanced across the page.

1 Return to the Design Tab. Select the Contact Name field and its field 
heading by using the Ctrl-click combination.

2 Place the cursor over one of the two highlighted text objects and drag 
them to the left, closer to the City field.

3 Click the Preview Tab and review your work again.

The report should look similar to this: 

The spacing between the fields is much better, but it looks as if the report 
title is off-center.

4 Click the report title object to select it.

5 Position the cursor on the right handle of the object until the cursor 
turns into a resizing cursor. Drag the right edge of the object frame 
until it is even with the right edge of the data in the Contact Name 
field object.

The report title automatically recenters itself based on the size of the 
object.

Grouping and sorting

Reports can be grouped and sorted in a variety of ways. Sorting and 
grouping tools provide a great deal of flexibility for customizing reports.
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Grouping the 
report

In many reports you need to break the data into groups in order to make 
it easier to read and to understand. Seagate Crystal Reports lets you do 
this easily. For this customer list, you will group the customers by region 
and then sort the customers alphabetically within each group.

1 In the Design Tab, click the INSERT GROUP button on the 
Supplementary toolbar. The Insert Group dialog box appears.

2 Select the Region field from the Customer table in the first drop-
down list. The program will now take all records with the same 
value in the region field and place them together in a group on the 
report.

3 Select in ascending order from the second drop-down list. The region 
grouping will be displayed on the report in alphabetic ascending 
order.

4 Click OK.

Notice that two new sections now appear in the Design Tab: GH1 
(Group Header) and GF1 (Group Footer). This is how the program 
shows that the report has been grouped.
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5 Click the Preview Tab to see what the report looks like.

6 If the group tree is not visible, click the TOGGLE GROUP TREE button 
on the Formatting toolbar to see the groups included in the report.

You can view the group of interest by simply clicking on the group name 
in the Group Tree. For example, to see the Texas customer group, simply 
click TX in the Group Tree. The program jumps to the Texas group, 
displaying that group in the Preview Tab. The Group Tree allows you to 
quickly jump to a specific group of interest instead of scrolling through 
the report looking for the group. For more information on the group tree, 
see Group Tree view, Page 63.

NOTE: For many reports, you will want to insert summaries, subtotals 
and grand totals. For example, when creating a sales report rather than a 
customer list, you would want to calculate the total sales amount for each 
region. See Sorting, Grouping, and Totaling, Page 245.

Understanding 
“live” group 
headers

When a group is inserted, a group name field is automatically inserted in 
the Group Header section of the report. The group name field displays 
the current group’s name. For example, if you group by region, when you 
preview the report, the group header for the CA (California) group will 
show “CA”.

The group field name is automatically formatted to stand out from the 
records in the group.

Sorting records In a typical customer list report, customer names are listed alphabetically. 
In this example, you will sort the customer names alphabetically within 
each region.

1 In the Preview Tab, click the SORT ORDER button on the Standard 
toolbar. The Record Sort Order dialog box appears.
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●   The Report Fields list box displays all fields currently on your 
report. You can choose to sort based on any of these fields.

●   The Sort Fields list box displays the fields that are already sorted in 
the report. Since the region field has already been sorted, the 
sorting you are about to do will be within each region, and not for 
the entire report.

2 Highlight the Customer Name field and click the Add button. Notice 
that the Customer Name field now appears in the Sort Fields list box.

3 Click the Ascending option button for the Sort Direction and click OK.

The report should now look similar to the following: 

Notice that the records within each group are in alphabetic order.
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Completing the report

You have just one step left to complete the report. A company logo needs 
to be added to the first page of the report.

Inserting a 
company logo

In this section, you will place a company logo at the top of the first page 
of the report.

1 In the Design Tab, click the INSERT PICTURE button on the 
Supplementary toolbar. The Open dialog box appears. 

2 Choose the xtreme.bmp and click Open. An object frame appears as 
you move the cursor over the report. The object frame represents the 
logo you will place. 

3 Position the object frame in the upper left-hand corner of the Report 
Header (RH) section of the report and click once to place it. 

Placing the logo in the Report Header (RH) section ensures that the 
logo is printed only on the first page of the report. See Area printing 
characteristics, Page 59.

NOTE: Although there does not appear to be enough room in the Report 
Header (RH) section when you place the graphic, the section will 
automatically expand to accommodate the picture.

4 Click the Preview Tab to view the report.

The final report should look like this: 

5 Save the report by clicking the SAVE button on the Standard toolbar.
Tutorial - Customer List 169



You have just completed your first report. It is an impressive report, and 
Seagate Crystal Reports made it easy to do.

Related Topics

For information about distributing reports (printing, exporting, etc.) see 
Printing, Viewing, and Exporting, Page 121.
170 Seagate Crystal Reports User’s Guide



8 Reporting on OLAP data

What you will find in this chapter...

Introduction, Page 172

Working with OLAP data, Page 172

OLAP Reporting with Seagate Crystal Reports, Page 172

OLAP grid objects, Page 173

Updating an OLAP database location, Page 174

OLAP Language, Page 175

Working with Hyperion Essbase data (Report Script Method), Page 175

Working with Informix MetaCube (MetaCube SQL Method), Page 183

HANDS-ON (Reporting on OLAP data), Page 183
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Introduction
Although relational databases such as SQL servers and PC databases are 
the most common source of data, Online Analytical Processing (OLAP) 
and Multi-Dimensional Data (MDD) are rapidly becoming popular data-
storage and analysis formats. Seagate Crystal Reports provides the same 
access and reporting features for OLAP data sources that it provides for 
relational data.

NOTE: The term OLAP is used in this topic to refer to all common forms 
of OLAP and multi-dimensional data storage and access systems.

Many of the tools and dialog boxes Seagate Crystal Reports provides for 
working with OLAP data require a previous understanding of the OLAP 
concept. Make sure you are familiar with OLAP concepts and your OLAP 
software before attempting to design OLAP-based reports. If you are 
already familiar with OLAP, this chapter provides the information you 
need to extend OLAP data with Seagate Crystal Reports, the most 
powerful solution to analyzing any data.

Working with OLAP data

Seagate Crystal Reports now integrates some of the most powerful OLAP 
tools for report creation and design. If your company uses the multi-
dimensional power of OLAP, you can easily design complex OLAP 
reports using Seagate Crystal Reports.

NOTE: If you are not sure if your company uses OLAP, contact your 
Administrator.

Many OLAP products allow you to quickly and easily manipulate 
dimensions and drill-down on complex data relationships through client-
side spreadsheet and worksheet applications. However, only Seagate 
Crystal Reports lets you apply the most powerful reporting features 
available to your OLAP data, not only evaluating multi-dimensional 
data, but also formatting that data in presentation quality reports, and 
finally, distributing that data in any format to any location.

OLAP Reporting with Seagate Crystal Reports

There are many different OLAP vendors on the market today. You can 
use Seagate Crystal Reports to report on the following OLAP data 
sources:
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●   Seagate Crystal Info Cube

●   Hyperion Essbase 

●   DB2 OLAP Server

●   Informix MetaCube

●   Microsoft SQL Server OLAP Services

●   OLEDB for OLAP sources

There are different methods for reporting on these OLAP sources. The 
first method uses what we call the Grid Object Method. All of these OLAP 
sources can be used by the Grid Object Method to create OLAP aware, 
grid- like reports. To learn how to create reports using this method, see 
How to create an OLAP report using the Grid Object, Page 183. 

Hyperion Essbase and DB2 OLAP Server can use another method, aside 
from the Grid Object Method. This method is called the Report Script 
Method. To learn more about this method see Working with Hyperion 
Essbase data (Report Script Method), Page 175.

Informix MetaCube uses a different method to access data from its OLAP 
engine. MetaCube reporting follows more of a relational report creation 
model. For more information, see Working with Informix MetaCube 
(MetaCube SQL Method), Page 183.

OLAP grid objects

When designing a report with OLAP data, Seagate Crystal Reports 
creates a primary report containing one or more OLAP grid objects. 
OLAP grid objects look and act much like cross-tab objects, but are 
designed specifically for OLAP data.

The OLAP grid object plots OLAP cube dimensions and fields across 
columns and rows, organizing hierarchies of data into bands. Highlight 
individual data cells or entire bands, format and pivot the entire grid or 
change the OLAP data entirely - only seconds are require to reshape 
complex multi-dimensional data into a clear and informative report.

The OLAP Grid, designed specifically for OLAP data, provides true, 
multi-dimensional reporting. Add multiple dimensions to either axis to 
analyze three, four or more dimensions in a single OLAP grid. 
Alternately, create groups in your report using the fields from one or 
more dimensions and multiple grid objects are generated, one per group.
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Updating an OLAP database location

There are many situations in which the location of the OLAP data 
accessed by a report may change. For instance, the location of the OLAP 
server or database may actually change due to a restructuring of IS 
resources. In addition, another cube instance may have been successfully 
processed and reflect more current information. Alternately, some 
reports may be designed and developed on a smaller database that 
represents a subset or production version of the primary OLAP database, 
then ported over to the actual working database to report on real data. In 
either case, you must update the information about the locations of the 
OLAP server and database in your report files.

The location on an OLAP database may be changed. To preview the data 
correctly: 

●   The report must be altered to meet any structural changes in the 
cube. 

●   Any dimensions and generations contained in the report that are 
not in the cube must be removed or renamed.

●   Any field referred to explicitly in the design of the report, such as a 
formula, must be removed or renamed.

If this is the case, the report file can be easily updated to point to the new 
location. Keep in mind, though, if a report contains one or more 
subreports, and the databases used for the subreports have changed 
name or location, you must also update each of the subreports.

To change a cube in the OLAP grid object:

1  Select the grid by clicking anywhere on it.

2 Right-click on the grid and choose a shortcut menu command or 
choose SET OLAP CUBE LOCATION from the Database menu.

3 Choose the new OLAP location that you would like to point to. If the 
report also displays dimension information in column format (i.e., in 
the multi-grid scenario), you need to use "set database location" to 
change to reference to the datasource by these "column fields".

NOTE: You can not change from one OLAP type to another, i.e., if 
working with Essbase you must only choose a different Essbase cube. 
Also, if a report contains more than one grid object, this process must be 
done for each grid object.

To change location for Essbase or DB2 OLAP Server using the Report 
Script Method:
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1 Select SET LOCATION from the Database menu and choose the 
different location of server, application and database.

2 Log on to the new database.

3 Click DONE.

To change location for MetaCube using the MetaCube SQL Method:

1 Select SET LOCATION from the Database menu and choose the 
different DSS location you would like to use.

2 Log on to the DSS.

3 Click DONE.

OLAP Language

Different OLAP Databases have different OLAP terminology. This 
section is designed to help ease the pain that you may experience when 
trying to report from a cube.

NOTE: This applies only to the Grid Object. The term "Use Long Field 
Names" is a Holos term and is the same as an "alias" in Essbase or DB2 
OLAP Server.

When selecting the appropriate rows and columns in your Grid Object, 
you will notice the term "Level". "Level 0" is the top dimension and listed 
in "level 1" are its children. In "level 2" are level 1's children and so on. 
’Level’ refers to a "Generation" in Essbase and DB2 OLAP Server.

Working with Hyperion Essbase data (Report Script Method)

Seagate Crystal Reports provides many features for working directly 
with Essbase data. This section provides conceptual information specific 
to creating reports based on Essbase databases. Essbase reports can be 
created using the Create Report Expert in Seagate Crystal Reports, just 
like any other report. Simply click the New button on the Standard 
toolbar, select a report style from the Report Gallery, and begin designing 
your report in the Create Report Expert.

The Data Tab of the Create Report Expert includes a button for accessing 
Essbase databases. Once you select an Essbase application and database, 
use the Members Tab of the Create Report Expert to specify dimensions 
and members to be included on a report. The Members Tab has been 
designed to resemble data selection dialog boxes that appear in Arbor 
Essbase client applications. If you have worked with Essbase before, you 
will quickly learn how to extract OLAP data in Seagate Crystal Reports.
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Selecting 
members for 
dynamic 
reporting

If database members frequently change and are updated in an Essbase 
database, you should consider carefully how you add members to a 
report during the design process. Rather than select specific members 
from the database outline, forcing the data to be filtered out by the 
Essbase server, you should consider including entire generations or 
levels and filtering out specific members from the Seagate Crystal 
Reports client.

For example, consider the Product dimension in the Essbase Sample Basic 
database:

NOTE: This diagram displays only a portion of the Product dimension in 
the Sample Basic database.

If new products are frequently added and older products discontinued, a 
report that includes this dimension should be designed to be easily 
refreshed whenever a product change occurs. As an example, consider 
the following scenario:

●   You have created a report that includes sales information for Cola, 
Diet Cola, Old Fashioned Root Beer, Birch Beer, Dark Cream Soda, 
and Vanilla Cream Soda. When you created the report, you 
selected each member individually from the database outline in an 
effort to exclude other products that you were not interested in.

●   A recent corporate decision has now eliminated Dark Cream Soda 
because of low sales figures. In addition, a recent marketing study 
has suggested that a new Cherry Cola be added to the company's 
product line, and you decide to include sales figures for this soda 
in your report. 

When you open the report and attempt to refresh the report data, Dark 
Cream Soda will no longer exist in the database, producing an error in 
your report. Furthermore, to add the Cherry Cola to the report, you must 
go through several steps to examine the new database outline, select the 
new member from the database, and add the member to the report.
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A different approach to designing this report would be to select the 
descendants of the Product dimension, generation 3 of the Product 
dimension, or level 0 of the Product dimension. Any of these methods 
produces similar results, without using specific members. When new 
members are added or old members eliminated, a simple refresh will 
update the report.

What if there are certain members you want to exclude from the report? 
In the above example, Caffeine Free Cola, Diet Root Beer, Sasparilla, and 
Diet Cream Soda are not used in the sales report. These members can be 
much more efficiently excluded using the Select Tab in the Create Report 
Expert or using the Select Expert. Once members are filtered out through 
record selection, those members will never appear in the report, even 
after refreshing the report. If one of the excluded members is removed 
from the original database, the report remains unaffected.

Keep in mind, though, that more general methods of selecting data, as 
described here, force Seagate Crystal Reports to retrieve more data from 
the Essbase database, increasing network traffic and resources and 
increasing time spent generating the report on the local system.

Essbase database 
security

Seagate Crystal Reports fully supports Essbase security. There are no 
additional settings or layers that need to be invoked.

Since Seagate Crystal Reports forces users to log on to an Essbase server 
before accessing Essbase databases, the server is allowed to verify log on 
information. All security is turned over to the Essbase server, and access 
to data is controlled by the server.

If a user attempts to request member data from Essbase that they do not 
normally have rights to view, Essbase will not return the requested data 
to Seagate Crystal Reports. Only data that the user has rights to view is 
returned and displayed in reports. In place of data that the user does not 
have access to, Essbase returns the #NOACCESS value.

When Seagate Crystal Reports receives #NOACCESS from Essbase, it 
translates this message into a null data value. The database members that 
produce the #NOACCESS value still appear in the report, but a blank 
space appears where the actual data value would normally be.

Using the Suppress Missing Data check box of the Report Options dialog 
box or the OLAP Tab of the Options dialog box, you can prevent Essbase 
from returning even the #NOACCESS value and any database member 
combinations that produce #NOACCESS.

To illustrate what happens to data that a user does not have access to, 
examine the following sample data:
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Normally, Seagate Crystal Reports produces the following output on 
reports:

With the Suppress Missing Data check box toggled on, the following data 
will appear in the report:

The report 
definition and 
the Essbase 
outline

A Seagate Crystal Reports file that reports on Essbase data is made up of 
a report definition, report data (optional), and an Essbase database 
outline (optional). The report definition is the core description of what 
data exists in the report, where that data comes from, and how the data 
looks when the report is printed or previewed on screen.

If you choose to store database data (actual data values stored in the 
database) with the report, you can save time generating the report when 
it is opened or printed in the future. However, if data values change in the 
original database, the report will not reflect these changes until you 
refresh the report data.

Additionally, an Essbase database outline can be saved with the report 
definition if the report, or a subreport, is based on an Essbase database. 
Having access to the Essbase database outline can be important when 
trying to view or edit existing report files. See Server Independence of 
Reports.

By default, Seagate Crystal Reports saves outline information of an 
Essbase database with any report that accesses it. Only information 
relevant to the data used by your report is saved, though.

When outline information is stored with a report, Seagate Crystal Reports 
has access to the original design of OLAP database information used to 
design the report. Such information allows you to make formatting 
changes to the report without reconnecting to the Essbase database.

Qtr1 33

Qtr2 NOACCESS

Qtr3 55

Qtr1 33

Qtr2

Qtr3 55

Qtr1 33

Qtr3 55
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NOTE: Actual Essbase DATA values (numeric data) are not stored with 
your report files unless the Save Data with Report check box from the File 
menu is toggled on.

You can prevent the program from storing database outline information 
with your report using the OLAP Tab in the Options dialog box. The 
OLAP Tab contains a Store Outline Information check box. By default, 
this check box is toggled on, but by toggling it off, you can keep database 
outlines from being stored with the report.

NOTE: In most cases, you should allow the program to store outline 
information with a report file unless drive space is a critical issue. 
Outlines increase the size of a report file and, therefore, require more 
disk space.

Storing database 
outlines

When you store a database outline with a report, the outline information 
is stored with the report definition file (a standard .RPT file). The 
database outline includes dimensions, members, consolidation attributes, 
expense attributes, any aliases defined in the Essbase Default alias table, 
and more.

Storing this information allows Seagate Crystal Reports to easily 
determine member parents, children, generations, and levels. 

Although storing outline information with a report allows more 
flexibility and power when working with existing reports, changes to the 
database outline in the original Essbase database are not reflected in a 
report file until the report is updated. Without updating the report, 
Seagate Crystal Reports remains unaware of any discrepancies between 
the outline in the report file and the actual database outline in Essbase. 
You can update the outline stored with a report file using the Verify 
Database command on the Database menu.

Saving reports 
without outlines

If you choose not to include the database outline from your Essbase 
databases with your reports, be aware that the lack of an outline forces the 
program to depend on connectivity to the Essbase server anytime 
changes are made to the report.

Most reports should be saved with database outline information unless 
disk space is a critical issue on your system. For more information about 
how report files can be dependent on or independent of the Essbase 
server, see Server independence of reports, Page 179. 

Server 
independence of 
reports

When you first create a report based on Essbase data, you must connect 
to the Essbase server to access the Essbase database. However, after you 
generate a report, you can save the Essbase database outline with the 
report, as described in the previous section, eliminating the need to have 
a connection to the server the next time you open the report file.
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On the other hand, some report features require that you re-establish the 
server connection before printing or scheduling a report. A server 
connection can be re-established by the Log On Server command on the 
File menu, if no report is currently open, or the Log On Server command 
on the Database menu, if another report is already open. The 
independence of a report file, in regards to the Essbase server, is 
controlled by several factors.

You must have a connection to the Essbase server if:

●   the report contains a cross-tab, and the database outline has not 
been saved with the report file, 

●   the report uses member aliases that are stored in an alias table 
other than the Default table, or

●   the report uses an Essbase related UFL function, such as 
EssbaseGeneration or EssbaseAncestor, and the database outline 
has not been saved with the report file. For more information, see 
The report definition and the Essbase outline, Page 178).

Otherwise, you do not need to have a connection to the Essbase server as 
long as you do not plan to refresh the database data values in the report. 
A good set of rules to follow is:

●   Cross-tabs require access to the database outline.

●   Essbase related UFL functions require access to the database 
outline.

●   Changes to database members that appear in the report require 
access to the server.

●   Access to member aliases stored in the Default alias table require 
access to the database outline.

●   Access to member aliases stored in an alias table other than the 
Default table require access to the original database.

●   Changes to database data values that appear in the report require 
access to the original database.

Access to the database outline can be given either by saving the outline 
with the report (see The Report Definition and the Essbase Outline), or by 
having a connection to the Essbase server. Access to database data values 
that are not saved with a report can only be given through a connection 
to the Essbase server.
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Updating 
Essbase server 
and database 
locations

If the location of the Essbase server or database changes, you must update 
the information about the server and database in report files. In addition, 
many reporting scenarios may require that you develop a report based on 
a smaller database that represents a subset or production version of the 
primary Essbase database.

In such cases, as long as the new database has the same structure as the 
original database that the report was based on, the report file can be easily 
updated to point to the new location. In addition, if a report contains one or 
more subreports, and the databases used for the subreports have changed 
name or location, you must update each of the subreports separately.

Seagate Crystal Reports provides several sample reports based on the 
Essbase Sample Basic database. By examining these sample reports, you 
may get ideas on how to design some of your own reports. Before you can 
use the subreports, though, you must update the location of the databases 
used for each one, based on the location of your Essbase server.

The following tutorial leads you through the process of updating the 
location of the databases used in the PL.RPT sample report located in the 
\Program Files\Seagate Software\Crystal Reports\Essbase directory.

With Seagate Crystal Reports running:

1 Choose the OPEN command from the File menu. The Open dialog 
box appears.

2 Locate and select the PL.RPT report file in the Open dialog box. By 
default, this report is installed in the \Program Files\Seagate 
Software\Crystal Reports\Essbase directory. When you have 
selected the report file, click OPEN, and the report file is opened 
inside Seagate Crystal Reports.

3 Choose the REFRESH REPORT DATA command from the Report menu. 
The Essbase Server Login dialog box appears.

4 Log on to your Essbase server using the user name and password 
you normally enter to log on. The Essbase Application & Database 
dialog box appears.

NOTE: If your Essbase server happens to have the same name as the 
server specified in the sample report, you do not need to change the 
server location. If so, the remaining steps are unnecessary.

5 Select the Sample application and the Basic database from your 
Essbase server. Click OK. Seagate Crystal Reports will continue 
prompting you for each subreport. You will be asked to log on to 
your Essbase server.

6 Save your report.
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Efficient access 
of Essbase 
databases

Normally, when Seagate Crystal Reports connects to an Essbase 
database, it loads the entire outline for that database into memory. This 
may create an initial delay while the outline is loaded, but once loaded, 
queries to the database are fast and changes to your report can be made 
easily and quickly in the Preview Tab.

Since the entire database outline is loaded into memory all at once, 
though, the size of the Essbase outline that can be accessed is limited by 
the size of the machine's memory and virtual memory. If you work with 
large Essbase databases that contain many dimensions and members, you 
may encounter problems when trying to connect to an Essbase database.

To solve this problem, Seagate Crystal Reports allows you to optimize its 
performance with large Essbase databases. When large database 
optimization is toggled on, Seagate Crystal Reports does not load the 
Essbase outline into memory ahead of time. So any size database outline 
may be accessed without regard to the machine's available memory. The 
drawback is that Seagate Crystal Reports must retrieve outline 
information directly from Essbase each time it requires additional data, 
thus slowing database access time.

Optimizing for 
large Essbase 
databases

Use the following process to optimize Seagate Crystal Reports for 
working with large Essbase databases:

1 With Seagate Crystal Reports running, choose the OPTIONS 
command from the File menu. The Option dialog box appears.

2 Click the OLAP Tab to activate it. This tab provides several options 
specific to OLAP databases.

3 Toggle the Optimize for Large Database check box on.

4 Click OK.

5 Close Seagate Crystal Reports and then reopen the program. The 
program will now allow you to access any database, regardless of 
size.

NOTE: Any reports that are open when the Optimize for Large Database 
check box is toggled on will not be affected by this option. Seagate 
Crystal Reports will continue to work with this report with the database 
outline stored in memory.

NOTE: For more information on creating Hyperion Essbase reports 
search for Working with Essbase in Crystal Reports online Help. The 
topics included will detail step by step the creation of several different 
types of Essbase reports.
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Working with Informix MetaCube (MetaCube SQL Method)

In addition to Info OLAP and Hyperion Essbase, Seagate Crystal Reports 
has been designed to work with MetaCube 4.02 and can take full 
advantage of MetaCube's 3-tier system.

Creating a report with MetaCube is very similar to creating a report based 
on any relational database. MetaCube is referred to as ROLAP, which 
stands for Relational Online Analytical Processing. When creating a 
report you will see a list of Tables, Sample tables and Predefined Queries 
with dimensions, attributes and measures. After you log on to the server 
you can choose the appropriate dimensions, attributes and measures and 
place them in your report just like you would fields in a relational 
database report. When working with OLAP data it is often a good idea to 
create a Cross-Tab style report. In addition it is also a good idea to add a 
filter to your report to limit the number of records that are returned when 
you run the report. This filtering can be done using the Record Selection 
Formula Editor in Crystal Reports.

HANDS-ON (Reporting on OLAP data)

How to create an OLAP report using the Grid Object

NOTE: The following tutorial demonstrates basic techniques for creating 
a report based on an Info OLAP cube. 

The OLAP Expert in the Report Gallery of Seagate Crystal Reports 
provides a fast and easy method for designing reports based on OLAP 
data.

In order to design reports based on Info OLAP cubes, you must have a 
successfully scheduled instance of a cube. If you are not sure whether or 
not an OLAP cube has been successfully scheduled on your system, 
contact your Network Administrator. Once a successful instance of an 
Info OLAP cube exists, you can begin designing reports based on that 
cube:

1 Click the New button on the Standard toolbar.

The Report Gallery appears.
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The OLAP Report Expert appears with the Data Tab active. The Data 
Tab allows you to select an Info OLAP cube to design a report.

.

NOTE: It is possible to use OLAP data with other report types that appear 
in the Report Gallery. However, only OLAP dimensions and fields are 
available to other report formats. No OLAP data values or aggregate 
values can be accessed. Such reports are most often used by Info OLAP 
Administrators that need to design reports based on the structure of the 
OLAP cube rather than the data contained within the cube.

The Choose OLAP Type dialog box appears.

2 Click the OLAP button to create a 
report using the OLAP Report Expert.

3 Click 
Select.
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NOTE: The types of OLAP servers you can connect to may vary. Contact 
your Network Administrator to find out what types of servers you may 
connect to.

5 Click OK. The Browse For Database dialog box appears.

6 Click the Browse button and use the files and directories dialog box to 
locate an instance which appears as an *.HDC file in a location 
designated by your Network Administrator. 

7 Click OK. You are returned to the OLAP Report Expert. 

8 Click the Grid Dim Tab to activate it.

4 Select the Info OLAP Cube.
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NOTE: The Show Long Names check box is toggled on by default. This 
means that, for example, the month field will be displayed as January, 
February, etc., as opposed to M01, M02, etc. You can toggle between 
long and short names in your report by returning to the OLAP Report 
Expert and toggling the Show Long Names check box on and off on the 
Grid Dim Tab. Use the Grid Dim Tab to specify the dimensions that will 
appear in the rows and columns of your report. This tutorial will show 
you how to create a report that analyzes products by region.

9 Highlight the products dimension in the Dimensions list box and click 
Add Rows. The generations of the products dimension appear in the 
Rows list box.
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10 Highlight the region dimension in the Dimensions list box and click 
Add Columns. The generations of the region dimension now appear in 
the Columns list box. Optionally you can click on the dimension icon 
to bring up a field picker, from it you can specify which subset of 
fields to display on the grid row/column.

At this point, you have successfully performed all of the necessary 
steps for designing an OLAP report.

11 Click the Other Dim Tab.
Reporting on OLAP data 187



The Other Dimensions list box displays all of the dimensions you did not 
use in the Grid Dim Tab. The Other Dim Tab lets you specify how 
dimensions that do not appear in your grid will affect the data for the 
dimensions that do appear in the grid. For example, the measure 
dimension currently displays the Budget member. This means all values 
in your report will represent budgeted data. However, you may want the 
values in your report to represent actual data.

12 To change this so that the report uses Actual sales data, highlight the 
measure dimension in the Other Dimensions list box, and click the 
Select Fields button. The Select a Field for Dimension "measure" 
dialog box appears.

13 Highlight Actual, 
and click OK.
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14 To change the report so that it uses This Year data, instead of Next 
Year data, highlight the yearly dimension, and click the Select Fields 
button. The Select a Field for Dimension "yearly" dialog box appears.

16 Finally, to use Sales Revenue data in the report instead of Volume 
data, highlight the line_item dimension, and click the Select Fields 
button. The Select a Field for Dimension "line_item" dialog box 
appears.

17 Highlight Revenue and click OK. Your report will display Sales 
Revenue of products in the line_item dimension in the Other Dim 
Tab.

18 Click the Layout Tab of the OLAP Report Expert.

19 Use the Layout Tab to design the general look of the OLAP Grid 

15 Highlight This Year 
and click OK.
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object. You will use it now to highlight the generation 2 aggregates of 
the products and region dimensions.

20 Highlight products, Level 1 in the Rows list box (the bottom left list 
box).

21 Select Silver from the Background Color drop-down list for level 1 data 
of the products dimension. A silver rectangle appears around the 
highlighted item in the list box.

22 Highlight region, Level 1 in the Columns list box (the top right list box), 
and select Silver for the background color.

The Layout Tab should now look like this:

At this point, you have connected to an OLAP database, selected 
dimensions and fields from the database, and formatted the report. 
Now, it is time to preview the results of your work.

23 Click Preview Report.

This Grid object can be formatted or moved anywhere in the report, 
and more Grid objects or other subreport objects can be added to the 
primary report. As you can see, designing OLAP reports is 
exceptionally easy. After designing a few reports using your own 
OLAP data, you will quickly master this powerful report design 
technique.

How to create a MetaCube report

1 Start Seagate Crystal Reports, and click the NEW button on the 
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Standard toolbar.

2 Click Standard from the Report Expert Gallery dialog box.

3 Scroll down in the list box in the Data Tab and click on MetaCube.

4 In the RDBMS Login & Choose DSS System dialog box, click OK to 
log on to the Demo database for this example.

5 Choose Brand Channel Net Profit from the SQL Tables list box.

6 Click Add, then click Done.

7 Click the Fields Tab to choose dimensions and members.

8 In the Fields Tab, select the fields you want from the Database Fields 
list box and click Add. In this case, select Channel, Brand and Net 
Profit.

9 Click the Sort Tab. Select Brand Channel Net Profit.Channel from the 
Report Fields list box and click Add. To view the report, click Preview 
Report.

NOTE: You may have to adjust the column widths of the fields and field 
headers to see all the data. If you wish to hide the Channel Field column 
simply select the top element in the field, click the right mouse button 
and select DELETE from the shortcut menu.

How to apply a filter to a MetaCube report

Imagine you wish to only see the records where net profit was $50,000 or 
above. The following instructions explain how to apply a filter using the 
report created from the tutorial on creating a MetaCube report. For more 
information, see How to create a MetaCube report, Page 190.

1 Choose EDIT SELECTION FORMULA|RECORD command from the 
Report Menu.

2 In the Fields list box double click Brand Channel Net Profit.Net 
Profit. Type in >= 50000. Click ACCEPT.

3 Click USE SAVED DATA in the Change in Record Selection Formula 
Detected dialog box you will notice that records with net profit 
under 50000 have disappeared.

How to create a MetaCube cross-tab report

1 From the Report Gallery dialog box, choose the Cross-tab Expert. From 
the list box in the Data Tab, scroll down and click MetaCube.
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2 In the RDBMS Login & Choose DSS System dialog box click OK to 
login to the Demo database for this example.

NOTE: If you have already been working with MetaCube reports during 
this session, step 2 may not be necessary.

3 In the choose SQL table dialog box choose Audio Sales YTD by 
Channel and Click ADD. Do the same for Brand Channel Net Profit. 
Click DONE. Click the Cross-Tab Tab.

4 In the Report Fields list box, drag and drop Channel under Audio Sales 
YTD by Channel to the Rows list box, Brand under Brand Channel Net 
Profit to the Columns list box, and Net Profit under Brand Channel Net 
Profit to the Summarize Fields list box. Click Preview Report and you 
will see a cross-tab report based on the fields you selected. Save the 
report.

How to add a field to a MetaCube cross-tab report

This tutorial is based on the report created in the tutorial for creating 
MetaCube cross-tab reports.

1 Select the entire cross-tab object by clicking in the top, left-hand 
corner of the object above the top row header, to the left of the far left 
column header.

2 Choose FORMAT CROSS-TAB from the Format menu.

3 In the Cross-Tab dialog box select Fiscal Year under Audio Sales 
YTD by Channel and drag and drop it to the Columns list box.

4 Click OK. Notice Fiscal Years is now added to the Cross-Tab report.

5 Save the report.

How to pivot fields in a MetaCube Cross-Tab report

This tutorial is based on the report created in the tutorial on how to add 
a field to a MetaCube cross-tab report. Because of the numerous brands, 
the report is difficult to work with as far as viewing data or printing. To 
make it more user friendly, it would be beneficial to switch the fields so 
that the columns became rows and rows became columns.

1 Click on the top column header "Alden" and drag it so that it is 
positioned over the row header "Department Stores" and drop it.

2 Now take the row header and drag it so it is positioned over the 
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column header "Year 1996" and drop it.

3 Finally, take the "Year 1996" column header, position it over the 
Alden row header and drop it.

How to add a formula to a MetaCube report

This tutorial is based on the report created in the tutorial on how to pivot 
fields in a MetaCube report.

1 Select the entire cross-tab object by clicking in the top left hand 
corner of the object above the top row header and to the left of the 
leftmost column header. Choose FORMAT CROSS-TAB from the 
Format menu.

2 Click New Formula. In the Formula Name dialog box, type in Net 
Profit Per Unit. Click OK.

3 In the Formula Editor dialog box, double-click Brand Channel Net 
Profit.Net Profit in the Fields list box, type "/" and double-click Audio 
Sales YTD by Channel.Units Sold in the Fields list box. Click Accept.

4 Now select Brand Channel Net Profit.Net Profit in the Summarized 
Fields list box and Click Remove. Drag and drop the formula @Net 
Profit Per Unit to the Summarized Fields list box. Click OK. You will 
notice the data has changed to reflect the formula.
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9 Multiple Section Reports

What you will find in this chapter...

Using multiple sections in reports, Page 196

HANDS-ON (Multiple Section Reports), Page 197
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Using multiple sections in reports

Seagate Crystal Reports provides five design areas to use when building 
your report: 

1. Report Header,

2. Report Footer,

3. Details,

4. Page Header, and

5. Page Footer.

Each area contains a single section when you first create a new report. 
Certain reporting tasks are performed most efficiently by creating 
multiple sections within an area, such as:

●   keeping variable length objects from overwriting each other (see 
How to prevent variable length objects from overwriting each other, Page 
197),

●   putting conditional messages in form letters (see How to print 
conditional messages in form letters, Page 205),

●   eliminating blank lines when fields are empty (see How to eliminate 
blank lines, Page 207), or

●   adding blank lines under specific conditions (see How to add blank 
lines conditionally, Page 208).

Once you understand the power of multiple sections, you will discover 
even more ways to produce the effects you want. 

Related Topics

How to add, delete, move, and merge sections, Page 79
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HANDS-ON (Multiple Section Reports)

How to prevent variable length objects from overwriting each other

When subreports or other variable length objects are placed above other 
objects in one section of the report while the Can Grow option for the 
variable length object is toggled on in the Format Editor, that object may 
overprint objects positioned directly below it unless you have:

●   expanded the section to fit the maximum size of the object, and

●   spaced the objects, allowing enough space for the first object to 
complete printing before the second one begins. See Types of 
formatting properties, Page 211.

You can eliminate this overprinting problem by creating multiple 
sections in an area and placing objects below the variable length object in 
their own section(s).

Now, when the report runs, the section with the variable length object 
will finish printing before the section below it prints and you will get the 
results you want. See FOR TWO UNRELATED REPORTS, Page 425.

NOTE: Memo and BLOB fields, as well as subreports, can cause 
overprinting.

How to work with text objects

You will use many of the capabilities of text objects when creating form 
letters. A brief discussion of text objects should make it easier for you to 
create the form letter in the next section.
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●   A text object can contain both text and fields; you will use both in 
this example.

●   You can resize text objects; you will be resizing the text object so 
that it prints as a letter.

Text objects operate in two modes:

1. the move/resize mode, and

2. the edit mode.

Move/Resize 
mode

When the object is in the move/resize mode, it appears as a broken line 
frame with resizing handles.

In this mode, you can resize the object by dragging any of the resizing 
handles, or you can move it by placing the cursor inside the object and 
dragging it to a new location. You can also insert fields in this mode, but 
you can not insert text. You put a text object into the move/resize mode 
in one of two ways:

1. by clicking the text object when it is inactive, or

2. by clicking the frame when the object is in edit mode.

Edit mode When the object is in the edit mode, it appears as a broken line frame 
without sizing handles, and an in-place ruler appears at the top of the tab. 

When you first place a text object, the program sets it in the edit mode. 
You can also put a text object into the edit mode by double-clicking it if 
it’s inactive or in the move/resize mode.

Each text object contains word processor capabilities, including the 
ability to change the fonts for individual characters and fields, and 
automatic word wrap. In the edit mode you can insert text and such non-
text objects as database fields and formulas. Whenever the object is in edit 
mode, it contains an insertion point, a flashing vertical line that indicates 
the position at which typed text or inserted fields will begin.

The insertion point moves as you type, automatically staying to the right 
of the last character. It also moves when you insert a field, automatically 
staying to the right of the field. It moves one character position at a time 
when you press the space bar. It moves down one line, to the inside left 
edge of the text object, when you press Enter. It moves to your cursor 
position when you click anywhere within the existing text.
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As you work through the tutorials for multiple sections, it is always 
expected that you will type or place fields at the existing insertion point, 
unless otherwise indicated.

●   To select text within a text object (to delete it, to change a font, etc.), 
position the cursor over the text and, when the I-beam cursor 
appears, drag the cursor to highlight the text you want to select. 
See Cursors, Page 54.

●   To select a field which is inside a text object, position the cursor 
over the field and, when the I-beam cursor appears, right-click.

●   To insert text, type in the desired text and it will appear at the 
insertion point.

NOTE: It is critical that you see the drag and drop cursor before placing 
the field. If it does not appear, you might place the field so that it overlays 
the text object instead of being inserted into it. It may appear to be inside 
the text object, but if you move the object the field will not move with it.

●   The insertion point is tied into the drag and drop cursor. If you 
have existing text or fields in the text object, the insertion point 
moves as you move the drag and drop cursor, enabling you to pick 
the exact position where you want to place the field. The program 
always places the field at the insertion point.

Related Topics

How to insert text objects, Page 108

As you move the drop cursor... the insertion point moves.
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How to create a form letter using a text object

While form letters themselves are not necessarily multi-section reports, 
they are often used in multi-section reports to generate custom mailings. 
The topic How to print conditional messages in form letters, Page 205, explains 
how to use multiple form letters or multiple versions of the same form 
letter for custom mailings. The following section shows you how to create 
a form letter.

You are going to use a text object to create a form letter. The form letter 
you create will be tied to a database table so that each letter will be 
customized with company information from a different record.

If you have difficulty performing any of the steps in this tutorial, please 
see How to work with text objects, Page 197.

Creating the 
form letter

The letter will consist of a date, an inside address, a salutation, a one 
paragraph letter body, and a closing section.

1 Create a report using the Customer Table of xtreme.mdb. The Design 
Tab appears with the Database Tab active in the Insert Fields dialog 
box.

2 Since you do not want field titles to appear above the fields that you 
insert into the letter, toggle the Insert Detail Field Titles option off on 
the Layout Tab of the Options dialog box.

3 Insert a text object into the Details section of the report.

4 Click the text object frame to put the object in move/resize mode.

5 Drag the resizing handle on the right side of the object to the right 
edge of the Design Tab. This will make the object about eight inches 
wide, the approximate width of a page. You may have to stop 
resizing, scroll the window, and resize some more to accomplish this.
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6 Double-click inside the text object to place it in edit mode. It is now 
ready for you to begin your work. The insertion point appears at the 
extreme left, inside the object.

DATE

1 To insert a date into the letter, select the PrintDate field on the Others 
Tab of the Insert Fields dialog box, drag the placement frame into the 
text object, and place it at the insertion point.

NOTE: To change the way the date is formatted in the letter, first click 
the border of the text object to put it in move/resize mode, right-click the 
PrintDate field, choose FORMAT [PRINTDATE] from the shortcut menu 
that appears, and make your modifications on the Date Tab of the Format 
Editor when it appears.

2 Press Enter twice to insert some white space between the date and 
the inside address and to move the insertion point down within the 
text object.
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INSIDE ADDRESS

To create the inside address, drag database fields into the text object from 
the Customer table on the Database Tab of the Insert Fields dialog box.

1 Drag in the Address 1 field and place it at the insertion point, and 
press ENTER. The insertion point moves down to the line below.

2 Drag in the City field and place it at the insertion point.

3 Type a comma, followed by a space.

4 Drag in the Region field and place it at the insertion point.

5 Type in two spaces.

6 Finally, drag in the Postal Code field, place it at the insertion point, 
and press ENTER. The insertion point moves down to the line below.

7 Press Enter one more time to move the insertion point down one 
more line to the position where the salutation should start. This 
completes the inside address.

NOTE: When a field is placed within a text object, it is automatically 
trimmed on both the left and right sides, so that it contains no extra white 
space.

SALUTATION

1 Press ENTER four times to move the insertion point down.

2 Type in the word “Dear” and a space (do not include the quotation 
marks).
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3 From the Insert Fields dialog box, highlight the Contact Title field 
from the Customer table and drag it into the text object, placing it 
immediately after the space.

4 Type a space. The program positions the insertion point immediately 
after the space.

5 Again from the Insert Fields dialog box, drag the Contact Last Name 
field into the text object and place it at the insertion point. The 
insertion point moves to the right of the field.

6 Type a colon “:” at the insertion point (without the quotation marks) 
and press ENTER to move the insertion point to the next line.

LETTER BODY

1 Now type “Your company” (do not include the quotation marks) and 
type a comma followed by a space.

2 Drag the Customer Name field into the text object and place it at the 
insertion point, just after the space.

3 Type a comma, followed by a space.

4 Type the following text (do not include the quotation marks): 
“helped make 1996 an outstanding year for Xtreme Mountain Bikes, 
Inc. I want to thank you and your staff for your support. I hope 1997 
will be a banner year for you.”

5 Press ENTER twice.

6 Type “Sincerely yours” (without the quotation marks), followed by a 
comma, and then press ENTER four times.

7 Finally, to complete the form letter, type your name.
Multiple Section Reports 203



The Design Tab should look similar to this:

8 Click the PRINT PREVIEW button on the standard toolbar to preview 
the form letter. 

It should look similar to this: 

How to format objects conditionally

You may want to create a report that uses different formats depending on 
the field value. For example, you may want to create an international 
report that prints currency values for each country in the format that is 
common in that country. You can do that using multiple sections.
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1 Create a report. See Tutorial - Customer List, Page 147, and Introduction 
to Reporting, Page 85.

2 Create one Details section for each country that requires a unique 
format. See How to add, delete, and move guidelines, Page 72.

3 Make certain that each of the Details sections contains the same data; 
every field that you place in the Details A section, you must also 
place in the Details B section, and in the Details C section, etc.

4 In the Details A section, select the currency field and then click the 
OBJECT PROPERTIES button on the supplementary toolbar. The Format 
Editor appears.

5 Set the currency values you want to use for the first country. See 
Formatting, Page 209.

6 Click OK to return to the report.

7 Click the SECTION EXPERT button on the standard toolbar. The Section 
Expert appears.

8 Select the Details A section in the Sections list box. Toggle the 
Suppress (No Drill-Down) check box on.

9 Click the Conditional Formula button to the right of the Suppress check 
box and use the Format Formula Editor to create a formula that 
specifies the conditions under which the section should be 
suppressed.

For example, if the Details A section contains currency values for the 
UK, you would create a formula that specifies that the country value 
is not equal to UK. In other words, you create a formula that 
suppresses the section when the country value is not UK. This will 
make the section print only when the record contained a UK value.

10 Repeat Steps 4 through 9 for each additional section.

Now, when the report is printed, the date and currency data for each 
country appears in the format that is expected for that country. See 
Conditional formatting, Page 212.

How to print conditional messages in form letters

It is likely that you will want to print conditional messages in form letters. 
For example, you may want to encourage customers with available credit 
to buy more and those who are over their credit limit to bring their 
accounts down below the limit once again. You can create both of these 
letters within a single report.
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1 Use the Section Expert to insert a second Details section in the report. 
See How to add, delete, move, and merge sections, Page 79.

2 Create two form letters. Place a letter that encourages customers to 
buy more in the Details A section of the report; place a letter that 
encourages customers to bring their balance down in the Details B 
section of the report. See How to create a form letter using a text object, 
Page 200.

3 Use the Section Expert to format the Details sections so that each is 
suppressed under certain conditions. For example:

Now, when a record indicates available credit, the buy more letter will 
print. When the account is over limit the over limit letter will print. And 
when the customer is right at the credit limit, nothing will print at all.

Related Topics

How to format objects conditionally, Page 204

Conditional formatting, Page 212

How to alternate background colors for rows

Another typical use of multiple sections is to vary the background color 
in alternating lines for the Details section of your report in order to 
improve readability (a greenbar-paper effect). 

1 Use the Section Expert to insert a second Details section. You should 
now have Details A and Details B sections. See How to add, delete, 
move, and merge sections, Page 79.

2 While in the Section Expert, highlight Details A in the Sections list 
box, click the Color Tab, and set the background color to White. See 
Formatting, Page 209.

Format this section to be 
suppressed when the balance is 
less than the credit limit.

Format this section to be 
suppressed when the balance is 
more than the credit limit.
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3 Click the Common Tab, click the Conditional Formula button to the 
right of the Suppress (No Drill Down) option, and type the following 
formula in the Format Formula Editor when it appears:

Remainder (RecordNumber,2)<>0

«This formula divides the record number by 2 and if the remainder is 
something other than zero (which will happen for every odd 
numbered record), it tells the program to suppress the section.»

Search for Formula Compiler Errors in Seagate Crystal Reports online 
Help.

4 Now select Details B and set the background color to Green.

5 Use the technique from Step 3 to set the Suppress option conditionally 
for this section using the following formula:

Remainder(RecordNumber,2) = 0

«This formula divides the record number by 2 and if the remainder is 
equal to zero, it tells the program to suppress the section.»

6 Create the report and make certain that the information and layout of 
each of the Details sections is identical. In other words, whatever 
objects you put in Details A should be put into Details B as well.

Now when you run the report, the program will print every even 
numbered line with a white background and every odd numbered line 
with a green background.

How to eliminate blank lines

It is very common to have two address lines in a customer table, one 
(Address 1) for street address and one (Address 2) that can be used for a 
suite number or mail stop. Address 1 usually contains a value but 
Address 2 is often blank. If you create a customer list using this data and 
stack the fields on top of one another in mailing label format, those 
customer records with an empty Address 2 field will print with a blank 
line. You can eliminate this blank line using multiple sections.

1 Use the Section Expert to create two new Details sections so that you 
have a total of three. See How to add, delete, move, and merge sections, 
Page 79.

2 Place the Address 2 field in the middle section and the other data in 
the sections above and below it as you want it to appear in the report.

3 Format the middle section to Suppress Blank Section. See How to hide 
parts of a report, Page 114.
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Now, when the report prints, if the Address 2 section is blank, the 
program will not print it and you will not get unwanted blank lines in the 
report.

How to add blank lines conditionally 

Use multiple sections to print a blank line on your report under specific 
conditions. For example, you may want to insert a blank line after every 
fifth record in the report.

1 Create two Details sections. See How to add, delete, move, and merge 
sections, Page 79.

2 Put the report detail data in the top section.

3 Leave the second section empty.

4 Format the second section to be suppressed unless the following 
condition is met:

Remainder (RecordNumber,5) <> 0

«This formula divides each record number by 5. If the division 
produces a remainder, it suppresses the blank section. But if the 
division produces no remainder, a zero (which it will for every fifth 
record printed), the program prints the second section, thus inserting 
a blank line.»

NOTE: To insert a blank line under different conditions, you can modify 
your formula appropriately. See Conditional formatting, Page 212.

Before suppressing blank 
lines, the Address2 field prints 
a blank line if it is empty.

After suppressing blank lines, 
the Address2 field does not 
print if it is empty.
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10 Formatting

What you will find in this chapter...

Formatting concepts, Page 210

Absolute formatting, Page 211

Types of formatting properties, Page 211

Conditional formatting, Page 212

HANDS-ON (Absolute Formatting), Page 215

HANDS-ON (Conditional Formatting), Page 221
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Formatting concepts

In this section, you will learn about formatting a report. Formatting refers 
to those things that are done to change the layout and design of a report, 
as well as the appearance of text, objects, or entire report sections. 

You can use formatting to do many things, including:

●   divide sections of a report,

●   call attention to certain data,

●   change the presentation of dates, numbers, Boolean values, 
currency values, and text (strings),

●   hide unwanted sections, or

●   give the report a professional appearance.

Seagate Crystal Reports offers a wide range of formatting commands and 
properties which can be applied to various elements of a report.

●   Use formatting commands by choosing or setting options in dialog 
boxes that are specific to the kind of formatting you are doing. For 
example, to change page margins, use a dialog box that allows you 
to specify the top, bottom, right, and left margins.

●   Set formatting properties in either the Format Editor (for objects) 
or the Section Expert (for sections) by toggling check boxes on and 
off or by supplying attribute values. In most cases, you can set one 
of two types of properties:

   Absolute (always apply the property), or

   Conditional (apply the property only if certain criteria are 
met).

You can use both kinds of formatting properties wherever you need them 
in the report. See Absolute formatting, Page 211, and Conditional formatting, 
Page 212.

In the topics that follow, you will learn about the kinds of formatting you 
can do with Seagate Crystal Reports, and you will get step-by-step 
instructions for performing a variety of formatting tasks.

NOTE: There are many date formats you can choose to use in your 
English report, but if you send the report to a Japanese system, there may 
be some formatting irregularities. Not all English date formats are 
viewable on a Japanese system, and the same is true going from Japanese 
to English. For more information, see Japanese Dates in Seagate Crystal 
Reports online Help.
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Absolute formatting

Absolute formatting is formatting that applies under any condition. 

SELECT, THEN APPLY

Absolute formatting always follows a select, then apply procedure:

●   you select what it is that you want to format (an object or a section), 
and then

●   you apply the formatting to the selection using property settings.

Use the following dialog boxes for formatting reports:

●   Format Editor for formatting field values.

   Borders Tab for formatting objects, numbers, and text,

   Box Tab for formatting boxes, and

   Line Tab for formatting lines.

●   Section Expert for formatting entire sections.

●   Highlighting Expert for formatting currency and number fields.

Each of these dialog boxes contains a number of different formatting 
properties as well as the tools for turning the properties on or off, or for 
specifying attributes. Search for the dialog box by name in Seagate 
Crystal Reports online Help.

Types of formatting properties

Formatting properties fall into two general categories: 

1. On or Off Properties, and

2. Attribute Properties.

ON OR OFF PROPERTIES

An on or off property is a property that is set using a check box.

●   When this check box is toggled on, the property is always applied.

●   When this check box is toggled off, the property is never applied.

The Suppress property is one such on or off property; an object or section 
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is either suppressed (on) or it is not (off).

ATTRIBUTE PROPERTIES

An attribute property is a property that specifies one of many possible 
attributes. The Color property, for example, gives you the opportunity to 
specify one of the 16 basic Windows colors or a custom color and then to 
create that color using the tools provided. Clearly such a property cannot 
be handled with a simple on or off switch. 

You set an attribute property in one of several ways, depending on the 
property. You can set it:

●   by clicking an option button,

●   by selecting an attribute from a drop-down list,

●   or, by typing an attribute in a text box.

Conditional formatting

Conditional formatting is formatting that applies only under certain 
conditions. For example, in a report you may only want:

●   customer balances printed in red if they are past due,
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●   the dates to appear in Day, Month, Year format if the customer is 
Canadian, or

●   background color to appear on every other line.

Seagate Crystal Reports makes it easy to apply formatting conditionally 
in these and hundreds of other situations. See How to format objects 
conditionally, Page 204.

With absolute formatting you follow the select, then apply procedure. For 
conditional formatting you follow the same general procedure, but you 
go a step further and set up conditions that determine whether or not the 
formatting will be applied. You specify these conditions using simple 
formulas. See Introduction to Formulas, Page 291.

NOTE: When you set up a conditional formatting formula, the formula 
overrides any fixed settings you have made in the Format Editor. For 
example, if you toggle the Suppress option on and then set up a 
conditional formula for the Suppress option, the property will still apply 
only if the condition in the formula is met.

The program enables you to set both on and off properties and set 
attribute properties conditionally. However, each of these requires a 
different kind of formula.

Conditional on 
or off properties

A conditional on or off property tests to see if a condition has been met. It 
is on if the condition is met, off if the condition is not met. There is no 
middle ground. Use Boolean formulas for this kind of formatting.

Value = condition

The program tests each value to see if it meets the condition and it returns 
a yes or no answer. It then applies the property to every value that returns 
a yes answer. 

Conditional 
attribute 
properties

A conditional attribute property tests to see which of two or more 
conditions is met. The program then applies the formatting appropriate 
to the condition. For example, assume that you want values under quota 
printed in red and all other values printed in black. The program tests to 
see whether the value is under quota or not. If it is under quota, then it 
applies the red attribute; if it is not, then it applies the black attribute. 

Use an If-Then-Else formula for this kind of conditional formatting. See 
How to create If-Then-Else formulas, Page 316.

If Condition A Then 
Red

Else
Black
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NOTE: When conditional attribute properties are set up, the program 
loads a selection of attributes into the Functions list in the Formula 
Editor. Double-click any of these attributes to add them to your formula. 
For example, if you are setting horizontal alignment conditionally, the 
Functions list box will contain attributes such as DefaultHorAligned, 
LeftAligned, Justified, etc. If you are setting borders conditionally, the 
Functions list box will contain attributes such as NoLine, SingleLine, 
DashedLine, etc.

You can take this kind of property one step further. You can specify a list 
of conditions and a property for each; you are not limited to two 
conditions. For example, if you have a number field on your report that 
contains sales figures from countries around the world, you can specify 
the number attribute(s) that you want to apply to each country. In this 
case, your conditions would specify that if it is from Country A, the 
program should apply the Country A attribute; if it is from Country B, the 
Country B attribute; if it is from Country C, the Country C attribute, and 
so on.

With more than two alternatives, use this kind of formula:

If Condition A Then
Red

Else If Condition B Then
Black

Else If Condition C Then
Green

Else
Blue

Use a multi-condition If-Then-Else formula for this kind of conditional 
formatting. See How to create multi-condition If-Then-Else formulas, Page 317.

Values that do 
not fit any 
condition

With conditional on or off properties, values will either meet the 
condition you set or they will not. But conditional attribute properties 
are different. There may be some cases in which values do not fit any of 
the conditions set up.

For example, if you set:

●   all sales figures that are more than 10% over quota to appear 
green, and 

●   all sales figures that are less than 10% over quota to appear red,

what is going to happen to values that are exactly 10%? The program 
takes care of that automatically. When a value does not fit any of the 
conditions in the formula (in this example, all values that are 10%), the 
program formats that value using the attribute setting in the dialog box. 
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In this example, if the Color drop-down list on the Font Tab of the Format 
Editor is set to Blue for the sales field, all values that are exactly 10% will 
appear in blue. The dialog box setting does not override the formula 
setting; it simply provides an attribute when the formula does not.

Several Hands-On topics are included showing how to format sections 
and objects conditionally. These topics both detail specific reporting 
needs and illustrate basic procedures.

HANDS-ON (Absolute Formatting)

How to add color, shading, and borders

Seagate Crystal Reports allows you to add color, borders, and shading to 
fields on your report in order to emphasize important data and create 
professional looking reports.

1 Right-click the field you want to format and choose CHANGE BORDER 
from the shortcut menu.

The Format Editor appears with the Border Tab active.

2 Select the border type (line style), color, placement, and background 
color you want and click OK when finished. 

The program formats the selected field to your specifications.
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How to add/edit lines and boxes

Seagate Crystal Reports allows you to add lines and boxes to a report to 
emphasize important data and create professional-looking reports.

Adding lines 1 Click the INSERT LINE button on the supplementary toolbar. A pencil-
shaped cursor appears.

Editing lines 1 Right-click the line you want to format and choose FORMAT LINE 
from the shortcut menu. The Format Editor appears with the Format 
Line Tab active.

The program formats the selected line to your specifications.

Adding boxes 1 Click the INSERT BOX button on the supplementary toolbar. A pencil-
shaped cursor appears.

2 Use the Pencil 
cursor to draw 
the line where 
desired.

2 Make the desired 
changes and click OK 
when finished to 
return to your report.
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Editing boxes 1 Right-click the box you want to format and choose FORMAT BOX from 
the shortcut menu. The Format Editor appears with the Format Box 
Tab active.

The program formats the selected box to your specifications.

How to change margins

1 Choose the PAGE SETUP command from the File Menu. The Page 
Setup dialog box appears.

2 Use the pencil 
cursor to draw 
the box where 
desired.

2 Select the color, 
width, style, and/
or fill color you 
want and click OK 
when finished. 
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All margins are calculated from the paper edge. Thus, a left margin of.25 
inches causes the printing to start exactly one quarter inch in from the 
edge of the paper.

How to add/delete white space between rows 

The height of a section in relation to the objects within it affects the 
amount of white space that appears between rows on the report.

The free form Design Tab allows you to add and delete white space in two 
ways: 

1. by using the Resizing cursor to resize the area in the Design Tab, or

2. by changing the options in the Section Expert.

NOTE: You can also right-click the shaded area to the left of the section 
and choose FIT SECTION from the shortcut menu. The program 
automatically resizes the section so that the bottom boundary is even 
with the baseline of the bottom object in the section. See How to eliminate 
blank lines, Page 207.

Deleting white 
space by resizing

To delete unnecessary white space within a section, simply move the 
mouse pointer over the lower section boundary line. The pointer will 
change to a Resizing cursor.

2 Change the default 
page margins to fit 
your needs and click 
OK when finished.
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Deleting white 
space using the 
Section Expert 

If an entire section is blank (for instance, if you are not putting anything 
into the Page Footer section of the report), you can eliminate the 
unnecessary white space by suppressing the section in the Section Expert.

1 Click the SECTION EXPERT button on the standard toolbar. The Section 
Expert appears.

2 Highlight the Page Footer section in the Sections list box.

3 Toggle the Suppress (No Drill-Down) check box on.

4 Click OK to return to the report.

The Page Footer section will no longer print.

Adding white 
space by resizing

To add extra white space between rows in the report, simply move the 
mouse pointer over the lower section boundary line. The pointer will 
change to a Resizing cursor.

When the Resizing cursor appears 
drag the section boundary upward 
to remove extra white space.

Your report will print like this...
Formatting 219



NOTE: White space can also be added to a section by right-clicking the 
shaded area to the left of the section and choosing INSERT LINE from the 
shortcut menu. The program resizes the section automatically, adding the 
amount of space necessary to hold a line of typical database fields.

Related Topics

How to add, delete, and move guidelines, Page 72

How to add blank lines conditionally, Page 208

How to set page orientation and paper size

You can print your reports using either portrait or landscape orientation, 
and in a variety of paper sizes. You can specify these options using the 
PRINTER SETUP command on the File Menu.

1 Choose the PRINTER SETUP command from the File Menu. The Print 
Setup dialog box appears.

When the Resizing cursor appears, 
drag the section boundary downward 
to add extra white space.

Your report will print like this... 
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2 Activate the printer you want to use if it is not already the active 
printer. The options for paper size are directly related to the selected 
printer. 

For example, the HP LaserJet driver (PCL) offers a choice of letter, 
legal, executive or A4 paper sizes, whereas the PostScript printer 
driver lets you choose from letter, legal, note, A4, B5, letter small, and 
A4 small paper sizes.

3 Select either Portrait or Landscape orientation by clicking the 
appropriate option button in the Orientation section.

4 Select the desired paper Size and Source from the drop-down lists in 
the Paper section.

5 Click OK when finished.

NOTE: The Remove and Remove All buttons can also be used to delete 
formulas.

HANDS-ON (Conditional Formatting)

How to create a footer that appears on all pages but the first 

You may choose to print a page footer on all pages except the first page. 
You can do this by formatting the Page Footer section conditionally, 
using an on or off property.
Formatting 221



1 Place the field you want displayed as a page footer in the Page Footer 
section of the report.

2 Click the SECTION EXPERT button on the standard toolbar. The Section 
Expert appears.

5 Enter the following formula in the Format Formula Editor:

PageNumber = 1

This formula suppresses the page footer on the first page but not on 
any of the other pages.

6 Click the Save formula and Close button.

●   If there is an error in the formula, a message box appears, asking 
whether to exit without examining the error. If you click No, a 
second message box will be displayed, detailing the error. 

●   If there is no error in the formula, you are returned to the Section 
Expert. Note that the Formula button has changed. This indicates 
that a formula has been entered for that property.

Search for Formula Compiler Errors in Seagate Crystal Reports online 
Help.

7 Click the PREVIEW button on the standard toolbar to preview the 
report and ensure that the page footer appears on all pages but the 
first.

4 Click the Conditional Formula button
to the right of the Suppress property to

open the Formula Editor.
3 Highlight the Page Footer 
section from this list.
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NOTE: If you have a multi-line page footer and you have inserted the 
lines into separate Page Footer sections, you will need to suppress each of 
those sections conditionally, using the formula above.

NOTE: To create a page header that appears on all pages but the first, put 
the header information in the Page Header section and then suppress that 
section conditionally, using the same formula that was used for 
suppressing the Page Footer section.

How to conditionally format fields using the Highlighting Expert

NOTE: You can only highlight currency and number fields.

1 Right-click the currency or number field you want formatted and 
choose HIGHLIGHTING EXPERT from the shortcut menu, or select the 
frame you wish to highlight and click the HIGHLIGHTING button on 
the Formatting toolbar.The Highlighting Expert appears.

4 To specify formatting changes, set the Font color, Background, and 
Border using the appropriate drop-down lists in the Item editor 
section of the dialog box.

5 Apply new formulas as needed. Use the Priority arrow buttons to 
specify the priority for each formula.

6 Click OK to return to the report.

2 Select a comparison from
this drop-down list.

3 Enter a numeric value
in the adjacent text box.
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How to Use the Highlighting Expert

Seagate Crystal Reports includes a powerful Highlighting Expert that 
allows you to efficiently apply conditional formatting to currency and 
number fields. The Highlighting Expert is most commonly used for 
highlighting field values that are in some way distinguished from the 
other values in the report. For example, if you wanted to highlight the 
{customer.LAST YEAR’S SALES} field in red whenever the sales are 
greater than $25,000, you could specify in the Highlighting Expert that, if 
the value is greater than $25,000, a red background color is applied to the 
field. You can also use the dialog box to set conditional font color and 
border style.

NOTE: Think of the Highlighting Expert as an alternative to the formula 
editor. The Highlighting Expert essentially runs the following equation: If 
Condition is True, Then Apply These Formatting Specifications. For this 
purpose, the dialog box is divided into two sections, the Item list section 
(which displays the formula), and the Item editor (which allows you to set 
the formula). The Item editor includes a Sample view to demonstrate the 
formatting specifications applied.

Here are some additional benefits to note:

●   The Highlighting Expert can also be used for numeric/currency 
fields in Cross-tabs, as well.

●   You can undo highlighting.

Setting 
highlighting 
priorities

The Priority buttons in the Item list section of the Highlighting Expert 
allow you to set the priorities for your formulas. This is useful when you 
have two or more formulas that could offer conflicting results in some 
situations.

For example, suppose you are highlighting the Unit Price field on the 
report. You assign to this field a highlighting formula that shows a yellow 
background when a unit price is greater than $100. Imagine then, that on 
this same report, you create another highlighting formula that shows a 
red background when a unit price is greater than $200. Considering that 
100 is a subset of 200, you could have Unit Price fields with yellow 
backgrounds when, in fact, those fields should have red backgrounds. In 
other words, a unit price of $300 could receive either a red or a yellow 
background depending on which formula has been assigned priority.

To set the priority for a formula:

1 Select the formula.
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2 Use the Up and Down Priority buttons to move the selected formula 
to a position above or below the conflicting formula(s).

NOTE: A formula has priority over another formula when it is higher in 
the Items list section. 

3 Click OK.

4 Refresh the report (or click the Preview tab) to see the highlighting 
changes.

NOTE: The Remove and Remove All buttons can also be used to delete 
formulas.
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11 Record and Group Selection

What you will find in this chapter...

Record selection, Page 228

Group selection, Page 231

Record selection formula templates, Page 233

HANDS-ON (Record and Group Selection), Page 238
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Record selection

Specifying 
records/groups 
to be included

When a field is selected to appear on a report, field values from every 
record in the active table(s) are printed by default. In many cases, you 
may not want to include all the values, but only a subset of those values. 
For example, you may want to include:

●   records only for a specific group of customers,

●   records for a specific range of account numbers out of the total 
number of records in the database, or

●   values from only those records that fall within a particular date 
range.

You can select records in one of two ways:

1. by using the Select Expert, or

2. by using the Formula Language.

Setting up record 
selection

USING THE SELECT EXPERT

Seagate Crystal Reports includes a very sophisticated formula language 
which you can use to specify virtually any type of record selection. 
However, you may not always need the flexibility in record selection that 
the formula language provides. The Select Expert is designed for such 
instances.

NOTE: The Select Expert can be used to set up both record selection and 
group selection requests. When a group name or summary field is 
selected, the program knows that the selection criteria set up is intended 
for group selection. In all other cases, the program knows that you are 
setting up record selection.

The Select Expert makes it easy to specify the records you want included 
in your report. You simply highlight the field on which you intend to base 
your selection and then set the selection criteria. If you want to set 
additional criteria for the selected field or if you want to base record 
selection on additional fields, then the Select Expert provides the tools 
you need. See How to set up record selection using the Select Expert, Page 238, 
and search for Select Expert in Seagate Crystal Reports online Help.

The Expert can be used to set up simple record selection requests. For 
example:

●   customers from Arizona,

●   orders in the first quarter, or

●   sales over $10,000.
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The Expert can also be used to set up some very sophisticated requests:

●   customers whose names start with “A”, “M”, or “S”, or

●   customers from California or Florida who ordered in July.

These are all range limit requests. One or more constants define the range. 
The program compares the field value in each record to the constant(s) 
and rejects records with values outside the range. The report is thus 
limited to values within the range. The Select Expert handles requests like 
this with ease.

NOTE: When creating a range limit request based on part of a field value, 
you are limited as to what you can do in the Select Expert.

You can set up all of these types of record selection requests without any 
previous knowledge of the formula language.

NOTE: You can use the formula language from within the Select Expert if 
you wish, but that masks its main purpose. The Select Expert’s purpose is 
to create powerful record selection requests using simple point-and-click 
processes.

USING THE FORMULA LANGUAGE

If you are planning to create a selection formula using the formula 
language, you can go directly to the appropriate Selection Formula Editor 
by using the EDIT SELECTION FORMULA command on the Report Menu, 
then choose either RECORD or GROUP from the submenu.

From the Selection Formula Editor, you can build your selection request 
using fields, functions, operators, and other formulas. The only 
restriction is that the resulting formula must be Boolean; that is, it must 
return either a True or False value. 

Related Topics

For complete instructions on creating formulas, see Introduction to 
Formulas, Page 291. 

For sample record and group selection templates, see Record selection 
formula templates, Page 233, and How to use record/group selection templates, 
Page 241. 

Search for Record/Group Selection Templates in Seagate Crystal Reports 
online Help.

DETERMINING WHAT FIELD(S) TO USE

When you select records, you are basing your report only on those 
records that meet some conditions that you have set. You base those 
conditions on what kind of information you want in the finished report.
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Assume, for example, that you want a report that only shows California 
data. The challenge is to find the best way to identify those records that 
come from California.

●   If the table used in a report has a State field or a Region field, you 
can specify in your request that the program use only those 
records in which the value in the state field is equal to California 
(Region is equal to CA). This is clearly the easiest way.

●   If the table does not have a State field and you still want to report 
only on California data, there may be another way to identify that 
data.

   If the table has a Postal Code field, you could base your record 
selection on the range of ZIP codes that apply to California 
(Postal Code is between n and N).

   If the table has an Area Code field, you could base your record 
selection on California Area Codes (Area Code is one of x, 
y,....z). 

NOTE: If the Area Code is stored in the telephone number field, you will 
not be able to do this same record selection using the Select Expert based 
on the Area Code. You will have to create a record selection formula 
using the formula language to extract the Area Code part of the phone 
number and then do record selection based on that. Search for Subscript 
in Seagate Crystal Reports online Help.

Clearly you are not locked into any one method of record selection. 
However, you should still use caution when you set up your selection 
criteria. For a list of details to consider, see Selection performance tips, Page 
236.

NOTE: As a general rule, if you can base your record selection on a 
number of fields (as in this example), you should select an indexed field 
instead of a field that is not indexed. See Indexed tables, Page 511.

Interaction of 
the Select Expert 
and the Selection 
Formula Editor

The Select Expert and the Selection Formula Editor are interactive. That 
is, record selection criteria you enter via the Select Expert automatically 
generates a record selection formula which can be reviewed and modified 
using the Show Formula button in either the Select Expert or the Record 
Selection Formula Editor. Likewise, record selection formulas and 
modifications to existing record selection formulas automatically update 
the selection criteria in the Select Expert.

Because of this interactivity, you can use the two facilities together as a 
tutorial for learning the formula language.

1 Use the Select Expert to set up the selection criteria.
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2 Click the SHOW FORMULA button and the Select Expert expands so 
you can review the formula the program generated based on your 
criteria.

3 Click the HIDE FORMULA button when you are done with your 
review.

4 Change your selection formula using the Select Expert.

5 Review the updated formula by clicking the SHOW FORMULA button 
again.

6 As you gain confidence and decide to make changes using the 
formula language, click the FORMULA EDITOR button in the expanded 
Select Expert and use the tools in the Record Selection Formula 
Editor to make your formula changes.

7 Review the results of those changes in the Select Expert. Select each 
field used in the record selection formula and observe how the 
program translates your formula into Expert selection criteria.

NOTE: Selection formula components that do not fit any of the fixed 
criteria in the Select Expert will not be translated. For example, if part of 
your record selection formula extracts the last four characters in a 
customer number, then the section of the formula code that performs 
that extraction will not be converted to Select Expert selection criteria. 
The Select Expert has no facility to perform such an extraction simply by 
pointing and clicking.

Group selection

When you group or summarize data, all the groups in the report are 
included by default. There may be times, however, when you do not want 
to include all the groups. For example: 

●   You might want to see only those groups that have certain group 
names, or whose summarized values meet a certain condition. 

●   You might want to see only the groups with the highest summary 
values, or the lowest. 

You can select the groups that appear in the report in several different ways.

You can do some selections by using either a record selection formula or 
a group selection formula. For example:

●   If you have a mailing list grouped by Region and your record 
selection formula specifies only California customers 
({customer.REGION} = “CA”), your report will have only a single 
group: California. 
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●   If you have a group selection formula that specifies only groups 
with the group name “CA” (GroupName({customer.REGION}) 
=”CA”) and no record selection formula, you will get an identical 
report, assuming that the California condition was the only 
selection test in both situations. However, if the group selection 
method is used, it could take longer to get the report back.

Select Expert You can select groups of records using the Select Expert in the same way 
that you can select individual records.

Instead of basing the selection criteria on standard fields, as you do for 
record selection, you base your criteria on group name fields or summary 
fields when you are setting group selection criteria.

●   If you have grouped your data but you have not summarized it, 
you can only set up group selection based on the group name 
field. For example, you may want to select only those groups 
whose Region is Massachusetts:

GroupName ({Customer.REGION}) = “MA”

●   If you have summarized your data, you can set up group selection 
based on either the group name field or the summary field. For 
example:

Sum({Customer.LAST YEAR’S SALES}, 
{Customer.REGION}) > 10000

NOTE: The Select Expert can be used to set up record selection and group 
selection requests. When a group name or summary field is selected, the 
program knows that the selection criteria you set up is intended for group 
selection. In all other cases, the program knows that you are setting up 
record selection.

Formula 
language

You can also select groups using the formula language. To do this, 
activate the Group Selection Formula Editor by choosing the GROUP 
command from the Report|Edit Selection Formula Menu.

In the Formula Editor you can build your group selection request using 
group fields, group name fields, and other formulas. As with record 
selection formulas, your only restriction is that the formula you create 
must be Boolean; that is, it must return either a True or False value. See 
Introduction to Formulas, Page 291.

Top N At times, you might want to show only the “top” or “bottom” groups in 
a report: the fastest selling product lines, the least productive sales 
regions, the states that generate the most orders, etc. Because this kind of 
group selection is so popular, the program includes the Top N Sort Group 
Expert for setting it up easily.
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You access the Top N Sort Group Expert by clicking the TOP N button on 
the supplementary toolbar. Use this Expert to specify first whether you 
want to display the Top N or Bottom N groups and then specify which 
number N is to represent.

For example:

●   To report on the three fastest selling product lines, select the top N 
option in the Top N Sort Group Expert and set N to be equal to 
three.

●   To report on the five least productive sales regions, select the 
bottom N option in the Top N Sort Group Expert and set N to be 
equal to five.

The program will display those groups as specified.

But there is one other element to consider when setting up Top N group 
selection and that is what to do with all the records from other groups that 
do not fit the Top N or Bottom N criteria you have set. You need to decide 
whether to eliminate those records from your report entirely or to lump 
them all together into a single group. The program enables you to do 
choose either option. See How to select the top or bottom N groups, Page 242.

Record selection formula templates

Formula 
templates

The following sample formulas can be used as templates to help you 
create your own selection formulas using the Record Selection Formula 
Editor. The examples illustrate different selections that you could do, not 
necessarily the best selections. To help identify the best way to set up 
your record selection, see Selection performance tips, Page 236.

NOTE: All of these formulas are available in Seagate Crystal Reports 
online Help, so you can copy them directly into the Selection Formula 
Editor. Search for Record selection formula templates in Seagate Crystal 
Reports online Help.

Record selection 
templates

FOR SELECTING RECORDS USING CHARACTER STRINGS

“C” in {file.FIELD}[1]

«Selects those records in which the value in the {file.FIELD} field 
begins with the character “C” (includes values like CyclePath, Corp. 
and Cyclist’s Trail Co.; excludes values like Bob’s Bikes Ltd. and Feel 
Great Bikes, Inc.).»

not (“C” in {file.FIELD}[1])
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«Selects those records in which the value in the {file.FIELD} field does 
not begin with the character “C” (includes values like Bob’s Bikes Ltd. 
and Feel Great Bikes, Inc.; excludes values like CyclePath, Corp. and 
Cyclist’s Trail Co.).»

“999” in {file.FIELD}[3 to 5]

«Selects those records in which the 3rd through 5th digits of the 
{file.FIELD} field is equal to “999” (includes values like 10999, 70999, 
and 00999; excludes values like 99901 and 19990).»

“Cycle” in {file.FIELD}

«Selects those records in which the value in the {file.FIELD} field 
contains the string “Cycle” (includes values such as CyclePath Corp. 
and CycleSporin, Inc.; excludes values like Cyclist’s Trail Co. and Feel 
Great Bikes, Inc.).»

FOR SELECTING RECORDS USING NUMBERS

Single values

{file.FIELD} > 99999 

«Selects those records in which the value in the {file.FIELD} field is 
greater than 99999.»

{file.FIELD} < 99999 

«Selects those records in which the value in the {file.FIELD} field is 
less than 99999.»

Range of values

{file.FIELD} > 11111 and {file.FIELD} < 99999 

«Selects those records in which the value in the {file.FIELD} field is 
greater than 11111 but less than 99999 (neither 11111 or 99999 is 
included in the range of values).»

{file.FIELD} >= 11111 and 
{file.FIELD} <= 99999 

«Selects those records in which the value in the {file.FIELD} field is 
greater than 11111 but less than 99999 (both 11111 and 99999 are 
included in the range of values).»

FOR SELECTING RECORDS USING DATES

The Month, Day, and Year functions can all be used in examples like the 
following:
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Year ({file.DATE}) < 1996 

«Selects those records in which the year found in the {file.DATE} field 
is earlier than 1996.»

Year ({file.DATE}) > 1992 and 
Year ({file.DATE}) < 1996

«Selects those records in which the year found in the {file.DATE} field 
falls between 1992 and 1996 (1992 and 1996 not included).»

Year({file.DATE}) >= 1992 and Year({file.DATE}) 
<= 1996

«Selects those records in which the year found in the {file.DATE} field 
falls between 1992 and 1996 (1992 and 1999 are included).»

Month({file.DATE}) in 1 to 4

«Selects those records in which the month found in the {file.DATE} 
field is one of the first four months of the year (includes January, 
February, March, and April).»

Month({file.DATE}) in [1,4]

«Selects those records in which the month found in the {file.DATE} 
field is the first or fourth month of the year (includes January and 
April, excludes February and March).» 

SELECTING RECORDS USING PRESET DATE RANGES

The preset date ranges can be used to create selection formulas similar to 
these:

{file.DATE} in LastFullMonth

«Selects those records in which the date found in the {file.DATE} field 
falls within the last full month. (If the month is May, this selects all 
records with an April date.)»

not({file.DATE} in LastFullMonth)

«Selects all records except those in which the date found in the 
{file.DATE} field falls within the last full month. (If the month is May, 
this selects all records except those with an April date.)»

{file.DATE} < Today

«Selects all records in which the date found in the {file.DATE} field 
falls before today's date.»
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SELECTING RECORDS USING DATE/NUMBER/CHARACTER 
COMBINATIONS

These formulas simply “mix and match” formulas from the categories above. 

“C” in {file.FIELD}[1] and Month({file.DATE}) in 
[1,4]

«Selects those records in which the value in the {file.FIELD} field 
begins with “C” and the month is either January or April. For 
example, if this kind of formula was used with an order database, you 
could be asking for a report showing all customers whose names 
begin with “C” and who placed orders in January or in April.»

“AOK” in {file.HISTORY}[3 to 5] and {file.OPENCRED} 
>= 5000

«Selects those records in which the {file.HISTORY} field shows the 
characters “AOK” as the 3, 4, and 5 characters and the 
{file.OPENCRED} field (the amount of available credit) is at least 
5000.»

These templates can be used as they are (with your own data), or they can 
be combined to create complex formulas. You can also use the principles 
illustrated here plus Seagate Crystal Reports online Help topics for 
functions and operators to create powerful selection formulas for 
yourself. Search for functions or operators by name in Seagate Crystal 
Reports online Help.

Selection 
performance tips

There are a number of performance-related items that you should 
consider when you are setting up your selection requests:

●   Record selection will be faster if it is based on indexed fields 
instead of non-indexed fields. See Indexed tables, Page 511.

●   If you have based record selection on indexed fields, make sure the 
Use Indexes or Server for Speed option is toggled on in the Report 
Options dialog box. Search for Report Options dialog box in Seagate 
Crystal Reports online Help.

●   If at all possible, avoid performing record selection based on 
formula fields, since it will result in less efficient reporting. For 
example, assume you have a formula field (@ExtendedPrice) in 
your report that returns the extended price of a line item (Quantity 
* Price). If you base your selection criteria on the formula 
(@ExtendedPrice > 1000), the SQL server will not understand the 
formula and the program will not pass the selection criteria down 
to the server. Instead, it will retrieve all of the records from the 
server and then it will apply record selection on the client 
machine.
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●   Try to avoid subscript ranges such as: 

 {file.FIELD}[1 to 5]

The program parses selection formulas and converts anything it 
can to SQL so that the bulk of the work can be off-loaded to the 
SQL server. However, because there is no SQL equivalent to 
subscript ranges, SQL pass through will not occur. Subscripting of 
only the first character works, but subscripting multiple characters 
does not. Search for Subscript in Seagate Crystal Reports online 
Help.

●   If you are using SQL/ODBC data sources and you are unsure 
whether or not the record selection is passing through to SQL, 
check it by choosing the SHOW SQL QUERY command from the 
Database Menu. If the SQL query does not have a WHERE 
statement or if the WHERE statement does not mention all the 
fields that you are dealing with in your record selection, then you 
will need to work through the formula again since the translation 
did not occur properly.

   Make sure you have logged on to your data source before 
choosing the SHOW SQL QUERY command from the Database 
Menu.

   SQL syntax will change with different drivers (ODBC or SQL), 
but the majority follow the Oracle SQL model as a guide. 
Consider the possibility that your driver may use slightly 
different syntax. This may also be the case for non-SQL 
databases.

●   Do not perform any data type conversions in the record selection 
formula (for example, converting a number to a string using the 
ToText function). Such conversions can not be translated to SQL 
and so SQL pass through will not occur. Search for ToText in 
Seagate Crystal Reports online Help.

Record selection 
with a group 
selection 
formula

To perform record selection on both indexed and non-indexed fields, you 
can set up your record selection in such a way as to maximize 
performance. You do this by creating a record selection formula and a 
group selection formula, and using them both to select records. This may 
require some explanation.

The Group Selection Formula Editor has the same functionality as the 
Record Selection Formula Editor. While its primary use is for setting up 
group selection, it can also be used to set up record selection.

While the two Formula Editors are fundamentally the same and the 
formulas they produce appear the same, they each produce formulas that 
are evaluated at different times.
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●   The formulas from the Record Selection Formula Editor are 
evaluated as the program reads records.

●   The formulas from the Group Selection Formula Editor are 
evaluated as the program is printing records. At this point, the 
only records that are saved with the report are those that passed 
record selection criteria.

By using this functionality, you can set up record selection based 
exclusively on:

●   indexed fields in a record selection formula, or

●   non-indexed fields in a group selection formula.

Since the program runs record selection when it reads records and runs 
group selection when it prints records, the following events occur:

●   The record selection formula on the indexed fields quickly returns 
a subset of data from your database. For this example, let’s say that 
it returns 5,000 records out of 100,000 and saves them in a buffer.

●   The group selection formula performs record selection but only on 
the subset of data records (5,000) that are saved with the report. 

You accomplish the same record selection but do it in a more efficient 
manner. With really big databases, this technique can save you significant 
processing time.

Related Topics

Introduction to Formulas, Page 291

Advanced Formulas, Page 315

Search for Functions and Operators and Variables in Seagate Crystal 
Reports online Help.

HANDS-ON (Record and Group Selection)

How to set up record selection using the Select Expert 

When you work with the Select Expert, you select the field to which you 
want to apply selection conditions and then you specify those conditions.

1 Right-click the field on which you want to base record selection and 
choose SELECT EXPERT from the shortcut menu, or select the field and 
click the SELECT EXPERT button on the standard toolbar. The program 
opens the Select Expert, ready for you to set the conditions on the 
highlighted field.
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NOTE: If you click the SELECT EXPERT button without first selecting a 
field in your report, the Choose Field dialog box appears. Select the field 
on which you want to base record selection (preferably an indexed field, 
see Indexed tables, Page 511) and click OK. The Select Expert appears. See 
Selection performance tips, Page 236, and search for Choose Field dialog box 
in Seagate Crystal Reports online Help.

4 Click OK when finished.

A selection formula is generated based on your specifications, limiting 
the report to the records you indicated.

NOTE: To view or edit the selection formula, click the Show Formula 
button. The Select Expert expands to show the formula. To use the tools 
in the Record Selection Formula Editor to modify the formula, click the 
Formula Editor button. The formula will appear in the Record Selection 
Formula Editor.

How to set up group selection using the Select Expert

When you work with the Select Expert, you select the summary field to 
which you want to apply selection conditions and then you specify those 
conditions.

1 Right-click the summary field on which you want to base group 
selection and choose SELECT EXPERT from the shortcut menu, or select 
the field and click the SELECT EXPERT button on the standard toolbar. 
The program opens the Select Expert, ready for you to set the 
conditions on the highlighted group field.

3 Use these drop-down lists to enter your 
selection criteria for the indicated field.

2 To base record selection on more than one field, 
click the New Tab and choose the next field from 
the Choose Field dialog box when it appears.
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NOTE: If you click the SELECT EXPERT button without first selecting a 
summary field in your report, the Choose Field dialog box appears. Select 
the summary field on which you want to base group selection (preferably 
an indexed field, see Indexed tables, Page 511) and click OK. The Select 
Expert appears. See Selection performance tips, Page 236, and search for 
Choose Field dialog box in Seagate Crystal Reports online Help.

NOTE: Summary fields identify the location of the summary value, the 
field that triggers a grouping when its value changes, the kind of 
summary, and the field being summarized. They look similar to this in the 
Choose Field dialog box:

Group Footer #1: Customer.Region
Sum of Last Year’s Sales

If you have not already previewed the report or refreshed the data, 
there will not be any data saved with the report. Without the data, the 
program can not calculate group values; thus, no values appear when 
you click the arrow in the right drop-down list. In this situation, you 
will have to type in the values you want. If you want real values to 
work with, you will need to preview your report first. This will 
calculate the actual summary values available for you to work with.

4 When you are finished, click OK in the Select Expert to return to the 
report.

How to create a record or group selection formula

NOTE: In order to create a selection formula, you need to have some 
understanding of the formula language and the use of the Formula 

3 Use these drop-down lists to enter your 
selection criteria for the indicated field.

2 To base the group selection on more than one field, 
click the New Tab and choose the next field from the 
Choose Field dialog box when it appears.
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Editors. For a thorough discussion of these tools, see Introduction to 
Formulas, Page 291, and Advanced Formulas, Page 315.

1 Choose the EDIT SELECTION FORMULA command from the Report 
Menu. A submenu appears.

3 Enter your selection formula in the Formula text box as you would 
any other formula. Since this is a selection formula, however, the 
formula must be Boolean (return either a True or False value).

4 Click the SAVE AND CLOSE button when finished.

5 If the Formula Editor reports errors, debug the formula as necessary 
and then click the SAVE AND CLOSE buttons again. See How to debug a 
formula, Page 336.

Now, when the program runs the report, it will include only those 
records or groups of records that you specified. See How to set record 
selection using parameter fields, Page 359.

How to use record/group selection templates

1 Select the template you want to use. You can do this in one of two 
ways:

●   Review the list in Record selection formula templates, Page 233, and 
write down the formula of interest.

●   Find the Record/Group Selection Templates topic in Seagate Crystal 
Reports online Help and copy the formula of interest to the 
Clipboard.

2 Choose the EDIT SELECTION FORMULA command from the Report 
Menu. A submenu appears.

...or choose Group to create a group 
selection formula (the Group 
Selection Formula Editor appears).

2 Choose Record to create a record 
selection formula (the Record 
Selection Formula Editor appears)...
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4 In the Formula text box, type in the formula you wrote down in Step 1 
or paste it from the Clipboard.

5 Replace the values (fields, text, etc.) in the formula with the values 
you want. For example, if the example formula is:

{file.FIELD} > 99999

and you want to limit your report to records for which the value in the 
{orders detail.QUANTITY} field is greater than 25, simply replace the 
existing values with the values you want, so that your selection formula 
reads:

{orders detail.QUANTITY} > 25

6 Click the SAVE AND CLOSE button when finished to exit the Selection 
Formula Editor, or click the REFRESH button on the standard toolbar 
to preview the results.

How to select the top or bottom N groups

NOTE: A report must contain a summary value in order to be able to 
perform a top N or bottom N selection.

When selecting top N or bottom N groups:

●   choose whether to show the top or the bottom groups,

●   specify how many groups to show, and

●   tell the program how to deal with the records that are not in one of 
the selected groups.

1 Create a report and summarize the data as desired. When you 
summarize the data, the program breaks the data into groups and 
summarizes each group.

●   With top N grouping, you are instructing the program to display 
those groups that have the highest summary values (Top N).

...or choose Group to create a group 
selection formula (the Group 
Selection Formula Editor appears).

3 Choose Record to create a record 
selection formula (the Record 
Selection Formula Editor appears)...
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●   With bottom N grouping, you are instructing the program to display 
those groups that have the lowest summary values (Bottom N).

2 Click the TOP N EXPERT button on the supplementary toolbar. The 
Top N/Sort Group Expert appears with a tab for your group.

If you have multiple group sections, the program will display a tab for 
each of the groups.

The summary drop-down list on the right is for those cases in which 
you have multiple summaries within a single group section. For 
example, in an orders report, you might sum and average the orders 
for each customer and then display both the sum and the average in 
the same group section. In such a case, you would select the sum or 
the average from this drop-down list.

5 In the where N is text box, enter the number of groups you want to 
display.

6 All that is left is deciding what you want to do with all those records 
that do not fit into the selected groups.

●   Toggle the include Others, with the name check box off if you want 
the other records excluded from the report.

●   Toggle the check box on and assign a name to the group to lump 
all the other records into a single group.

7 Click OK when finished.

8 Now, when the program runs the report, it will include only those 
groups that you specified.

3 Choose Top N, Bottom N, or Sort 
All from this drop-down list.

4 Choose the 
summary on 
which you want 
to base your 
selection from 
this drop-down 
list.
Record and Group Selection 243



244 Seagate Crystal Reports User’s Guide



12 Sorting, Grouping, and Totaling

What you will find in this chapter...

Sorting, Grouping, and Totaling Overview, Page 246

Creating custom groups, Page 250

HANDS-ON (Sorting, Grouping, and Totaling), Page 252
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Sorting, Grouping, and Totaling Overview

Sorting, grouping, and totaling are the steps that turn disorganized data 
into useful information on a report. This overview is an introduction to 
the concepts behind sorting, grouping, and totaling. Refer to the many 
Hands-On tutorials for detailed instructions.

Sorting Sorting means putting values in some kind of order to help you find and/
or evaluate them. For example, information in a phone book is sorted 
because unsorted, it would have little usefulness. Trying to find 
someone’s phone number in an unsorted book would entail a random 
search through tens of thousands of names, a true needle-in-a-haystack 
experience. With sorting, however, you can find the number you need in 
a hurry. For example, if you are looking for the phone number of John J. 
Smith, the following levels of sorting might help you to find it.

●   The data is sorted alphabetically by last name so you know the 
name Smith is in the S section of the book and you turn there 
immediately.

●   When you find the Smiths, (and there are a lot of them) you see 
that they are sorted alphabetically by first name so that John Smith 
comes after Bob Smith. You turn to the John Smiths.

●   Finally, when you find the John Smiths, you see that they are 
sorted by middle initial so the John J. Smiths come after the
John D. Smiths. You turn to John J. Smith, find his phone number, 
and place the call.

Thanks to sorting, you can find anybody’s listed phone number in seconds.

Sorting by 
record

When you sort, the program asks you to select two things:

1. the field you want the sort to be based on (sort field), and

2. the sort direction.

SORT FIELD

A sort field is a field that determines the order in which data appears on 
your report. Seagate Crystal Reports sorts field data using rules specific 
to the Country you select in the International section of the Windows 
Control Panel (Windows 95 and Windows 98, Windows NT 3.51 or 4.0) 
or the Regional section (Windows 3.x).

Any field can be used as a sort field, including formula fields. A field's 
data type determines the method in which the data from that field is 
sorted: 
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●   String fields are sorted in the following manner:

   Single-character values are sorted so that blanks have the 
lowest value, then punctuation, then numbers, then uppercase 
letters, and finally lowercase letters. 

   Next two-character values are sorted, then three, etc., using the 
same rules. As a result:

   “BOB” comes before “bob”, 

   “123” comes before “124”, 

   “ “ (blank) comes before “a”, and 

   “aa” comes before “aaa”.

●   Currency fields are sorted in numeric order.

●   Number values (120 or 5555) are sorted in numeric order.

●   Date fields are sorted in chronological order.

●   DateTime fields are sorted in chronological order by date and 
same-date values are then sorted by time.

●   Time fields are sorted in chronological order.

●   Boolean comparison fields are sorted so that False values (0) come 
first, then True values (1).

When a sort field is selected, the program sorts the values from that field.

SORT DIRECTION

Direction refers to the order in which the values are displayed, once 
sorted.

●   Ascending
Ascending order means smallest to largest (1 to 9, A to Z, False to 
True). The program sorts the records in ascending order based on 
the values in the sort-and-group-by field you select, and then it 
begins a new group whenever the value changes (from Adams to 
Brown, for example).

●   Descending
Descending order means largest to smallest (9 to 1, Z to A, True to 
False). The program sorts the records in descending order based 
on the values in the sort-and-group-by field you select, and then it 
begins a new group whenever the value changes.

When data is grouped, two more sort direction options are available:

●   Original
Original order is the order the data was originally saved in the 
database. The program leaves the records in the order in which 
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they appear in their originating database table, and begins a new 
group whenever the value changes in the sort-and-group-by field 
you select.

●   Specified order
Specified order is a user-defined order. The program puts each 
record into the custom group you specify, and it leaves the records 
in each group in original order or it sorts them in ascending or 
descending order, depending on your instructions. See Creating 
custom groups, Page 250.

Single field sorts In single field sorts all the records used in the report are sorted based on 
the values in a single field. Sorting an inventory report by stock number 
or sorting a customer list by customer number are examples of single field 
sorts. See Results using different sorting and grouping operations, Page 248, 
and How to do a single field sort, Page 253.

Multiple field 
sorts

In multiple field sorts, Seagate Crystal Reports first sorts the records 
based on the values in the first field selected, putting them in ascending 
or descending order as specified. When two or more records have the 
same field value in the first sort field, the program then sorts those 
records based on the value in the second sort field. For example, in a sort 
on last name and then first name (in ascending order), “Smith, Bob” 
would be returned before “Smith, John” no matter which way the fields 
are listed in the database. The program follows a similar process for three 
field sorts, four field sorts, and so on. See Results using different sorting and 
grouping operations, Page 248, and How to do a multiple field sort, Page 256.

Sorting and 
grouping

Seagate Crystal Reports has the most powerful sorting and grouping 
capabilities of any Windows based report writer. When you select a 
grouping option, the program automatically sorts the data as part of the 
grouping operation. See Results using different sorting and grouping 
operations, Page 248.

Results using 
different sorting 
and grouping 
operations

The following chart shows how data would appear after being 
manipulated using different sorting and grouping operations.

1 2 3 4 5 6 7 8 9

CO AZ WA AZ WA CO WA CA WA

WA CA WA WA CA CA WA

CA CA WA CA WA WA CA CA WA

CA CA CO CA CA CA CA

CA CA CO CA CO CA WA CA CA

AZ CA CA CA CO CA WA WA CA
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●   Column 1
 The data as it appears in the database table.

●   Column 2
The data from Column 1 sorted in ascending order (A to Z, 1 to 9). 
There is no grouping.

●   Column 3
The data from Column 1 sorted in descending order (Z to A, 9 to 
1). There is no grouping.

●   Column 4
The data grouped in ascending order. The program automatically 
sorts the data in ascending order and then inserts a group break 
whenever the value changes.

●   Column 5
The data grouped in descending order. The program 
automatically sorts the data in descending order and then inserts a 
group break whenever the value changes.

●   Column 6
The data grouped in original order. The data is not sorted before it 
is grouped. The program inserts a group break whenever the 
group value changes. Note that similar values may appear in more 
than one group (for example, CA and CO have more than one 
group).

●   Column 7
The data grouped in specified order. This is one of thousands of 
possible custom groupings. In this example, the first group consists 
of Pacific states and the second group consists of Mountain states. 
The records in each group are sorted in original order.

WA CO CA CA CA CA WA CA

WA CO CA CA CA WA CA

CA WA CA CO CA AZ

CA WA CA CO CA CO AZ CO

CO WA AZ CA WA AZ CO CO

WA CA WA CO CO AZ

WA

WA AZ CA

CA

CO

1 2 3 4 5 6 7 8 9
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●   Column 8
The same specified order grouping as Column 7, but the records in 
each group are sorted in ascending order.

●   Column 9
The same specified order grouping as Column 7, but the records in 
each group are sorted in descending order.

The way you sort and group data can have a major impact on the way it 
appears on a report.

Creating custom groups

Most of the time, data is sorted based on the values from a field in the 
report. For example, if you have a customer list and you want to sort-and-
group-by state, the program first sorts the list by state. Then it breaks the 
list into state groups whenever the value in the State field changes.

Sometimes, however, you may not want to group based on the values 
found in one of the fields on your report. For example, the report:

●   May not contain the field you want to group on. For instance, your 
report may contain a City field and a State field but no Country 
field, although you need to group by country.

●   May contain the field you want to group on, but you may not be 
happy with the grouping based on the values in that field. For 
example, you may have a Color field on your report that includes 
specific color names (Logan Green, Sky Blue, Emerald Green, 
Navy Blue, etc.) but you want all shades of each color to appear as 
a single group (Greens, Blues, Reds, etc.). In this case you can 
build custom groups and manually assign the records you want to 
be in each group.

●   May contain the field you want to group on, but you want to select 
specific values or ranges of values for each group. For example, 
you might want one group to contain records where gross sales 
are less than a certain value, a second group where gross sales are 
greater than a certain value, and a final group where gross sales 
fall between two values. In this case, you can build your groups 
using the same range of selection facilities that are available to you 
for building record selection queries.

Specified order grouping provides a solution to these custom sorting and 
grouping challenges. Specified order grouping enables you to create both 
the customized groups that will appear on your report and the records 
that each group will contain. Your only real limitation is that a record can 
be assigned to only one group.
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To create a custom group using specified order grouping, you select in 
specified order as your sort option. The program gives you the in specified 
order option whenever you:

●   create groups using the GROUP, SUBTOTAL, or SUMMARY command 
on the Insert Menu,

●   create groups while building a report using one of the Report 
Creation Experts, or

●   choose the CHANGE GROUP EXPERT command from the Report 
Menu.

Summarizing 
group values

One of the primary purposes for breaking data into groups is so that you 
can run some calculations on each group of records instead of on all the 
records in the report. When you do this, the program evaluates all the 
values in each group and then summarizes them. For example:

●   For a customer list report, you might want to determine the 
number of customers in each state. The summary would consist of 
counting the distinct customers in each state group.

●   For an order report, you might want to determine the average 
order placed each month. The summary would calculate the size 
of the average order for each month group.

●   For a sales report, you might want to determine the total sales per 
sales representative. The summary would sum or subtotal the 
order amounts for each sales representative group.

As you can see, grouped data can be summarized in a variety of ways to 
make useful reports.

When the program summarizes data, it sorts the data, breaks it into 
groups, and then summarizes the values in each group. It does this all 
automatically; all you have to do is specify:

●   the field you want summarized,

●   the type of summary operation to be performed on the field,

●   which field will trigger a new group whenever its value changes, 
and

●   the sort order.

The program handles all the details.

The program includes a number of summarizing options. Depending on 
the data type of the field you plan to summarize, you can:

●   sum the values in each group,
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●   count all the values or only those values that are distinct from one 
another,

●   determine the maximum, minimum, or average value, and

●   calculate up to two kinds of standard deviations and variances.

All these summaries are set up by clicking the INSERT SUMMARY button on 
the standard toolbar or by choosing the SUBTOTAL command from the 
Insert Menu. Search for Subtotal command and Summary functions in 
Seagate Crystal Reports online Help. 

Sorting 
summarized 
group values

Summarized group values can be sorted in either ascending or 
descending order. For example, in an orders report, if you subtotal orders 
by state, you could have the group with the:

●   lowest subtotal first, then the next lowest, and so forth (ascending), 
or

●   highest subtotal first, then the next highest, and so forth 
(descending).

You can sort your report based on group values by using the TOPN/SORT 
GROUP EXPERT command on the Report Menu. For more information on 
TopN/BottomN sorting and grouping, see How to select the top or bottom 
N groups, Page 242.

NOTE: To sort groups that are not summarized, choose the CHANGE 
GROUP EXPERT command from the Report Menu.

HANDS-ON (Sorting, Grouping, and Totaling)
When you insert a database field into your report, the data within the 
fields appears in the order in which it was originally entered into the 
database.
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report.

As you can see, pinpointing information in this kind of report would be 
difficult. It would be much easier to review or find information when you 
can see it sorted in a logical format. For instance, you may want to have a 
customer list sorted alphabetically by name or by country. That is known 
as a single field sort.

NOTE: To see an example of the above report, open the SGT01.RPT file 
in the \CRW16 directory (16-bit), or \Program Files\Seagate 
Software\Crystal Reports directory (32-bit).

How to do a single field sort

1 To get started, create a report using the customer table in 
xtreme.mdb, and place the following fields from left to right in the 
Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}
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2 Click the SORT ORDER button on the standard toolbar. The Record 
Sort Order dialog box appears.

NOTE: The following illustrates both a "before" and "after" state of the 
dialog box. Typically, any fields you move to the Sort Fields list box will no 
longer appear in the Report Fields list box. 

Records are sorted based on the values in the sort field.

For example, if you choose to sort the {customer.COUNTRY} field in 
ascending order, the report would appear as follows:

3 Highlight the field to be
sorted from this list.

4 Click Add... ...the selected field is added to this list. 

5 Specify the sort direction.

6 Click OK when finished.
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report.

Notice that the records are displayed in alphabetic order by country: all 
of Canada, then Spain, then the United States. There is no further sorting 
of these records, however. If you want your customers sorted by Country 
and then, for example, by Region, then you need to do a multiple field 
sort.

NOTE: To see an example of the above report, open the SGT02.RPT file 
in the \CRW16 directory (16-bit), or \Program Files\Seagate 
Software\Crystal Reports directory (32-bit).

Related Topics

Introduction to Reporting, Page 85

How to do a multiple field sort, Page 256

How to sort records within groups, Page 260

Countries are now sorted in alphabetic order.

The Regions within
each Country

remain unsorted.
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How to do a multiple field sort

Using the report you created in How to do a single field sort, Page 253, you 
can further organize your data by sorting on multiple fields.

1 Click the SORT ORDER button on the standard toolbar. The Record 
Sort Order dialog box appears.

NOTE: The following illustrates both a "before" and "after" state of the 
dialog box. Typically, any fields you move to the Sort Fields list box will no 
longer appear in the Report Fields list box.

Records are sorted by Country first and then by Region.

For example, if you choose to sort first by the {customer.COUNTRY} field 
and then by the {customer.REGION} field, both in ascending order, the 
report would appear as follows:

2 Highlight the field you want the 
data sorted by first and click the Add 
button to add it to the Sort Fields list.

3 Highlight the field you want 
the data to be sorted by second 
and add it to the Sort Fields list.

4 As you add each field to the Sort
Fields list, specify the sort direction.

The selected fields are
displayed in the order by

which they are sorted.

5 Click OK
when finished.
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report.

Notice that the data is organized alphabetically by Country, and where a 
country has customers in different regions, those regions are sorted in 
alphabetic order as well. 

NOTE: To see an example of the above report, open the SGT03.RPT file 
in the \CRW16 directory (16-bit), or \Program Files\Seagate 
Software\Crystal Reports directory (32-bit).

Related Topics

Introduction to Reporting, Page 85

How to do a single field sort, Page 253

How to sort records within groups, Page 260

The Regions within each
Country are sorted in

alphabetic order.

Postal Codes within each
Region are unsorted.

Countries are sorted in alphabetic order.
Sorting, Grouping, and Totaling 257



How to group data

Sometimes sorting is not enough. You may want to break data into 
meaningful groups. Seagate Crystal Reports allows you to group data in 
one easy step.

NOTE: It is unnecessary to sort data before you group it. The program 
does the necessary sorting automatically, as part of the grouping 
procedure. To sort data, follow the sorting procedures outlined in How to 
do a single field sort, Page 253, and How to do a multiple field sort, Page 256.

1 To get started, create a report using the sample data, xtreme.mdb, 
and place the following fields from left to right in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}

You will use this same data for the topic How to sort records within groups, 
Page 260, as well.

2 Click the INSERT GROUP button on the supplementary toolbar. The 
Insert Group dialog box appears.
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report.

3 Select the field you want your data
grouped by from this drop-down list.

4 Next, specify the sort
direction.

5 Click OK when finished.

The Customers 
are grouped by 
Country.

The groups are 
also sorted in 
ascending (A-Z) 
order...

...but the records
within each group

are unsorted.
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Notice that the values are grouped by Country, and that the Country 
groups appear in ascending (A to Z) order. Notice too, however, that the 
records within each group remain unsorted. To remedy this, you need to 
sort the records within each group. See How to sort records within groups, 
Page 260.

NOTE: To see an example of the above report, open the SGT04.RPT file 
in the \CRW directory (16-bit), or \Program Files\Seagate Crystal Reports 
directory (32-bit).

Related Topics

Introduction to Reporting, Page 85

How to sort records within groups, Page 260

How to group based on the first letter of a company name, Page 274

How to group data in intervals, Page 277

How to create group headers, Page 285

How to sort records within groups

Once you have grouped your data, you can easily sort the records within 
the groups to further organize the information. For this tutorial, you must 
first group your data using the technique in How to group data, Page 258.

1 Once the data is grouped, click the SORT ORDER button on the 
standard toolbar. The Record Sort Order dialog box appears.

NOTE: The following illustrates both a "before" and "after" state of the 
dialog box. Typically, any fields you move to the Sort Fields list box will no 
longer appear in the Report Fields list box. 
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report.

2 Highlight the field you want the
records in the groups sorted by

and click the Add button...

3 Specify the sort direction.

4 Click OK when finished.

...the selected fields are
displayed in the order by

which they are to be sorted.

NOTE: This field specifies the sort 
done automatically when you 
grouped the data. It can’t be moved.

The customers within
each country are sorted.

The data is grouped by Country.
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NOTE: To see an example of the previous report, open the SGT05.RPT 
file in the \CRW directory (16-bit), or \Program Files\Seagate Crystal 
Reports directory 32-bit).

Related Topics

Introduction to Reporting, Page 85

How to do a single field sort, Page 253

How to do a multiple field sort, Page 256

How to summarize grouped data

Often, you will want to summarize the data in each group and then print 
the summaries in your report. You can use summaries to:

●   count the number of values in a group,

●   calculate the sum, average, standard deviation, or variance of 
values in a group, or

●   identify the minimum or maximum value in a group.

For more information on summarizing your data, search for Summary 
functions in Seagate Crystal Reports online Help.

For example, you may want to count the number of customers within 
each country. To do this, the data must be broken into country groups, 
and then the records in each group must be counted. Instead of grouping 
the data manually and then summarizing it, you can let the program 
group and summarize in a single step.

1 To get started, create a report using the sample data, xtreme.mdb, 
and place the following fields from left to right in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}

2 Click the Customer Name field (the field you want to summarize) 
and click the SUMMARY button on the standard toolbar. The Insert 
Summary dialog box appears. 
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report.

3 Select the desired summary
operation from this drop-down list.

4 Highlight the field you want
the data to be grouped by.

5 Specify the sort direction.

6 Click OK when finished.

This will 
count the 
records in 
each group.

The data is 
broken into 
Country 
groups.
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NOTE: To see an example of the previous report, open the SGT06.RPT 
file in the \CRW16 directory (16-bit), or \Program Files\Seagate 
Software\Crystal Reports directory (32-bit).

Related Topics

Introduction to Reporting, Page 85

How to subtotal grouped data, Page 264

How to create multiple levels of subtotals, Page 270

How to extend prices and then subtotal the extensions, Page 266

How to calculate a percentage of the grand total, Page 282

How to create group headers, Page 285

How to subtotal grouped data

A subtotal is a special kind of summary. It totals or sums numeric values 
in a group. Like any summary, the program groups and subtotals in a 
single step. For more information on summary functions, search for 
Summary functions in Seagate Crystal Reports online Help.

In this example you will group the data by Country and subtotal Last 
Year’s Sales by Country. To get started, create a report using the sample 
data, xtreme.mdb, and place the following fields from left to right in the 
Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}
{customer.LAST YEAR’S SALES}

1 Right-click the Last Year’s Sales field and choose INSERT SUBTOTAL 
from the shortcut menu. The Insert Subtotal dialog box appears with 
the chosen field listed at the top of the dialog box.
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report.

NOTE: To see an example of the above report, open the SGT07.RPT file 
in the \CRW16 directory (16-bit), or \Program Files\Seagate 
Software\Crystal Reports directory 32-bit).

2 Choose the field you want
the data grouped by, specify

a sort direction, then click
OK when finished.

The field you 
selected to be 
subtotaled.

The values in 
each group 
are now 
subtotaled.

Data is broken 
into Country 
groups.
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Related Topics

How to summarize grouped data, Page 262

How to create multiple levels of subtotals, Page 270

How to extend prices and then subtotal the extensions, Page 266

How to calculate a percentage of the grand total, Page 282

How to create group headers, Page 285

How to sort based on summarized group values

1 Click the TOP N button on the supplementary toolbar. The Top N Sort 
Group Expert appears with a tab for each of the groups in the report.

2 Click the tab for the group you want to sort.

3 Select the Sort All option from the drop-down list on the left.

4 From the top-right drop-down list, select the summary you want to 
sort by (when you have more than one summary in the group section 
- for example, you might have both a sum and an average summary 
in a section).

5 Click the option button to specify the sort direction.

6 To select a second sort group, repeat Steps 2-5.

When you run the report, the program will sort your data based on the 
group order(s) specified.

How to extend prices and then subtotal the extensions

In an orders report or invoice, you may need to extend the prices for 
individual line items and then subtotal the extensions. You do this by 
using a simple formula to extend the prices, and then you subtotal the 
formula field.

1 To get started, create a report using the Customer, Orders, and 
Orders Detail tables in xtreme.mdb, and place the following fields 
from left to right in the Details section:

{customer.CUSTOMER ID}
{orders detail.PRODUCT ID}
{orders detail.QUANTITY}
{orders detail.UNIT PRICE}
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2 To create the formula for extending the prices, click the Formula Tab 
in the Insert Fields dialog box to activate it.

5 Click OK. The Formula Editor appears. Enter the following formula 
into the Formula text box:

{orders detail.QUANTITY} * 
{orders detail.UNIT PRICE}

See Introduction to Formulas, Page 291, for more information on 
formulas.

6 Click the SAVE AND CLOSE button when finished. The Formula Editor 
disappears and the program returns you to the Insert Fields dialog 
box with the name of your formula highlighted in the list box.

3 Click New.

4 Type a name to identify 
the formula.
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8 Place the formula field to the right of the Unit Price field in the 
Details section of the report.

9 Click Close to close the Insert Fields dialog box.

Next you will subtotal the extensions.

NOTE: The menus have been shortened by removing some of the 
commands that are unrelated to the current discussion.

The Insert Subtotal dialog box appears, already set to subtotal 
@Extension (the extended price field). For more information on 
summary functions, search for Summary functions in Seagate Crystal 
Reports online Help.

7 Click the Insert button to place 
the formula in the report.

The formula you just created.

10 Right-click the formula field, and choose 
Insert Subtotal from the shortcut menu.
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You are interested in weekly sales, so you want to create a subtotal 
whenever the values in the Order Date field change from one week to 
the next.

11 Choose {orders.ORDER DATE} as the sort-and-group-by field, and 
choose for each week as the date change that is going to trigger the 
grouping.

NOTE: In order to do this, the Orders table must be linked to the Orders 
Detail table before you preview the report. Search for Visual Linking 
Topics Index in Seagate Crystal Reports online Help.

NOTE: The Section will be printed drop-down box will not be activated 
until you choose the Order Date field. 

The dialog box should look like this: 

When you click OK, the program inserts the subtotal in the report.

Your final report should look similar to the following:

The data will be 
sorted by date...

...and grouped 
whenever the date 
changes from one 
week to the next.
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report.

NOTE: To see an example of the above report, open the SGT08.RPT file 
in the \CRW16 directory (16-bit), or \Program Files\Seagate 
Software\Crystal Reports directory(32-bit).

Related Topics

How to summarize grouped data, Page 262

How to subtotal grouped data, Page 264

How to calculate a percentage of the grand total, Page 282

How to create group headers, Page 285

How to create multiple levels of subtotals

Sometimes one level of subtotals will not do. For example, you may not 
only want to see the sales for each region subtotaled, but also the sales for 
each sales representative or each postal code within each region. The 
program enables you to create these multiple subtotals with ease.

There are two keys to effective reporting using multiple subtotals:
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1. First, make sure the subtotals are entered in the correct order. The 
rule to follow is to go from general to specific. For example, to 
subtotal both by country and by region, enter the country subtotal 
first and then the region subtotal.

2. The other key is to make sure you label the subtotals for clarity. With 
multiple subtotals, it can be difficult to tell which is which unless 
they are labeled properly.

Here is how you subtotal Last Year’s Sales by Country and then by 
Region:

1 To get started, create a report using the sample data, xtreme.mdb, 
and place the following fields from left to right in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.COUNTRY}
{customer.LAST YEAR'S SALES}

NOTE: The menus below have been shortened by removing some of the 
commands that are unrelated to the current discussion.

3 When the Insert Subtotal dialog box appears, select Country as your 
sort-and-group-by field and click OK. 

...choose Insert 
Subtotal from the 
shortcut menu.

2 Right-click the database field, and....
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The program creates a group section (GH1, GF1) and places the 
subtotal in the Group Footer.

4 Now right-click the Last Year’s Sales field again and choose INSERT 
SUBTOTAL from the shortcut menu.

The field you are 
going to subtotal.

Every time the value in 
this field changes, a 
subtotal will be shown 
for each country.

The country subtotal.
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5 This time, select Region as your sort-and-group-by field and click 
OK. The program creates a second group section (GH2, GF2) and 
places this subtotal in the second Group Footer (GH2). See How to 
group data, Page 258.

Your report should look similar to the following:

You are subtotaling the 
same field.

A subtotal for each 
region will be shown.

The country subtotal.

The region subtotal.
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report. 

NOTE: To see an example of the above report, open the SGT09.RPT file 
in the \CRW16 directory (16-bit), or \Program Files\Seagate 
Software\Crystal Reports directory (32-bit).

Related Topics

For more information on summarizing your data, search for Summary 
functions in Seagate Crystal Reports online Help.

How to group based on the first letter of a company name

You might want to break your data into groups based on the first letter of 
the company name. For example, in a customer list you might want all the 
“A” customers in a group, then all the “B” customers, and so forth. To do 
this requires the use of a formula.

Do not worry if you are unfamiliar with formulas. This text will show you 
what formula you need here and how to enter it.

You can learn more about creating and editing formulas in Introduction to 
Formulas, Page 291.

This report
contains multiple

levels of subtotals.

Each 
region is 
subtotaled.

So is each 
country.
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You are going to create a formula that will extract the first letter of each 
customer’s name. Then you will group the data using that formula field 
as the sort-and-group-by field. The program will sort the data based on 
the first letter of each customer name and start a new group whenever 
that letter changes.

1 To get started, create a report using the sample data, xtreme.mdb, 
and place the following fields from left to right in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}

2 Click the INSERT FIELDS button on the standard toolbar. When the 
Insert Fields dialog box appears, click the Formula Tab to activate it.

5 When you click OK, the Formula Editor appears. Type the following 
formula into the Formula text box:

{customer.CUSTOMER NAME}[1]

6 Click the SAVE AND CLOSE button. The Formula Editor disappears 
and you are returned to the Insert Fields dialog box. The name of the 
formula is now highlighted in the list box.

7 Click the INSERT button to place the formula object in the report.

3 Click the New button.

4 Type a name to identify 
the formula.

8 Place the formula object temporarily in 
the Page Header section of the report.
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You are going to move the formula object into a Group Header 
section, but the report does not have one yet. As soon as you group 
the data, you can move the formula object into the desired section.

9 Click the Insert GROUP button on the supplementary toolbar. The 
Insert Group dialog box appears.

You are returned to your report with the data grouped by the formula 
field as specified.

12 Finally, move the formula field into the Group Header #1 (GH1) 
section where it will serve as a live group header, changing 
according to the value returned by the formula calculation. For more 
information on live headers, see Live headers, Page 286.

Your report should look similar to the following:

10 Select the formula 
field as the field you 
want your data 
grouped by.

11 Click OK when finished.
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NOTE: This sample report has been designed to illustrate concepts only, 
not the actual look of the finished report.

NOTE: To see an example of the above report, open the SGT10.RPT file 
in the \CRW16 directory (16-bit), or \Program Files\Seagate 
Software\Crystal Reports directory (32-bit).

Related Topics

Introduction to Formulas, Page 291

Introduction to Reporting, Page 85

How to group data, Page 258

How to group data in intervals, Page 277

How to create group headers, Page 285

How to group data in intervals

You may want to group your data into intervals. Age groups, time 
periods, and sales categories are some of the interval groupings that can 
be created using the process you will learn here. In this example, you will 
rank customers by the amount of business they did in the previous year.

The data is broken into
groups based on the first
letter of the Customer’s

Name.

The formula also provides
a live header for every

group.
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This example uses specified order grouping. This kind of grouping lets 
you specify the records that will be included in each group. You define 
the intervals you want and the program will do the rest.

1 To get started, create a report using the sample data, xtreme.mdb, 
and place the following fields from left to right in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}
{customer.LAST YEAR’S SALES}

2 Right-click the Last Year’s Sales field and choose INSERT SUBTOTAL 
from the shortcut menu. The Insert Subtotal dialog box appears. You 
want to set up intervals based on the previous year’s sales so select 
Last Year’s Sales as the sort-and-group-by field (the top drop-down 
list).

3 Select in specified order from the second drop-down list. The Specified 
Order Tab appears in the dialog box.
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4 Click the NEW button. The Define Named Group dialog box appears.

5 Type “Less than $10,000” in the Group Name edit box. This is the 
name that will appear as the Group Name field value for the group. 

6 Since the first group is to contain only those records that have a Last 
Year’s Sales figure of less than $10,000, set the three edit boxes so 
your condition reads:

is less than 10000
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8 Click NEW again, and the Define Named Group dialog box 
reappears. This time set up a second group that contains values 
between $10,000 and $25,000.

9 Type “$10,000 to $25,000” in the Group Name edit box.

10 Set the first two edit boxes so the condition reads:

is between

The program creates a fourth edit box. There are now two edit boxes 
on the right, one above the other, with the word “and” separating 
them. Use the drop-down lists on these boxes to specify a range of 
values.

11 To specify the range:

●   type “10000” in the top edit box, and

●   type “25000” in the bottom edit box.

You have now set up the group to contain all values between $10,000 
and $25,000.

12 Click OK to return to the Specified Order Tab.

13 To set up the final group (all values over $25,000), click the NEW 
button again.

14 When the Define Named Group dialog box appears, type “Over 
$25,000” in the Group Name edit box.

15 Set the three edit boxes so the condition reads:

is greater than 25000

16 Click OK to return to the Specified Order Tab. 

17 Immediately to the right of the Specified Order Tab is the Others Tab.

7 Click OK to return to the Specified Order Tab.
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Use this tab to specify how you want to handle all values that do not 
fit into any of the groups. Since all of the values in the Last Year’s Sales 
field fall into one of the three groups, you will not have to worry about 
your settings here, so click OK. The program returns you to your 
report.

Only one other thing remains in setting up your interval report and 
that is to insert group headers in order to identify each of the groups. 
If you insert the Group Name field into the Group Header (GH) 
section of your report, then the program will use the name you 
assigned to each group to identify those groups in the report.

18 Click the INSERT FIELDS button on the standard toolbar. The Insert 
Fields dialog box appears.

19 Click the Others Tab. There should only be one group name in the 
list: Group #1 Name.

20 Drag that name into the Group Header section.

Your report should look similar to this:
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report.

NOTE: To see an example of the above report, open the SGT11.RPT file 
in the \CRW16 directory (16-bit), or \Program Files\Seagate 
Software\Crystal Reports directory (32-bit).

Related Topics

Introduction to Reporting, Page 85

How to group based on the first letter of a company name, Page 274

How to create group headers, Page 285

How to calculate a percentage of the grand total

In some reports, you want to see what percentage of the grand total each 
group contributes. In this example, you will create a report that subtotals 
orders by country and then determines what percentage of total 
worldwide sales each country generated. The process is simple and 
straightforward. It uses built-in subtotaling techniques plus one simple 
formula.

This report is grouped by
interval in a specified order.
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1 To get started, create a report using the sample data, xtreme.mdb, 
and place the following fields from left to right in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.COUNTRY}
{orders.ORDER AMOUNT}

2 Right-click the Order Amount field and choose INSERT SUBTOTAL 
from the shortcut menu.

3 When the Insert Subtotal dialog box appears, specify Country as 
your sort-and-group-by field and click OK. 

4 Right-click the Order Amount field again and choose INSERT GRAND 
TOTAL from the shortcut menu. When the Insert Grand Total dialog 
box appears, make sure that the function is set to sum and then click 
OK. Search for Summary functions in Seagate Crystal Reports online 
Help. 

This field will be 
subtotaled...

...whenever the 
value in this field 
changes.

This calculates the sales for 
each country. It breaks the 
data into country groups 
and subtotals each group.
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Now you need to determine the percentage of worldwide sales 
generated by each country. To do this, you will create a simple 
formula.

5 Open the Formula Editor and enter the following formula in the 
Formula text box:

Sum ({orders.ORDER AMOUNT}, {customer.COUNTRY})/Sum 
({orders.ORDER AMOUNT})*100

See Introduction to Formulas, Page 291.

6 Place the formula in the Group Footer section of the report, just to the 
right of the Country subtotal.

After you add labels, headers, and formatting, and you run the report, 
the Design Tab should look similar to this:

Your report should look similar to the following:

The operation to 
be performed on 
the field.

The field that is 
going to be totaled.

This calculates world-
wide sales, the total of 
all sales in the report.
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NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of the finished report.

NOTE: To see an example of the above report, open the SGT12.RPT file 
in the \CRW16 directory (16-bit), or \Program Files\Seagate 
Software\Crystal Reports directory (32-bit).

Related Topics

Introduction to Formulas, Page 291

How to create group headers

Whenever you create a group, a subtotal, or a summary, the program 
creates both a Group Footer (GF) section (where it places any subtotal or 
summary value), and a Group Header (GH) section (where it 
automatically places the group name/header). Group Headers are 
useful, even necessary, if you want your report data to be clear and easily 

Each customer
is subtotaled.

Each country is subtotaled.

The program calculates the percentage of total sales
contributed by each customer and each country.
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understood. Though the program creates a group header automatically, 
you may find that you would like to change/modify the header to suit 
your needs. In this tutorial, you will learn how to create the five most 
common kinds of group headers: 

●   Standard headers, Page 286, 

●   Live headers, Page 286, 

●   Live headers for groups based on a formula, Page 288, and

●   Headers for custom groups, Page 289. 

Standard 
headers

A standard header is a block of text that is used to identify each group in 
a rather generic kind of way. “Customer,” “State,” and “Monthly Orders” 
are all examples of this kind of header.

While the header is somewhat descriptive (“Region Sales Figures” clearly 
means it is a regional group), you never know what region is in the group 
without first looking at the details in the group. 

Nonetheless, this kind of header has its place and it is easy to create.

1 To create a standard header, click the INSERT TEXT OBJECT button on 
the standard toolbar.

2 When the object pointer appears, move the object frame into the 
Group Header section.

3 When the Text Object is positioned, the program automatically 
selects the frame for editing. Enter the text you want to use for the 
header.

4 Click outside the frame when finished to complete the process. Now 
when you run the report, the same header will appear at the 
beginning of each group. See How to insert text objects, Page 108.

Live headers A live header is a header that changes based on the content of the group. 
If the data is subtotaled by region, for example, a live header would 
typically identify the region detailed in each group. Thus, the Arizona 
group would have a header identifying the data as Arizona data, the 
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California group would have a header identifying the data as California 
data, and so on.

NOTE: When creating a group, the program automatically inserts a group 
name field in the Group Header section unless you have toggled the 
option off using the OPTIONS command on the File Menu. The 
information that follows details how to manually insert such a section (if 
you do not have the program insert one automatically) and how to create 
different kinds of live headers for different needs.

GROUP NAME ONLY

The easiest live header to create is an identifying field value. To create this 
type of live header for region groups, for example, simply insert a Group 
Name field in the Group Header section. This prints Arizona (or AZ) at 
the beginning of the Arizona group, California (or CA) at the beginning 
of the California group, and so on.

1 Click the INSERT FIELDS button on the standard toolbar. The Insert 
Fields dialog box appears.

2 Click the Others Tab to activate it.

3 Select the Group Name field that matches the group you are working 
with and drag it into the Group Header section for that group.

4 Format the field as desired.

Now, when you run the report, the region identifier will appear as the 
group header for each region group.

GROUP NAME WITH TEXT

A more complex type of live header combines a field value and text. A 
typical group header of this kind for data broken down by region would 
be, “Sales for California” or “Customers in Postal Code 60606“. Creating 
these headers involves three steps:

1. Insert a text object in the Group Header section.

2. Type in the text you want to appear.

3. Enter the Group Name field in the text field where you want it to 
appear in the Group Header.

For example, if you want your header to read “Sales for” and then the 
name of the region in the current group (Sales for AZ, Sales for CA, and 
so forth), follow these steps:

1 Click the INSERT TEXT OBJECT button on the standard toolbar.

2 Place the object frame into the Group Header section for the group.
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3 When the TEXT OBJECT is positioned, the program automatically 
selects the frame for editing. Type in “Sales for” with a space after it.

4 Click the INSERT FIELDS button on the standard toolbar. The Insert 
Field dialog box appears.

5 Click the Others Tab to activate it.

6 Select the Group Name Field that matches the group, and drag it into 
the text object, immediately after the text and the space you entered.

7 Format the text object as you want it to appear.

Now, when you run the report, the program will create a live header 
(with text) for each of your groups.

Live headers for 
groups based on 
a formula

When you create a group and use a formula field as a sort-and-group-by 
field, the program automatically creates a group name field based on the 
value returned by the formula.

For example, if you create this formula:

{customer.CUSTOMER NAME}[1]

and then group on the formula, the program will group your data based 
on the first letter in the Customer Name field.

To create a live group header for a group based on a formula, simply 
insert the group name field in the Group Header section.

When you run the report, the “A” group will have the letter “A” as a 
header, the “B” group will have the letter “B”, and so on. For more 
information, see How to group based on the first letter of a company name, Page 
274.
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To create a more descriptive header such as “Customers beginning with 
the letter B”, you simply follow these four steps:

1 Insert a text object in the Group Header section.

2 Type in this text:

Customers beginning with the letter

3 Add a space.

4 Insert the group name field into the text object and place it right after 
the space.

NOTE: If the program automatically inserted a group name field in the 
Group Header section, you will need to delete that field so you will not 
have duplicate headers.

Headers for 
custom groups

The final type of header is a header for the types of custom groups created 
when things are grouped in a specific order. When using specified order 
grouping, both the name for each group and the records that belong in it 
are specified. As in the other grouping situations, the program creates a 
group name field for each group based on the group names specified.
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1 Click the INSERT FIELDS button on the standard toolbar. The Insert 
Field dialog box appears.

2 Click the Others Tab to activate it.

3 Select the Group Name field for the custom group and drag it into 
the Group Header section for that group.

The program automatically applies each of the group names you 
assigned to the appropriate groups.

NOTE: Make certain that when you assign the names to the groups using 
the Define Named Group dialog box, the names you assign are the names 
you want to appear as group headers.
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13 Introduction to Formulas

What you will find in this chapter...

What are formulas?, Page 292

How formulas are created: an introduction to the Formula Editor, Page 296

Other formula conventions, Page 304

Formula syntax, Page 306

How formulas are evaluated - order of precedence, Page 309

HANDS-ON (Formulas), Page 309
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What are formulas?

In many cases, the data needed for a report already exists in database 
table fields. To prepare an order list, for example, you simply need to 
place the appropriate fields on the report.

Sometimes, however, you need to put data on the report that does not 
exist in any of the data fields. In such cases, you need to create a formula. 
For example, to calculate the number of days it takes to process each 
order, you need a formula that determines the number of days between 
the order date and the ship date. Seagate Crystal Reports makes it easy 
for you to create such a formula.

By placing these fields...

...you get this kind of report.
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1 Click the INSERT FIELDS button on the standard toolbar. The Insert 
Fields dialog box appears.

5 When you click OK in the Formula Name dialog box, the Formula 
Editor appears. Use the Formula Editor to create, test, and modify 
the formula.

For more information on the Formula Editor, see How formulas are 
created: an introduction to the Formula Editor, Page 296.

6 To build the processing time formula, enter the Ship Date field, the 
Subtraction operator, and the Order Date field.

3 Click New.

4 Type a name to 
identify the formula.

2 Click the Formula Tab to activate it.
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NOTE: When you double-click an item in the Fields, Functions, or 
Operators tree, it is placed in the Formula text box complete with the 
brackets, punctuation, and other syntax items the Formula Editor needs to 
process them correctly (see Formula syntax, Page 306).

NOTE: The list of values in the Browse Field Data dialog box represents 
only a subset of the available records.

10 When you are finished, click the CHECK button. The program checks 
the formula syntax.

11 If the syntax is correct, click the SAVE AND CLOSE button. The 
Formula Editor closes and you are returned to the Insert Fields 
dialog box.

NOTE: If you use the SAVE AND CLOSE button, your personalized settings 
will be saved. The next time the Formula Editor is opened, it will appear 
with the settings you specified. However, if you use the SAVE button to 
save the formula, and later use the CANCEL button any resizing or 
customizing performed in the Formula Editor will be lost. The next time 
the Formula Editor is opened, it will appear with its default settings 
active.

NOTE: Other formulas can also be edited from within the Formula Editor. 
To do this, select the formula you want to edit from the drop-down list at 
the top of the Formula Editor.

7 Double-click the Orders.Ship 
Date field in the Report Fields list.

8 Double-click the subtraction 
operator in the Operators list.

The formula components are 
entered as you choose them.

9 Double-click the 
Orders.Order 
Date field from the 
Report Fields list.
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12 Click the Insert button to place the formula field object in the report.
 

This is just one example of how formulas can be used to create powerful 
reports.

Some of the other typical uses for formulas are:

●   creating calculated fields to add to your report 

{orders detail.UNIT PRICE}*.85

«Calculates a price discounted 15%.»

●   formatting text on a report

UpperCase ({customer.CUSTOMER NAME})

13 When the object frame appears, place it where
you want the formula to appear in the report.

You get this kind of report:
The formula subtracts the Order Date from

the Ship Date and then prints the result here.
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«Changes all the values in the Customer Name field to uppercase. 
See How to format text with formulas, Page 318.»

●   pulling out a portion, or portions, of a text string,

{customer.CUSTOMER NAME} [1]

«Extracts the first letter of the customer name. See How to group 
based on the first letter of a company name, Page 274, and search for 
Subscript in Seagate Crystal Reports online Help.»

●   pulling out a portion of a date

Month ({orders.ORDER DATE})

«Determines what month an order was placed.»

These examples just scratch the surface. If you have a need for specialized 
data manipulation, chances are you can do it with a formula.

Related Topics

Advanced Formulas, Page 315

How formulas are created: an introduction to the Formula Editor

Creating a formula in Seagate Crystal Reports is much like creating one 
in any spreadsheet application. You can use: 

●   fields:
 ({customer.CUSTOMER LAST NAME}, {customer.LAST YEAR'S 
SALES}, etc.),

●   numbers:
 (1, 2, 3.1416, etc.), 

●   text:
 (“Quantity”, “ ”, “:”, ’your text’, etc.), 

●   operators:
 (+, -, etc.), 

●   functions:
(TrimRight (x), Length (x), etc.),

●   group field values:
(Average (fld, condFld), Sum (fld, condFld, “condition”), etc.), or 

●   other formulas:
 (@GrossProfit, @QUOTA, etc.).
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The Formula Editor is used to combine these components into working 
formulas. The Formula Editor allows you to type the components into the 
formula directly, or, in the case of fields, functions, operators, group field 
values, and other formulas, to select them from lists of those items that are 
available.

The Formula Editor requires you to enter the various components 
according to a specific set of rules called syntax, such rules as:

●   text enclosed in quotation marks,

●   arguments enclosed in parentheses (where applicable),

●   referenced formulas identified with a leading @ sign,

●   and so on.

The Formula Editor checks the syntax and helps you debug (fix) 
problems before you enter the formula into the report. 

The Formula Editor combines elements to create a working formula. The 
three drop-down lists at the top of the Formula Editor contain the 
primary formula components.

Formula Editor 
Toolbar

The formula editor toolbar enables you to access many popular options 
with the click of a button or a selection from a drop-down list. 

One drop-down list is available on the toolbar.
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Use this drop-down list to select a formula to create for the report you are 
currently working on.

The buttons on the Formula Editor toolbar perform the following 
functions: 

Creates a new formula.

Saves the formula.

Saves the formula and closes the Formula Editor.

Tests the syntax of the formula for errors.

Undoes an action.

Repeats an action.

Views the data in that data field.

Finds/Replaces.

Bookmarks the current line of the selected formula or 
removes the bookmark from the current line.

Jumps to the next bookmark.

Jumps to the previous bookmark.

Clears all bookmarks.

Arranges directories alphabetically in the field, function, 
and operator trees.
298 Seagate Crystal Reports User’s Guide



NOTE: The Formula Editor has drag-and-drop capability.

NOTE: The Options dialog box (File menu) allows you to change the font 
size and the background/foreground color of text, comments, and 
keywords in the Formula Editor.

Formula Editor 
Key Controls

The Formula Editor accepts the following key controls:

Hides or views the Field Tree.

Hides or views the Function Tree.

Hides or views the Operator Tree.

Keyboard 
Combination Action Preformed

Alt-T Shows toolbar (when it has been closed).

Ctrl-A Selects all.

Ctrl-C Copies.

Ctrl-End Goes to the end of the last line of the formula.

Ctrl-F Opens the Find dialog box (same as clicking the 
find button).

Ctrl-F2 Sets bookmark.

Ctrl-F3 Finds Next (based on the last search performed 
using the Find/Replace function).

Ctrl-Home Goes to the beginning of file.

Ctrl-Left 
Arrow

Goes to the beginning of the left work (+Shift key 
will do the selection).

Ctrl-M Sets focus to formula name combination box.

Ctrl-N Creates a new formula.

Ctrl-Right 
Arrow

Changes focus to next control box (reverse order of 
Ctrl-Tab).

Ctrl-S Saves and closes formula.

Ctrl-Shift-
Tab

Changes focus to next control box (reverse order of 
Ctrl-Tab).

Ctrl-Tab Changes focus to next control box.

Ctrl-V Pastes.
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Bookmarks Bookmarks make it easy to navigate through long formulas, allowing you 
to write and edit complex formulas efficiently. For example, bookmarks 
can be used to mark:

●   frequently edited parts of a formula, so you can find them easily 
when you want to revise the formula;

●   major sections of a formula, so you can quickly navigate through 
long formulas; and

●   the beginning of each new if-then statement, so you can easily 
jump to the next if-then statement.

As an example, consider a long formula that calculates a salesperson’s 
salary based on a minimum base pay value from a database, a variable 
related to length of service, a formula that calculates commission based on 
sales, and other considerations. Imagine that this formula is quite lengthy, 
contains multiple if-then statements, and includes frequent comments. 
Each time you edit this formula, you might have to spend time to 
reacquaint yourself with its structure. However, if you use bookmarks to 
mark key sections in your formula, you can quickly jump to the important 
parts.

HOW TO USE BOOKMARKS IN A FORMULA

You can place bookmarks on formulas that you create or edit in the 
Formula Editor and the Format Formula Editor.

1 To place a bookmark, position the insertion point in the line of text 
which you want to mark with a bookmark.

2 Click the TOGGLE BOOKMARK button on the Formula Editor toolbar. 
A blue dot appears in the gray column left of the text line, indicating 
that the line is now bookmarked.

3 Repeat Steps 1 and 2 for each bookmark you want to place.

Ctrl-X Cuts.

Ctrl-Z Undoes an action.

Ctrl-Shift-Z Redoes an action.

End Goes to end of line.

Enter Copies a selected object from a tree to the formula 
text box.

F2 Goes to next bookmark.

Keyboard 
Combination Action Preformed
300 Seagate Crystal Reports User’s Guide



Once bookmarks are placed on a formula, you can quickly jump between 
bookmarks by using buttons on the Formula Editor toolbar. Click the 
Next Bookmark and Previous Bookmark buttons to jump to the next and 
previous bookmark, respectively. When you click these buttons, the 
insertion point moves to the beginning of the line marked by the next or 
previous bookmark.

You can easily delete bookmarks that you don’t need. Simply position the 
insertion point in the line of text which is marked with a bookmark and 
click the Toggle Bookmark button. The blue dot disappears from the gray 
column left of the text line, indicating that the line is not bookmarked. To 
remove all bookmarks from your formula, click the Clear All Bookmarks 
button on the Formula Editor toolbar.

Fields tree The Fields tree contains all the fields you can use as formula arguments.

NOTE: The Fields tree is resizable. It is also dockable; you can right-click 
within the tree to toggle the dockable property on/off. You can also right-
click and choose Hide from the shortcut menu to hide the tree box.

HOW TO INSERT FIELDS INTO A FORMULA

Fields can be inserted into a formula in two ways:

1. by placing the I-beam cursor where you want the field to appear in 
the Formula text box of the Formula Editor, setting the insertion point 
and then double-clicking the desired field in the Fields tree, or

2. by placing the I-beam cursor where you want the field to appear in 
the Formula text box and then typing it in manually.

NOTE: Be sure to review the correct syntax for using fields in your 
formulas. If you fail to include the file name, include the separating 
period, or surround the field in braces, the program will generate a 
Formula Compiler Error message detailing your error. See Formula syntax, 
Page 306, and search for Error Messages and Formula Compiler Warnings in 
Seagate Crystal Reports online Help.

Fields already used in the report.

Formulas used/defined in the report.

All active database fields.

Parameter fields used/defined in the 
report.
Introduction to Formulas 301



Functions tree The Functions tree lists the dozens of functions that are included with 
Seagate Crystal Reports. These functions are prebuilt procedures that 
return values. They perform such calculations as average, sum, count, etc. 
All functions available are listed with their arguments and are arranged 
by their use.

NOTE: The Functions tree is resizable. It is also dockable; you can right-
click within the tree to toggle the dockable property on/off. You can also 
right-click and choose Hide from the shortcut menu to hide the tree box.

 HOW TO INSERT FUNCTIONS INTO A FORMULA

Functions can be inserted into a formula in the same manner as fields:

●   via the Functions tree, or

●   by typing them in manually.

See HOW TO INSERT FIELDS INTO A FORMULA, Page 301.

NOTE: Be sure to review the correct syntax for using functions in your 
formula. If a function has required arguments, all arguments must be 
entered. If any required arguments are not entered, the program will 
generate a Formula Compiler Error message detailing the error. See 
Formula syntax, Page 306, and search for Error Messages and Formula 
Compiler Warnings in Seagate Crystal Reports online Help.

Operators tree The Operators tree lists the “action verbs” you can use in your formulas. 
Operators include such things as + (add), / (divide), -x (negate), etc. 
Search for Operators and Variables in Seagate Crystal Reports online Help.

Function name.

Arguments you must 
supply.

Models showing how operators are used.

Operator names.
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NOTE: The Operators tree is resizable. It is also dockable; you can right-
click within the tree to toggle the dockable property on/off. You can also 
right-click and choose Hide from the shortcut menu to hide the tree box.

HOW TO INSERT OPERATORS INTO A FORMULA

Operators can be inserted into formulas in the same manner as fields and 
functions:

●   via the Operators tree, or

●   by typing them in manually.

See HOW TO INSERT FIELDS INTO A FORMULA, Page 301.

Formula 
text box

The Formula text box is where you actually enter the formula.

You can:

●   use the keyboard to enter the formula manually,

●   choose the formula components from the Fields, Functions, and 
Operators trees, or

●   combine the two methods, choosing some of the components from 
the list boxes and entering other parts of the formula manually.

HOW TO INSERT TEXT AND NUMBERS INTO A FORMULA

Insert text and numbers into formulas by typing them directly into the 
Formula text box of the Formula Editor. You can also click the Browse Field 
Data button, highlight the value you want to insert from the list that 
appears, and select Paste to paste the value into your formula. See HOW 
TO INSERT FIELDS INTO A FORMULA, Page 301.

NOTE: Be sure to review the correct syntax for text and numbers in 
formulas. See Formula syntax, Page 306.

HOW TO SEARCH AND REPLACE IN THE FORMULA EDITOR

Click the FIND/REPLACE button to open a Find dialog box. From this 
dialog box, you can search and replace text within the Formula text box. 
Click the MARK ALL button to mark all occurrences of the search text. 
Click the REPLACE ALL button to replace all occurrences of the search text 
with the contents of the Replace with text box.
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You can also search (but not replace) within any of the Formula Editor 
trees (use the Search options to specify which tree boxes you are 
searching). The MARK ALL, REPLACE, and REPLACE ALL buttons become 
inactive when you specify a search within a tree box.

Other formula conventions

The following is a description of the remaining elements available for use 
in assembling a formula.

Other formulas Just as you can insert fields into formulas, you can also insert other 
formulas within formulas. Seagate Crystal Reports performs the 
calculations in the inserted formula, and then uses the value returned by 
the referenced formula in the same way it uses any other value.

For example, the formula:

1*(2+4*6/3-7*12-8) +2*(2+4*6/3-7*12-8) +3*(2+4*6/
3-7*12-8) +4*(2+4*6/3-7*12-8)= -820

includes the expression (2+4*6/3-7*12-8) repeated many times.

If you create a formula for the repeated expression (@F = (2+4*6/3-7*12-
8)) and then reference that formula instead of entering the expression 
itself, you will get the same result.

1*{@F}+2*{@F}+3*{@F}+4*{@F} = -820

Every time the program sees the formula @F, it performs the @F 
calculation and returns the value -82, just as the expression underlying 
the formula (2+4*6/3-7*12-8) returns the value -82. See How formulas are 
evaluated - order of precedence, Page 309.

HOW TO INSERT FORMULAS INTO OTHER FORMULAS

Formulas can be inserted into other formulas in the same manner as you 
did other fields:

●   via the Fields tree, or

●   by typing them in manually.

See HOW TO INSERT FIELDS INTO A FORMULA, Page 301.

NOTE: Be sure to review the correct syntax for using formula fields in 
your formula. See Formula syntax, Page 306.

Group field 
values

Group field values are values that summarize a group (a group subtotal, 
a group average, etc.). You can use them in formulas for a variety of 
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purposes. For example, you could use group field values to find the 
percentage of the grand total contributed by each group. For instance, 
you may want to know what percentage of the $2,300,000 U.S. sales figure 
the Western Region generated.

HOW TO INSERT GROUP FIELD VALUES INTO FORMULAS 

Group field values can be inserted into formulas in the same way you 
inserted other fields:

●   via the Fields tree, or

●   by typing them in manually.

NOTE: Due to the syntax complexity of some group fields, it is 
recommended that you enter group fields by selecting them from the 
Fields tree instead of manually typing them in. See Formula syntax, Page 
306.

Formula 
comments

Formula comments are notes included with a formula to explain its 
design and operation.

Comments do not print and they do not affect the formula, but they 
appear in the Formula Editor. It is always a good idea to include 
comments with complex formulas for other users of your reports, 
especially those formulas that will be used again and again.

HOW TO INSERT COMMENTS INTO FORMULAS

Type your comments into the Formula text box in the Formula Editor. A 
comment must be preceded by two slashes (//). The comment can be 
above or below the formula, or it can even follow the formula on the same 
line. 

Any of the following three placements are acceptable:

//This is an acceptable
//position for a comment.
//Note that when you force the line break, 
//you have to begin each new line 
//with double slashes. These comments
//refer to the formula below.

If {orders.ORDER AMOUNT} in (100.00 to 250.00) Then
.10 * {orders.ORDER AMOUNT}

Else
0

//This is also an acceptable comment position
//for detailing the formula above.
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If {orders.ORDER AMOUNT} > 10.00 Then
“” //This position is also acceptable.

Else
“Flag”

Formula 
comment 
considerations

The following are considerations when including comments with 
formulas:

●   The proper syntax for a comment is two forward slashes (//) 
followed by the comment. When the program sees the two slashes, 
it realizes that the text that follows for the rest of the line is 
comment only and not to be evaluated as part of the formula itself.

●   Seagate Crystal Reports treats everything that follows the slashes 
on the same line as a comment.

●   If a comment is long and automatically wraps to the next line, no 
additional slashes are necessary; the program treats it as one 
continuous comment.

●   If the Enter key is used to break the comment into two or more 
lines, each new line must begin with two slashes. If each new line 
does not begin with two slashes (//), the program treats each 
unslashed line as part of the formula itself and displays an error 
message when you check the formula syntax.

Formula syntax

Seagate Crystal Reports requires the various components of a formula to 
be entered according to a specific set of rules called syntax. Learning and 
perfecting syntax, like the grammar of any language, takes practice. 
Formula components must be written in a specific way and entered in 
specific order. The program uses syntax items (quotation marks, brackets, 
parentheses, etc.) to identify the various formula components, so it is very 
important that you stick to the rules in order for the program to recognize 
your formulas as well as have them work as you plan.

The various components of formulas, and their syntax, are listed below:

Text “Text” or ’Text’

When using text in formulas, it must be enclosed within single (’) or 
double (”) quotes. Whatever text is within those quotes will be printed. If 
your text includes an apostrophe, you must use double quotes.
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CORRECT

“Last Year’s Sales”

INCORRECT

’Last Year’s Sales”

Numbers 23134.7

When using numbers in formulas, they must be entered without any 
comma separators or currency symbols.

Fields {table.FIELD}

When using fields in formulas, they must be enclosed within French 
braces { }. Enter the table name to identify which database table you are 
referring to, followed by a period and then enter the field name within 
that table.

EXAMPLE

{customer.REGION}

This identifies the Region field from the Customer table.

Operators 1+1 

When using operators in formulas, you simply type in the operator where 
desired. You may place a space before and after the operator if you desire, 
but it is not required (i.e., 1 + 1).

Functions FunctionName(x)

When using functions in formulas, you simply type the function and 
supply the arguments (if any) as specified in the parentheses. For example, 
the Average (x) function requires a field or formula as its (x) argument. 

EXAMPLE

Average({order.AMOUNT})

This formula will calculate the average of all values in the Amount field. 

Brackets in 
formulas

Seagate Crystal Reports uses three different types of brackets in formulas. 
Each one has a specific purpose and can be used only with certain 
formula elements.

●   { } are called French braces and are placed around database, 
formula, and parameter fields:
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{customer.REGION}, {@sum}, {?Region}

●   [ ] are called Square brackets and are placed around the Subscript 
or Array Operator: 

{customer.CUSTOMER NAME} [1]

●   ( ) are called Parentheses and are placed around the arguments of a 
function:

Round(x, # places), Abs(x)

NOTE: Parentheses can also be used to control the order in which the 
formula elements are evaluated. See How formulas are evaluated - order of 
precedence, Page 309.

HINT: Here is a useful way to remember when to use different types of 
brackets:

●  French { } = Fields

●  Square [ ] = Subscript (and Array)

●  Parentheses ( ) = Parameters

Whether the formula is entered manually or by selecting formula 
components from the component list boxes, the correct syntax must be 
used in order for the formula to work.

When you double-click this Sum 
function, the program enters the 
function and required syntax items.

Commas between
arguments

Quotes for
arguments

Parentheses

Sums the values in the
Order Amount field...

...whenever the
date changes...

...from one week
to the next.
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How formulas are evaluated - order of precedence

When you are creating formulas that contain different types of operators, 
it is important to consider the order by which the program evaluates the 
separate elements of your formula. This order is called order of 
precedence.

Simple order of precedence follows basic math rules of precedence. 
Multiplication and division are performed first, from left to right; then 
addition and subtraction are performed. For example:

5 + 10 * 3 = 35

The multiplication 10 * 3 is performed first to get 30. Then, 30 is added to 
5 to arrive at the final answer, 35.

Now, if your intention is to add 5 to 10 and then multiply the sum by 3, 
you have to modify the order of precedence by using parentheses. You 
can do that as follows:

 (5 + 10) * 3 = 45

It is clear that parentheses have a higher precedence than the add, 
subtract, multiply, and divide operators. They redirect the order of 
calculation.

NOTE: When a formula contains other formulas such as:

@Extension * 107.5%

the program first evaluates the embedded formula, @Extension, following 
order of precedence rules and then evaluates the rest of the primary 
formula.

HANDS-ON (Formulas)

How to insert a formula into a report

1 Click the INSERT FIELDS button on the standard toolbar. The Insert 
Fields dialog box appears with the Database Tab active. Click the 
Formula Tab to activate it.
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The Formula Name dialog box appears. 

The Formula Editor appears. 

2 Click New.

3 Type a name to identify 
the formula.

4 Click OK when finished.

5 Enter the formula by typing in the components or 
selecting them from the trees.
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6 When finished, click the CHECK button to check the syntax in the 
formula, then fix any syntax errors the Formula Checker identifies.

7 When the formula has the correct syntax, click the SAVE AND CLOSE 
button to return to the Insert Fields dialog box. Your formula appears 
in the Formula Name list box.

NOTE: When you click either the SAVE or SAVE AND CLOSE button, 
Seagate Crystal Reports automatically checks the syntax of the formula 
before allowing you to place it in the report.

8 Highlight the formula and click the INSERT button to place the 
formula in the report.

9 When the cursor is placed over the report, an object frame appears. 
Click once to set the field in the desired position.

How to delete formulas from a report 

When a formula is created and added to a report, Seagate Crystal Reports:

●   stores the specification for creating the formula, using the name 
you assigned to it, and

●   places a working copy of that formula at the point you specify in 
the report. A working copy is any occurrence of the formula in the 
report.

In order to delete formulas, you must delete the specification and all 
working copies of the formula.

NOTE: You can not delete the specification without deleting all working 
copies of the formula.

Deleting 
individual 
working copies 
of a formula

1 Select the formula copy you want to delete from the report.

2 Press the Delete key.

NOTE: Even after all of the working copies of a formula have been 
deleted from the report, the formula specification remains unchanged. 
The specification is listed in the Formula Tab of the Insert Fields dialog 
box, and it is available for immediate use should you wish to enter the 
formula in the report again. Search for Insert Fields dialog box in Seagate 
Crystal Reports online Help.
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Deleting the 
formula 
specification 

NOTE: This step can only be completed after you have deleted all 
working copies of the formula from your report.

1 Once you have deleted all working copies of the formula, click the 
INSERT FIELDS button on the standard toolbar. The Insert Fields 
dialog box appears with the Database Tab active. 

2 Click the Formula Tab to activate it.

3 Highlight the formula specification you want to delete in the Formula 
name list.

4 Click the DELETE button, and the program deletes the formula 
specification.

NOTE: If the formula is being used in another formula the program will 
delete the specification nonetheless.

NOTE: If you have not deleted all working copies of the selected formula, 
the program displays the message: Formula Name in use. It can not be 
deleted.

How to copy formulas from online Help

Windows allows you to copy text from online Help topics to the 
Clipboard. You can then paste this text wherever it is needed. Since the 
formulas you develop using the Formula Editor are simply text, you can 
save yourself a lot of time by copying useful formulas directly into the 
Formula Editor and then modifying them to fit your needs.

1 With the Formula Editor open, activate the online Help in any of the 
standard ways (Help menu, F1 function key, etc.).

2 Regardless of the topic that first appears, use the Search or Find 
facility to locate the topic that contains the formula of interest.

3 Scroll through the topic until you locate the formula you want to 
copy.

4 Highlight the formula by dragging the I-beam cursor over it, and 
then choose the COPY command from the Edit menu or press Ctrl-C. 
Windows puts a copy of the selected text on the Clipboard.

5 Place the insertion point where you want the text to appear in the 
Formula text box of the Formula Editor and press Ctrl-V to paste the 
text from the Clipboard.

6 Modify the formula by changing the fields, formulas, group fields, 
conditional statements, and text strings as necessary for use with the 
data in the new report.
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How to copy formulas from one report to another

You may find yourself wanting to copy a formula created in one report 
for use in another report. Copying formulas from one report to another is 
a simple procedure, but it requires careful attention to detail.

Since formulas are stored as text, it is a simple matter to copy the text 
formula from one report to another via the Clipboard. 

1 Select the formula field you want to copy in the report.

2 Choose the COPY command from the Edit menu or press Ctrl-C.

3 Open the report you want to copy the formula to.

4 Choose the PASTE command from the Edit menu or press Ctrl-V.

5 When the program displays the object frame, drag the formula to the 
new location.

6 Change the fields, formulas, group fields, conditional statements, 
and text strings (if necessary) for use with the data in this report.

To make these changes, right-click the formula and choose EDIT 
FORMULA from the shortcut menu. The Formula Editor appears.

7 Delete the old values and type in the new values, or select them from 
the Fields, Functions, and/or Operators trees. When making changes, 
use the following points as a guide:

●   All fields, formulas and group fields referenced in the formula 
copy must actually exist in the new report. This means that any 
database referenced in the original formula (or a database with the 
same structure, field names, and alias) must be active in the new 
report.

   If such a database is not active, you must change the field, 
formula, and group field references in the formula copy to 
correspond to elements in your new report.

●   If the formula contains conditional elements, make certain that the 
conditions apply to the data in the new report. For example, if the 
formula in your old report performed an action when the quantity 
was greater than 100, make sure that the greater than 100 
condition makes sense in the new formula. When modifying a 
formula, you may find that greater than 10 or greater than 2000 
makes more sense with your new data.

●   If you are using the formula with new data, and if your report 
contains statements similar to the following: 
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If {file.FIELD} = “text string”

Make sure that the text strings used in the formula match values 
that actually exist in the new data.

8 Click the SAVE AND CLOSE button when finished.

Related Topics

HOW TO INSERT FIELDS INTO A FORMULA, Page 301

HOW TO INSERT FUNCTIONS INTO A FORMULA, Page 302

HOW TO INSERT OPERATORS INTO A FORMULA, Page 303
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14 Advanced Formulas

What you will find in this chapter...

How to create If-Then-Else formulas, Page 316

How to print Time or dateTime values conditionally, Page 317

How to create multi-condition If-Then-Else formulas, Page 317

How to format text with formulas, Page 318

How to use variables in formulas, Page 319

How to declare a variable, Page 322

How to assign a value to a variable, Page 323

How to combine a variable declaration and assignment expression, Page 325

How to declare and assign values to multiple variables, Page 325

How to conditionally assign values to variables, Page 325

How to use an array in a formula, Page 326

How to use a range in a formula, Page 328

How to use semicolons in formulas, Page 331

How to fine-tune group selection formulas, Page 331

How to fine-tune record selection formulas, Page 333

How to debug a formula, Page 336
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How to create If-Then-Else formulas

If-Then-Else formulas are conditional formulas: if a condition is met, then 
a certain consequence (an action) takes place. If the condition is not met, 
then a different action takes place. If-Then-Else formulas are created 
using the If-Then-Else operator. Search for If-Then-Else in Seagate Crystal 
Reports online Help.

Examples ●   If a sales representative has already earned the maximum 
allowable bonus, print the amount of the maximum bonus 
allowed; if he has not yet earned the maximum, calculate the 
bonus actually earned and print it.

●   If the value in the title field is “Mr.”, print “Dear Mr.” as the 
beginning of the salutation; if it is not “Mr.”, print “Dear Ms.” as 
the salutation.

●   If the quantity on hand of a certain part is greater than or equal to 
the reorder amount, reorder according to the reorder instructions; 
if the quantity is less than the reorder amount, do nothing.

These are just a few of the kinds of conditional formulas you can create 
using the If-Then-Else operator.

When using the If-Then-Else operator, remember that there must be three 
separate elements to any If-Then-Else formula:

1. If 
This portion sets the condition.

2. Then 
This portion sets the action that takes place when the If condition is 
met.

3. Else 
This portion sets the action that takes place when the If condition is 
not met.

NOTE: The data types (text, number, currency, date, time, dateTime, or 
Boolean) for the Then and Else parts of the formula must be the same. 

Thus, if the action that takes place when the condition is met (Then) is to 
print a text string, the action that takes place when the condition is not 
met (Else) must also be to print a text string, even if that text string is 
empty. For example:
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If {file.FIELD} = 5 Then
“Text String”

Else
“Another Text String”

OR

If {file.FIELD} = 5 Then
0

Else
1

NOTE: If-Then-Else formulas that use a Time or dateTime data type as a 
Then action and a null or empty Time or dateTime as an Else action can 
not be created because there are no null or empty values for those data 
types. However, Time or dateTime values can be printed conditionally. 
See How to print Time or dateTime values conditionally, Page 317.

How to print Time or dateTime values conditionally

To print Time or dateTime values conditionally (print a field if the condition 
is met, print a field in another color if the condition is met, etc.), you can not 
do it using an If-Then-Else formula because there is no such thing as an 
empty or null value for the Time or dateTime data type. Instead, you insert 
the field itself in the report and set its Suppress property conditionally.

1 Place the dateTime field where you want it to print on the report.

2 Select the field and click the OBJECT PROPERTIES button on the 
supplementary toolbar. The Format Editor appears.

3 Click the Common Tab to activate it. 

4 Click the FORMULA button to the right of the Suppress property.

5 Type the following formula into the Formula Editor when it appears.

{employee.LAST NAME} <> “Fuller” 

Now when you run the report, the program will print the dateTime field 
whenever the employee last name is Fuller and it will suppress the field 
when the last name is anything but Fuller.

How to create multi-condition If-Then-Else formulas

The If-Then-Else operator can be used to create powerful multi-condition 
formulas.
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Multi-condition and nested If-Then-Else formulas can be set up in this 
general pattern: 

●   If the X (first) condition is met, Then, go to the Y (second) 
condition. 

●   If the Y condition is met, Then perform the Y action.

●   If the Y condition is not met (Else), perform the Y alternative. 

●   If the X condition is not met (Else), perform the X alternative. Thus:

If {file.FIELD1} = “X” Then 
If {file.FIELD2} = “Y” Then 

“Y Action” 
Else 

“Y Alternative” 
Else 

“X Alternative”

See How to create If-Then-Else formulas, Page 316.

This formula checks the field FIELD1 first. 

●   If the value of that field is “X,” the FIELD2 field is checked. 

   If the value of that field is “Y,” then “Y Action” is printed. 

   If the value of FIELD2 is not “Y,” then “Y Alternative” is 
printed.

●   If the value of FIELD1 is not “X,” then “X Alternative” is printed.

While multi-condition formulas look complex at first, after you have 
worked through one or two you will find that they are not as intimidating 
as they seem, especially considering their usefulness.

How to format text with formulas

You can use formulas to format text. For instance, functions are included 
with the program for removing unnecessary leading or trailing spaces 
from text stings as well as converting text entirely to upper or lower case. 

Examples TrimLeft(“   Al/4520/B12”)

«Returns “A1/4520/B12”.»

TrimRight(“A1/4250/B12   ")

«Returns “A1/4250/B12”.»
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LowerCase(“Ronald Black”)

«Returns “ronald black”.»

Related Topics

Formatting, Page 209

How to use variables in formulas

Variables can be used to solve many formula problems, but they have two 
primary uses:

1. streamlining formulas, and

2. expanding formula capabilities.

Unlike a constant value, which is fixed and unchanging, a variable can be 
repeatedly assigned different values. You assign a value to a variable and 
the variable maintains the value until you later assign a new value. Then 
the variable maintains the new value until you later assign yet another 
new value, and so on.

Using variables 
to streamline 
formulas

With variables, you can write formulas much more efficiently than you 
can without them. For example, to evaluate the {customer.FAX} field to 
determine if the area code is for Washington state (206, 360, 509) or British 
Columbia, Canada (604, 250), without the benefit of variables, you must 
write a formula similar to the following: 

If {customer.FAX}[1 to 3] = “604” or
{customer.FAX}[1 to 3] = “250”

Then
“BC”

Else
If {customer.FAX}[1 to 3] = “206” or
{customer.FAX}[1 to 3] = “509” or
{customer.FAX}[1 to 3] = “360” Then

“WA”
Else

“”

See How to create If-Then-Else formulas, Page 316, and search for Subscript in 
Seagate Crystal Reports online Help.

You have to write out the instructions for extracting the area code from 
the telephone number field ({customer.FAX} [1 to 3]) every time you want 
the formula to use the area code from the current record.
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By using a variable (for example, AreaCode), you write those instructions 
only one time. Using those instructions, the program automatically 
extracts the area code from the {customer.FAX} field, and stores it in the 
variable each time it reads a new record. You simply reference the 
variable AreaCode whenever you want to use the area code from the 
current record in your formula. Here's an example of the same formula, 
this time using the AreaCode variable:

StringVar AreaCode:={customer.FAX}[1 to 3];
If AreaCode = “604” or AreaCode = “250”
Then

“BC”
Else If AreaCode = “206” or AreaCode = “509” Then

“WA”
Else

“”

Not only does the streamlined version take less time to write, but it takes 
less time to process as well, so your report prints more quickly.

Using variables 
to expand 
formula 
capabilities

Besides their ability to streamline formulas, variables allow you to 
expand your formula writing capabilities. Before discussing the specifics 
of using variables in formulas, it is important to understand how the 
Formula Editor reads formulas.

SPECIAL REQUIREMENTS FOR USING VARIABLES IN 
FORMULAS

In the discussion thus far, formula requirements have been narrowly 
defined:

●   a given operator only works in certain situations and with certain 
kinds of text and/or data,

●   a function only works with a specific number of arguments, and 
each argument must be a specific data type, and

●   If-Then-Else formulas work only if the data type of the Else part of 
the formula matches the data type of the Then part.

Such narrow definitions allow you to create formulas, in many cases, 
simply by filling in the blanks, with the formula checker pointing out any 
mistakes you make.

Variables, however, are not so narrowly defined. They are extremely 
flexible; you make them what you want them to be. You create them at 
will, and include them in formulas as needed.

Because of this flexibility, it is necessary for you to define the variables 
before using them so that the program:
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●   is aware of them,

●   understands how you intend to use them, and

●   can set up the memory space they require.

You also need to assign values to the variables so the program knows 
what values they are to return.

Seagate Crystal Reports knows only what you tell it about the variables. 
The fail-safe formula-checker routines that work automatically with the 
other formula elements work with variables only after you define them.

To use a variable in a formula, you must do three things:

1. declare the variable,

2. set the value of the variable, and

3. enter the variable in the formula.

Declaring the 
variable

Seagate Crystal Reports requires you to declare all variables prior to 
using them. When you declare a variable, you tell the program:

●   the name you intend to use for the variable, and

●   the type of data you want the variable to contain.

The program uses this information to set aside memory for receiving and 
storing the values that are assigned to the variable.

NOTE: If you declare a variable with the same name and data type in two 
or more formulas, then the formulas share the same variable. Thus, if one 
formula sets the value of the variable, the variable in the second (and 
additional formulas) reflects the change.

Naming the 
variable

You can name the variable anything you wish with the following 
qualifications:

●   the variable name must not exceed 254 characters, and

●   it can not have the same name as an operator or a built-in function. 
Search for Functions and Operators and Variables in Seagate Crystal 
Reports online Help.

NOTE: As a general rule, you are probably better off if you keep the 
variable name short, easy to remember, and unique (not so close to the 
name of another variable as to cause confusion).

Variable data 
types

The data type of a variable determines the type of data that can be stored 
as a value in that variable. You can create a variable with one of seven 
data types:
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1. number (100000)

2. currency ($30,000.00)

3. Boolean (TRUE)

4. date (January 1, 1996)

5. string (’Hello’)

6. time (11:59:01)

7. dateTime (96/12/31 11:59:59 P.M.)

How to declare a variable

You must declare a variable at the beginning of the formula that uses the 
variable.

NOTE: Variables can not be declared globally. If you are using a variable 
that was declared in another formula, you must declare it again. 

NOTE: If you declare a variable with the same name and data type in two 
or more formulas, the formulas share the same variable. Thus, if one 
formula sets the value of the variable, the variable in the second (and 
additional formulas) reflects the change.

To declare a variable you must enter:

●   the data type and the variable name,

●   followed by a semicolon to mark the end of the declaration.

For example, to declare a number variable named Amount, enter the 
following declaration statement:

NumberVar Amount;

To declare a Boolean variable named Outstanding, enter the following 
declaration statement:

BooleanVar Outstanding;

To declare more than one variable, you can list them. Each variable is 
separated by a semicolon. For example:

NumberVar Amount;
BooleanVar Outstanding;
DateVar MonthEnd;

The program uses your declaration statement to set aside a block of 
memory that holds each of the variable values and assigns a default value 
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to each memory block. The default value assigned depends on the data 
type you declare for the variable. The default values assigned are as 
follows:

How to assign a value to a variable

You assign a value to a variable using an assignment statement. The 
assignment statement consists of:

●   the variable name, 

●   the assignment operator, and

●   the value you want assigned to the variable.

Variable name The variable name is the name used to declare the variable.

Assignment 
operator

The assignment operator is a colon followed by an equals sign (:=). Search 
for Assignment operator in Seagate Crystal Reports online Help.

Variable value The variable value can be any value that matches the data type of the 
variable. For example, you can assign a number to a number variable. You 
can also assign an expression that results in a number or even a sequence 
of expressions. For a string variable you could assign a character, a word, a 
sentence, or an expression that results in a string. A variable value can be a 
constant, an expression, or a sequence of expressions.

EXAMPLE ASSIGNMENT STATEMENTS

Following are the assignment statements for assigning different kinds of 
values to variables:

Data type To Default value

number NumberVar 0

currency CurrencyVar 0

Boolean BooleanVar False (No, 0)

date DateVar date (0, 0, 0)

string StringVar empty string (“”)

dateTime DateTimeVar No default1

time TimeVar No default1

1 Since Time (00:00:00) is midnight, you can not use 00:00:00 as a 
default time or as part of a default dateTime either. Thus, a default is 
not assigned here.
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Amount:= 0

«Assigns (initializes) the variable Amount to zero.»

Amount:= 100

«Assigns the value 100 to the variable Amount.»

Amount:= Amount + {orders detail.QUANTITY}

«Assigns the result of a calculation to the variable Amount. The 
calculation adds the value of the quantity field ({orders 
detail.QUANTITY}) to the current value of the Amount variable. 

Amount:= {file.QUANTITY1} + {file.QUANTITY2} + 
{file.QUANTITY3}

«Adds the three quantity fields and assigns the result to the variable 
Amount.»

Customer:= “Westside Motors”

«Assigns the string “Westside Motors” to the variable Customer.»

Customer:= {customer.FIRST NAME} + {customer.LAST 
NAME}

«Adds (concatenates) two string fields and assigns the concatenated 
value to the variable Customer.»

Customer:= TrimRight({customer.FIRST NAME}) + 
{customer.LAST NAME}

«Trims the trailing blanks from the First Name field ({customer.FIRST 
NAME}), concatenates that field to the Last Name field 
({customer.LAST NAME}), and assigns the concatenated value to the 
variable Customer.»

Customer:= “Mr. “ + {customer.LAST NAME}

«Concatenates the string “Mr. “ with the value of the Last Name field 
{customer.LAST NAME}, and assigns the concatenated value to the 
variable Customer.»

Amount:= 100; 
Customer:= “Westside Motors”;

«Assigns the constant 100 to the number variable named Amount, 
and assigns the string “Westside Motors” to the variable Customer. 
You can assign values to multiple variables by separating the 
assignment statements with semicolons.»
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How to combine a variable declaration and assignment 
expression 

For efficiency, you can declare a variable and assign it a value in a single 
line of formula code. To do this, simply declare the variable, allow a blank 
space, enter the assignment operator, and then assign the value. 

For example, to declare a currency variable SellPrice and assign the value 
of the Cost field ({product.PRICE (SRP)}) times two (a 100% markup), use 
the following expression:

CurrencyVar SellPrice:={product.PRICE(SRP)} * 2;

To declare a Boolean variable OverQuota and assign the result of the 
comparison {file.SALES}>{file.QUOTA}, use the following expression:

BooleanVar OverQuota:= {file.SALES}>{file.QUOTA};

How to declare and assign values to multiple variables

There may be times when you want to declare multiple variables and 
assign values to each of them. To do this in the most efficient manner, 
simply chain the declaration/assignment expressions together, 
separating them with semicolons. 

For example, to declare two variables (a number variable Quantity, and a 
currency variable SellPrice) and then assign values to each variable (the 
number 5 to the variable Quantity, and {file.COST} * 2 to the variable 
SellPrice), use expressions similar to the following:

NumberVar Quantity:= 5;
CurrencyVar SellPrice:= {file.COST} * 2;

How to conditionally assign values to variables 

Seagate Crystal Reports formula language gives you the ability to assign 
different values to variables based on whether or not conditions are met. 
Consider the following formula:

NumberVar Total;
NumberVar Result;

Total:= Total + {invoices.ITEM TOTAL};
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If Next ({invoices.CUST#})<>{invoices.CUST#} Then
(Result:= Total; Total:= 0)

Else
Result:= 0;

Result;

The If-Then-Else part of this formula says that when the If condition is 
met (if the customer numbers [{invoices.CUST#}] are not equal), the 
program is to do two separate things:

1. Assign the value stored in the variable Total (the running total) to the 
variable Result, and

2. Reset the value in the variable Total to 0.

When the If condition is not met (if the customer numbers are equal), the 
program is to assign the value 0 to the variable Result.

How to use an array in a formula

An array is a special type of variable that can hold several values at once. 
The entire array can be passed to a summary function for evaluation, or 
separate elements of the array can be extracted using the Subscript 
operator. Search for Subscript in Seagate Crystal Reports online Help.

A common use for an array is to store the names of the days of the week:

StringVar array Weekdays:= [“Sunday”, “Monday”, 
“Tuesday”, “Wednesday”, “Thursday”, “Friday”, 
“Saturday”];

There are five parts to declaring an array variable:

1. A variable declaration operator specific to the type of data the array 
will hold, StringVar in this example. 

2. The word array follows the variable declaration operator.

3. The name you assign to the array follows the word array - Weekdays 
in this example.

4. The Assignment operator follows the name and is used to assign 
values to the array variable.

5. Square brackets follow the assignment operator and are used to 
enclose the values (elements) stored by the array. Each element is 
separated by a comma. 

Search for Assignment in Seagate Crystal Reports online Help.
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An index value is assigned to each element in the array according to the 
sequence of the elements.

●   The first element is assigned index 1,

●   The second element is assigned index 2, and so on.

To extract an element from the following array in your code:

StringVar array Weekdays:= [“Sunday”, “Monday”, 
“Tuesday”, “Wednesday”, “Thursday”, “Friday”, 
“Saturday”];

use the Subscript operator with the index number for the element you 
want to extract:

Weekdays[5]

«Returns “Thursday”.»

Negative numbers can also be used to extract array elements:

Weekdays[-4]

«Returns “Wednesday”.»

An array of values can be created for any valid data type. However, 
arrays have the following restrictions:

●   All elements must be of the same data type.

●   You must declare the array with one of the variable declaration 
operators.

●   An array is limited to 100 elements.

●   Each element in an array of string values is limited to 254 
characters (the standard limit of any string value in Seagate 
Crystal Reports.

Examine the following examples of array declarations to become more 
familiar with arrays:

NumberVar array x := [1, 10, 44];

CurrencyVar array Cost := [$19.95, $79.50, $110.00, 
$44.79, $223.99];

DateVar array PayDays := [Date(1999, 05, 15), 
Date(1999, 05, 31)];

Arrays can also be used without being assigned to array variables. For 
example:
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[“One”, “Two”, “Three”][2]

«Returns “Two” because it is the second item in the array.»

In some situations, you may wish to use arrays dynamically in this 
fashion. However, most formula situations that require arrays can be 
handled more easily by defining the array as an array variable.

Using arrays 
with summary 
functions

Summary functions accept arrays as parameters without requiring the 
array be declared as a variable. For example:

Average([5, 10, 15]) = 10

Use the square brackets to indicate that an array is being used with the 
function. Search for Summary Functions in Seagate Crystal Reports online 
Help.

A sample 
formula

To better understand how arrays can be used in formulas, examine the 
following sample formula:

StringVar array Weekdays := [“Sunday”, “Monday”, 
“Tuesday”, “Wednesday”, “Thursday”, “Friday”, 
“Saturday”];

Weekdays[DayOfWeek({orders.SHIP DATE})]

«If DayOfWeek is 2, Monday will be returned because it is the second 
item in the array.»

This formula prints the name of the day of the week that each order was 
shipped. First, the Weekdays array is declared and is assigned string 
values for each day of the week. Search for DayOfWeek in Seagate Crystal 
Reports online Help.

Next, the DayOfWeek function evaluates the date stored in the 
{orders.SHIP DATE} field and returns a number representing the day of 
the week (1 for Sunday, 2 for Monday, etc.).

Finally, the Subscript operator is used with the Weekdays array to 
retrieve the name of the day of the week, according to the number 
returned by the DayOfWeek function. The name of the day is then 
returned by the formula and appears in the report. Search for Subscript in 
Seagate Crystal Reports online Help.

How to use a range in a formula

A range is designed to conveniently handle an entire spectrum of values- 
values that fall between a minimum and a maximum value.
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For example, you would declare a number range variable as follows:

NumberVar Range GradeA;

A range variable is declared much like an array:

●   A variable declaration operator appropriate to the type of values 
stored by the range, NumberVar in this example.

●   The word Range follows the variable declaration operator.

●   The name of the range variable follows the word Range - Grade A 
in this example.

●   The Assignment operator, which follows the name, is used to 
assign the range of values which the range variable will store.

Search for Assignment in Seagate Crystal Reports online Help.

To indicate range, type the Make Range operator, followed by a 
minimum and maximum value for the range.

Search for Make Range in Seagate Crystal Reports online Help.

Ranges have two principle uses:

1. To extract a range of values from a list of all possible values, and

2. To extract a range of characters from a string value.

Extracting a 
range of values

Consider the following example:

NumberVar Range GradeA := 90 to 100;
NumberVar Range GradeB := 80 to 89;
NumberVar Range GradeC := 70 to 79;
NumberVar Range GradeD := 60 to 69;

If {student.TEST SCORE} in GradeA Then
“A”

Else If {student.TEST SCORE} in GradeB Then
“B”

Else If {student.TEST SCORE} in GradeC Then
“C”

Else If {student.TEST SCORE} in GradeD Then
“D”

Else
“F”

This formula starts by creating four range variables. Each contains a 
range of possible test scores. Notice that, unlike an array, no brackets are 
used to set off the range of values assigned to each range variable. Only 
the Make Range operator is used, along with the minimum and 
maximum test scores for each range.
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The multiple If-Then-Else statement repeatedly evaluates the value in the 
{student.TEST SCORE} field to determine if it falls within a specific grade 
range. The formula then prints letter grades in the report appropriate to 
the test scores received by each student.

See How to create multi-condition If-Then-Else formulas, Page 317.

Extracting a 
range of 
characters

The following formula demonstrates how to use ranges to extract 
characters from a string value:

StringVar AreaCode := {customer.FAX}[1 to 3];

If AreaCode = “604” Then
“BC”

Else If AreaCode = “206”
or AreaCode = “509” 
or AreaCode = “360” Then
“WA”

Else
“”

This formula creates a variable that holds the first three characters in the 
string value of the {customer.FAX} field. For instance, if the value in 
{customer.FAX} is “6045551234”, then:

{customer.FAX}[1 to 3]

«Returns “604”. Notice that square brackets are used to indicate a 
range of characters in a string (unlike the range of numeric values 
seen in the previous example).»

The variable AreaCode is assigned the value “604”. The multiple If-Then-
Else statement evaluates the value in the AreaCode variable to determine 
in which region the fax number is located.

A range can be applied to a constant string value, as well:

“6045551234”[1 to 3] 

«Returns “604”.»

When referring to characters in a string, negative numbers can also be used:

“abcdef”[-3 to -1]

«Returns “def”.»

NOTE: A range can not be used as an element or as part of an element in 
an array.

See How to create If-Then-Else formulas, Page 316, and search for Subscript in 
Seagate Crystal Reports online Help.
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How to use semicolons in formulas

In a formula with multiple statements, the result of the final statement is 
the result that is returned (gets printed). When you have multiple 
statements in a formula, you must separate the statements using 
semicolons so that the program knows where one statement ends and the 
next begins. Without semicolons, the entire formula is treated as a single 
statement. In a multiple statement formula, this can result in an incorrect 
result or an error message.

How to fine-tune group selection formulas

In some cases, no values will print when using a group selection formula, 
even though there are values that match the selection criteria. Typically, 
in these cases:

●   the group selection formula references another formula, and 

●   the referenced formula is one that calculates the value of each 
group as a percentage of the total value of all groups (i.e., a 
subtotal as a percentage of a grand total).

1 Use xtreme.mdb to create a report that includes the following fields:

{customer.CUSTOMER NAME}
{customer.REGION}
{orders.ORDER ID}
{orders.ORDER AMOUNT}

For each order, the report shows the company that placed the order, 
the state in which that company is located, the order ID number, and 
the amount of the order.

2 Subtotal the {orders.ORDER AMOUNT} field using 
{customer.REGION} as the sort-and-group-by field to see the orders 
coming from each state (the program sorts the data by state and 
calculates a subtotal in the {orders.ORDER AMOUNT} field every 
time the state changes). See How to subtotal grouped data, Page 264.

3 Insert a grand total on the {orders.ORDER AMOUNT} field to see the 
total value of all orders placed.

4 Create a formula (Percent) that calculates each subtotal as a 
percentage of the grand total to see the value of the orders for each 
state group as a percentage of all orders placed. Place the formula in 
the Group Footer section of the report.
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Sum({orders.ORDER AMOUNT}, {customer.REGION}) % 
Sum({orders.ORDER AMOUNT})

5 Reference the formula (@Percent) in a group selection formula that 
selects only those groups for which the percentage (of subtotal to 
grand total) is less than 5% in order to find out which states 
individually contributed less than 5% of total sales:

{@Percent} < 5

When you click the Check or Accept button you will receive the 
following error message: 

This formula can not be used because it must be 
evaluated later.

How to correct 
this problem

The problem can be corrected easily. Instead of using the formula name 
(in this case @Percent) in the group selection formula, enter the formula 
itself (the formula named @Percent). Thus, instead of using the group 
selection formula:

{@percent} < 5

use the group selection formula:

Sum({orders.ORDER AMOUNT}, {customer.REGION}) % 
Sum({orders.ORDER AMOUNT}) < 5

Now when you print, only the states that contributed less than 5% will 
print.

Speeding up the 
process

To speed the process and minimize the chance for mistakes, you can copy 
the formula into the group selection formula using Windows' Copy and 
Paste commands. 

1 Select the formula you want to use in the group selection formula.

2 Choose the FORMULA command from the Edit Menu. The Formula 
Editor appears with the formula in the Formula text box.

3 Copy the formula to the Clipboard using the Copy command (Ctrl-
C).

4 Click the SAVE AND CLOSE button to close the Formula Editor.

5 Choose the GROUP command from the Report|Edit Selection 
Formula Menu. The Formula Editor appears.

6 Paste the formula into the Formula text box using the Paste command 
(Ctrl-V).

Add additional formula elements as needed.
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How to fine-tune record selection formulas

You may encounter a situation in which you create a record selection 
formula (using the RECORD command on the Report|Edit Selection 
Formula Menu), and, while header and footer information prints on your 
report, no detail information appears. The problem is a selection formula 
that is rejecting all records, and this usually occurs because of some 
inadvertent error in the creation of the selection formula.

There are several potential causes of your problem in the selection 
formula:

●   Uppercase/lowercase inconsistencies, Page 333

●   Number in text object not in quotes, Page 334

●   Unwanted spaces appear in selection formula, Page 334

Uppercase/
lowercase 
inconsistencies

Record selection formulas are case sensitive. That is, “Bob” matches only 
with “Bob”. It does not match with “bob”, “BOB”, “BoB”, “bOB”, “boB”, 
or “BOb”. Thus, if your selection formula is set to include only those 
records with “BOB” in the {customer.CONTACT FIRST NAME} field, but 
all the entries in the {customer.CONTACT FIRST NAME} field are mixed 
case (“Bob”, for example), the selection formula will find no matches and 
thus will not print any details for the report.

You can solve this problem by using the UpperCase (str) or LowerCase 
(str) functions in your selection formula to convert field data to a 
consistent case before the program begins its selection. For example, if 
you were using this formula:

{customer.CONTACT FIRST NAME} = “BOB”

you can change the formula to this:

UpperCase({customer.CONTACT FIRST NAME}) = “BOB”

This second formula first converts the value of the {customer.CONTACT 
FIRST NAME} field to upper case characters and then checks to see if the 
value in that field is equal to “BOB”. Using this formula, any instance of 
the three letters “b,” “o,” and “b” will be a match, regardless of case, 
because the case will be converted to uppercase.

You could use the LowerCase function in a similar manner to match with 
“bob.”

Check your selection formula closely and make sure you have the correct 
case for any text you are trying to match. If in doubt, use the UpperCase 
(or LowerCase) function to assure consistency and proper matching.
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Another formula which performs much the same functions is the following:

“BOB” in UpperCase({customer.CONTACT FIRST NAME})

Number in text 
object not in 
quotes

When a number is stored in a text object, it is considered text even though 
it looks like a number. Whenever a value from a text object is used in a 
record selection formula, you must surround the value with single or 
double quotation marks. If your selection formula is set to look for a 
number in a text object and you fail to place the number in quotes in the 
selection formula, the selection formula will find no matches and thus 
will not print any details for the report.

For example, this selection formula

{customer.CUSTOMER ID} = 12345

will not find any matches, even though the value 12345 appears in the 
{customer.CUSTOMER ID} field of many records.

To select records with the characters 12345 in a string field, you must put 
quotes around the characters you are attempting to match, like this:

{customer.CUSTOMER ID} = “12345”

Check your selection formula closely, and make sure that any numbers 
you are attempting to match within a text object are surrounded by single 
or double quotation marks.

Unwanted 
spaces appear in 
selection 
formula

Spaces are characters, and when you include spaces in the search key of 
a record selection formula, the formula looks for records with the exact 
match in the selected field, spaces and all. For example, the following 
formula:

“Mr . “ in {customer.TITLE}

will not find any matches with the form of address “Mr.” because there is 
an extra space in the search key between the letter “r” and the period. 
Likewise, “Ph. D” will not match “Ph.D”.

Check your selection formula closely, and make sure that the spaces in the 
selection formula match the spaces in the fields you are trying to match.

Trouble-
shooting record 
selection 
formulas 

To troubleshoot your selection formula, you should first begin by making 
sure that all of the fields referenced in the selection formula are placed on 
your report. Then delete the selection formula and test it as you rebuild 
it, step by step.

1 Write down the record selection formula on paper. You will use this 
written copy to help you reconstruct the selection formula one step at 
a time.
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2 Remove the record selection formula from your report by deleting 
the formula from the Formula text box in the Formula Editor.

3 Click the SAVE AND CLOSE button when finished.

4 Make certain that all fields referenced in the record selection formula 
(the selectors) are on the report physically and are not hidden.

For example, if one of the selectors is:

{customer.POSTAL CODE} > “80000”

but the {customer.POSTAL CODE} field is not used on your report (as 
in the case of a sales report that uses the zip code to define territories 
but does not include the postal code in the report data), then insert the 
{customer.POSTAL CODE} field into the report.

Or, if one of the fields referenced in the selection formula is on the 
report but is hidden, unhide it by toggling the Hide when Printing 
option off in the Format Editor for that field.

5 Print the report and make certain that the data in those fields which 
are referenced in the selection formula print satisfactorily. Make 
certain that all the data prints. For example, if there are x total 
records in the database you should have x records printing for each 
of the referenced fields. This establishes a baseline against which you 
can compare the results of printing with the selection formula.

6 When you are sure that you are getting satisfactory results without 
using the selection formula, you can enter the selection formula 
using only one of the selectors.

For example, to use this as the final selection formula:

{customer.POSTAL CODE} > “80000” and 
{customer.CONTACT LAST NAME}[1] = “C” and 
{customer.LAST YEAR'S SALES} >= 5000

this formula will select all of those records that show a Postal code 
greater than 80000, a value in the {customer.CONTACT LAST 
NAME} field beginning with “C”, and a value in the {customer.LAST 
YEAR'S SALES} field greater than or equal to 5000.

You might start with this as the first test selection formula:

{customer.POSTAL CODE} > “80000”

Print the report and evaluate the data that prints when you have only 
one selector activated. Does the {customer.POSTAL CODE} field 
show only ZIP codes greater than 80000? 

●   If it does, then you know that this part of the selection formula is 
working.
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●   If it does not, then troubleshoot this part of the selection formula.

7 Once the selection formula with one selector activated is working 
properly, add a second selector. For example, the new selection 
formula might look like this:

{customer.POSTAL CODE} > “80000” and 
{customer.CONTACT LAST NAME}[1] = “C”

8 Print the report and evaluate the data that prints when you have two 
selectors activated. Evaluate the data in the {customer.CONTACT 
LAST NAME} field (since you already evaluated {customer.POSTAL 
CODE} in the last step).

Does the {customer.CONTACT LAST NAME} field show only text 
strings beginning with the letter “C”?

●   If it does, then this part of the selection formula is working.

●   If it does not, then troubleshoot this part of the selection formula.

9 Once the selection formula with two selectors activated is working 
properly, add a third selector, then a fourth, etc., until you have 
tested each selector in the selection formula. By the time you have 
troubleshot the entire selection formula, you should have uncovered 
the source of the problem and the formula should select records 
according to your wishes.

How to debug a formula

Follow the example below to learn the necessary steps for debugging a 
formula. After completing this exercise, use the same principles to debug 
your own formulas.

NOTE: This tutorial uses the xtreme.mdb sample database located either 
in the \CRW16 directory (16-bit), or \Program Files\Seagate Software\ 
Crystal Reports directory (32-bit), or the directory in which your program 
was installed.

The following formula is the formula you will test for errors:

If ({customer.CUSTOMER NAME} [1 to 2 = “Bi” and 
ToText({customer,CUSTOMER ID}) [1] = “6”) Or 
({customer.CUSTOMER NAME} [1] = 'Ro” and 
ToText({customer.CUSTOMER ID}) [1] = “5”) 

“PREFERRED CUSTOMER” 
Else 

“DOES NOT FIT CRITERIA” 
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If correct, this formula should pick out all customers whose names begin 
with “Bi” and whose customer IDs begin with “6” as well as those 
companies whose names begin with “Ro” and whose customer IDs begin 
with “5”. When printing the field, those selections will read 
“PREFERRED CUSTOMER”, while the rest will read “DOES NOT FIT 
CRITERIA.”

You will now break down the formula to check and see that each 
condition of the formula is working individually. 

Formula1 1 To get started, create a report using the Customer table in 
xtreme.mdb and place the following fields from left to right in the 
Details section:

{customer.CUSTOMER ID}
{customer.CUSTOMER NAME}

To test each portion of the formula, you will place a new formula field 
next to these two fields in the report.

2 Create a new formula called Formula1.

3 Type the following in the Formula text box of the Formula Editor: 

If {customer.CUSTOMER NAME} [1 to 2 = “Bi” Then 
“TRUE” 

Else 
“FALSE” 

4 Click the CHECK button to test for errors. You will receive the 
following error message: 

The ] is missing.

5 Correct the formula by inserting the missing “ ] “ after the 2. 

6 Click the CHECK button again. You will receive the following 
message:

No errors found.

7 Click the SAVE AND CLOSE button to return to the Insert Fields dialog 
box.

8 Insert the corrected formula field to the right of the two data fields in 
the Details section of your report.

9 Click the PRINT PREVIEW button on the standard toolbar to check the 
values in the report and compare the fields to see if the field values 
returned by @Formula1 are correct.
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You will find “TRUE” listed next to the customer names that begin with 
“Bi” and “FALSE” next to all the others. Now you will check the other 
portions of the formula. Create Formula2, Formula3, and Formula4, by 
following Steps 1 - 9, using the formulas specified below for each. Insert 
each formula field on the same line of the Details section for easy 
comparison. Check each one for errors, fix as needed, and make sure the 
values returned are correct before moving on to the next formula.

Formula2 1 Create a new formula called Formula2.

2 Type the following in the Formula text box of the Formula Editor: 

If ToText({customer,CUSTOMER ID}) [1] = “6” Then 
“TRUE” 

Else 
“FALSE”

3 Click the CHECK button to test for errors. You will receive the 
following error message: 

This field name is not known.

4 Correct the formula by replacing the comma (,) in the field name 
with a period (.).

5 Click the CHECK button again. The formula should now be error-free.

6 Place the formula to the right of the @Formula1 field.

7 Click the PRINT PREVIEW button on the standard toolbar to check the 
values in the report and compare the fields to see if the field values 
returned by @Formula2 are correct. 

You should see “TRUE” next to all customer numbers that begin with 6 
and “FALSE” next to all customer numbers that do not begin with 6.

Formula3 1 Create a new formula called Formula3.

2 Type the following in the Formula text box of the Formula Editor: 

If {customer.CUSTOMER NAME} [1 to 2] = 'Ro” Then 
“TRUE” 

Else 
“FALSE”

3 Click the CHECK button to test for errors. You will receive the 
following error message: 

The matching ' for this string is missing.

4 Correct the formula by changing the single quote (’) before Ro to a 
double quote (“).
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5 Click the CHECK button again. The formula should now be error-free. 

6 Place the formula to the right of the @Formula2 field.

7 Click the PRINT PREVIEW button on the standard toolbar to see the 
values in the report and compare the fields to check if the field values 
returned by @Formula3 are correct. 

You should see “TRUE” next to all Customer names that begin with “Ro” 
and “FALSE” next to all Customer names that do not begin with “Ro”.

Formula4 1 Create a new formula called Formula4.

2 Type the following in the Formula text box of the Formula Editor: 

If ToText({customer.CUSTOMER ID}) [1] = “5”
“TRUE” 

Else 
“FALSE” 

3 Click the CHECK button to test for errors. You will receive the 
following error message:

The word 'then' is missing.

4 Correct the formula by typing in the word “Then” at the end of the 
first line after “5”.

5 Click the CHECK button again. The formula should now be error-free.

6 Place the formula to the right of the @Formula3 field.

7 Click the PRINT PREVIEW button on the standard toolbar to see the 
values in the report and compare the fields to check if the field values 
returned by @Formula4 are correct. 

You should see “TRUE” next to all Customer IDs that begin with 5 and 
“FALSE” next to all Customer IDs that do not begin with 5.

Now that the formulas are error-free and the field values returned are 
correct, you will create a formula that links the separate components 
together. You will begin by linking the first two formulas (@Formula1 
and @Formula2) and then you will add @Formula3 and @Formula4 to 
create the final formula @FinalFormula. 

Formula1+2 1 Create a new formula called Formula1+2.

2 Type the following in the Formula text box of the Formula Editor: 
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If {customer.CUSTOMER NAME} [1 to 2] = “Bi” and 
ToText({customer.CUSTOMER ID}) [1] = “6” Then 

“TRUE” 
Else 

“FALSE”

3 Place the formula to the right of the @Formula4 field. 

You should see “TRUE” next to each customer whose name begins with 
Bi and Id begins with 6, and “FALSE” next to all Customer IDs that do not 
meet this criteria.

If this formula is working correctly, you can create one last formula 
adding the code from @Formula3 and @Formula4.

FinalFormula 1 Create a new formula called FinalFormula.

2 Type the following in the Formula text box of the Formula Editor: 

If ({customer.CUSTOMER NAME} [1 to 2] = “Bi” and 
ToText({customer.CUSTOMER ID}) [1] = “6”) or 
({customer.CUSTOMER NAME} [1 to 2] = “Ro” and 
ToText({customer.CUSTOMER ID}) [1] = “5”) Then 

“PREFERRED CUSTOMER” 
Else 

“DOESN'T FIT CRITERIA”;

3 Place the formula where you want it to appear in the Details section 
of the report. You can now delete all other formula fields from the 
report. See How to delete formulas from a report, Page 311.

You can use this same process of condition-by-condition testing for any 
formulas as a means of systematically checking them.
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15 Running Totals

What you will find in this chapter...

Introduction, Page 342

HANDS-ON (Running Totals), Page 343
Running Totals 341



Introduction 

Seagate Crystal Reports  introduces a new type of field, the Running Total 
field.  Running Total fields are similar to summary fields but allow more 
control over how the total is calculated and when it is reset.  Running 
Total fields are specifically suited to perform the following totaling 
functions:

●   to see the value of a total accumulate as it is calculated record by 
record,

●   to total a value independent of the report’s grouping,

●   to total a value conditionally,

●   to total a value after a group selection formula has been applied, 
and

●   to total a value from the driving table in a one to many linking 
relationship.

A Running Total field is created with the Running Total Expert. The 
Running Total Expert creates a Running Total Field by asking you to 
select a field to summarize, the summary operation to use, a condition 
upon which to base the evaluation, and a condition upon which to reset 
the evaluation.

Once you create a Running Total field you can insert it into the report just 
like a Database field or you can refer to it in a formula. The calculation of 
a Running Total field is not affected by where it is placed in a report, its 
performance is entirely dependent upon the settings established in the 
Running Total Expert. While a Running Total field can be used to 
calculate a total on any database or formula field it can not be used to 
calculate the total of a print time formula.

The topics covered in this chapter include advanced techniques. Before 
starting, familiarize yourself with designing reports in Seagate Crystal 
Reports, grouping values in a report, and summarizing data.

Related Topics

Sorting, Grouping, and Totaling, Page 245
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HANDS-ON (Running Totals)

How to maintain running totals in a list 

Running totals are totals that are displayed generally on a record by 
record basis. They total all records (in the report, in the group, etc.) up to 
and including the current record. For example, if your first three records 
have values of 2, 4, and 8, the running total for each of the three records 
would be as follows:

The most basic form of a running total is a single running total 
maintained throughout a list. In this tutorial you create this kind of report 
by setting up a running total for a list of order amounts.

NOTE: Running total fields are prefixed by the # sign.

1 To get started, create a report using the sample database 
xtreme.mdb, link the Customers and Orders tables, and then place 
the following fields from left to right in the Details section:

{customer.CUSTOMER NAME}
{orders.ORDER ID}
{orders.ORDER AMOUNT}

2 Choose RUNNING TOTAL FIELD from the Insert Menu. The Insert 
Fields dialog box appears.

3 Click NEW. The Create Running Total Field dialog box appears.

4 Enter the name "TotalOrders" in the Running Total Name text box.

5 Select {orders.ORDER AMOUNT} from the Available Tables and Fields 
list box, and use the first arrow button to enter that field in the Field 
to summarize text box.

6 Select sum from the Type of summary drop-down list.

7 In the Evaluate section of the dialog box, click the On change of field 
option, and select {orders.ORDER ID} as the “change of” field. The 
running total will execute each time this field changes.

Values Running Total

2 2 = 0 + 2

4 6 = 2 + 4

8 14 = 6 +8
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8 In the Reset section of the dialog box, click the Never option (this 
gives you a running total that never resets; that is, the running total 
continues throughout the report).

9 Click OK to save the running total field. The program returns you to 
the Insert Fields dialog box.

10 Insert the running total field in the Details section of the report, just 
to the right of {orders.ORDER AMOUNT}.

Related Topics

How to create a running total for a group, Page 345

Introduction to Reporting, Page 85

The value in each record is added to the
sum of the previous value in the report.

The total continues, unbroken,
throughout the running list.
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How to create a running total for a group

Another common use for running totals is tallying items in a group. The 
running total starts with the first item in the group and ends with the last. 
Then it starts all over again for the next group, then the next, and so on.

In this tutorial, you will create a report that:

●   maintains a running total of customer orders,

●   groups customer orders and resets the running total for each 
group, and

●   displays the subtotal for each order (the last running total for that 
order).

To set up this report, create a running total that resets for each new group 
so that you have a subtotal for each group. This subtotal will take the last 
value in the running total field and display that value on the report (for 
example, if the numbers 2, 4, and 8 were tallied by the running total, the 
subtotal will be 14). This will give you a running total and a subtotal for 
each group.

1 To get started, create a report using the sample data, xtreme.mdb. 
Link the Customers and Orders tables and place the following fields 
from left to right in the Details section:

{customer.CUSTOMER NAME}
{orders.ORDER ID}
{orders.ORDER AMOUNT}

2 Group on the {customer.CUSTOMER NAME} field.

3 Choose RUNNING TOTAL FIELD from the Insert Menu. The Insert 
Fields dialog box appears.

4 Click NEW. The Create Running Total Field dialog box appears.

5 Enter the name "GroupRunningTotal" in the Running Total Name text 
box.

6 Select {orders.ORDER AMOUNT} from the Available Tables and Fields 
list box, and use the first arrow button to enter that field in the Field 
to summarize text box.

7 Select sum from the Type of summary drop-down list.

8 In the Evaluate section of the dialog box, click the For each record option.

9 In the Reset section of the dialog box, choose to reset on change of 
Group #1.
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10 Click OK to save the running total field. The program returns you to 
the Insert Fields dialog box.

11 Place the running total field in the Details section of your report, just 
to the right of the {orders.ORDER AMOUNT} field.

How to create a conditional running total

There may be times when you have a list of ungrouped values, and you 
only want to subtotal some of the values in the list. For example:

●   you have a list that contains both Canadian and U.S. customers,

●   you want to keep customer records sorted alphabetically based on 
customer name,

●   you do not want to break the data into groups based on the 
country, but

●   you want a total of the values from just the Canadian records, and

●   you also want a total of the values from just the U.S. records.

To accomplish this, create two running totals, one to keep a running total 
of the U.S. records, and one to keep a running total of the Canadian 
records.

●   USTotal 
Maintains a running total of the U.S. records.

●   CanadaTotal 
Maintains a running total of the Canadian records.

1 To get started, create a report using the sample data, xtreme.mdb. 
Place the following fields from left to right in the Details section:

{customer.CUSTOMER NAME}
{customer.COUNTRY}
{customer.LAST YEAR'S SALES}

2 Sort the records based on the {customer.CUSTOMER NAME} field.

3 Choose RUNNING TOTAL FIELD from the Insert Menu. The Insert 
Fields dialog box appears.

4 Click NEW. The Create Running Total Field dialog box appears.

5 Enter the name "USTotal" in the Running Total Name text box.

6 Select {Company.LAST YEAR’S SALES} from the Available Tables and 
Fields list box, and use the first arrow button to enter that field in the 
Field to summarize text box.
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7 Select sum from the Type of summary drop-down list.

8 In the Evaluate section of the dialog box, click the Formula option 
button and then click the Formula button. The Running Total 
Condition Formula Editor appears.

9 Enter the following formula in the Formula text box:

{Customer.Country} = “USA"

This tells the program to evaluate the running total each time it comes 
to a record where {Customer.COUNTRY} is equal to "USA." The 
running total will ignore all other records (such as records for 
Canada).

10 In the Reset section of the dialog box, click the Never option.

11 Click OK to save the running total field. The program returns you to 
the Insert Fields dialog box.

12 Place the running total field in the Details section of your report. 

13 Now create the CanadaTotal running total field using the process 
outlined in steps 3-11. The only difference is that this time you will 
set the Evaluate formula to:

{Customer.Country} = "Canada"

14 When you are finished, place the #CanadaTotal field in the Details 
section of your report, just to the right of the {Customer.LAST 
YEAR’S SALES} field. 

15 Place the two running total fields you created in the Report Footer 
section of your report.

Your report should look similar to the following:

NOTE: This sample report has been designed to illustrate concepts only, 
not the actual look of the finished report. 
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How create a running total in a one to many linking relationship 

The term A to B, A to C report is used to refer to any report in which a 
primary table is linked to two lookup tables (see Methods of looking up 
tables (direct access databases), Page 524). However, in a true A to B, A to C 
link, a single field in the primary table is used to link to both of the lookup 
tables.

In a true A to B, A to C relationship, one of the two lookup tables usually 
has more records than the other. If you group these records based on a 
field in the primary table, values in the smaller lookup table are repeated 
for each value in the larger lookup table. The following table shows data 
for an A to B, A to C relationship. The Customer table is linked to the 
Credits table and again to the Orders table. Notice that Jones has only one 
Credit ID, but the credit and its amount are repeated, once for each of 
Jones’ two orders. 

Name Credit ID Credit 
Amount Order ID Order 

Amount

Jones 1 -10.00 1 10.00

Jones 1 -10.00 2 12.00

Smith 2 -23.00 3 20.00
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In this example, a standard subtotal is used for both the Order Amount 
field and the Credit Amount field. Thus, Jones’ single credit is counted 
twice, and the subtotal displays an inaccurate value of -20.00. 

NOTE: Notice that the total Credit Amount for Jones is incorrect.

This problem also occurs in the Order Amount field if Jones had two 
different Credit Amounts and only one Order Amount. Avoid this 
problem by creating a running total for each field you want subtotaled. 

1 To get started, create a report using the sample data, ORDRCR.MDB. 
Place the following fields from left to right in the Details section:

{cust.NAME}
{credits.CREDIT ID}
{credits.CREDIT}
{orders.ORDER ID}
{orders.ORDER AMOUNT}

NOTE: The sample data in ORDRCR.MDB has been specially designed to 
demonstrate a true A to B, A to C link. Use the Visual Linking Expert to 
make sure that the {credits.CUST} field is linked to both the 
{orders.CUSTOMER} and {cust.NUMBER} fields.

2 In the Design Tab, highlight the {orders.ORDER AMOUNT} field 
and insert a subtotal, grouping on the {cust.NAME} field.

3 Choose RUNNING TOTAL FIELD from the Insert Menu.  The Insert 
Fields dialog box appears.

4 Click NEW.  The Create Running Total Field dialog box appears.

Smith 3 -45.00 4 30.00

Name Credit ID Credit 
Amount Order ID Order 

Amount

Jones 1 -10.00 1 10.00

Jones 1 -10.00 2 12.00

-20.00 22.00

Smith 2 -23.00 3 20.00

Smith 3 -45.00 4 30.00

-68.00 50.00

Name Credit ID Credit 
Amount Order ID Order 

Amount
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5 Enter the name "CreditsSubtotal" in the Running Total Name text box.

6 Select {credits.CREDIT} from the Available Tables and Fields list box, 
and use the first arrow button to enter that field in the Field to 
summarize text box.

7 Select sum from the Type of Summary drop-down list.

8 In the Evaluate section of the dialog box, click the On change of field 
option and choose the field {credits.CREDIT ID}.

NOTE: For customer Jones there is only one Credit ID, so the running 
total will take the credit amount of $10.00.

9 In the Reset section of the dialog box, click the On change of field 
option and choose the field {cust.NAME}.

NOTE: The Running Total resets for the second customer (Smith). For 
Smith there are two Credit ID’s (2 and 3), so the running total sums the 
credit amounts ($23.00 and $45.00).

10 Click OK to save the Running Total field. The program returns you to 
the Insert Fields dialog box.

11 Place the running total in the Group Footer section of the report.

Related Topics

Introduction to Reporting, Page 85
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16 Parameter Fields

What you will find in this chapter...

Parameter field objects overview, Page 352

Multiple parameter fields, Page 353

Parameter field considerations, Page 353

HANDS-ON (Parameter Field Objects), Page 354
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Parameter field objects overview

Parameter fields are fields that prompt you to specify a value each time 
you refresh the data in a report. When you supply a value, the program 
runs the report using that value. By using parameter fields in formulas, 
selection formulas, and in the report itself, you can create a single report 
that you can modify whenever your needs change. Parameter Fields can 
also be used in subreports and compiled reports. See Introduction to 
Formulas, Page 291.

For example, you may create a report in which you want to include only 
California records. Without parameter fields, you could enter a record 
selection formula similar to this:

{customer.REGION} = “CA”

This formula tests the records in the {customer.REGION} field to see if 
they contain the value “CA.” If a record contains that value, the formula 
prints that record in the report. If a record does not contain the value, then 
the formula rejects that record. The report runs exactly the way you want 
it to - if you always want to run reports using only California records. 
However, to run reports using records from other states, you have to edit 
the formula and hard code your changes. For example, if you want to run 
the report using Arizona records, you would have to change “CA” to 
“AZ” in the Record Selection Formula Editor or the Select Expert. See 
How to set up record selection using the Select Expert, Page 238.

Using a parameter field in place of the state field value allows you to 
make changes “on the spot,” without hard coding a new value. Here is 
how it works:

1 Let’s say you set up a parameter field by choosing the PARAMETER 
FIELD command from the Insert Menu. For the purpose of this 
example, call this parameter field Region.

2 Then choose the parameter field in their selection formula, instead of 
using the formula:

{customer.REGION} = “CA”,

create a formula similar to this:

{customer.REGION} = {?Region}

NOTE: {?Region} is the parameter field created in Step 1. The program 
uses the {?ParameterFieldName} format for parameter fields in formulas 
and Experts.
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3 Whenever you refresh the data in the report, the program prompts 
them to either supply a value for the parameter field or accept the 
default value. The program selects the records for the report using 
the value specified.

With parameter fields, you can create a single report that can be 
customized quickly to meet a variety of needs.

Multiple parameter fields

Formulas and record selection formulas can contain multiple parameter 
fields. When this is the case, the program prompts you for each parameter 
before it refreshes the data. So, you could use a selection formula similar 
to the following:

{customer.REGION} = {?Region} AND {customer.LAST 
YEAR’S SALES} <= {?Sales}

This particular formula will prompt you first for the region you want to 
report on, and then for the amount against which you want to compare 
last year’s sales. This means that the Enter Parameter Values dialog box 
will contain multiple tabs, one for each parameter field.

When you supply the parameter values, the selection formula will then 
limit the report to records in which the region is equal to the value you 
specified for the {?Region} parameter field, and in which last year’s sales 
is equal to the value you specified for the {?Sales} parameter field.

Parameter field considerations

There are a number of things to keep in mind when working with 
parameter fields:

●   A parameter field does not have to be placed in a report in order to 
be used in a record or group selection formula. You just create the 
parameter field and then enter it in your formula as you would 
any other field.

●   The program supports parameter fields in the following data types: 
String, Number, Currency, Boolean, Date, Time, and DateTime.

●   Parameter field prompting text can be up to two lines long with 
approximately 40-50 characters per line (depending on character 
width, up to the 255 character limit). The program performs 
automatic word wrap on prompts more than one line long.
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●   You can create a pick list for the user to choose the parameter 
value rather than enter it manually.

●   In compiled reports, parameter fields can be used to prompt for 
record selection criteria for which you would not normally be 
prompted. In this way, the program allows you the opportunity to 
specify, in report selection formulas, values that contain only 
fields and operators. However, if you place a parameter field in 
your selection formula, the program will prompt you for its value - 
even if that value is not a field.

HANDS-ON (Parameter Field Objects)
This section includes Hands-On tutorials for performing a number of 
different tasks involving parameter fields. How to create a parameter field, 
Page 354, How to use a parameter field in a formula, Page 362, and How to 
respond to parameter field prompts, Page 362, are sequential; they provide an 
overview of typical processes involving parameter fields. The remaining 
tutorials can be read individually, as needed.

How to create a parameter field

1 Click the INSERT FIELDS button on the standard toolbar. The Insert 
Fields dialog box appears. Click the Parameter Tab to activate it.

The Create Parameter Field dialog box appears.

2 Click New.
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3 Enter a name for the parameter field in the Name text box, for 
example Region, Country, Employee, etc. (up to 35 alphanumeric 
characters).

4 Enter the desired prompting text in the Prompting Text text box (up to 
255 alphanumeric characters). The prompting text is the text that 
appears when the program prompts you for a parameter value.

5 Select the data type of the parameter field from the Value Type drop-
down list.

NOTE: If you select Boolean, the dialog box changes. You can then 
choose the default value (True/False) from the Default Value drop-down 
list, and (optionally) use the Options section of the dialog box to place the 
parameter field in a group. Click OK to proceed. If, on the other hand, 
you select String, the Length Limit check box and the Edit Mask text box 
appear. If you select a Currency, Date, DateTime, Number, or Time data 
type, the Range Limited Field check box appears.

6 Toggle the Allow multiple values check box on or off to designate 
whether the parameter field can accept multiple values.

7 Click either the Discrete value(s) option or the Range value(s) option to 
specify whether the parameter field will accept a range of values.

●   If you click Discrete value(s), the parameter field will accept single 
values (rather than ranges of values).
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●   If you click Range value(s), then when you are prompted for 
parameter values, you can enter a start value and an end value, 
and the report will then display all records within that range. For 
example, if you enter the values "5" and "10", the range is 5-10, and 
the report will display all records with values between 5 and 10. 
This also works for string parameter fields. With a start value of 
"A" and an end value of "E", the report will display all records 
within an alphabetical range of A-E.

NOTE: If Allow multiple values is toggled on, and the Discrete value(s) 
option is selected, the parameter field will accept multiple single values. In 
this case, you can enter more than one value, but these values will be 
evaluated individually and will not be interpreted as a range. So you could 
enter "CA" and "WA" for a {?Region} parameter field, and the report 
would display all the records for the states of California and Washington. If 
Allow multiple values is toggled on, and the Range value(s) option is 
selected, the parameter field will accept multiple ranges.

8 If applicable, toggle the Length Limit check box on or off to designate 
whether the length of the parameter values must fall within a certain 
range. If you toggle Length Limit on, the Min Length and Max Length 
text boxes become active; use these text boxes to specify the 
mandatory range. These options are only available if you are creating 
a string parameter field.

9 If applicable, toggle the Range Limited Field check box on or off to 
designate whether the parameter field is a range limited field. This 
check box is only available if you are creating a parameter field that 
does not have string values. If you toggle Range Limited Field on:

NOTE: Range Limited only appears in the professional edition.

●   for a Currency or Number parameter field, the Min Value and Max 
Value text boxes appear;

●   for a DateTime or Time parameter field, the Beginning and Ending 
text boxes appear;

●   for a Date parameter field, the First Date and Last Date text boxes 
appear.

10 To specify range limitations, use one of the following pairs of text 
boxes:

●   Min Value/Max Value (currency/numeric): Enter the minimum and 
maximum values allowed.

●   Min Length/Max Length (string): Enter the minimum and maximum 
number of alphanumeric characters allowed.
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●   Beginning/Ending (DateTime/Time): Enter a time range in Time 
(hour, minute, second) format, or a DateTime range in DateTime 
(day, month, year/ hour, minute, second) format.

●   First Date/Last Date (Date): Enter the earliest and latest dates 
allowed.

NOTE: For Date, Time, and DateTime fields, the dialog box provides a 
DateTime Picker to help you enter these ranges quickly. The DateTime 
Picker consists of, where applicable, a text box with arrows for selecting a 
time, and a calendar for selecting a date (the calendar appears when you 
click the arrow button to the right of the date entry text box).

●  The Browse Table drop-down list can be used to specify a default 
table.

●  The Browse Field drop-down list can be used to specify a default field.

NOTE: If you specify range limitations after selecting a default table and 
default field, the Values to be added list will be modified so that only those 
values that are within the range appear on the list.

11 For a string parameter field, you can choose to enter an Edit Mask in 
the Edit Mask text box, rather than specifying a range. The Edit Mask 
can be any of a set of masking characters used to restrict the values 
you can enter as parameter values (the edit mask also limits the 
values you can enter as default prompting values). You can enter any 
of the following masking characters, or any combination of them:

●   “A” (allows an alphanumeric character and requires the entry of a 
character in the parameter value)

●   “a” (allows an alphanumeric character and does not require the 
entry of a character in the parameter value)

●   “0” (allows a digit [0 to 9] and requires the entry of a character in 
the parameter value)

●   “9” (allows a digit or a space, and does not require the entry of a 
character in the parameter value)

●   “#” (allows a digit, space, or plus/minus sign, and does not 
require the entry of a character in the parameter value)

●   “L” (allows a letter [A to Z], and requires the entry of a character in 
the parameter value)

●   “?” (allows a letter, and does not require the entry of a character in 
the parameter value)

●   “&” (allows any character or space, and requires the entry of a 
character in the parameter value)
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●   “C” (allows any character or space, and does not require the entry 
of a character in the parameter value)

●   “.  ,  :  ;  -  /” (separator characters)

   Inserting separator characters into an edit mask is something 
like hard coding the formatting for the parameter field. When 
the field is placed on the report, the separator character will 
appear in the field object frame, like this: LLLL/0000. This 
example depicts an edit mask that requires four letters 
followed by four numbers.

●   “<“ (causes subsequent characters to be converted to lowercase)

●   “>” (causes subsequent characters to be converted to uppercase)

●   “\” (causes the subsequent character to be displayed as a literal. 
For example, the Edit Mask “\A” would display a parameter 
value of “A.” If the Edit Mask is “00\A00,” then a valid parameter 
value would consist of two digits, the letter “A,” and then two 
additional digits).

●   “Password”

   If you set the Edit Mask to “Password,” you can create 
conditional formulas specifying that certain sections of the report 
become visible only when certain user passwords are entered.

NOTE: Some of the Edit Mask characters require that you enter a 
character in their place (when entering a parameter value), while others 
allow you to leave a space, if needed. For example, if the Edit Mask is 
000099, you can enter a parameter value with four digits, five digits, or 
six digits, since the ‘9’ Edit Mask character does not require the entry of a 
character. However, since ‘0’ does require such an entry, you could not 
enter a parameter value with less than four digits.

NOTE: When you enter an Edit Mask, the range text boxes become inactive.

12 Enter the default prompting values by adding or selecting values 
from the "Select or enter value to add" list and using the Add (>) and 
Add All (>>) buttons to add these values to the Default Values list. You 
can use the Remove (<) and Remove All (<<) buttons to remove 
prompting values from the list. The program will populate a drop-
down list on the Enter Parameter Values dialog box with the default 
prompting values you specify.

NOTE: If you selected Range Limited Field, the values you can enter in the 
prompting box are limited to that range.

13 When you have more than one item in the Default values list box, the 
Allow Editing of default values check box appears. This check box is 
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toggled on by default to specify that you can edit or enter new values 
when prompted for parameter values. Toggle this check box on or off 
as needed.

NOTE: This check box is inactive until you enter at least two default 
prompting values.

14 Click OK. The parameter field is saved, and the parameter field name 
appears in the list on the Parameters Tab of the Insert Fields dialog 
box. Use the priority arrow buttons on the tab to determine the order 
in which the parameter fields appear when prompted for parameter 
values.

How to set record selection using parameter fields

You can easily use parameter fields for record selection. In this tutorial, 
you will create a parameter field that selects regions to be included in the 
report.

1 To get started, create a report using the Customer table in 
xtreme.mdb. Place the following fields from left to right in the 
Details section:

{customer.CUSTOMER NAME}
{customer.LAST YEAR’S SALES}

2 With the Insert Fields dialog box still active, click the Parameter Tab.

The Create Parameter Field dialog box appears.

3 Click New.
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4 Enter the following information into the corresponding edit boxes:

●   Type “Region” in the Parameter Name text box.

●   Type “Enter the region you would like to see sales for” in the 
Prompting Text text box.

●   Select String from the Value Type drop-down list.

●   Select Customer from the Browse Table drop-down list.

●   Select Region from the Browse Field drop-down list.
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●   Either select “CA” as the sole default prompting value, or select a 
number of regions as the default prompting values by repeatedly 
clicking the Add (>) arrow button or by clicking the Add All (>>) 
button. If you select a number of regions, the user will be able to 
choose a value from a pick list of the values you supply. For details 
on selecting default prompting values, see How to create a parameter 
field, Page 354.

5 You may also specify an edit mask restricting the type and number of 
characters that can enter as parameter values. For information about 
edit masking, see Step 11 and the table following that step in How to 
create a parameter field, Page 354.

6 Click OK. You are returned to the Insert Fields dialog box. The 
parameter field you have just created now appears in the list box.

7 Click the SELECT EXPERT button on the standard toolbar.

The Choose Field dialog box appears.

8 Select Region and click OK. The Select Expert appears.

NOTE: If a field is selected in the Design Tab, the Select Expert appears in 
place of the Choose Field dialog box. Click an empty section of the 
Design Tab to deselect all fields and repeat Step #5.

9 Leave the first drop-down list set to is. Choose equal to from the 
second drop-down list. A third drop-down list appears.

10 Click the arrow on the drop-down list to display the list of regions. 
The prompting variable that you created, {?Region}, now appears at 
the top of the list.

11 Select the prompting variable from the list and click OK.

Now, when you refresh your data, the program will prompt you for the 
parameter values and will base record selection on the values you 
provide. See How to create a record or group selection formula, Page 240.

NOTE: If you base record selection on a parameter field that accepts 
range values (a parameter field for which the Range Value(s) option is 
selected in the Create Parameter Field dialog box), you could create a 
selection formula like {Orders.Orders Date} in {?pDateRange}, where 
{?pDateRange} is a parameter field that allows range values. Then you 
can enter a range value when prompted, and the report will display all 
records in which {Orders.Orders Date} falls within that range.
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How to use a parameter field in a formula

1 Click the Insert Fields button on the standard toolbar the insert field 
dialog box appears.

2 In the Insert Fields dialog box, click the Formula Tab to activate it.

3 Click the NEW button. Type a name for the formula in the Formula 
Name dialog box. 

4 Click OK when finished. The Formula Editor appears.

5 Create a formula using the parameter field as you would any 
constant value. For example, rather than creating a formula that 
hard-codes the region name:

{customer.REGION} = “CA”

Use a parameter field instead of “CA”:

{customer.REGION} = {?[ Name of Parameter Field]}

6 Click the SAVE AND CLOSE button. The program returns you to the 
Insert Fields dialog box. The name of the formula you have just 
created is highlighted in the Formula list box.

7 Click the INSERT button and place the formula where you want it to 
appear in the report.

8 Click CLOSE to exit the Insert Fields dialog box.

9 To see how this field works, click either the PRINT PREVIEW button or 
the REFRESH button on the standard toolbar.

A dialog box appears, prompting you for values. See How to respond 
to parameter field prompts, Page 362.

NOTE: The program automatically puts a question mark before the field 
name to identify it as a parameter field. See Introduction to Formulas, Page 
291.

How to respond to parameter field prompts

Previewing a 
report for the 
first time

When you preview a report for the first time, the Enter Parameter Values 
for Main Report dialog box appears, prompting you for a value.

●   If you specified a default value when you created the parameter 
field, the program will use that value unless you specify a new 
one.
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●   If you did not specify a default value, then the program will not 
refresh the data until you supply a new value.

Refreshing 
report data

When you refresh data from the Preview Tab, the Refresh Report Data 
dialog box appears.

●   Click Use current parameter values to use the current parameter 
value.

●   Click Prompt for new parameter values to enter a new parameter 
value. If you click this option and click OK, the Enter Parameter 
Values dialog box appears.

   Enter String values exactly as they will appear in the field. If 
the parameter field allows multiple values, you can enter 
additional parameter values using the ADD button.

   Enter Boolean values using the following format: TRUE or 
FALSE.

   Enter Number values exactly as they will appear in the field.

   Enter Currency values exactly as they will appear in the field.

   Enter Date values using the following format: Date (Year/
Month/Day). For example, Date (1997/5/21). You can also 
enter Date values in the format used for the Windows short 
date settings (which are specified on the Date Tab of the 
Regional Settings dialog box, in the Control Panel). To use the 
Date Picker to enter Date values, activate the Date Picker by 
toggling the Pick from defaults check box off. The Date Picker 
appears in place of the list when you click the drop-down list 
arrow.

   Enter Time values using the following format: Time (Hour: 
Minutes: Seconds AM/PM). For example, Time (04:32:12 AM). 
You can also enter Time values in the Windows time style 
(which is specified on the Time Tab of the Regional Settings 
dialog box, in the Control Panel). To use the Time Picker to 
enter Time values, activate the Time Picker by toggling the 
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Pick from defaults check box off. The Time Picker appears to the 
right of the drop-down list.

   Enter DateTime values using the following format: Date (Year/
Month/Day), Time (Hour: Minutes: Seconds AM/PM). For 
example, Date (1997, 5, 21), Time (04:32:12 AM). You can also 
enter DateTime values in the format used for the Windows time 
style and short date settings (which are specified on the Time 
Tab and the Date Tab of the Regional Settings dialog box, in the 
Control Panel). To use the DateTime Picker to enter DateTime 
values, activate the DateTime Picker by toggling the Pick from 
defaults check box off. The time picker appears to the right of the 
drop-down list. The date picker appears in place of the list when 
you click the drop-down list arrow.

NOTE: The Date/Time/DateTime Picker is only available if you have the 
correct version of comctl32.dll (there is a separate install program for this 
on Seagate Crystal Reports installation disk).

NOTE: If the parameter field is range limited, then you can only enter 
values within a certain range.

The program now runs the report using the new value(s) you specified.

How to conditionally format using parameter fields 

Parameter fields can be used to create conditional formatting formulas. 
You can customize these formulas whenever you refresh the report data. 
A conditional formatting formula could be used for color-flagging data 
that meets certain conditions. For example:

To use a value other than 
the default, select a new 
value from this drop-down 
list or, if permitted, enter a 
new value in the text box.

To use the default value, simply click OK.
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●   sales representatives who sell more than 10% over quota,

●   customers who have not ordered in the last quarter, and

●   inventory items that have not had any movement in the last month.

If the conditions under which you flag these items never change, you do 
not need to use parameter fields. You can just use formulas (for text flags) 
or conditional formatting (for border flags). However, to change the 
conditions from report to report, you need to use parameter fields in 
formulas and conditional formatting formulas.

1 Create the parameter field in the data type you need for the formula.

2 Create the formula and use the parameter field in place of the fixed 
value you would normally use.

3 For example, to be prompted for all the customers whose last year’s 
sales were over a certain value and to print their names in red, then 
select the Last Year’s Sales field and click the OBJECT PROPERTIES 
button on the supplementary toolbar. The Format Editor appears.

4 Click the Conditional formula button next to the Color property on the 
Font Tab, and format the field using a conditional formatting 
formula like this:

If {customer.LAST YEAR’S SALES} > 
{?ParameterFieldName} Then 

Red
Else

Black

Now, when you refresh the data, the program will prompt you for the 
value that triggers the color flag (known as the threshold value). It then 
runs the report and flags all the customers that had sales last year above 
the threshold figure. You can change the figure each time you run the 
report and the program will flag a different set of Customer Names.

Related Topics

How to create If-Then-Else formulas, Page 316

Conditional attribute properties, Page 213

Conditional formatting, Page 212

How to format objects conditionally, Page 204
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How to create a report title using parameter fields

Seagate Crystal Reports allows you to use parameter fields to create a 
Report Title that can be changed each time the report is refreshed.

1 From the Insert Fields dialog box, click the Parameter Tab to activate it.

2 Click the NEW button. The Create Parameter Field dialog box appears.

3 Type a name for the parameter field in the Name edit box. Type in 
any prompting text you wish in the Prompting Text edit box. Select 
String in the Value Type drop-down box.

4 To specify a default title, type the desired text into the Select or enter 
value to add text box and click the ADD (>) button to add the title to 
the Default Values list box.

NOTE: Repeat Step 4, as needed, to enter more than one default title. In 
this case, the program will prompt you with a list of default titles when 
you run the report.

5 Click OK when finished. You are returned to the Insert Fields dialog 
box. The parameter field you created appears in the list.

6 Select the parameter field and click the INSERT button.

7 Place the parameter field in the Page Header section of the report to 
have the title appear on every page, or in the Report Header section 
if you want the title to appear on only the first page of the report.

Now, when you refresh the data, the program will prompt you for a 
report title. If you wish, you can change the title each time you run the 
report.

How to set sort order using parameter fields 

To set the sort order using parameter fields, you need to first create a 
formula that includes a parameter field and then sort based on that 
formula. For example, assume that you have a customer list report based 
on the Customer table. For each customer, you show the Customer Name, 
City, Region, Country, and Phone Number. You want to be able to sort 
the report by Country, by Region, or by City, depending on your needs at 
the time.

1 Create a parameter field and name it SortField. See How to create a 
parameter field, Page 354.

2 In the Prompting Text edit box, enter a prompt similar to this:
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Type R to sort by Region or C to sort by City; 
otherwise, data will be sorted by Country.

3 Select String from the Value Type drop-down list.

4 You may want to limit the number of characters the user can type to 
one. To do this, toggle the Length Limit check box on, and type the 
numeral 1 into the Max Length text box. Now the parameter field will 
only accept single-character values. The field will accept "C" as a 
value, but not "City."

5 Create a formula similar to this and call it Sort:

If {?SortField} = “C” Then 
{customer.CITY}

Else
If {?SortField} = “R” Then

{customer.REGION}
Else

{customer.COUNTRY}

«This formula prompts for a value for the parameter field {?SortField}. 
If you enter “C”, the formula will sort by the City field. If you enter 
“R” it will sort by the Region field. If you enter anything else, or do 
not enter anything at all, the formula will sort by the Country field. 
See How to create multi-condition If-Then-Else formulas, Page 317.»

6 Place the formula in the Report Header section of the report and 
toggle its Suppress option on in the Section Expert so that it does not 
print. Search for Section Expert in Seagate Crystal Reports online 
Help.

7 Click the SORT RECORDS button on the standard toolbar. Choose your 
formula, @Sort, as your sort field. See How to do a single field sort, Page 
253.

Now when you run the report, the program will prompt you for a sort 
field, the formula will return a value based on your selection, and the sort 
facility will use that value as your sort field.
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17 Charting

What you will find in this chapter...

Charting Overview, Page 370

Where to place a chart, Page 373

Data you can chart on, Page 374

Before you create a chart, Page 374

HANDS-ON (Charting), Page 375
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Charting Overview

Seagate Crystal Reports enables you to include sophisticated, colorful 
charts in your reports. You can use charts any time you want to improve 
the usefulness of a report. For example, you can use charts to show 1996 
fiscal results or the sales within the fiscal quarters.

Choosing a chart type

Seagate Crystal Reports provides 12 chart types to make data visually 
accessible in reports. These include common chart types like the Bar and 
Pie charts, as well as 3-D Surface, XY Scatter, Radar, Bubble, and Stock 
charts. There is also a custom chart option and multiple templates for 
each chart type.

Chart layouts The Chart Expert provides four powerful layouts. Each layout is 
especially useful for charting on certain sets of data. Charts can be created 
with any of the following layouts:

1. Group
The Group layout is a very simplified layout in which you show a 
summary on change of a geographic field (such as Region). In order 
to create a chart using the Group layout, you must have at least one 
group and at least one summary field in the report.
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2. Detail
The Detail layout is more complex than the Group layout. Use the 
Detail layout when using multiple chart values, rather than only one, 
or when you do not have any groups or summaries in a report. You 
can use multiple dimensions in detail charts, a function that allows 
you to create a 3D group. Other specifics functions with the Detail 
layout include:

●   charts based on a cross-tab can perform a summary function on 
one cell, and 

●   values can be grouped in ascending, descending or specified 
order.

3. Cross-Tab
Use the Cross-Tab layout to chart a cross-tab object. The cross-tab 
information can be used as the basis for this chart. A Cross-Tab chart 
does not require groups or summary fields.

4. OLAP
Use the OLAP layout to chart on an OLAP grid. The OLAP data can 
be used as the basis for this chart. An OLAP chart does not require 
groups or summary fields.

NOTE: The following rules apply when changing the layout of an existing 
chart:

1. A chart (or a map) based on a group layout can be changed to detail 
layout, and vice versa.

2. A chart (or a map) based on a cross-tab object can be changed to 
detail or group layout only (i.e., not to an OLAP cube), the same is 
NOT true in the reverse order.

3. A chart (or a map) based on an OLAP cube can be changed to detail 
or group layout only; the same is NOT true in the reverse order.

Chart types Different sets of data are particularly suited to a certain chart type. The 
following is an overview of the main chart types and their most common 
uses.

●   Bar chart
A Bar chart (also known as a Column chart) is an excellent tool for 
displaying or comparing several sets of data. Two very useful bar 
charts include the:

   Side-by-Side bar chart
A Side-by-Side bar chart displays data as a series of vertical 
bars. This type of chart is best suited for showing data for 
several sets over a period of time (for example, last year’s sales 
figures for CA, AZ, OR, and WA). 
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   Stacked bar chart
A Stacked bar chart displays data as a series of vertical bars. 
This type of chart is best suited for representing three series of 
data, each series represented by a color stacked in a single bar 
(for example, sales for 1994, 1995, and 1996).

●   Line
A Line chart displays data as a series of points connected by a line. 
This type of chart is best suited for showing data for a large 
number of groups (for example, total sales over the past several 
years).

●   Area
An Area chart displays data as areas filled with color or patterns. 
This type of chart is best suited for showing data for a limited 
number of groups (for example, percentage of total sales for CA, 
AZ, OR, and WA).

●   Pie
A Pie chart displays data as a pie, split and filled with color or 
patterns. Pie charts are typically used for one group of data (for 
example, the percentage of sales for the entire inventory); 
however, you now have the option to choose multiple pie charts 
for multiple groups of data.

●   Doughnut
A Doughnut chart is similar to a pie chart, displaying data as 
sections of a circle or doughnut. If, for example, you charted sales 
by region on a particular report, you would see the total number of 
sales (the figure) in the center of the doughnut and the regions as 
colored sections of the doughnut. As with the Pie chart, you have 
the option to choose multiple doughnut charts for multiple groups 
of data.

●   3-D Riser
A 3-D Riser chart displays data in a series of 3-dimensional objects, 
lined up side-by-side, in a 3-dimensional plane. The 3-D Riser 
chart does an excellent job of showing the extremes in your report 
data. For example, the difference in sales between countries is 
visually dynamic when presented in this chart.

●   3-D Surface
3-D Surface charts present a topographic view of multiple sets of 
data. If, for example, you need a chart to show the number of sales 
by customer by country, in a visually dynamic and relational 
format, you might consider using the 3-D Surface chart.
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●   XY Scatter
An XY Scatter chart is essentially a collective of plotted points that 
represent specific data in a pool of information. The XY Scatter 
chart allows the user to consider a larger scope of data for the 
purpose of determining trends. For example, if you input 
customer information, including sales, products, countries, 
months, and years, you would have a collective of plotted points 
that represents the pool of customer information. Viewing all of 
this data on an XY Scatter chart would allow you to speculate as to 
why certain products were selling better than others or why 
certain regions where purchasing more than others.

●   Radar
A Radar chart positions group data, such as countries or 
customers, at the perimeter of the radar. The Radar chart then 
places numeric values, increasing in value, from the center of the 
radar to the perimeter. In this way, the user can determine, at a 
glance, how specific group data relates to the whole of the group 
data.

●   Bubble
A Bubble chart displays data as a series of bubbles, where the size 
of the bubble is proportional to the amount of the data. A Bubble 
chart would be very effective with the number of products sold in 
a certain region; the larger the bubble, the greater the number of 
products sold in that region.

●   Stock
A Stock chart presents high and low values for data. With this 
ability, the Stock chart is an excellent tool for monitoring financial 
or sales activities.

NOTE: The Chart Expert also includes 3-D templates for Bar, Area, and 
Pie charts.

Where to place a chart

The placement of a chart determines which data is displayed and where 
it is printed. For example, if you place a chart in the Report Header 
section, the chart includes data for the entire report. If you place it in a 
Group Header or Group Footer section, it displays group specific data.

NOTE: If your report contains subreports, you can place charts in those 
subreports as well. See Subreports, Page 415.
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Drill-down 
with charts

Not only is a chart a powerful way of presenting data, it is also a powerful 
analysis tool. When you move your mouse pointer over a segment of the 
chart in the Preview Tab the cursor becomes a Drill-down cursor. You can 
double-click to view the details supporting that section of the chart.

Analyzer Tab

Seagate Crystal Reports provides a third tab (besides the Design and 
Preview Tabs) specifically for advanced charting and mapping. This is 
the Analyzer Tab. Use this tab to organize your charts for more efficient 
analysis. The Analyzer Tab allows you to set the properties of an 
individual instance of a chart independently of the rest of the report. You 
can change the chart title and the titles for the X-, Y-, and Z-axes. You can 
also stagger labels, reverse a series or a group, and change colors. For 
more information, see Analyzer Tab, Page 65.

Data you can chart on

You can chart on the following:

●   summary and subtotal fields (see How to chart on a summary or 
subtotal field (group charts), Page 375),

●   detail fields (see How to chart on a details field, Page 376),

●   formula fields (see How to chart on a formula field, Page 377),

●   cross-tab summaries (see How to chart on cross-tab summaries, Page 
379), and

●   OLAP data (see How to chart on an OLAP cube, Page 379).

Before you create a chart

You will typically chart at the group level on summary and subtotal 
information; exceptions include the Detail, Cross-Tab, and OLAP grid 
charts. Before you can create a chart at the group level, you must have at 
least one group and at least one summary or subtotal in your report.

For example, if you have a sales report grouped by Region with a subtotal 
of Last Year’s Sales for each Region, you can quickly create a chart that 
will display sales by Region.
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HANDS-ON (Charting)

How to chart on a summary or subtotal field (group charts)

Many of the charts you create will be based on summary or subtotals 
within your report. In order to create these charts, you must have a 
summary or subtotal already inserted into your report. For more 
information on inserting summaries and subtotals, see How to summarize 
grouped data, Page 262 and How to subtotal grouped data, Page 264.

1 With the summary or subtotal field selected, click the INSERT CHART 
button on the standard toolbar. The Chart Expert appears with the 
Type Tab active.

2 Choose the type of chart that will best illustrate your data (see 
Choosing a chart type, Page 370).

3 Click the Group button on the Data Tab to specify that your chart will 
be based on grouped data.

4 Use the Place Chart drop-down list and the Header and Footer options 
to specify map placement.

NOTE: When summarizing or subtotaling a field, the data is automatically 
grouped. For more information, see Sorting, Grouping, and Totaling, Page 
245.
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5 Use the appropriate drop-down lists to specify the data on which 
you want to chart.

6 If desired, you can use the Text Tab to add text to your chart and the 
Axes Tab to add grid lines, data values, etc.

7 Click the OK button when you are finished. The chart automatically 
appears in the Report Header or the Report Footer, depending on the 
option you chose in the Data Tab.

NOTE: When a chart is inserted, it may cover a portion of your report. You 
can move and resize the chart so that it fits properly within the report.

How to chart on a details field

A Detail chart allows you to create a chart based on specific values. Charts 
are often created based on a summary field in your report in which the 
values plotted in the chart depend on the values in the summary field. With 
a Detail chart, you can create a chart without the need for a summary field 
by using values that appear in the Details section of your report.

To create a Detail chart, you need to specify two things:

1. Conditions (there can be two), and

2. Values (there can be multiple values).

Condition The Condition is used to indicate when to plot the point. For example, a 
chart showing last year’s sales for your customers uses the Customer 
Name field as the condition. Each time the condition changes (the 
customer name changes), a point is plotted.

Value The Detail chart uses the Value to indicate what information is plotted as 
the points on your chart. For example, if you want to create a chart 
showing last year’s sales for your customers, the Last Year’s Sales field 
would be the value. Each time a point is plotted, it will be plotted at the 
point corresponding to the value in the Last Year’s Sales field.

Creating and modifying your Detail chart is easy with the use of the Chart 
Expert. The Expert walks you through the creation of your chart step-by-
step.

1 Highlight the details field on which you want to chart and click the 
INSERT CHART button on the standard toolbar. The Chart Expert 
appears.

2 Choose the type of chart you want to create by clicking the 
corresponding button on the Type Tab. See Choosing a chart type, Page 
370.
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3 Click the Data Tab to activate it.

4 Use the Place Chart drop-down list and the Header and Footer options 
to specify chart placement.

5 Click the DETAIL button to specify a Detail chart.

6 Select the "on change of" field (the chart values will be shown on each 
change of this field) from the Data scroll box and click the arrow (>) 
button to the left of the On change of text box. The field appears in that 
text box.

7 Use the Ctrl-Click combination to select the fields that you want used 
as chart values from the Data scroll box, and click the arrow (>) 
button to the left of the Show Values scroll box. The selected fields 
appear in that scroll box.

8 Toggle the Don’t summarize values check box on if you do not want 
the program to automatically summarize the chart values.

9 Enter a title, headings, etc., as desired using the Text Tab.

10 Add a legend, grid lines, and other elements to your chart using the 
Axes and Options Tabs.

11 Click the OK button when you are finished. The chart automatically 
appears in the Report Header or the Report Footer, depending on the 
option you chose in the Data Tab.

NOTE: When a chart is inserted, it may cover a portion of your report. 
You can move and resize the chart so that it fits properly within the 
report.

How to chart on a formula field

Seagate Crystal Reports allows you to create a chart based on a formula 
field. Charting on a formula field is much like charting on a details field 
(see How to chart on a details field, Page 376).

To create a chart for a formula field you need to specify two things:

1. Condition, and

2. Value.

Condition The Condition is used to indicate when to plot the point. For example, a 
chart showing last year’s sales by Country uses the Country field as the 
condition. Each time the condition changes (the country changes), a point 
is plotted.
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Value The Value is used to indicate what information is plotted as points on 
your chart. For example, if you want to create a chart showing a 
calculation for last year’s sales (i.e., a budget projection for next year of 
last year’s sales plus 10%), the Last Year’s Sales field would be the value. 
Each time a point is plotted, it will be plotted at the point corresponding 
to the value in the Last Year’s Sales field.

1 Highlight the formula field on which you want to chart and click the 
INSERT CHART button on the standard toolbar. The Chart Expert 
appears.

2 Choose the type of chart you want to create by clicking the 
corresponding button on the Type Tab. See Choosing a chart type, Page 
370.

3 Click the Data Tab to activate it.

4 Use the Place Chart drop-down list and the Header and Footer options 
to specify chart placement.

5 Click the DETAIL button to specify a chart for formulas.

6 Select the "on change of" field (the chart values will be shown on each 
change of this field) from the Data scroll box and click the arrow (>) 
button to the left of the On change of text box. The field appears in that 
text box.

7 Use the Ctrl-Click combination to select the fields that you want used 
as chart values from the Data scroll box, and click the arrow (>) 
button to the left of the Show Values scroll box. The selected fields 
appear in that scroll box.

8 Toggle the Don’t summarize values check box on if you do not want 
the program to automatically summarize the chart values.

9 Enter a title, headings, etc., as desired using the Text Tab.

10 Add a legend, grid lines, and other elements to your chart using the 
Axes and Options Tabs.

11 Click the OK button when you are finished.

The chart automatically appears in the Report Header or the Report 
Footer, depending on the option you chose in the Data Tab.

NOTE: When a chart is inserted, it may cover a portion of your report. 
You can move and resize the chart so that it fits properly within the 
report.
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How to chart on cross-tab summaries

Seagate Crystal Reports allows you to include a chart based on summary 
values in your cross-tab report. For example, with a cross-tab that shows 
the amount of a certain product sold in each region of the United States, 
you may want to include a chart showing the percentage of total sales 
provided by each region for that product.

To create a Cross-Tab chart you must first have a cross-tab in your report. 
For more information, see Cross-Tab Objects, Page 443.

1 With the cross-tab highlighted, click the INSERT CHART button on the 
standard toolbar. The Chart Expert appears with the Type Tab active.

2 Choose the type of chart you want to create by clicking the 
corresponding button on the Type Tab. See Choosing a chart type, Page 
370.

3 Click the Data Tab to activate it. Notice that the Cross-Tab Layout 
button is already selected.

4 Use the Place Chart drop-down list and the Header and Footer options 
to specify chart placement.

5 Use the Graph on drop-down list to specify the summarized field on 
which you want to base your chart.

6 Use the By drop-down list to specify the primary row or column on 
which you want to base your chart.

7 If desired, specify the secondary row or column on which you want 
to base your chart by using the Subdivided By drop-down box.

8 Click the OK button when you are finished. The chart automatically 
appears in the Report Header or the Report Footer, depending on the 
option you chose in the Data Tab.

NOTE: When a chart is inserted, it may cover a portion of your report. 
You will need to move the chart and possibly resize it to fit in your report 
the way you want.

How to chart on an OLAP cube

The OLAP layout can be used to chart on an OLAP grid. In order to create 
an OLAP chart, you must first have an OLAP grid in your report. For 
more information, see Reporting on OLAP data, Page 171.
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1 With the OLAP grid on which you want to chart selected, click the 
INSERT CHART button on the standard toolbar. The Chart Expert 
appears with the Type Tab active.

2 Select the chart type that will best illustrate your data (see Choosing a 
chart type, Page 370).

3 Click the Data Tab to activate it. Notice that the OLAP LAYOUT 
button is already selected.

4 Use the Place Chart drop-down list and the Header and Footer options 
to specify chart placement.

5 Use the Options section to specify style and formatting options 
related to the selected chart type.

6 Click the Text Tab. You can use the text boxes on this tab to specify a 
chart title and format information.

Click OK when you are finished. The program places your chart in the 
Report Header, Group Header, Report Footer, or Group Footer section, 
depending on the options you selected.

How to edit a chart using the Chart Expert

Once you have created a chart, you may want to add a title, headings, or 
a legend, change fonts, or even change the type of chart. Modifying charts 
is easy with the use of the Chart Expert.

1 Right-click the chart that you want edited and choose FORMAT 
CHART from the shortcut menu.

The Chart Expert appears with all the details of the selected chart.

2 Make the desired changes and click OK to update the chart.

How to edit charts using PGEditor

The PGEditor is a powerful chart editor that offers 80 chart types and full 
formatting control of every chart element. The PGEditor is commonly 
used to format chart titles, change chart colors, and resize portions of the 
chart.

A very popular feature of the PGEditor is the ability to save chart 
formatting templates. These templates are like stylesheets for charts. 
They contain custom formatting instructions that can be applied instantly 
to new charts. If you continually create pie charts, for example, and you 
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need the charts to appear in custom colors, you can create a template for 
those colors. Then, whenever a new chart is created, simply apply the 
template and the chart is formatted to the template specifications.

See SSCHART.HLP (located in the \CRW16\SSCHART directory (16-
bit), or \Program Files\Seagate Software\Sschart (32-bit)) for more 
information on the PGEditor application.

How to change chart size and position

You can use the Object Size and Position dialog box to specify the height, 
width, and position of a chart (in inches).

1 From within either the Design or Preview Tab, right-click the chart 
and choose OBJECT SIZE AND POSITION from the shortcut menu. The 
Object Size and Position dialog box appears.

2 In the X Pos text box, enter the desired distance in inches from the left 
edge of the chart object to the left margin of the report section. The 
default distance is 0.04 inches.

3 In the Y Pos text box, enter the desired distance in inches from the 
upper edge of the chart object to the upper margin of the report 
section. The default distance is 0.02 inches.

4 In the Height text box, enter the desired vertical height of the chart, in 
inches.

5 In the Width text box, enter the desired horizontal height of the chart, 
in inches.

6 Click OK to return to your report. The program will implement your 
specifications immediately.

How to change the border of a chart

1 From the Design or Preview Tab, right-click the chart and choose 
CHANGE BORDER from the shortcut menu. The Format Editor appears 
with the Border Tab active.

2 Change the border as needed.

3 Click OK. The program immediately implements these changes.
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How to use the underlay feature with charts

Since charts can only print in certain sections of your report, the underlay 
feature gives you more power and control in the overall look of your 
report. Instead of having a chart print ahead of the data it represents, it 
can appear next to the data for a more comprehensible report. See Area 
printing characteristics, Page 59. 

1 Create the chart and place it in the Report Header section. For more 
information see How to chart on a summary or subtotal field (group 
charts), Page 375.

2 Click the SECTION EXPERT button on the standard toolbar. The Section 
Expert appears.

3 Highlight the Report Header section in the Sections list box and 
toggle the Underlay Following Sections option on.

4 Click OK.

You are returned to your report. The chart will now underlay the 
sections below it. Move or resize the chart as desired.

Related Topics

How to make an object underlay a following section(s), Page 111

How to analyze a chart

The Analyzer Tab allows you to analyze charts in-depth. The commands 
on the Analyzer Tab shortcut menu help you customize a chart, allowing 
you to examine complex data and identify trends.
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There are a number of operations you can perform on any chart in the 
Analyzer Tab, as described below. There are also a few additional 
commands on the shortcut menu that are chart-specific. For example, in 
the case of a Pie chart, you may have commands for resizing the pie and 
for adjusting the pie rotation. In the case of a bar chart, you may have 
commands for staggering the labels. In this way, the Analyzer Tab offers 
you maximum flexibility.

NOTE: Changes performed in the Analyzer Tab are applied to the 
currently selected chart or charts. You can have two charts selected in the 
analyzer at one time. When you try to select a third chart and bring it into 
the analyzer, you will be asked to discard one of the previously selected 
charts.

To analyze a chart in depth, right-click the chart and choose LAUNCH 
ANALYZER from the shortcut menu. The program opens the Analyzer 
Tab.

Changing the 
chart title

To change the chart title:

1 Right-click the chart and choose CHANGE CHART TITLE from the 
shortcut menu. The Change Label dialog box appears.

2 Enter a new title in the text box.

3 Click OK to return to the Analyzer Tab. The program implements the 
changes immediately.

Changing axis 
titles

You can change the titles for the X-, Y-, and Z-axes; there is a separate 
command for each, and each command will open the Analyzer Tab’s 
standard Change Label dialog box.

1 Right-click the chart and choose the desired title change command 
(CHANGE X-AXIS TITLE, CHANGE Y-AXIS TITLE, or CHANGE Z-AXIS 
TITLE) from the shortcut menu. The Change Label dialog box 
appears.

2 Enter a new axis title in the text box.

3 Click OK to return to the Analyzer Tab. The program implements 
your changes immediately.

Reversing the 
series order

You can reverse the order in which the series are displayed on the chart. 
Right-click the chart and choose REVERSE SERIES from the shortcut menu 
to toggle the check mark that appears beside the command on or off as 
needed. If the check mark is toggled on, the series will be reversed. If the 
check mark is toggled off, the series will be displayed in their default 
direction.
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Reversing the 
group order

You can reverse the order in which the groups are displayed on the chart. 
Right-click the chart and choose REVERSE GROUPS from the shortcut menu 
to toggle the check mark that appears beside the command on or off as 
needed. If the check mark is toggled on, the groups will be reversed. If the 
check mark is toggled off, the groups will be displayed in their default 
direction.
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18 Mapping

What you will find in this chapter...

Mapping Overview, Page 386

Choosing a map, Page 386

Where to place a map, Page 390

Analyzer Tab, Page 391

Data you can map on, Page 391

For more map information, Page 391

HANDS-ON (Mapping), Page 391
Mapping 385



Mapping Overview

With Seagate Crystal Reports, you can include professional geographic 
maps in reports. Maps help analyze report data and identify trends more 
efficiently. For example, you could create a map that shows sales by 
region. You would then be able to:

●   drill-down on the map regions to view underlying data,

●   use one of the five map types to analyze the data, and

●   use the Analyzer Tab to adjust the appearance and organization of 
the map (allowing you to better identify trends).

In order to place a generic, group-based map on a report, you must first 
have a group and a summary or subtotal field present in the report. 
However, the program does provide several specialized map layouts 
(Detail, Cross-Tab, and OLAP) that do not require groups and 
summaries.

NOTE: When a field is summarized or subtotaled, the program 
automatically groups the data. For more information, see Sorting, 
Grouping, and Totaling, Page 245.

NOTE: Mapping only appears in the 32 bit version.

Choosing a map

The Map Expert provides a wide range of mapping abilities, including:

●   four map layouts, and

●   five map types.

You can choose the map layout and type that is best suited to your data.

Map layouts The Map Expert provides four powerful layouts. Each layout is especially 
useful for mapping on certain sets of data. Any of the following layouts 
can be used to create a map:

1. Group
The Group layout is a very simplified layout in which a summary on 
change of a geographic field (such as Region) is shown. In order to 
create a map using the Group layout, you must have at least one 
group and at least one summary field for that group.
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2. Detail
The Detail layout is more complex than the Group layout. Use the 
Detail layout when using multiple map values, rather than only one, 
or when you do not have any groups or summaries in the report.

3. Cross-Tab
Use the Cross-Tab layout when mapping on a cross-tab object. The 
cross-tab information can be used as the basis of the map. A Cross-
Tab map does not require groups or summary fields.

4. OLAP
Use the OLAP layout when mapping on an OLAP grid. The OLAP 
data can be used as the basis of the map. An OLAP map does not 
require groups or summary fields.

NOTE: If there is no map associated with the data you specify, then no 
map will be shown. For example, if you create a map based on country 
and one of you detail records has a country for which there is no map an 
empty block will appear unless the section that the map is placed in has 
been formatted to suppress if blank.

Map types The Map Expert also provides five basic map types, each suitable for a 
different strategy of data analysis. When deciding which map type best 
fits your report, you should consider the type of data you want to 
analyze. For example, if you want the map to display one data item for 
each geographic division (city, state, country, etc.), then you might use a 
Ranged, Dot Density, or Graduated map. On the other hand, if you want 
the map to display more than one value for each new geographic 
division, then you could use a Pie Chart map or a Bar Chart map. The 
map types are:

1. Ranged
A Ranged map breaks the data into ranges, assigns a specific color to 
each range, and then codes each geographic area on the map by color 
to display the range. For example, you could create a map that 
displays Last Year’s Sales by Region. If you have sales ranging from 
zero to 100,000, you might give the map five ranges, with equal 
intervals of 20,000 each. You could use shades of red (going from 
dark red to light red) to color code each region according to those 
sales figures. Then you could use this map to see where sales are the 
highest. With equal intervals, you might end up with all your regions 
ranging between zero and 20,000, except perhaps one region (for 
example, California) that might have exceptionally high sales (such 
as 98,000). This map would be a very distorted representation of the 
data. A more useful map would have ranges like 0-5000, 5001-10000, 
10001-15000, 15001-20000, and over 20000. It is important to define 
your ranges carefully. There are four different range options:
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●   Equal count
This option assigns intervals in such a way that the same number 
of regions (or as close to the same number of regions as possible) 
appear in each interval. In other words, this option should assign 
intervals so that each color on the map is assigned to the same 
number of regions. The numeric quantity of the summary values 
in each interval may or may not be equal, depending on the 
individual regions and their summary values.

●   Equal ranges
This option assigns intervals in such a way that the summary 
values in each interval are numerically equal. The number of 
regions in each interval may or may not be equal, depending on 
the individual regions and their summary values.

●   Natural break
This option assigns intervals using an algorithm that attempts to 
minimize the difference between the summary values and the 
average of the summary values, for each interval.

●   Standard deviation
This option assigns intervals in such a way that the middle 
interval breaks at the mean (or average) of the data values, and the 
intervals above and below the middle range are one standard 
deviation above or below the mean. Standard deviation is the 
square root of the variance. It projects how various values in a set 
of values deviate from the mean for that set.

2. Dot Density
A Dot Density map displays a dot for each occurrence of a specified 
item. For example, you might create a United States map that shows 
one dot for each shipbuilder in the nation. In states like Tennessee, 
there would be no dots. In some coastal states, such as South 
Carolina, you might be able to count the dots on the map, since their 
dispersal would be fairly wide. However, for states with major 
shipbuilding industries, such as California and Virginia, the dots 
would all merge together into a solid mass along the coastline. The 
purpose of a Dot Density map, then, is to provide an overall 
impression of the distribution of the specified item. A Dot Density 
map is much like a nighttime satellite photo of the U.S., where you 
can see the lights of all the cities. Such a map is not a very accurate 
means of communicating information (particularly if you have a 
large number of items), but is a good way to give an impression of 
the distribution.
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3. Graduated
A Graduated map is much like a Ranged map; it shows one symbol 
per instance of a specified item. This symbol is a circle by default, but 
you can choose a different symbol if you prefer. Each symbol is 
proportional in size to the value of the item it represents (within a 
range of three sizes). A Graduated map communicates the same 
information as the Ranged map, but you would usually create a 
Ranged map for a case in which the geographic areas will have 
distinct geographic boundaries (as in the case of regions), while you 
would use a Graduated map for displaying data that is linked to 
points rather than precise areas (as in the case of cities). For example, 
a map of an individual region could use graduated circles to 
represent the sales for each office. The size of each circle would be 
proportional to the sales (or to the sales range) of the office it 
represents. On this map, an office with a sales figure of $70,000 might 
have a large circle, and an office with a sales figure of $20,000 might 
have a small circle. So, a Graduated map provides a more efficient 
representation of point data than a Ranged map does, and it uses 
sized symbols rather than colors to distinguish variations in the 
values of the items it represents.

4. Pie Chart
A Pie Chart map displays a pie chart over each geographic area. The 
pie charts represent data items that make up a whole. Each slice of 
the pie represents an individual data item and shows that item’s 
percentage in the whole. For example, you could create a pie chart 
map showing heating fuel types by region. You might have four 
types of heating fuel (four slices in each pie): electricity, gas, wood, 
and solar. Each region would then have a pie chart showing the 
breakdown of heating fuel types within that region. Washington 
state would probably use a high percentage (a large slice of the pie) 
of electricity because of the hydropower in that region, while Idaho 
would probably use a high percentage (a large slice of the pie) of 
natural gas. You can use this map type to compare the distribution of 
several items within a particular region. You can also specify that the 
pie charts be sized proportionately, so that, as with the symbols in a 
Graduated map, the pie charts will appear in various sizes, 
depending on the underlying data values. This will allow you to 
compare the totals between regions.

5. Bar Chart
A Bar Chart map works like a Pie Chart map, but may be more useful 
for certain sets of data. Typically, you would use a Bar Chart map for 
items that do not total 100% (that is, for data items that do not make a 
whole, or for data items that are unrelated). For example, you could 
create a Bar Chart map that displays use of heating fuel by region. 
You might choose to analyze use of three types of fuel: electricity, 
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gas, and solar. Each bar chart on the map could contain individual 
bars for each of these types. In this example, the data items 
(electricity, gas, and solar) do not comprise a whole. There may be 
other types of fuel used in these regions, such as wood, but this map 
only focuses on three of them. Also, the purpose of the map is to 
compare each region’s use of each fuel type with that of every other 
region. In a Pie Chart map, you could show these three fuel types as 
percentages of the entire fuel use within each region, and though you 
could compare the percentages for each region, you would probably 
not be able to compare the actual values for each region, because 
each region would have the same total value (100%).

Where to place a map

When you choose where to place the map, you determine the amount of 
data that will be included in the map. For example, if you place the map 
in the Report Header section, the map includes data for the entire report. 
If you place it in a Group Header or Group Footer section, it displays 
group-specific data. This choice will also determine whether the map 
prints once for the entire report, or many times (once for each instance of 
a given group).

NOTE: If your report contains subreports, you can place maps in those 
subreports as well. See How to map on a subreport, Page 396.

Drill-down with 
maps

Not only is mapping a powerful means of presenting data - it is also a 
powerful analysis tool. You can activate drill-down mode by right-
clicking the map in the Preview Tab and choosing Drill-down from the 
shortcut menu. When you are in drill-down mode, and the mouse pointer 
is moved over a section of the map in the Preview Tab, and the pointer 
becomes a Drill-down cursor, double-click to view the underlying details 
for that section of the map.

NOTE: If you drill-down on a region that has no data associated with it, 
you will get a message saying "There are no detail records for that 
{Region Name]." For example, if you are looking at a world map and try 
to drill-down on Germany, but there is no Germany group in the report 
you will get the above message.
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Analyzer Tab

Seagate Crystal Reports provides a third tab (besides the Design and 
Preview Tabs) specifically for advanced charting and mapping. This is 
the Analyzer Tab. Use this tab to organize your maps for more efficient 
analysis. The Analyzer Tab allows you to set the properties of an 
individual instance of a map independently of the rest of the report. You 
can center the map, zoom in and out, pan the map, change the map style, 
and rearrange the map layers. For more information, see Analyzer Tab, 
Page 65.

To activate the Analyzer Tab, right-click the map you want to analyze and 
choose LAUNCH ANALYZER from the shortcut menu.

Data you can map on

You can map on the following:

●   groups (see How to map on a group, Page 393).

●   detail fields (see How to map on a detail field, Page 393).

●   cross-tab summaries (see How to map on a cross-tab, Page 394).

●   OLAP data (see How to map on an OLAP cube, Page 396).

For more map information

Seagate Crystal Reports comes with a standard set of maps. For more 
information and additional maps visit our web site at:

http://www.seagatesoftware.com/scr-productinfo/moremaps

HANDS-ON (Mapping)

How to create and insert a map

1 Click the INSERT MAP button on the standard toolbar. The Map 
Expert appears with the Data Tab active.
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2 Use the Place Map drop-down list and the Header and Footer options 
to specify map placement.

3 Choose a map layout by clicking one of the four map buttons on the 
Data Tab (GROUP, DETAIL, CROSS-TAB, OR OLAP). For more 
information about the four map layouts, see Map layouts, Page 386.

4 Use the drop-down lists, list boxes, and arrow buttons on the Data 
Tab to specify a summary field (which will supply the numeric 
values for your map), a geographic field (which will supply the 
geographic areas for your map), and map values.

5 Click the Type Tab.

6 Choose a map type by clicking one of the five map buttons on the 
Type Tab (RANGED, DOT DENSITY, GRADUATED, PIE CHART, or BAR 
CHART). Some of these map types will not be available with certain 
map layouts. For more information about the five map types, see 
Map types, Page 387.

7 Use the Options section of the Type Tab to specify style and 
formatting options related to the selected map type.

8 Click the Options Tab.

9 Use the text boxes and option buttons on the Options Tab to give 
your map a title and a legend.
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10 Click OK. The program places the map on the report as specified in 
Step 2, and returns you to the report.

The process for creating a map varies depending on the data you are 
mapping on. The following sections detail each mapping process.

How to map on a group

To map on a group, you can use the Group layout, in which you show a 
summary (such as Last Year’s Sales) on change of a geographic field (such 
as Region). In order to create a map using the Group layout, you must 
have at least one group and at least one summary field in your report.

1 Click the INSERT MAP button on the standard toolbar. The Map 
Expert appears with the Data Tab active.

2 Click the GROUP button to specify that you want to map on a 
grouped and summarized field.

3 Use the Place Map drop-down list and the Header and Footer options 
to specify map placement.

4 Select the group on which you are mapping from the On change of 
drop-down list.

5 Select a summary field from the Show drop-down list. The value in 
the summary field will be shown each time the group changes.

6 Click the Type Tab.

7 Select the map type that will best illustrate your data: Ranged, Dot 
Density, or Graduated (see Map types, Page 387).

8 Use the Options section to specify style and formatting options 
related to the selected map type.

9 Click the Options Tab. You can use the text boxes on this tab to 
specify a map title and legend information.

10 Click OK when you are finished. The program places your map in 
the Report Header, Group Header, Report Footer, or Group Footer 
section, depending on the options you selected in Step 3.

How to map on a detail field

Using the Detail layout, you can map on a detail field. This layout also 
allows you to use multiple fields as map values. Use this layout to use 
multiple map values, rather than only one, or when you do not have any 
groups or summaries in a report.
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NOTE: You must map on a geographic field, such as Country, Region, or 
City. The program cannot generate a map based on a non-geographic 
field.

1 Click the INSERT MAP button on the standard toolbar. The Map 
Expert appears with the Data Tab active.

2 Click the DETAIL button to specify that you want to map on a detail 
field.

3 Use the Place Map drop-down list and the Header and Footer options 
to specify map placement.

4 Select the field on which you want to map from the Data scroll box 
and click the top arrow (>) button. The field appears in the Geographic 
Field text box.

5 Select the "on change of" field (the map values will be shown on each 
change of this field) from the Data scroll box and click the arrow (>) 
button to the left of the On change of text box. The field appears in that 
text box.

6 Use the Ctrl-Click combination to select the fields that you want used 
as map values from the Data scroll box, and click the arrow (>) button 
to the left of the Map Values scroll box. The selected fields appear in 
this scroll box.

7 Toggle the Don’t summarize values check box on if you do not want 
the program to automatically summarize the map values. This check 
box is toggled on by default.

8 Click the Type Tab.

9 Select the map type that will best illustrate your data (see Map types, 
Page 387).

10 Use the Options section to specify style and formatting options 
related to the selected map type.

11 Click the Options Tab. The text boxes on this tab can be used to 
specify a map title and legend information.

12 Click OK when you are finished. The program places your map in 
the Report Header, Group Header, Report Footer, or Group Footer 
section, depending on the options you selected in Step 3.

How to map on a cross-tab

With the Cross-Tab layout, you can map on a cross-tab summary field. 
For example, with a cross-tab that shows the total number of items of a 
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product sold in each region of the United States, you may want to include 
a map that shows the percentage of the total sales of the product provided 
by each region.

In order to create a cross-tab map you must first have a cross-tab in your 
report. For more information, see Cross-Tab Objects, Page 443.

1 With the cross-tab on which you want to map selected, click the 
INSERT MAP button on the standard toolbar. The Map Expert appears 
with the Data Tab active.

2 Click the CROSS-TAB button to specify that you want to create a cross-
tab map.

3 Use the Place Map drop-down list and the Header and Footer options 
to specify map placement.

4 Select the summary field on which you want to map from the Map on 
drop-down list. This field will supply the numeric data for the map.

5 Select the geographic field you want shown from the Show Geographic 
Field drop-down list. This field will supply the geographic areas for 
the map.

6 You can select an additional field to map on from the Subdivided by 
drop-down list, if desired. The program uses this field to subdivide 
the pie or bar charts appearing on your map.

7 Click the Type Tab.

8 Select the map type that will best illustrate your data (see Map types, 
Page 387).

●   If mapping on only one field (if you selected None from the 
Subdivided by drop-down list), you can select one of these map 
types: Ranged, Dot Density, or Graduated.

●   If mapping on two fields (if you selected an additional field from 
the Subdivided by drop-down list), you can select one of these map 
types: Pie Chart or Bar Chart.

9 Use the Options section to specify style and formatting options 
related to the selected map type.

10 Click the Options Tab. You can use the text boxes on this tab to 
specify a map title and legend information.

11 Click OK when you are finished. The program places your map in 
the Report Header, Group Header, Report Footer, or Group Footer 
section, depending on the options you selected in Step 3.
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How to map on an OLAP cube

Using the OLAP layout, you can map on an OLAP grid. In order to create 
an OLAP map, you must first have an OLAP grid in your report. For more 
information, see Reporting on OLAP data, Page 171.

1 With the OLAP grid on which you want to map selected, click the 
INSERT MAP button on the standard toolbar. The Map Expert appears 
with the Data Tab active.

2 Click the OLAP button to specify that you want to create an OLAP 
map.

3 Specify map placement using the Place Map drop-down list and the 
Header and Footer options.

4 Use the Data Tab to select the summary and geographic fields that 
you want to use for the map.

5 Click the Type Tab.

6 Select the map type that will best illustrate your data (see Map types, 
Page 387).

7 Use the Options section to specify style and formatting options 
related to the selected map type.

8 Click the Options Tab. Use the text boxes on this tab to specify a map 
title and legend information.

9 Click OK when you are finished. The program places your map in 
the Report Header, Group Header, Report Footer, or Group Footer 
section, depending on the options you selected in Step 3.

How to map on a subreport

Inserting a map into a subreport involves the same process used to insert 
a map into the primary report. The only difference is that you must insert 
the map with the subreport Design Tab active.

1 Click the INSERT MAP button on the standard toolbar. The Map 
Expert appears with the Data Tab active.

2 Complete the Map Expert, and click OK. The program places the 
map in the section you specified in the Map Expert, and returns you 
to the report.

3 Resize or move your map as desired.
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The process for creating a map varies depending on the type of data you 
are mapping on. For more information about mapping:

●   see How to map on a group, Page 393. 

●   see How to map on a detail field, Page 393. 

●   see How to map on a cross-tab, Page 394. 

●   see How to map on an OLAP cube, Page 396.

How to edit a map using the Map Expert

Once you have created a map, you may want to add a title, headings, and 
a legend, and you may want to change fonts, or even the map type. From 
either the Design or Preview Tab, you can easily open the Map Expert and 
make your modifications.

1 Right-click the map you want to edit and choose MAP EXPERT from 
the shortcut menu.

The Map Expert appears, supplying all the settings for the selected 
map.

2 Make the desired changes and then click OK to update the map.

How to change map size and position

You can use the Object Size and Position dialog box to specify the height, 
width, and position of your map, in inches.

1 From within either the Design or Preview Tab, right-click the map 
and choose OBJECT SIZE AND POSITION from the shortcut menu. The 
Object Size and Position dialog box appears.

2 In the X Pos text box, enter the desired distance in inches from the left 
edge of the map object to the left margin of the report section. The 
default distance is 0.04 inches.

3 In the Y Pos text box, enter the desired distance in inches from the 
upper edge of the map object to the upper margin of the report 
section. The default distance is 0.02 inches.

4 In the Height text box, enter the desired vertical height of the map, in 
inches.

5 In the Width text box, enter the desired horizontal height of the map, 
in inches.
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6 Click OK to return to your report. The program will implement your 
specifications immediately.

NOTE: You can also change size and position by moving and resizing the 
map. However, the Object Size and Position dialog box allows you to 
make exact adjustments.

How to change the border of a map

1 From the Design or Preview Tab, right-click the map and choose 
CHANGE BORDER from the shortcut menu. The Format Editor appears 
with the Border Tab active.

2 Use the Border Tab to change the border as needed. You can change 
the line style, the color, and you can add or remove a drop shadow.

3 Click OK when finished. The program immediately implements your 
changes.

How to use the underlay feature with maps

Since maps can only print in certain areas and sections of your report (see 
Area printing characteristics, Page 59), the underlay feature makes mapping 
even more useful. Instead of having a map print before the data it 
represents, you can have the map appear alongside the data, thus making 
the report easier to read and easier to understand.

1 Create your map and place it in the Report Header section. For more 
information, see How to create and insert a map, Page 391.

2 In the Design Tab, right-click the gray area to the left of the Report 
Header section and choose FORMAT SECTION from the shortcut menu. 
The Section Expert appears.

3 Toggle the Underlay Following Sections check box on for the Report 
Header section.

4 Resize the map as needed, to underlay the following sections.

5 Click OK.
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How to analyze a map

The Analyzer Tab lets you analyze your maps in-depth. The commands 
on the Analyzer Tab shortcut menu help you customize your map, 
allowing you to examine complex data and identify trends.

To analyze a map in depth, right-click the map and choose LAUNCH 
ANALYZER from the shortcut menu that appears. The program opens the 
Analyzer Tab.

Zooming, 
panning, and 
centering

Both the Preview Tab and the Analyzer Tab include commands for 
zooming, panning, and centering maps. These commands allow you to be 
very mobile. You can zoom in and out on your maps at will, whenever 
you need to view more precise or more general information. By panning, 
you can quickly drag your map anywhere you please. By centering, you 
can quickly return your map to the center of the Tab after panning. These 
commands offer you maximum flexibility for examining maps.

1 To zoom in on a map, right-click that section of the Analyzer Tab and 
toggle on the check mark beside the ZOOM IN command on the 
shortcut menu. A Zoom cursor appears; click yhe map to zoom in 
one level of magnification. Click again to zoom in further. 

NOTE: To specify more accurately the area you want to zoom in on, drag 
the mouse to highlight the section of the map you want to see when the 
Zoom cursor appears.

2 To zoom out on a map, right-click that section of the Analyzer Tab 
and toggle on the check mark beside the ZOOM OUT command on the 
shortcut menu. A Zoom cursor appears; click the map to zoom out 
one level of magnification. Click again to zoom out further.

3 To pan a map, right-click that section of the Analyzer Tab and toggle 
on the check mark beside the PAN command on the shortcut menu. A 
Panning cursor appears. Use this cursor to click and drag the map 
across the screen.

4 To center a map, right-click within that section of the Analyzer Tab 
and choose CENTER MAP from the shortcut menu. You can also 
choose NONE from the shortcut menu to disable all movement 
options. This will prevent accidental panning or zooming.

NOTE: If a map occurs once for each instance of a group, then any 
panning or zooming settings you specify are instance-specific. In other 
words, if you zoom in on the map in one group header, this setting is only 
for that group header. None of the headers have been changed. This way, 
you can set each map to different settings.
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NOTE: If the Save Data with Report option is enabled (File menu), your 
panning and zooming settings will be saved with the report. If the option 
is not enabled, then only the default map settings will be saved.

Changing the 
map style

From within the Analyzer Tab, you can quickly change the map type and 
set the properties for that map. For example, if you are analyzing a Range 
map, and you want to see how the data would look if it were presented 
in a Dot Density style, you can quickly rearrange the map, without 
having to return to the Map Expert and rework the format. The Analyzer 
Tab also offers more advanced options for changing the appearance of the 
map you have specified.

1 Right-click the section of the Analyzer Tab in which your map 
appears, and choose CHANGE MAP STYLE from the shortcut menu. 
The Customize Map dialog box appears.

2 Select the desired map type from the Map type drop-down list.

3 In the Options section of the dialog box, set the properties for the map. 
The properties available will vary depending on the map type chosen.

4 Click OK.

The program returns you to the Analyzer Tab. Your specifications take 
immediate effect.

Changing map 
layers

It takes only a moment to rearrange map layers. You can also set 
properties, such as visibility, for those layers, and you can add and 
remove layers as needed.

1 Right-click the appropriate section of the Analyzer Tab and choose 
CHANGE LAYERS from the shortcut menu. The Layer Control dialog 
box appears.

2 Use the UP and DOWN buttons to arrange the map layers in the Layers 
list box.

3 For each map layer, set the properties in the Properties section of the 
dialog box you can specify whether the layer is visible, whether it can 
be selected, and whether it is automatically labeled.

4 If desired, click the Display button to open the Display Properties 
dialog box. Use this dialog box to set the default display mode and 
zoom range (the minimum and maximum possible magnification) 
for the layer in question, and then click OK to return to the Layer 
Control dialog box.

5 If desired, click Labels to open the Label Properties dialog box. Use 
this dialog box to specify the visibility, styles, and position of the 
labels for the layer in question (if applicable), and then click OK to 
return to the Layer Control dialog box.
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6 Click OK to return to the Analyzer Tab. The program implements 
your specifications immediately.

Changing the 
map title

To change the map title:

1 Right-click the map and choose CHANGE TITLE from the shortcut 
menu. The Change Label dialog box appears.

2 Enter a new title in the text box.

3 Click OK to return to the Analyzer Tab. The program implements 
your changes immediately.
Mapping 401



402 Seagate Crystal Reports User’s Guide



19 OLE

What you will find in this chapter...

OLE Objects Overview, Page 404

Inserting OLE objects into reports, Page 406

Linked vs. Embedded Objects, Page 407

Dynamic OLE menu commands, Page 408

OLE and the Picture command, Page 409

General OLE considerations, Page 409

HANDS-ON (OLE Objects), Page 410
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OLE Objects Overview

When a graphic, spreadsheet, or some other object is inserted into a 
report, it may be necessary to change that object. Normally, in order to 
make changes, you would have to:

●   exit Seagate Crystal Reports,

●   open the original application,

●   change the object,

●   return to Seagate Crystal Reports,

●   delete the object originally inserted, and

●   insert the newly revised object.

All of these steps can be avoided by using Object Linking and Embedding 
(OLE). OLE allows you to insert objects (OLE objects) into a report from 
other applications (OLE server applications) and then use those 
applications from within Seagate Crystal Reports to edit the objects if 
necessary.

To better understand the program’s use of OLE, some terminology may 
be helpful:

●   OLE
OLE is an acronym for Object Linking and Embedding. It refers to 
the ability to create compound reports, that is, reports that contain 
elements from other applications that can be edited using the 
original application.

●   OLE Object
An OLE object is, broadly speaking, a presentation of data that was 
created in another application and that maintains a relationship 
with the application that was used to create it. A bitmap created in a 
paint program, an Excel spreadsheet, or a graph from MS Graph 
may all be OLE objects if they are inserted in the receiving 
document as OLE objects. If they are not inserted as OLE objects, 
they retain no relationship with the originating application.

●   OLE Container Application
An OLE container application is one that can contain and process 
OLE objects created in other applications (such as Paint or Excel). 
Seagate Crystal Reports is a container application.

●   Container Document
A container document is a document that was created using the 
container application and that contains an OLE object.
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●   OLE Server Application
An OLE server application is an application that is able to create 
OLE objects which can then be placed into container documents. 
Microsoft Word and Excel are examples of applications that are 
both OLE servers and OLE containers. That is, they can both create 
new OLE objects and they can contain OLE objects created 
elsewhere. 

●   Server Document
The server document is a file created in the server application that 
stores the original OLE object.

●   Linked object
A linked object contains a presentation of the object and a link to 
its duplicate in the server document. When you modify the 
original object in the server document, the links assure that the 
object in your report is also modified automatically. Conversely, if 
you modify the object in the container document, the original 
object in the server document is modified. As a general rule, use 
linked objects when the data in the server document is changing 
and you want the object in the container document to be updated 
when changes occur.

●   Embedded object
An embedded object contains a presentation of the object, all of the 
data that pertains to the object, and information about the 
application used to create it. When you modify the original object 
in the server document, nothing happens to the embedded object 
unless you specifically update that object. Likewise, when you 
modify the embedded object, nothing happens to the original. As a 
general rule, use embedded objects when you need to edit the 
object in the container application without affecting the original 
object.

●   In-place editing
In-place editing is the ability to change an OLE object’s properties 
from within an OLE container application (such as Seagate Crystal 
Reports). The container application’s menu items change to 
provide the editing tools from the server application so that you 
can make changes easily.

●   Static OLE Object
If a user does not have the server application in which an OLE 
object was created, still has the option of using the static OLE 
object that the container application has saved and stored. A static 
OLE object is a picture of an object that can be displayed and 
printed, but not edited in place. The static OLE object offers 
improved online and print performance over a standard bitmap.
OLE 405



When an OLE object is placed in a report, the object becomes part of the 
report. To edit the object, double-click it and then modify it using the 
editing tools found in the object’s original application or from a similar 
application that allows in-place editing. Using OLE objects in a report 
enables you to create robust documents that are easy to maintain.

Inserting OLE objects into reports

There are several methods of inserting OLE objects into an application.

●   The PASTE SPECIAL command on the Edit Menu can be used to cut 
the object from an OLE server application and paste it in a report. 
If the object can be pasted in multiple formats, you need to decide 
which format to use. For example, when inserting text from a 
Microsoft Word document, you can paste the text as Microsoft 
Word document text (which can be edited in Word), or as a 
metafile which is simply a non-editable picture of the text. Use the 
PASTE SPECIAL command to place either embedded or linked 
objects.

●   The OLE OBJECT command on the Insert Menu can be used to 
import an existing object or create a new one. You can place either 
embedded or linked objects using this method.

●   Finally, you can drag and drop an object from an OLE server 
application. You do this by opening Seagate Crystal Reports in one 
window and the OLE server application in another and then 
dragging the object between the two. However, when an object is 
dragged into a report, the object is embedded, not linked.

NOTE: When inserting selected information (portions of larger files), it is 
best to use either the COPY or PASTE SPECIAL commands on the Edit Menu, 
or drag and drop editing. When inserting entire files, use the OBJECT 
command on the Insert Menu.

Linked vs. Embedded Objects

Since linked and embedded objects each have different properties, it is 
important for you to consider the capabilities of each when deciding 
which OLE format to use.

Linked objects When a linked object is inserted into a report, Windows copies a snapshot 
of the data from a file that already exists. Only the image of the object is 
added to your report. The actual data remains with the original file.
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When the object is opened from within a report, the original file is opened 
inside the application that was used to create it. Any changes you make 
directly affect the original file also.

If you want the data in an object to remain available to other applications, 
and always reflect the most current changes to the data, link the object to 
the report.

NOTE: When you have a linked object and you break the link using the 
Links dialog box, all connections to the original data in the server 
document are broken. A linked object in a container application is merely 
a representation of that object and a link between the object and the 
server document. When you break the link you’re left with only the 
representation, with no relationship to the original data or to the editing 
capabilities of the server application. In such a situation, Seagate Crystal 
Reports turns the object into a picture (a metafile), a stand-alone object 
that can neither be edited using OLE capabilities nor converted into a 
modifiable OLE object.

Embedded 
objects

An embedded object can be created from within Seagate Crystal Reports, 
or by using a file that already exists. The data, as well as the image of the 
object, is saved with the report.

To create a new object for a report from scratch, or copy the information 
from an existing file and edit the data without ever affecting the original 
file, embed the object in the report.

●   If the original object is changed, the embedded object does not 
change.

●   If you edit an embedded object, changes made to the object are 
stored with the report file; the changes do not affect the original.

Dynamic OLE menu commands

The OBJECT command on the Insert Menu is dynamic; it changes to reflect 
the properties of the selected object.

The object may be described as a Document object, Bitmap Image object, 
Picture object, Worksheet object, or something similarly descriptive.

●   If the object is embedded, the Insert Menu displays those 
commands that are available to that type of embedded object.

●   If the object is linked, the Insert Menu displays commands for that 
type of linked object. 

Commands on the shortcut menus change in a similar fashion.
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These dynamic commands are provided to give you more control when 
working with OLE objects.

OLE and the Picture command

If the OBJECT command on the Insert Menu is used to place pictures in a 
report, the picture can be treated as either an embedded or a linked object.

However, if the PICTURE command on the Insert Menu is used to place 
pictures in a report, Seagate Crystal Reports converts them into static 
OLE objects in order to enhance online and printing performance.

Static objects do not support in-place editing. To edit an object in place, it 
will have to be converted into an editable type of object using the 
CONVERT command on the Edit Menu.

If the OBJECT or PASTE SPECIAL commands on the Insert Menu are used to 
insert bitmaps, Seagate Crystal Reports automatically converts them to 
static OLE objects. However, the program does not convert bitmaps that 
are stored in databases as BLOB field values. When database bitmap 
fields are placed in a report, the program displays them as normal 
bitmaps with no OLE characteristics.

General OLE considerations

There are several points to keep in mind when utilizing OLE 
functionality.

●   When you double-click an embedded OLE object, Seagate Crystal 
Reports changes its menus and toolbars to those of the object’s 
server application. When you are finished editing, click outside 
the object and Seagate Crystal Reports toolbars reappear.

●   When you double-click a linked OLE object, the program opens 
the object’s server application with the object displayed and ready 
for editing. You can not edit a linked object in place in Seagate 
Crystal Reports because you are working on the original object. 
Since the object could be linked to multiple documents, and since, 
conceivably more than one person could want to edit it at a given 
time, displaying the original in the server application limits access 
to one editor at a time.

●   Windows 3.x shipped Microsoft Paintbrush (PBRUSH.EXE) as the 
native bitmap editor. Windows 95 and Windows 98 ship Microsoft 
Paint (MSPAINT.EXE) as the new bitmap editor. While Windows 
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95 and Windows 98 know to register and convert PBRUSH.EXE 
OLE bitmaps as MSPAINT OLE bitmaps, the opposite is not true. 
You can open a Windows 3.1 OLE bitmap report in Windows 95 
and Windows 98; however, you can not open a Windows 95 and 
Windows 98 OLE bitmap report in Windows 3.x. Thus, if you are 
going to be working back and forth between these two operating 
systems, it is best to create the reports in Windows 3.1 rather than 
in Windows 95 and Windows 98.

HANDS-ON (OLE Objects)

How OLE objects are represented in a report

An OLE object is displayed in a report in any of several different formats 
depending on how you choose to insert the object.

●   If you have chosen to display the object as an icon, the icon will 
appear in the report. Using this capability with large bitmaps will 
speed up report processing. Users can choose to edit the bitmap 
later by double-clicking the icon.

●   If the object was created from an existing file, the data from that 
file (or an icon) will be displayed in the report. This data can be 
edited by double-clicking the object or its icon.

●   If you are creating a new object, the application for the object type 
that you chose will open, and you can begin designing the object. 
When you are finished, close or exit the application. The object (or 
its icon) will be displayed in the report.

Related Topics

Search for Insert Object dialog box in online Help.

How to use OLE - General Overview Tutorial

The easiest way to understand the OLE concepts is to create a sample 
report that uses static, embedded, and linked objects and compare their 
differences.

Static OLE object 1 To begin, create a report using the sample data, xtreme.mdb. Place 
any field in the Details section of the report.
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2 Choose the PICTURE command from the Insert Menu and then choose 
Xtreme.bmp from the \CRW16 directory (16-bit), or \Program 
Files\Seagate Software\Crystal Reports directory (32-bit). When the 
object frame appears, place the picture on the far left side of the 
Report Header section.

3 Right-click the picture. When the shortcut menu appears, notice that 
the picture is identified as an OLE object.

4 When you double-click the object, nothing happens. A static OLE 
object can not be edited in place.

Embedded 
OLE object

1 Choose the OLE OBJECT command from the Insert Menu. The Insert 
Object dialog box appears.

2 Click the Create From File option. The dialog box changes, allowing 
you to either type in an object name or browse. 

3 Click Browse and choose Xtreme.bmp from the \CRW16 directory 
(16-bit), or \Program Files\Seagate Software\Crystal Reports 
directory (32-bit).

4 Click Insert to return to the Insert Object dialog box.

5 Click OK to return to the report. An object frame appears.

6 Place the object in the Report Header section, just to the right of the 
first picture.

7 Right-click this picture and observe that it is also identified as an 
OLE Object on the shortcut menu. The second command from the 
bottom of the shortcut menu identifies it as a Bitmap Image Object. It 
is an embedded OLE object.

8 Double-click the object. Note that you have remained in Seagate 
Crystal Reports but that all the menus and tools have changed to 
those found in Microsoft Paint. These tools can be used to edit the 
bitmap in place. Remember that even though you are working with 
the tools of the OLE server application, you are not working on the 
original object; you are working with a copy and nothing you do 
here will affect the original. 

9 Click the first object you placed - the static OLE object. Note that 
when you click the object, the tools and menus change back to those 
from Seagate Crystal Reports. This confirms that the static object can 
not be edited in place. It also demonstrates how to stop editing an 
embedded object; when your editing is finished, simply click outside 
the object to return to Seagate Crystal Reports.

Linked bitmap 
image object

1 Choose the OLE OBJECT command from the Insert Menu. The Insert 
Object dialog box appears.
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2 Click the Create From File option. The dialog box changes, allowing 
you to either type in an object name or browse. 

3 Click Browse and choose Xtreme.bmp from the \CRW16 directory 
(16-bit), or \Program Files\Seagate Software\Crystal Reports 
directory (32-bit).

4 Click Insert to return to the Insert Object dialog box.

5 This time, toggle the Link check box on.

6 Click OK to return to the report. An object frame appears.

7 Place this object just to the right of the embedded object.

8 Right-click this object and observe that this object is identified as an 
OLE object. The second command from the bottom of the shortcut 
menu identifies this as a Linked Bitmap Image Object.

9 Double-click the object. Microsoft Paint opens, displaying the 
original version of the object. Any changes you make to the original 
will be reflected in the object that appears in your report.

10 Close Microsoft Paint and return to your report.

Converting a 
static OLE object 
to a linked 
bitmap image 
object

1 Right-click the first object you placed -- the static OLE object.

2 When the shortcut menu appears, choose CONVERT PICTURE OBJECT. 
The Convert dialog box appears.

3 Select Paintbrush Picture from the Object Type list, and click OK. You 
have just converted a static OLE object to a modifiable OLE object.

4 Right-click the object you have just converted. The second command 
from the bottom of the shortcut menu is now BITMAP IMAGE OBJECT, 
the same command that appeared for the first object you linked.

5 Now double-click the object. Microsoft Paint opens, just as it did for 
the linked bitmap image object. 

6 Click the SAVE button on the standard toolbar and save the report as 
OLE.RPT.

Dragging and 
dropping OLE 
objects

One more procedure needs to be demonstrated: dragging an object from 
a server application and dropping it in Seagate Crystal Reports. For this 
tutorial, you will work with a spreadsheet object instead of a graphic 
object.

NOTE: This procedure assumes that you have Microsoft Excel on your 
computer or another spreadsheet program that is an OLE server 
application.
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1 Open both Seagate Crystal Reports and Microsoft Excel and size the 
program windows so that they both are visible at the same time. You 
will need to be able to see both the object’s origin and its destination.

2 In Seagate Crystal Reports, open OLE.RPT if it's not already open.

3 Create a simple spreadsheet in Microsoft Excel by typing the 
numbers one through ten (1-10) in cells A1 through A10.

4 Highlight cells A1 through A10.

5 Move the cursor to the left edge of the highlighted cells until you get 
an arrow pointer.

6 Press the mouse button and hold it down. This activates the cells to 
be moved. Since you're only going to copy the cells, press the Control 
key and hold it down too.

7 Now drag the cells into the Details section of the report in Seagate 
Crystal Reports and, when you have the cells positioned, release the 
mouse button and Control key. That's all there is to it. You have just 
dragged an OLE object into your report.

8 Save the file you created in Excel and close the application.

9 Right-click the spreadsheet object in the report. When the shortcut 
menu appears, observe that it is identified as an OLE object and that 
the second command from the last identifies it as a Worksheet 
Object.

10 Double-click the spreadsheet object. The menus and tools change to 
those from the OLE server application. You can now edit the object in 
place. The object is an embedded object. Any changes you make to 
the object will not affect the original.

11 Click outside the object when you are finished. The menus and tools 
change back to those from Seagate Crystal Reports.

Now that you have a working understanding of OLE, you can use these 
capabilities within Seagate Crystal Reports to make your work more 
efficient.

How to insert a graphic/picture as an OLE object 

You can add already existing graphics/pictures to your reports as OLE 
objects or you can create new graphics/pictures from scratch.
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1 Choose the OLE OBJECT command from the Insert Menu. The Insert 
Object dialog box appears. You have two options when it comes to 
OLE objects. You can:

●   insert an existing object, or

●   create a new object in Seagate Crystal Reports, using in-place 
editing.

A frame approximating the size of the object (or icon) appears.

2 Select the Object
Type you want to

create.

...The associated program takes
control of Seagate Crystal

Reports, allowing you to create
the object in place.

3 When finished, click 
anywhere on the report 
to exit the graphic 
program.

When you choose the 
Create New option...

4 Type in the full path of 
the object you want to 
insert.

6 If you do not know the 
path, click the Browse 
button to locate the object.

5 Toggle this option on to 
have the object 
automatically updated.
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7 Position the OLE object (icon 
shown here) where you want
it to appear in your report.
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20 Subreports

What you will find in this chapter...

What are subreports?, Page 416

Unlinked vs. linked subreports, Page 416

How subreport linking works, Page 417

Database links vs. subreports in one-to-many situations, Page 418

HANDS-ON (Subreports), Page 419
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What are subreports?

A subreport is a report within a report. The process for creating a 
subreport is similar to the process of creating a regular report. A 
subreport can have most of the characteristics of a report, including its 
own record selection criteria. The only differences between a subreport 
and a primary report are that a subreport:

●   is inserted as an object in a primary report; it can not stand on its 
own (although a subreport can be saved as a primary report), 

●   can be placed in any report section and the entire subreport will 
print in that section, and 

●   can not itself contain a subreport.

There are four instances in which a subreport would typically be used:

1. To combine unrelated reports into a single report. See How to combine 
unrelated reports by using subreports, Page 425.

2. To coordinate data that can not otherwise be linked. See How to use 
subreports with unlinkable data, Page 427.

3. To present different views of the same data within a single report. 
See How to show different views of the same data in one report, Page 431.

4. To perform one-to-many lookups from a field that is not indexed on 
the lookup field. See ONE-TO-MANY RELATIONSHIPS, Page 515.

Unlinked vs. linked subreports

Unlinked Unlinked subreports are freestanding; their data is not in any way 
coordinated with the data of the primary report.

In unlinked subreports, there is no attempt to match up the records in one 
report with the records in the other. An unlinked subreport does not have 
to use the same data as the primary report; it can use the same data source 
or a different data source entirely. In addition, the subreport is not limited 
to reporting on a single table. An unlinked subreport can be based on a 
single table or on multiple tables. Regardless of the underlying data 
sources, the reports are treated as unrelated.

Linked Linked subreports are just the opposite; their data is coordinated. The 
program matches up the records in the subreport with the records in the 
primary report. If you create a primary report with customer information 
and a subreport with order information and link them, the program 
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creates a subreport for each customer and includes in that subreport all 
the orders for that customer.

For more information on linking, search for Visual Linking Topics Index in 
Seagate Crystal Reports online Help.

How subreport linking works

When you link a subreport to a primary report, the program creates the 
link by using a parameter field. See Parameter Fields, Page 351.

Note: When an existing report with saved data is added as a linked 
subreport, the data is refreshed from the database. Unlinked subreports 
can preserve the saved data.

When a subreport link field is selected, the program creates:

●   a parameter field in the subreport which is then used to retrieve 
values passed to it by the primary report, and

●   a record selection formula for the subreport using the parameter 
field.

   the selection formula limits the subreport to those records in 
which the link field is equal to the parameter field value.

When the report is run, the program finds the first primary field record it 
needs and passes the value in the link field to the parameter field in the 
subreport. The program then creates the subreport with record selection 
based on the parameter field value. Here is an example:

●   You create a report that shows customer data and a subreport that 
shows order data and then you link the two reports using the 
Customer ID field.

●   When you run the report, the program finds the first customer 
record it needs and passes the Customer ID value from that record 
to the subreport parameter field.

●   The program runs the Orders subreport. Since the subreport 
selection formula selects only those records in which the Customer 
ID value is equal to the parameter field value, and since that 
parameter field value is equal to the Customer ID in the first 
record in the primary report, the subreport contains only those 
records that have the same customer ID. Namely, those records 
that are orders for the first customer.
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●   When the subreport is finished, the program locates the second 
record it needs in the primary report, prints the customer data, 
and then passes this customer’s ID number to the parameter field.

●   The program then runs a subreport including only those order 
records for the second customer.

●   The process continues until the report is finished.

●   All of this parameter field manipulation takes place behind the 
scenes. You simply pick the fields that will link the primary report 
with the subreport and the program does the rest. The values are 
passed without the parameter field prompting you for a value.

NOTE: If you have a linked subreport and you click the PRINT PREVIEW 
button on the standard toolbar (from the Subreport Design Tab), then the 
program runs the subreport on its own, without waiting to receive a 
parameter field value from the primary report and without evaluating the 
tab text formula. In this case, the program displays the Enter Parameter 
Values for Subreport dialog box and prompts you for a value.

Database links vs. subreports in one-to-many situations

When two tables in a report have a one-to-many relationship, the 
program retrieves the data in different ways depending on:

●   the data source,

●   the index situation,

●   the record selection criteria, and

●   whether you are creating a single report based on linked tables or a 
primary report that contains a subreport.

The value entered here is 
the value the program 
uses to run the subreport.
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When you are considering whether to use a subreport or linked tables, 
you need to understand the ramifications of each. These issues are 
discussed fully in Performance considerations in one-to-many links, Page 515.

As a general rule, if you have:

●   indexed tables,

●   linked indexed fields, and

●   range limiting record selection criteria based on the indexed fields,

the program needs to read the same number of records whether you are 
linking tables in a single report or using subreports. Since each subreport 
is run as a separate report, linked tables may have a performance 
advantage. See Indexed tables, Page 511.

HANDS-ON (Subreports)
How to insert a subreport, Page 419, and How to link a subreport to the data in 
the primary report, Page 421, explain in detail how to perform the two basic 
subreporting tasks. You need to perform one or both of these tasks each 
time you set up a subreport. The other tutorials in this chapter will 
address more specific issues (i.e., how to create certain types of reports 
using subreports). In these later tutorials, instructions involving basic 
procedures will be conveyed in very general terms (i.e., "create a 
subreport," " link these two fields," etc.). To study these basic procedures 
in greater detail, refer back to the first two topics.

How to insert a subreport

1 Click the SUBREPORT button on the supplementary toolbar. The Insert 
Subreport dialog box appears. 
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3 Click OK. The program displays an object frame. 

●   If you imported the subreport, the program creates a Subreport 
Design Tab, which is labeled with the subreport name.

   If you do not want to edit the report, then you are finished.

   To edit the report, click the Subreport Design Tab and then 
make your modifications.

●   If you are creating a new subreport, the program creates a 
Subreport Design Tab labeled with the subreport name.

   To edit the subreport further, after exiting the Expert, click the 
Subreport Design Tab and finish modifying the subreport as 
you would with any other report.

   If you do not want to edit the report, then you are finished.

2 To choose an existing subreport, click this option button and type the 
subreport name into the text box. If you do not know the name, click 
the Browse button and locate it in the dialog box that appears, or...

...to create a new subreport, click this option button and type a 
name into the text box. If you need assistance in creating the 
subreport, click the Report Expert button. 

4 Move this frame to the 
desired position in the report 
and click once to place it.
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For information about creating a custom caption for the Subreport 
Preview Tab, see How to add captions to subreports, Page 430.

How to preview a subreport

There may be times when you want to preview a subreport on its own 
instead of previewing it as a part of the main report. For example, you 
may want to preview the subreport in order to view and analyze the data 
for a particular set of parameter values. While most Windows report 
designers do not allow you to preview subreports separately, Seagate 
Crystal Reports makes it easy.

1 Click the Design Tab corresponding to the subreport of interest.

2 Click the PRINT PREVIEW button on the standard toolbar.

The program displays a preview of the selected subreport.

How to link a subreport to the data in the primary report

Frequently, the data in a subreport supplements the data in the primary 
report. You might, for example, have customer data in a primary report 
and then use subreports to show the orders for each customer.

Click the Preview Tab to
see the parent report.

Click the Example Subreport 
Preview Tab to see the subreport.
Subreports 421



In such cases, you will need to coordinate the data in the primary report 
with the data in the subreport so that the orders in each subreport match 
up with the correct customer.

To do this, you need to specify a field that is common to both the 
subreport and the primary report. With the Subreport Links dialog box, 
you create a link between the two common fields. Seagate Crystal Reports 
uses the link to match up records from the primary report to those in the 
subreport. The link makes certain that the "orders" data in the subreport 
sits on the same row as the corresponding "customer" data in the primary 
report. You can navigate to the Subreport Links dialog box in two ways:

1. Whether you are importing a report as a subreport or creating a 
subreport from scratch, click the Subreport Link button in the Insert 
Subreport dialog box. Then, you can build or import the subreport 
and link it to the primary report with one process.

2. If you have already placed a subreport in the primary report, but did 
not create a link at setup, you can navigate to the Subreport Links 
dialog box by choosing the SUBREPORT LINKS command on the Edit 
Menu. 

From within the Subreport Links dialog box, follow these steps:

Primary Report Data Linked Subreport Data
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4 Repeat steps 2 and 3 for each additional link, as desired.

5 Use the Field link section (which will only appear if you have selected 
a link field) to set up the link for each link field:

●   select the field you want linked to the primary report from the 
Subreport parameter field to use drop-down list, and

●   toggle the Select data based on field check box on and select a field 
from the adjacent drop-down list if you want to organize the 
subreport data based on a specific field (this is the quick 
equivalent of using the Select Expert). If nothing is specified here, 
the subreport will adopt the organization of the primary report.

6 Click OK.

When you run the report, the program will coordinate the data in the 
primary report with the data in the subreport.

NOTE: The field type of the Containing Report field determines which 
subreport fields are visible. Because Seagate Crystal Reports reads dates 
as either strings, Dates, or Date-Time fields, you must make sure your 
subreport parameter field type matches the field type set up in Report 
Options in the main report for the field you want linked.

1 Choose the subreport that you want to link from
this drop-down list (if it is not already selected).

3 Click the > 
(arrow) button.

The field is 
added to this list 
box, and is now 
selected as the 
link field.

2 Select the field you want
used as a link field in the

primary report from this list
box.
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How to link a subreport to the main report without modifying 
the selection formula

At times, you may wish to use a linked parameter field in a subreport 
without using it as part of the selection formula for the subreport. For 
instance, you may want the main report to pass in a summary value that 
can be used in calculations by the subreport, or you may want the main 
report to pass in the title of the subreport.

You can accomplish these tasks using Seagate Crystal Reports, but first it 
is important to understand how the program handles subreport linking.

Seagate Crystal Reports uses a parameter field mechanism for linking 
subreports to main reports.

When linking a main report field that is not a parameter field to a 
subreport field, the program:

●   automatically creates a parameter field to complete the link, and

●   modifies the subreport record selection formula to select those 
records in which the subreport field is equal to the parameter field 
value.

The need for a parameter field is implied; it is called an “Implicit Link” 
situation.

When you link a field in the main report to a parameter field that you 
have created in the subreport, the Visual Linking Expert:

●   checks the link you have specified,

●   does not create any additional parameter fields, and

●   does not modify the subreport record selection formula.

Specifying a link is called an “Explicit Link” situation.

For example, if you want to link a subreport to the main report but do not 
want to modify the selection formula, you must use an Explicit link. To 
do this:

1 Create a parameter field in the subreport.

2 Link a field in the main report to that parameter field using the 
Visual Linking Expert.
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How to combine unrelated reports by using subreports 

At times, you may wish to combine unrelated reports into a single report. 
For example, you may want to create a single report that presents:

●   sales grouped by sales representative, and

●   sales grouped by item.

While both reports deal with sales data, there is no real linear relationship 
between the reports. 

NOTE: This sample report has been designed to illustrate concepts only, 
and not the actual look of your finished report.

Subreports can be used to combine unrelated reports into a single report 
like this. While the reports could be based on the same data set, they do 
not have to be. They could each be based on entirely different data sets.

Each of these reports is freestanding; the data in any of the reports is not 
linked in any way to data in another report. This is the easiest of the 
subreport options to work with.

FOR TWO UNRELATED REPORTS

To create a report that consists of two unrelated reports: 
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1 Create the report you want printed first as the primary report.

2 Import an existing report for use as a subreport or create a new 
subreport.

FOR THREE OR MORE UNRELATED REPORTS

To create a report that consists of three or more unrelated reports:

1 Create the report you want printed first as the primary report.

2 Import or create each of the other reports you want to use as 
subreports.

3 Use the Section Expert to insert enough Report Footer sections to 
match the number of subreports that you are using. For example, if 
you want to use three subreports, insert two new Report Footer 
sections so that you have a total of three Report Footer sections.

4 Place in Report Footer A the subreport you want printed 
immediately after the primary report, in Report Footer B the 
subreport you want printed next, and so forth. The primary report 
will print first and then the subreports in the order that you placed 
them in the report.

NOTE: Subreports can be placed side-by-side in the same Report Footer 
section. They will print next to each other at the end of the report.

3 Place the report you want printed 
first in the Details section.

4 Place the subreport into the Report 
Footer and it will print immediately 
after the primary report.
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Related Topics

Area printing characteristics, Page 59

How to add, delete, move, and merge sections, Page 79

How to use subreports with unlinkable data

Tables can be linked in a report as long as the following criteria are met:

●   the link fields are both database fields,

●   the link fields contain similar data,

●   the link fields are the same length, and

●   the link field in the link to (lookup) table is indexed (PC databases 
only).

Linking tables is rarely a problem. However, there are some 
circumstances in which you can not coordinate data from different tables 
because the data does not meet the linking criteria. 

For example:

●   linking to or from a formula field, or

●   linking two unindexed tables,

can not be done in a single report. Subreports must be used.

Linking 
to/from a 
formula field

There are situations in which you may need to link to or from a formula 
(calculated) field. For example, an employee ID could be an 11 character 
value that consists of a two-character department code followed by the 
employee’s nine-character Social Security Number (for example, 

5 Place the report you want to 
print first in the Details section.

6 Place the subreports into the 
Report Footer sections and they 
will print sequentially after the 
primary report.
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HR555347487). The formula language makes it easy to extract the Social 
Security Number from this field:

{employee.EMPLOYEE ID} [-9 to -1]

OR

{employee.EMPLOYEE ID} [3 to 12]

For the value HR555347487, either formula would return the value 
555347487. 

While the return value is a valid Social Security Number, the fact that it 
comes from a formula prevents you from using the field to link to a Social 
Security Number field in another table. You can report on and coordinate 
the values in the two tables, however, by using a subreport. Search for 
Subscript in Seagate Crystal Reports online Help. 

LINKING TO A FORMULA FIELD

1 Create the primary report using a table that includes the Social 
Security Number field (for this example, {file.SSN}).

2 Create (or import) a subreport using the formula that extracts the 
Social Security Number from the Employee ID field (for this 
example, {@EXTRACT}). See How to insert a subreport, Page 419.

3 Place the subreport where you want it to appear in the primary 
report.

4 Link the subreport to the primary report by linking the Social 
Security Number field in the primary report ({file.SSN}) to the 
formula that extracts the number in the subreport ({@EXTRACT}). 
See How to link a subreport to the data in the primary report, Page 421.

LINKING FROM A FORMULA FIELD

1 Create the primary report using the formula that extracts the Social 
Security Number from the Employee ID field (for this example, 
{@EXTRACT}).

2 Create (or import) a subreport using a table that includes the Social 
Security Number field (for this example, {file.SSN}). See How to insert 
a subreport, Page 419.

3 Place the subreport where you want it to appear in the primary report.

4 Link the subreport to the primary report by linking the formula that 
extracts the Social Security Number in the primary report 
({@EXTRACT}) to the Social Security Number field in the subreport 
({file.SSN}). See How to link a subreport to the data in the primary report, 
Page 421.
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Linking 
unindexed tables

When using PC databases (not SQL or ODBC), the link field in the lookup 
database needs to be indexed in order to create a valid link. You can not 
link the tables in a single report when two tables contain related data yet 
neither is indexed on the field which you want to use as a link field, or 
when the primary table is indexed but the lookup table is not. You must 
use subreports if you want to coordinate the data in both tables. 

NOTE: It is important to note that linking unindexed tables or linking 
from an indexed primary table to an unindexed lookup table may cause 
inefficient reporting. If your data set is large, this kind of report will take 
considerable time to run. Use this technique only if you do not have other 
options.

1 Create the primary report.

2 Create (or import) the subreport and insert it into the primary report. 
See How to insert a subreport, Page 419.

3 Use the unindexed fields (or the indexed field in the primary table 
and the unindexed field in the lookup table) to link the subreport to 
the primary report. See How to link a subreport to the data in the primary 
report, Page 421.

How to create an on-demand subreport

Seagate Crystal Reports now allows you to create on-demand subreports. 
In the Preview Tab, an on-demand subreport is represented by an object 
frame, which is much easier to manage than the bulk of an entire 
subreport. Furthermore, the actual data is not read from the database 
until the user drills down on the frame. This way only data for on-
demand subreports that are actually viewed will be retrieved from the 
database.

NOTE: Data for an on-demand subreport is not saved unless the 
subreport is actually open in a preview window.

On-demand subreports can be especially useful if you want to create a 
report that contains multiple subreports. In this case, you can choose to 
have these subreports appear only as object frames. This makes the 
subreports much more manageable.

Best of all, the process of creating an on-demand subreport is easy and 
fast. Simply place an ordinary subreport in your primary report, and then 
complete the following three steps:

1 Click the OBJECT PROPERTIES button on the supplementary toolbar. 
The Format Editor appears.
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2 With the Subreport Tab active, toggle the On-demand subreport check 
box on.

3 Click OK.

The program does all the work for you.

For information about adding a caption to your on-demand subreport, 
see How to add captions to subreports, Page 430.

How to add captions to subreports

To further organize a report, captions can be created for the Subreport 
Preview Tab and for the placeholder frame of an on-demand subreport. 
This allows you to quickly organize reports in a concise and visually 
manageable form. Note that placeholder frame captions only apply to on-
demand subreports, while tab text captions apply to both on-demand 
subreports and regular subreports. Since the data from a regular 
subreport is in place and visible on the Preview Tab, rather than on-
demand and represented by a placeholder object frame, there is no need 
for a frame caption when you format a regular subreport.

NOTE: A tab text caption replaces the subreport file name caption on the 
Subreport Preview Tab.

Captions are written by using formulas. Both placeholder frame captions 
and Subreport Preview Tab captions can include field names from the 
main report. To add a caption:

1 Select the subreport and click the OBJECT PROPERTIES button on the 
supplementary toolbar. The Format Editor appears.

2 Click the Subreport Tab.

3 You can enter either an on-demand subreport caption or a tab text 
caption by clicking the appropriate Formula button and opening the 
Format Formula Editor.

4 Enter your formula in the Formula text box. For example:

"More Information About " + {Customer.Customer 
Name}

Using the xtreme.mdb sample database, this formula would give you 
a caption like "More Information About Pathfinders" or "More 
Information About Rockshocks for Jocks".

5 Click CHECK to check the formula for errors. If the program finds an 
error, it will prompt you with a message box detailing the nature of 
the error.
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6 After fixing any errors, click the SAVE AND CLOSE button. The 
program returns you to the Format Editor.

7 Click OK to return to the report.

NOTE: A tab text formula is only evaluated when you drill-down on a 
subreport. If you preview a subreport separately from the primary report, 
the formula will not be evaluated.

NOTE: Again, frame captions apply only to on-demand subreports, while 
tab captions apply to both on-demand subreports and regular subreports. 
For more information about on-demand subreports, see How to create an 
on-demand subreport, Page 429.

How to show different views of the same data in one report

Subreports can be used to provide a different view of the data in the 
primary report. For example, assume you want to show summary values 
at the top of a report and details at the bottom, like this:

NOTE: This sample report has been designed to illustrate concepts only 
and not the actual look of your finished report.

This can be done in a variety of ways. The two easiest methods are:
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1. By creating the summary report as the primary report and the details 
report as the subreport. In this method, the details subreport would 
be placed in the Report Footer section.

2. By creating the details report as the primary report and the summary 
report as the subreport. In this method, the summary report would 
be placed in the Report Header section.

Use the appropriate link fields to link the report and coordinate the data.

How to save a subreport as a primary report

You may find it advantageous to save a subreport as a primary report for 
the sake of distributing the information to a variety of audiences. For 
example, the primary report containing the subreport may be relevant for 
a stockholders meeting at the end of the fiscal year; however, the data 
contained in the subreport may be relevant for everyday use by your 
managers. In such cases, it is easy to save a subreport as a primary report.

1 In the Design Tab, right-click the subreport and choose Save 
Subreport As from the shortcut menu. The Save As dialog box 
appears.

2 Choose the appropriate directory from the list box.

3 Type a new name for the subreport.

4 Click Save.

The program saves the subreport as a primary report so that you can open 
it separately when necessary.
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21 Document Import Tool

What You Will Find...

 How to use the Document Import Tool, Page 435

 How to set report font size, Page 441

How to define custom colors, Page 441

How to specify a custom formula, Page 442
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The Document Import Tool

Seagate Crystal Reports offers a powerful reporting functionality in the 
Document Import Tool. With this specialized reporting tool, you can 
easily convert a plain ASCII text report to Seagate Crystal Reports.

This new tool lets you:

●   convert old text reports,

●   remap the fields to the original database, and then

●   generate the text report whenever you want, from within Seagate 
Crystal Reports.

The Document Import Tool extends your reporting capabilities by allowing 
you to use Seagate Crystal Reports functionality in all your reports.

NOTE: The Document Import Tool does not convert cross-tabs.

Why use this 
Tool?

To give you an example of the uses of this tool, suppose that you created 
a plain text report in Microsoft Word, and now you want to modify the 
report using Seagate Crystal Reports functionality. If you save the Word 
document as an ASCII text file, you can open that file in the Document 
Import Tool and generate a Seagate Crystal Reports based on that file. 
You can then use all the familiar formatting abilities of Seagate Crystal 
Reports to modify the report, adapting it to better suit your needs.

Using the 
Document 
Import Tool

To convert an ASCII text report to a Seagate Crystal Reports, you must 
specify the correlations between the sections and objects in the ASCII 
report and the sections and objects in Seagate Crystal Reports. You can 
accomplish this by highlighting various sections and objects in the ASCII 
report with a colored, resizable frame. These frames represent report 
headers and footers, page headers and footers, details sections, etc. 
Highlight only:

●   the first instance of each header,

●   the last instance of each footer, and

●   the first instance of the Details section.

You can highlight sections by using the Sections Menu or by using the 
button toolbar displayed to the right of the ASCII text report. A set of text 
boxes are displayed below the toolbar, allowing you to set the properties 
for each highlighted section.

NOTE: When highlighting fields, make certain your highlighting frames 
are at least as large as the maximum size of the field. That way, values 
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appearing in the field will not be truncated when the report is converted. 
For example, if the first record in the field contains the name “Bob,” but a 
record occurring later contains the name “Cynthia,” then you must 
highlight at least seven characters or spaces for that field.

NOTE: The Document Import Tool comes with two sample text reports 
and two conversion interfaces files. For information on .cif files, see  
Generating the Report, Page 439. The text reports are Import1.txt and 
Import2.txt, in the C:\Program Files\Seagate Software\Crystal 
Reports\reports\Import directory(32-bit), or in the directory in which the 
program resides. You can refer to these reports for examples of successful 
conversion.

NOTE: You can delete a highlighting frame by selecting the frame and 
pressing the Delete key, or by right-clicking the frame and choosing 
Delete from the shortcut menu.

HANDS-ON (Document Import Tool)

How to use the Document Import Tool

1 Click the NEW button on the standard toolbar. The Report Gallery 
appears.

The Document Import Tool appears.

2 Click 
Document 
Import Tool.
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3 To convert an ASCII report, choose the NEW command from the File 
Menu. 

The New dialog box appears.

4 Enter the name of the ASCII report you are converting in the Legacy 
File text box, or click Browse to search for an ASCII report in the Open 
dialog box.

5 Click OK when finished. The selected ASCII report appears in the 
Document Import Tool.

NOTE: If you have already formatted an ASCII report, you can click the 
OPEN button on the standard toolbar and enter the name of the ASCII 
report legacy file and the .cif file in the Open dialog box. You must supply 
both files. Click OK, and the selected ASCII report appears as previously 
formatted in the Document Import Tool.

CONVERTING AN ASCII TEXT REPORT

For information about the various sections of a Seagate Crystal Reports, 
see Design Tab Areas, Page 57.
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1 Click the REPORT button to highlight the report header and footer, if 
applicable. Click the row of data you want designated as the report 
header. A resizable frame appears; adjust the frame as needed. Then 
repeat the process to designate a report footer. You can determine 
that something is a report header or footer if it only appears once, at 
either the start or the end of the report.

2 Click the PAGE button to highlight the first instance of the page 
header and footer, if applicable. Designate the page header and 
footer just as you would designate a report header and footer. You 
can determine that something is a page header or footer if it appears 
at either the top or the bottom of every page in the report.

3 Click the GROUP 1 button to highlight the first instance of the group 
header and the last instance of the group footer. For the next group 
level, increment the group number by clicking the up arrow button 
(to the right of the Group button). The Group 1 button becomes the 
GROUP 2 button. Define the new group, and then repeat the process 
for all remaining groups. Be careful not to highlight more than one 
instance of the same group level.

NOTE: For each group, set the Group by property to one of the fields in 
the report. This field will work like the Group by field in Seagate Crystal 
Reports.

NOTE: Both the header and the footer of a group need not be present in 
a report. If a report only has a group header and not the associated group 
footer, then it is not necessary to define the group footer in the 
Document Import Tool. The generated report, in this case, will have the 
group footer suppressed and the end result will look like the original text 
report.

4 Click the DETAIL button to highlight the first instance of the Detail 
section.

NOTE: All headers (Report Header, Page Header, Group Headers) should 
appear before the Detail section. All footers should appear after the 
Detail section.

5 Click the TEXT button to highlight the text instances (which will 
become text objects) occurring in the previously highlighted sections. 
Then set the properties for the text objects in the field information 
text boxes.

NOTE: You must set all the properties for all the text objects in order for 
the report to generate properly.

6 Click the FIELD VALUE button to highlight the database field 
instances occurring in the previously highlighted sections. Make 
certain each field highlighting frame is large enough to contain the 
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maximum number of characters that can appear in that field. Then set 
the properties for the field values in the field information text boxes (you 
may need to resize the window in order to see all the text boxes):

●   Set the field data type.

●   Set the field name to the name from the text file’s original database.

●   Set the default value, if other than NULL (for example, some 
reports display null date field values as XXX-00-0000).

●   If you want the field suppressed when duplicated (a displayed 
field value is identical to the previous displayed field value), then 
set the Suppress if Same parameter in the field information to Yes.

NOTE: You must set all the properties for all the fields in order for the 
report to generate properly.

NOTE: The Document Import Tool sorts the data in ascending order, by 
default.

7 Click the FORMULA button to highlight the formula instances 
occurring in the previously highlighted sections.

●   If the field is a summary field, set the field name to the name of the 
database field on which the summary is based.

●   Set the summary type (use the Type drop-down list). If the field is 
a custom formula, set the type to Custom. For information about 
specifying custom formulas, see How to specify a custom formula, 
Page 442.

NOTE: You must set all the properties for each formula in order for the 
report to generate properly.

8 Click the SPECIAL button to highlight the special field instances 
occurring in the previously highlighted sections. Set the field type in 
the field information text boxes.

NOTE: You must set all the properties for each special field in order for 
the report to generate properly.

Setting the Confidence Threshold

When the Document Import Tool converts a report, it uses a confidence 
percentage (C). If fewer than C percent of the fields are located correctly, 
the conversion will fail. You can change the confidence threshold from 
the Compile Menu.

1 Choose SET CONFIDENCE from the Compile Menu, or click the SET 
CONFIDENCE button on the standard toolbar. The Confidence dialog box 
appears.
438 Seagate Crystal Reports User’s Guide



2 Set the confidence threshold in the Confidence Threshold text box. The 
default threshold is 80%.

3 Click OK.

The confidence percentage (if changed) is displayed on the status bar. 
When you generate the report, the system will apply the specified 
confidence threshold.

Generating the Report

When a converted text report is generated for the fist time, the program 
generates a conversion interface file (.cif extension), which saves your 
highlighting and formatting specifications, and an Access.mdb database 
that contains the data from the text report’s original database.

When you highlight a section or an object in the Document Import Tool 
and set properties for database fields, these settings are saved in the .cif 
file. You can use the .cif file to convert ASCII text reports that have a 
similar format, without having to do any additional highlighting. Also, if 
you need to generate a certain text report daily, you can convert that 
report automatically every day, without highlighting anything, because 
your format specifications are already saved in the .cif file.

The database, meanwhile, stores the original data from the text report. 
The database does not store formulas, text objects, etc., only database 
fields. The Document Import Tool then uses this database to create the 
report.

Furthermore, if the field names you specified for the report are the same 
as the names specified in the text report’s original database, you can 
remap the fields in the generated report to the original database. If you 
remap the fields in this way, you will no longer require the ASCII text 
report. You will be able to generate your reports directly from within 
Seagate Crystal Reports, without having to use the Document Import 
Tool.

Finally, when the report is generated, the program uses repetition in the 
structure of the report to match any lines that are not highlighted. This is 
possible because any given section can be followed by certain other 
sections. For example, a Details section can only be followed by another 
Details section, a Group Footer 1, or a Page Footer.

This situation has the following ramifications:

●   The same .cif file may be used to convert any other instance of the 
same report.

●   Because the report will always contain the same basic structure, 
you only have to highlight the first instance of headers, and the 
last instance of footers.
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●   The Document Import Tool will not be able to convert text reports 
that do not match the basic nested structure of Seagate Crystal 
Reports. For example, the Document Import Tool can not import a 
cross-tab-like text report because a cross-tab report does not follow 
the structural pattern of the sections in Seagate Crystal Reports.

●   If a section is matched incorrectly in the Document Import Tool, 
the report will not be generated correctly. For example, suppose 
you highlight a Details section. Then you look at the next section 
and assume that it is another Details section (when, in reality, it is 
a Group Footer). In this case, the Group Footer will not be 
specified correctly, and the group may not appear on the 
generated report.

When generating the report the Document Import Tool creates a log file 
which can be used to view the results of the failed report generation. 
Check this log file to determine the cause of the first error in the log file. 
Often, if you fix this problem the other problems will disappear. If you’re 
still having problems converting a report, check to see whether the 
sections are highlighted correctly. Make certain you verify that all the text 
objects have been highlighted as text objects, and not as string fields. 

To generate the report:

1 Choose GENERATE REPORT from the Compile Menu, or click the 
GENERATE REPORT LOCALLY button on the standard toolbar. 

The Generate Report dialog box appears.

2 Enter a report name for the converted report in the Report File text 
box. To specify a file path and additional options, click More to open 
the File Option dialog box.

3 Enter a database name in the Database File text box (for the database 
that will be generated when the report is generated). To specify a file 
path and additional options, click More to open the File Option 
dialog box.

4 Click OK. The program generates the report as specified.
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How to set report font size

Before compiling, you can specify the report font size as follows:

1 Choose OUTPUT FONTSIZE from the Compile Menu, or click the SET 
REPORT FONTSIZE button on the standard toolbar. 

The Output Fontsize dialog box appears.

When the report is generated, the field values will appear in the specified 
fontsize.

How to define custom colors

For more comfortable ASCII report conversion, the Document Import 
Tool allows you to:

●   select highlighting colors other than the default colors, and

●   define custom highlighting colors.

1 Choose the command corresponding to the section of interest from 
the View|Colors Menu, or right-click a color button and choose 
COLOR from the shortcut menu.

The Color dialog box appears.

2 To select a new color for the specified highlighting frame, click one of 
the Basic colors.

3 To define a custom color for the specified highlighting frame, click 
Define Custom Colors. The Color dialog box expands to include a color 
chart. Use this chart to define your custom colors. Then select one of 
the custom colors you have defined.

4 Click OK to return to the Document Import Tool. The new color is 
applied to the color button and to the appropriate highlighting frames.

NOTE: You can also specify a color or define a color for the module 
guidelines, by choosing either VERTICAL GUIDELINE or HORIZONTAL 

2 Enter the desired font size in 
this text box.

3 Click OK.
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GUIDELINE from the View|Colors Menu, depending on which guideline 
you want customized. Then use the Color dialog box to select or define 
the desired color.

How to specify a custom formula

1 Set the summary type for the formula field to Custom. The Select 
Formula dialog box appears.

The New Formula dialog box appears.

The Formula Editor dialog box appears.

5 Enter the custom formula in the Formula text box.

6 Click the SAVE FORMULA AND CLOSE button. The custom formula 
now appears in the Select Formula dialog box. Click Select to use that 
formula in the formula field. The formula name now appears in the 
Type text box in the field information.

NOTE: The Formula Editor does not check a formula before accepting it. 
Error messages for incorrect formulas will not be generated until the 
report is generated.

2 Click New to create a 
new formula.

3 Enter a formula 
name in this text box.

4 Click OK.
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22 Cross-Tab Objects

What you will find in this chapter...

Cross-tab overview, Page 444

Cross-tab components, Page 448

HANDS-ON (Cross-Tab Objects), Page 450
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Cross-tab overview

A cross-tab is an object that summarizes and presents data in a compact 
row and column format. This format makes it easy to compare data and 
identify trends. 

Report examples have been provided with this version of Seagate Crystal 
Reports to demonstrate the power of cross-tabs. Cross-tabs become an 
option when you want to consider a specific set of data in relation to a 
specific category. In other words, use cross-tabs when the word by is 
included in your report description. For example:

●   sales by state,

●   products sold by color and size, or

●   orders by customer.

While there are certainly many ways to create these kinds of reports, 
cross-tabs present data in a more compact, easier to understand form than 
other reporting methods.

NOTE: You can insert as many cross-tab objects in a report as you need. 
You can even place them in subreports. Thus, you can use cross-tabs to 
show summarized data in a report that presents the details in another 
form.

In the following examples, the goal is to analyze the unit sales of five 
different bicycle locks in four different regions (a unit sales of locks by 
region report). For greater clarity, only the most essential information in 
these reports has been included:

●   the region from which the order came,

●   the name of the lock, and

●   the quantity ordered.

The first way of looking at the data is in the most basic of all reports, a 
columnar report with no grouping or sorting.
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Report of order 
data - no
sorting/grouping

This report presents nothing but details. Each row represents an 
individual order. There are many orders from each of the regions for 
different locks. But because there is no summary information, it is nearly 
impossible to get any useful information out of a report like this.

The next logical step is to group the data in some way. You can group it 
by region, or by product line. The following section shows a look at both 
of these options.

Report of order 
data - grouped 
by region

This report uses the data seen in the first report, but here the data is 
grouped by region. All the orders in each region are grouped together, 
but each regional group contains orders for different types of locks. 
Because the groups contain different kinds of data, summarizing the 
Quantity field will determine the total number of locks sold per Region, 
but not the total of each type.
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Report of order 
data - grouped 
by product

This report groups the data by product. Each group displays all the 
orders for a specific product. At first it appears that this might be useful, 
but then it becomes clear that each product group includes orders from 
several different regions. The information is helpful, and it brings you 
closer to your goal, but you are still a long way from having the 
information you need.

Report of order 
data - grouped 
by region and 
product

This report is the logical next step. If the By Region report contains 
multiple products in each region group, and the By Product report 
contains multiple regions in each product group, then it seems to make 
sense to combine the two. Doing that, you group first by Region and then 
by Product.

Each region 
group contains 
orders for 
different kinds 
of locks.

Each product 
group contains 
orders for many
regions.
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But the data is all spread out and remains difficult to analyze. This 
information is useful, and with a little work you can use a report like this 
to get the comparison information you need. However, a cross-tab offers 
a better solution.

Order data in a 
cross-tab object

With cross-tabs, all the information you need is provided in a compact 
format. The report shows the products sold in each region and what the 
unit sales were. It is easy to see, for example, that Guardian Mini Locks 
are not popular at all in California but they are the biggest seller in BC or 
that Florida is being outsold by Alabama in every lock category.

Each group 
contains orders 
for one product 
for one region.

Product names

Regions

Total - one product
in all regions

Total - all products
in one region

Total - all products 
in all regions

Total - one product
in one region
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In this cross-tab:

●   Product names make up the row headings.

●   Regions make up the column headings.

●   The value at each row/column intersection is the sum of all the 
orders for a particular product for a particular region; for example, 
the total number of Guardian Mini Locks purchased in British 
Columbia. 

●   The total at the end of each row is the total of all of the purchases 
for one product in all regions; for example, the total number of 
Guardian ATB Locks purchased in Alabama, British Columbia, 
California, and Florida combined.

●   The total at the bottom of each column is the total number of all 
kinds of locks ordered in one region; for example, the number of 
locks of all kinds purchased in California. 

●   The total in the bottom right corner is the grand total showing the 
total unit sales of all five locks in all four regions.

The report is compact, and you can compare your customers' purchasing 
habits in a hurry. Clearly this is a worthwhile report in situations such as 
this.

Cross-tab components

A cross-tab is an object that summarizes and presents data in a compact 
row/column format. This format makes it easy to compare data and 
identify trends. A cross-tab is made up of three elements:

1. rows,

2. columns, and

3. summary fields.
448 Seagate Crystal Reports User’s Guide



●   The rows in a cross-tab run horizontally (from side to side). In the 
example above, “Gloves” is a row.

●   The columns in a cross-tab run vertically (up and down). In the 
example above, “USA” is a column.

●   The summary fields are found at the intersection of rows and 
columns. The value found at each intersection represents a 
summary (sum, count, etc.) of those records that meet the row and 
the column criteria. In the example above, the value at the 
intersection of “Gloves” and “USA” is four, the number of gloves 
sold in the USA.

A cross-tab also includes several totals:

●   At the end of each row is a total for that row. In the example above, 
this total represents a single product sold in all countries. At the 
end of the “Gloves” row is the value 8, the total number of gloves 
sold in all countries.

●   At the bottom of each column is a total for that column. In the 
example above, this total represents all products sold in a single 
country. The value at the bottom of the “USA” column is four, the 
total number of products (gloves, belts and shoes) sold in the USA.
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●   At the intersection of the Totals column (totals for the products) 
and the Totals row (totals for the countries) is a grand total. In the 
example above, the value at the intersection of the Total Column 
and Total Row is 12, the total number of all products sold in all 
countries.

HANDS-ON (Cross-Tab Objects)

How to create a cross-tab object

In this tutorial you will create a simple Product by Region count cross-tab 
using xtreme.mdb (located in the \CRW16 directory (16-bit), \Program 
Files\Seagate Software\Crystal Reports directory (32-bit), or the 
directory in which the program resides).

The Xtreme database contains several tables. For this example use the 
following tables:

●   Customer,

●   Orders,

●   Orders Detail, and

●   Product.

NOTE: Using the Ctrl-click combination allows you to pick a non-
continuous range of fields. You can use the Shift-click combination to 
pick several fields from the list that are continuous.

NOTE: Make certain that the Customer table is linked to the Product 
table via the Orders and Orders Detail tables for this example. Search for 
Visual Linking Topics Index in Seagate Crystal Reports online Help for 
assistance.

The Customer and Product tables contain records for a variety of 
products and sales regions. To keep the report a manageable size, you 
will create a cross-tab that shows only a subset of those products and 
regions. You will restrict the report to Xtreme Mtn, Xtreme Rhino, and 
Xtreme Titan locks sold in California, Florida, Illinois, and Oregon. To do 
this, you will limit the number of regions and products by using record 
selection tools.

NOTE: For this example place the following fields in the Details section:

●  Customer Name and Region (From the Customer table)

●  Product Name (From the Product table)
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The Select Expert makes it easy to specify the records you want included 
in a report. Simply highlight the field you want to base your selection on 
and then select the desired records. See Record and Group Selection, Page 
227.

Selecting regions 1 Highlight the Region field of the Customer Table, and use the Select 
Expert to select the following records:

●   CA

●   FL

●   IL

●   OR

Selecting 
products

2 Highlight the Region field of the Customer Table and, use the Select 
Expert to select the following records:

●   Xtreme Mtn Lock,

●   Xtreme Rhino Lock, and

●   Xtreme Titan Lock.

Now you are ready to create a cross-tab.

3 Click the INSERT CROSS-TAB button on the supplementary toolbar. 
The Cross-Tab dialog box appears. Use this dialog box to add the 
rows, columns, and summary fields that will make up the cross-tab.

Adding rows 4 From the Fields list box, select the {product.PRODUCT NAME} field 
listed under the Report Fields heading and click Add Row. The 
highlighted field are added to the Rows list box.

Adding columns 5 From the Fields list box, select the {customer.REGION} field found 
listed under the Report Fields heading and click Add Column. The 
highlighted field is added to the Columns list box.

Adding 
summarized 
fields

6 From the Fields list box, select the {product.PRODUCT NAME} field 
listed under the Report Fields heading, and click Set Summarized 
Field. The field is added to the Summarized Fields list.

NOTE: You can also drag fields from the Database Fields section of the 
Fields list box to the Rows, Columns, and Summarized Fields list boxes 
using the drag-and-drop feature.

The dialog box should look similar to the following:
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7 Click OK. A placement frame appears. Place the cross-tab in the 
Report Header section of the report.

NOTE: Placing the cross-tab in different sections of a report produces 
different results. For example, cross-tabs placed in the Report Header will 
contain data for the entire report and will print only once at the 
beginning of the report, while cross-tabs placed in a Group Header will 
contain data for that group only, and will print every time the group 
changes. See Design Tab Areas, Page 57, and Area printing characteristics, 
Page 59.

8 Click the PRINT PREVIEW button on the standard toolbar to preview 
the cross-tab. It should look similar to the following:
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NOTE: Rows and columns of a cross-tab can be independently formatted 
with background colors, shading, borders, and fonts to emphasize 
important data and create professional-looking reports. See How to format 
a cross-tab, Page 460.

How to create a cross-tab with multiple rows/columns 

You may want to create reports that contain multiple levels of 
information. For example, if you have a report that contains the sales data 
for a single product sold to all customers in the USA, you can break it 
down further into a region by region analysis. Seagate Crystal Reports 
enables you to create cross-tabs with multiple rows and/or columns to 
accommodate multiple levels of information such as these.

In this tutorial you will create a cross-tab with multiple rows (number of 
Products sold by Country and Region) using xtreme.mdb (located in the 
\CRW16 directory (16-bit), \Program Files\Seagate Software\Crystal 
Reports directory (32-bit), or the directory in which the program resides).

The Xtreme database contains several tables. For this example you will 
use the following tables:

●   Customer,

●   Orders,

●   Orders Detail, and

●   Products.

NOTE: Make certain that the Customer table is linked to the Product 
table via the Orders and Orders Detail tables for this example. For more 
information on linking tables, search for Visual Linking Topics Index in 
Seagate Crystal Reports online Help.

The Customer, Orders, Orders Detail, and Products tables contain 
records for a variety of products, countries, and sales regions. To keep the 
report a manageable size, create a cross-tab that shows a subset of the 
products, regions, and countries included in the sample data. Restrict the 
report to the: Extreme Adult, Triumph Pro, and Triumph Vertigo helmets 
sold in the USA in California and Oregon only. To do this, limit the 
number of products, regions, and countries using record selection tools.

NOTE: For this example place the following fields in the Detail section:

●  Customer Name, Region, and Country (From the Customer table)

●  Quantity (From the Orders Detail table)

●  Product Name (From the Product table)
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The Select Expert makes it easy to specify the records you want included 
in your report. Simply highlight the field you want to base your selection 
on and then select the desired records. For more information on record 
selection, see Record and Group Selection, Page 227.

Selecting 
countries

1 Highlight the Country field of the Customer Table and use the Select 
Expert to select the record for USA.

Selecting regions 2 Highlight the Region field of the Customer Table and use the Select 
Expert to select the following records:

●   CA, and

●   OR.

Selecting 
products

3 Highlight the Product Name field of the Product Table and use the 
Select Expert to select the following records:

●   Xtreme Adult Helmet,

●   Triumph Pro Helmet, and

●   Triumph Vertigo Helmet.

Now you are ready to create a cross-tab.

4 Click the INSERT CROSS-TAB button on the supplementary toolbar. 
The Cross-Tab dialog box appears. Use this dialog box to add the 
rows, columns, and summary fields that will make up the cross-tab.

Adding multiple 
rows

5 In the Fields list box, highlight the {customer.COUNTRY} and click 
the ADD ROW button. The highlighted field is added to the Rows list 
box.

6 Repeat Step 5, to add the {customer.REGION} to the Rows list box as 
well.

NOTE: The order in which rows, columns, and summary fields are added 
affects their placement in the cross-tab. The first row or column added 
will remain outermost in the cross-tab. Consecutive rows will be added 
inside (to the right of the first column and below the first row). 
Consecutive summary fields will be added below the first summary field. 
For more information on multiple summary fields, see How to create a 
cross-tab with multiple summary fields, Page 456.

Adding the 
column

7 In the Fields list box again, highlight {product.PRODUCT NAME} 
and click the ADD COLUMN button. The highlighted field is added to 
the Columns list box.
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NOTE: To create a cross-tab with multiple columns, simply add the 
desired columns to the Columns list box by repeating Step 7.

Adding the 
summarized 
field

8 In the Fields list box again, highlight {orders detail.QUANTITY} and 
click the SET SUMMARIZED FIELD button. The highlighted field is 
added to the Summarized Fields list box.

The dialog box should look similar to the following:

9 Click OK. A placement frame appears. Place the cross-tab in the 
Report Header section of the report.

NOTE: Placing the cross-tab in different sections of a report produces 
different results. For example, cross-tabs placed in the Report Header will 
contain data for the entire report and will print only once, at the 
beginning of the report, while cross-tabs placed in a Group Header will 
contain data for that group only, and will print every time the group 
changes. For more information see Design Tab Areas, Page 57, and Area 
printing characteristics, Page 59.

10 Click the PRINT PREVIEW button on the standard toolbar to preview 
the cross-tab. It should look similar to the following:
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NOTE: Rows and columns of a cross-tab can be independently formatted 
with background colors, shading, borders, and fonts to emphasize 
important data and create professional-looking reports. See How to format 
a cross-tab, Page 460.

How to create a cross-tab with multiple summary fields 

You will often find it useful to include multiple summaries in a report. 
For example, you may have a report that shows the total number of 
orders for each of your California and Oregon customers. You might then 
want to see the average dollar amount of each customer's order as a 
means of comparing their purchasing habits. To accommodate situations 
such as these, Seagate Crystal Reports allows you to create cross-tabs 
with multiple summary fields.

In this tutorial you will create a cross-tab with multiple summary fields 
(total and average orders for each Customer, by Region) using 
xtreme.mdb (located in the \CRW16 directory (16-bit), \Program 
Files\Seagate Software\Crystal Reports directory (32-bit), or the 
directory in which the program resides).

The Xtreme database contains several tables. For this example you will 
use the following tables:

●   Customer, and

●   Orders.

NOTE: The Customer table must be linked to the Orders table for this 
tutorial. For more information on linking tables, search for Visual Linking 
Topics Index in Seagate Crystal Reports online Help.
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The Customer and Orders tables contain records for a variety of 
customers, regions, and orders. To keep the report a manageable size, you 
will create a cross-tab that shows a subset of the customers and regions 
included in the sample data. You will restrict the report to Sporting 
Wheels Inc. and Whistler Rentals in California and Oregon only. To do 
this, you will use record selection tools to limit the number of customers 
and regions.

NOTE: For this example place the following fields in the Detail section:

●  Customer Name and Region (From the Customer table)

●  Order Amount (From the Orders table)

The Select Expert makes it easy to specify the records you want included 
in a report. Simply highlight the field you want to base the selection on 
and then select the desired records. For more information on record 
selection, see Record and Group Selection, Page 227.

Selecting regions 1 Select the Region field of the Customer Table and use the Select 
Expert to select the record for CA.

Selecting 
customers

2 Highlight the Customer Name field of the Customer Table and, 
using the Select Expert, select the following records:

●   Sporting Wheels Inc., and

●   Whistler Rentals.

Now you are ready to create the cross-tab.

3 Click the INSERT CROSS-TAB button on the supplementary toolbar. 
The Cross-Tab dialog box appears. Use this dialog box to add the 
rows, columns, and summary fields that will make up the cross-tab.

Adding rows 4 From the Fields list box, highlight {customer.REGION} and click the 
ADD ROW button. The highlighted field is added to the Rows list box.

Adding columns 5 From the Fields list box again, highlight the {customer.CUSTOMER 
NAME} field and click the ADD COLUMN button. The highlighted 
field is added to the Columns list box.

Adding multiple 
summary fields

6 From the Fields list box again, highlight {customer.CUSTOMER 
NAME} and click the SET SUMMARIZED FIELD button. The highlighted 
field is added to the Summarized Fields list box.

7 Repeat Step 6 and add the {orders.ORDER AMOUNT} to the 
Summarized Fields list box as well.

NOTE: The order in which rows, columns, and summary fields are added 
affects their placement in the cross-tab. The first row or column added 
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will remain outermost in the cross-tab. Consecutive rows will be added 
inside (to the right of the first row and below the first column). 
Consecutive summary fields will be added below the first summary field.

The dialog box should look similar to the following:

8 Click OK. A placement frame appears. Place the cross-tab in the 
Report Header section of the report.

NOTE: Placing the cross-tab in different sections of a report produces 
different results. For example, cross-tabs placed in the Report Header will 
contain data for the entire report and will print only once at the 
beginning of the report while cross-tabs placed in a Group Header will 
contain data for that group only and will print every time the group 
changes. For more information, see Design Tab Areas, Page 57, and Area 
printing characteristics, Page 59.

9 Click the PRINT PREVIEW button on the standard toolbar to preview 
the cross-tab. It should look similar to the following:
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The first summary operation on the cross-tab is the count of orders for 
each of the three customers. The second summary operation is the sum of 
all the orders made by each company. For this example, you want to 
calculate the average order amount for each customer. To do this you will 
need to change the summary operation for the {sum of orders.ORDER 
AMOUNT} field.

NOTE: If the first summary operation is not a count, follow the directions 
below to change the summary operation to count.

Changing the 
summary 
operation 
(aggregate 
function) 

10 In the Design tab, right-click the summary field that you want to 
change {sum of orders.ORDER AMOUNT}, and choose CHANGE 
SUMMARY OPERATION from the shortcut menu. The Change 
Summary Operation dialog box appears.

11 Select the desired function from the Summary Operation drop-down 
list and then click OK. For this example, select average. The summary 
operation will be changed as specified.

For more information on summary functions, search for Summary 
Functions Index in Seagate Crystal Reports online Help.

12 Click the PRINT PREVIEW button on the standard toolbar again to 
preview the cross-tab. It should now look similar to the following:
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The first summary operation in the cross-tab is the count of orders for 
each of the three customers and now the second summary operation is 
the average order amount for each customer.

By creating cross-tabs with multiple summary fields such as these, you 
can pinpoint customer information and easily identify purchasing trends.

NOTE: Rows and columns of cross-tabs can be independently formatted 
with background colors, shading, borders, and fonts to emphasize 
important data and create professional-looking reports. See How to format 
a cross-tab, Page 460.

How to format a cross-tab

Seagate Crystal Reports has powerful formatting capabilities that can be 
applied to cross-tabs. You can:

●   change the width and height of cross-tab cells,

●   format the background color of an entire row/column at once,

●   format the background of Grand Totals,

●   format fields individually,

●   format several fields at once, 

●   suppress empty rows, columns, or totals, and

●   print cross-tabs that span multiple pages, with the option of 
repeating the row headings.

By applying such formatting as background color, borders, and fonts, 
you can emphasize important data and create professional-looking and 
easy-to-understand cross-tabs. You can also use the Highlighting feature 
to add conditional formats to numbers and currencies. For more 
information, see How to Use the Highlighting Expert, Page 224.
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Changing width 
and height of 
cross-tab cells

1 In the Design Tab, click a Row or Column heading, or a cell of 
summarized data, to activate the sizing handles.

2 Click and drag one of the sizing handles to expand the width or 
height of the cross-tab cell.

3 Click the Preview Tab to view the changes.

NOTE: Changing one row or column heading affects all of the rows or 
columns. Changing one cell of summarized data effects all of the cells of 
summarized data.

Formatting 
background 
color of entire 
rows/columns

1 Right-click the blank top-left area of the cross-tab and choose 
FORMAT CROSS-TAB from the shortcut menu. The Cross-Tab dialog 
box appears.

2 Highlight the row (from the Rows list box) or column (from the 
Columns list box) for which you want a background color, and select 
a color from the Background Color drop-down list.

3 Click OK to return to the cross-tab. The row/column will be 
formatted as specified.

A cross-tab with a single row highlighted looks similar to the 
following:

NOTE: To apply background colors for grand total rows and columns, 
select the desired colors from the Background drop-down lists on the 
Advanced Cross-Tab Options dialog box. Search for Advanced Cross-Tab 
Options dialog box in Seagate Crystal Reports online Help.

NOTE: You can also apply separate background colors to Row and 
Column totals.

Formatting 
background of 
Grand Totals

1 Right-click the blank top-left area of the cross-tab and choose 
FORMAT CROSS-TAB from the shortcut menu. The Cross-Tab dialog 
box appears.
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2 Highlight the Grand Total row (from the Rows list box) or Grand 
Total column (from the Columns list box) for which you want a 
background color, and select a color from the Background Color drop-
down list.

3 Click OK to return to the cross-tab. The Grand Total row/column 
will be formatted as specified.

Formatting fields 
individually

1 Right-click the field you want formatted and choose FORMAT FIELD 
from the shortcut menu. The Format Editor appears.

2 In the Format Editor, make font, background, borders, numbering, 
currency symbols, and printing characteristics choices.

3 Click OK to return to the cross-tab. The field will be formatted as 
specified.

A cross-tab with a single field formatted looks similar to the 
following:

Formatting 
several fields at 
one time

1 Use the Shift-click method to select the desired fields.

2 Right-click any of one and choose FORMAT OBJECTS from the shortcut 
menu. The Format Editor appears.

3 In the Format Editor, make font, background, borders, numbering, 
currency symbols, and printing characteristics choices.

4 Click OK to return to the cross-tab. The fields will be formatted as 
specified.

A cross-tab with several fields formatted looks similar to the 
following:
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How to suppress 
empty rows, 
columns, 
subtotals, and 
grand totals

Seagate Crystal Reports makes it easy to remove rows and columns from 
a cross-tab report when those rows and columns contain:

●   no records,

●   subtotals, or

●   grand totals.

Row and column labels

The Cross-Tab dialog box can be used to remove the label on a cross-tab 
report for specified fields.

NOTE: You can only suppress the label of fields for which you are also 
suppressing the subtotal.

1 In the Rows or Columns list box of the Cross-Tab dialog box, highlight 
the field whose label you want to suppress.

2 Toggle the Suppress Subtotal check box on.

3 Toggle the Suppress Label check box on. Now, when you print the 
report, no label will appear for the selected field.

Empty rows and columns

The Advanced Cross-Tab Options dialog box can be used to remove 
empty rows and/or columns from a cross-tab.

1 In the Cross-Tab dialog box, click the ADVANCED button. The 
Advanced Cross-Tab Options dialog box appears.

2 Toggle the Suppress Empty Rows and/or the Suppress Empty Columns 
check box(es) on, as needed. Now, when you print the report, no 
empty rows and/or columns will appear.
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Subtotals

The Cross-Tab dialog box can be used to suppress a subtotal for a 
particular field.

1 In the Rows or Columns list box of the Cross-Tab dialog box, highlight 
the field whose subtotal you want to suppress.

2 Toggle the Suppress Subtotal on. Now when you print the report, no 
subtotal field will appear.

Grand totals

The Advanced Cross-Tab Option dialog box can be used to remove the 
entire grand total row or column from a cross-tab.

1 In the Cross-Tab dialog box, click the ADVANCED button. The 
Advanced Cross-Tab Options dialog box appears.

2 Toggle the Suppress (Rows Grand Totals) and/or Suppress (Column 
Grand Totals) check box on, as needed. Now, when you print the 
report, no row and/or column grand totals will appear.

How to print 
cross-tabs that 
span multiple 
pages 

When you create a cross-tab that is wider or longer than the specified 
page size, the program will automatically span the printing across 
enough pages to accommodate the size of the cross-tab. In the Preview 
Tab, a line will appear at each page break. For ease in reading, column 
headings will be repeated on subsequent pages. Row headings may also 
be repeated.

1 In the Cross-Tab dialog box, click the ADVANCED button. The 
Advanced Cross-Tab Options dialog box appears.

2 Toggle the Repeat Row Labels on Page Break option on in the Advanced 
Cross-Tab Options dialog box.
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23 The Crystal SQL Designer

What you will find in this chapter...

The Crystal SQL Designer, Page 466

Why use a query?, Page 466

Using the SQL Designer, Page 467

HANDS-ON (Queries), Page 468
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The Crystal SQL Designer

The Crystal SQL Designer is a type of query; a request for specific 
information from a database. If you are requesting that information from 
an SQL database (or from a database accessed via ODBC), your query 
must be written using the Structured Query Language (SQL). The SQL 
language is not difficult to learn, but mastering the fine points of creating 
and retrieving data with SQL can take quite a while. Since the SQL 
Designer eliminates the need to understand SQL, it can get you building 
effective queries right away.

The SQL Designer has been designed to meet the needs of individuals 
with little or no query background as well as the needs of experienced 
SQL professionals.

●   If you are new to querying, you will enjoy the way the SQL 
Designer helps you create queries. By answering a few questions 
on a set of sequential tabs, you’ll give the program all the 
information needed to generate a query that fits your needs. The 
program will do all the work for you.

●   If you are an SQL professional, you will appreciate the facility that 
enables you to fine-tune the queries that the SQL Designer 
generates. If you are more comfortable writing your own SQL 
queries, you will find it easy to enter the queries directly or even 
paste them in from another source.

The Crystal SQL Designer can be a powerful tool for many of your 
information gathering needs.

NOTE: The SQL Designer can only access data stored in an ODBC data 
source. Any SQL or any other type of database mentioned in this chapter 
must be accessed through an ODBC data source.

Why use 
a query?

Query files provide a means of off-loading much of the data generating 
tasks normally performed by Seagate Crystal Reports on to an SQL or 
other database server. The set of data returned represents a subset of the 
actual data in the database - only the data you specifically need.

If you are an experienced SQL programmer, the Crystal SQL Designer 
allows you to reuse your existing queries, quickly and easily. All of your 
existing queries become convenient query files that you can use to design 
reports with Seagate Crystal Reports.

In addition, a Query file provides full ANSI SQL compatibility. Although 
Seagate Crystal Reports supports powerful SQL pass-through reporting, 
it does not support the full SQL language or allow you to edit every part 
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of an SQL statement. When using the SQL Designer to create data sets on 
which to base your reports, you get all of the power of SQL, including 
complex joins, sorts, and aggregate functions.

NOTE: Many of the topics in this chapter refer to specific SQL clauses. If 
you are experienced with SQL, use this information to better understand 
how the Query Expert generates an SQL statement. If you are new to 
SQL, you can ignore this information and continue to use the Query 
Expert.

Using the SQL 
Designer

The SQL Designer has two primary uses:

1. Designing and developing data sets for building reports in Seagate 
Crystal Reports, and

2. Retrieving and analyzing current information on an “as needed” 
basis to facilitate informed decision making.

SEAGATE CRYSTAL REPORTS AND QUERY DATA SETS

Seagate Crystal Reports allows you to design a report based on a query 
data set rather than tables and fields. Since the query contains a 
predefined set of data, the tables and fields necessary for the report are 
already included.

The set of data produced by the SQL query works just like a database 
table when you design your report. The name of the query, along with 
fields it accesses, appear in the Insert Field dialog box. Aggregate 
functions and SQL expressions act like fields, providing data values 
corresponding to each record in the SQL query.

DATA ANALYSIS AND DECISION MAKING

You may not always need to produce finished reports based on your data; 
sometimes you just need numbers in a hurry (to prepare for a meeting, to 
help make projections, etc.). The SQL Designer makes it easy to get the 
information you need.

Sometimes you may need to retrieve the same data on a recurring basis 
(weekly, every month end, etc.). By setting up and saving a single query, 
you can retrieve updated data quickly, whenever you need it, with 
minimal effort.

NOTE: The SQL Designer can not retrieve any number value longer than 
20 characters or calculate a formula with a value longer than 20 
characters. Values longer than 20 characters will be truncated.
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HANDS-ON (Queries)

How to use an SQL query that was designed elsewhere 

1 Copy the SQL statement to the Windows Clipboard. Many SQL 
editors allow the SQL statement to be copied to the Clipboard using 
the Ctrl-C key combination.

2 Click the NEW button on the toolbar in the Crystal SQL Designer.

The New Query dialog box appears.

The Log On Server dialog box appears.

The SQL Server Login dialog box appears.

3 Click the Enter SQL 
statement directly button.

4 Select the desired SQL server for 
your SQL statement and click OK.
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5 Enter your user ID and password to log on to the SQL server, and 
click OK.

After a message appears indicating the success of your log on 
(assuming you logged on correctly) the Enter SQL Statement dialog 
box appears.

7 To log on to another server or ODBC data source, click the Log On 
Server button. All data sources that you are logged on to will appear 
in the Data Source drop-down list.

8 In the Title text box, type a descriptive title for the query.

6 Select an ODBC data source from this
drop-down list.

If you are not already logged on to an SQL Server, click
this button and use the Log On Server dialog box to log on.
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The SQL edit box allows you to make any changes you wish to the 
SQL statement. You can even enter an entirely new SQL statement if 
you wish.

11 Make any changes you need and click the OK button when you are 
finished.

The old SQL statement becomes a new SQL query that can be used with 
Seagate Crystal Reports just like any other SQL query file.

Alternatively, you can import an SQL statement saved in an ASCII text 
file. To do so, disregard Step 1 above, follow Steps 2 through 6 to open the 
Enter SQL Statement dialog box and log on to the ODBC data source, then 
click Import to import the SQL statement from the text file.

How to create a new query

1 Click the NEW button in the Crystal SQL Designer.

The New Query dialog box appears.

9 Edit the SQL statement in this box.

10 Click this 
button to paste 
the SQL 
statement into 
the SQL edit box.
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The Create Query Expert consists of several tabs. The tabs are numbered 
to lead you step-by-step through the query creation process.

NOTE: The Links Tab only appears when two or more database tables are 
selected on the Tables Tab.

NOTE: Once you select at least one field for the query on the Fields Tab, 
you can view the data retrieved by your query at any time, by clicking the 
Preview Query button at the bottom of the dialog box. After you are done 
viewing the query data, use the Edit button to return to the Query Expert.

How to add tables to a query

FROM clause

The FROM clause specifies the sources (tables) of the database fields 
indicated in the SELECT statement.

1 Click the Tables Tab in the Create Query Expert.

2 Click the Use Crystal 
Query Expert button.
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2 Click the SQL/ODBC or Dictionary button.

●   If you click SQL/ODBC:

   Select an SQL or ODBC data source in the Log On Server 
dialog box.

   Choose one or more database tables in the Choose SQL Table 
dialog box. Click Add to add each table to your SQL query. 
Click Done when finished.

●   If you click Dictionary:

   Select Dictionary (.DC5) in the File Open dialog box, and click 
OK.

   All ODBC database tables accessible from the dictionary will 
be added to your SQL query.

NOTE: Dictionary files must be based on an ODBC data source. See 
Dictionaries, Page 487, for further information.

How to link tables and specify a join type

WHERE clause

The WHERE clause specifies how two database tables are linked.

NOTE: Some links can be generated in the FROM clause.
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1 Click the Links Tab and click the Smart Linking button. The Create 
Query Expert will make any links it can detect between tables. These 
links are represented by an arrow between the two fields. This arrow 
is called a link line.

2 Click one of the link lines. It becomes highlighted, along with the 
fields on either end of the line.

3 Click the Options button to open the Link Options dialog box. This 
dialog box describes the link between the tables in greater detail. 
Search for Link Options dialog box in Crystal SQL Designer online 
Help.

Link line.
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Related Topics

SQL join types (ODBC data sources), Page 527

WHERE, Page 541

How to add fields to a query

SELECT clause

The SELECT clause selects specific data items to retrieve from the 
database tables specified by the FROM clause.

1 Click the Fields Tab in the Create Query Expert.

4 Select an SQL 
join type.
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Related Topics

SELECT, Page 540

How to identify unique values in a query

DISTINCT clause

DISTINCT forces the query to retrieve only unique (distinct) sets of data.

1 Click the Fields Tab of the Create Query Expert.

2 Select the fields you want to 
appear in your query from this list. 3 Click the Add button...

...the 
field(s) are 
added to 
this list.

4 Click Remove to remove any fields 
from the Query Fields list box.
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Related Topics

DISTINCT, Page 540

How to summarize data with aggregate functions

GROUP BY clause

The GROUP BY clause retrieves a set of summary data.

Aggregate functions

Use aggregate functions to obtain summary information on all records or 
on specific groups of records. Aggregate functions are most useful when 
you do not need the detailed information and you only want to examine 
totals.

For example, you might need the total number of orders made and the 
average amount of each order. For this type of query, you apply the 
COUNT function to the Order ID field, and the AVG (average) function 
to the Amount field. The query calculates the summary information and 
provides the results you need.

1 Click the Fields Tab of the Create Query Expert.

2 Toggle the Select Distinct 
Values check box on to activate it.
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3 From the Total drop-down list, choose an aggregate function to apply 
to the selected field.

●   COUNT( ) counts the number of values within a group.

●   SUM( ) adds the values within a group, to provide a total.

●   AVG( ) finds the average of all values within a group.

●   MIN( ) finds the minimum value within a group.

●   MAX( ) finds the maximum value within a group.

The query summarizes the field to which the aggregate function is 
applied. Any other fields that appear in the Query Fields list box are 
used to sort the data.

Related Topics

GROUP BY, Page 542

How to sort records according to field values

ORDER BY clause

The ORDER BY clause specifies that the database records retrieved be 
sorted according to the values in a specific field.

2 Highlight the field on this list you want
to summarize.
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You can group either by sorting data, so that records with like data 
appear grouped in the sorted list, or by summarizing data with aggregate 
functions, so that summary data appears in your query for each group of 
records. For information on using aggregate functions in your query, see 
How to summarize data with aggregate functions, Page 476. This section 
shows you how to group data by sorting.

1 Click the Sort Tab in the Create Query Expert.

Related Topics

ORDER BY, Page 541

How to specify records to be included in a query

WHERE clause

The WHERE clause can specify record selection criteria.

1 Click the Select Tab of the Create Query Expert.

2 Select the field you 
want sorted from this list. 3 Click Add...

...the field is added 
to this list.

Use these 
arrows to 
move the 
field
up/down 
the list.

4 Select the sort order
from this drop-down list.
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This tab works much like the Select Expert in Seagate Crystal Reports. 
Search for Select Expert in Crystal SQL Designer online Help.

5 Repeat Steps 2 and 3 for every field in the Select Fields list box.

Related Topics

WHERE, Page 541

How to select groups to be included in a query

GROUP BY and HAVING clauses

The HAVING clause creates selection criteria for the summary 
information produced by the GROUP BY clause.

1 Click the Fields Tab of the Create Query Expert.

2 Select the field that 
contains the data you 
want to base selection 
criteria on from this list. 3 Click Add... ...the field is added to this list.

4 Use these controls to specify the selection criteria to be 
applied to the field highlighted in the Select Fields dialog box.
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4 Click the Select Tab.

2 Select the field you want to 
summarize from this list.

3 Select the aggregate function from this drop-down
list you want applied to the highlighted field.
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Related Topics

GROUP BY, Page 542

How to create an SQL expression

NOTE: You must have some familiarity with the SQL language and SQL 
expressions before trying to add an expression to your query file.

1 Click the Fields Tab in the Create Query Expert.

5 Select the aggregate 
function from this list box. 6   Click Add... 

...the field 
is added to 
this list.

7 Use these drop-down lists to specify which group summary 
values based on the aggregate function should appear in the result.
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The SQL Expression dialog box appears.

2 Click Expression.

3 Type a name for the new 
expression and click OK.

4 Double-click a field in 
this list to add it to the 
expression.

5 Edit the expression 
in this edit box.
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6 When you have finished designing the SQL expression, click OK to 
return to the Fields Tab.

How to create a query from another Crystal Query

1 Click the NEW button in the Crystal SQL Designer.

The New Query dialog box appears.

7 Highlight the new SQL expression. 
It will be indicated by a @ sign. 8 Click Add...

...the field 
is added 
to this list.

2 Click Start from 
existing Crystal Query.
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3 Use the File Open dialog box to highlight the query (*.QRY) file that 
you want used to base a new query on, and click OK. The program 
runs the existing SQL query and displays the data set.

4 Click the EDIT button. 

The Create Query Expert appears with the specifications for the 
selected query already in place.

5 Use the Create Query Expert to make any changes necessary to the 
query. Click Preview Query when finished to view the new query 
results.

6 Choose SAVE AS from the File Menu to save the new query under a 
different name. The new query is saved in a separate file; your source 
query remains unchanged.

How to select a query for a report

1 In Seagate Crystal Reports, click the NEW button on the standard 
toolbar.

 The Report Gallery appears.

2 Click a Report Expert from the Report Gallery. The Create Report 
Expert appears.

3 On the Tables Tab, click Query. The File Open dialog box appears.
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4 Use the controls in this dialog box to locate and highlight the query 
(.QRY) file you want to use to create a new report.

5 Click OK. The query file for your report is opened. Use the tools in 
the Create Report Expert to design a new report. Your query fields 
will appear in each section of the Expert just as any other database 
fields would. In the list boxes, the name of the query file will appear 
above the fields, where you would normally see the name of a 
database table.

NOTE: More than one query file can not be used in a report.
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24 Dictionaries

What you will find in this chapter...

Dictionaries Overview, Page 488

Why use a dictionary?, Page 489

HANDS-ON (Dictionaries), Page 489
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Dictionaries Overview 

A dictionary is a structured and simplified view of data that you can 
create for some or all of the individuals in your organization that are 
using Seagate Crystal Reports. 

Unlike some systems that force users to access data through a data 
distribution metalayer, dictionaries are optional components. Data can 
still be accessed directly by the user. Dictionaries simply provide all of the 
convenience without the restrictions.

Dictionaries allow you to:

●   design a single, dynamic view of all the data that is necessary to 
create organizational reports and queries,

●   organize the data and rename tables and fields to make it easier for 
users to understand the content and purpose of the data, and

●   create complex data-manipulation formulas that users can access 
without the need to understand formula concepts.

NOTE: The Formula Editor used in Crystal Dictionaries is not as complete 
as the one used in Seagate Crystal Reports. Please see Crystal Dictionary 
online Help for a description of the Formula Editor for use in Crystal 
Dictionaries.

Dictionaries reduce support cost and time, increase user productivity, 
and reduce data misuse, loss, and damage. They are a powerful 
component of Seagate Crystal Reports.

When a Dictionary is used to create a report, the only data used in the 
report is the data accessed through the Dictionary; you can not use a 
Dictionary and some other data source in the same report. Because 
Dictionaries are often used to impose data security, it would breach that 
security to allow unrestricted data access in a Dictionary report.

NOTE: You can include a subreport based on a different data source in a 
primary report based on a Dictionary.

Finally, Dictionaries provide an easy means of changing the underlying 
data set without changing the view of the data seen by users. You can 
change field and table names in the underlying data, for example. Then 
you remap the Dictionary to the new field and table names without 
changing the aliases assigned to the data. The users create their reports 
using the same data interface they've been using, never knowing what 
has changed under the surface.
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Once created, the Dictionary acts as a filter, providing a view of complex 
data that is clear and easy for any user to understand.

Why use a 
dictionary? 

Dictionaries are often designed and distributed by Information System 
(IS) Managers or Network Administrators who control and manage a 
company’s databases. These databases are often complex collections of 
data spread throughout several tables with hundreds or even thousands 
of fields. A user, trying to locate and use a small set of data for a report, 
can easily get lost among database, table, and field names.

By creating a customized dictionary that contains a small amount of data 
specific to the work performed by a small group of users, you provide 
those users with clear and easy access to all of the data they need. For 
example, the Accounting department’s dictionary can be different from 
the Sales department’s dictionary, or the Personnel department’s 
dictionary. Some data may overlap between dictionaries, but it can be 
named and organized in a fashion that best suits the users accessing it.

HANDS-ON (Dictionaries) 

How to create a new dictionary 

1 Click the NEW button on the toolbar. The Crystal Dictionary Expert 
appears.

 

This Expert contains several tabs. Each tab is numbered to lead you 
through the development process step-by-step.

NOTE: The Links Tab appears only when you have added more than one 
table to your dictionary.
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2 To access the options on each tab, simply click the tab. Information 
and controls needed for the selected step will be displayed in the 
dialog box. You may also use the Next>> and <<Back buttons to go to 
the next (right) and previous (left) tab, respectively.

NOTE: Certain steps must be performed before others in the creation 
process. For example, you must select tables before you can select fields 
from those tables. For that reason, some tabs may not be available until 
you perform the required steps prior to selecting those tabs.

3 Click Save at the bottom of the Expert to save at any time.

NOTE: Since a dictionary must contain some database data, the Save 
button will be disabled until you add at least one field to the Headings & 
fields in View list box on the View Tab.

How to add a data file 

1 While in the Crystal Dictionary Expert, click the Tables Tab to 
activate it.

The Choose Database File dialog box appears.

3 Use the options in this dialog box to highlight a database file.

4 Click Add to add the file. If the selected database file contains only 
one table, that table will appear in the list box on the Tables Tab.

NOTE: When there is more than one table to add from the selected 
database file, the Select Tables dialog box appears. Highlight the tables 
you wish to include from the list and click OK. Only the tables you 

2 Click Data File.
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selected will appear in the list box on the Tables Tab. See How to select 
tables and fields for users, Page 494.

NOTE: You can not create a dictionary from two different data sources.

5 Repeat Steps 3 and 4 for each database file you want to add to the 
dictionary.

6 Click Done when you are finished adding database files.

NOTE: When a database file is added, the tables and fields from that file 
will not necessarily appear to the user who opens the dictionary from 
Seagate Crystal Reports. The tables that appear on the Tables Tab are 
only the tables available to the creator of the dictionary. To add specific 
fields, see How to select tables and fields for users, Page 494.

You may also need to pick an index file to be used by one of the database 
tables. This is done in the Tables Tab:

The Choose New Location dialog box appears.

9 Use the controls in this dialog box to highlight a new index file, and 
click OK when finished.

NOTE: By default, Crystal Dictionaries will use any index file it finds with 
the same name as the database file. You only need to select an index file if 
you want to use an index with a different name than the database file. For 
more information on indexes, see Indexed tables, Page 511.

NOTE: Data files and ODBC data sources can be mixed in the same 
dictionary file. However, to link data files and ODBC data sources 
together, you can only use string fields to perform the links.

8 Click Index.
7 Highlight the database table you

want to pick a specific index for.
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How to open an SQL or ODBC data source 

1 While in the Crystal Dictionary Expert, click the Tables Tab to 
activate it.

The Log On Server dialog box appears.

4 If the data source requires any log on information, such as user name 
and password, the SQL Server Login dialog box will appear. Use this 
dialog box to log on to the ODBC data source just as you normally do 
from your Database Management System application.

5 Click OK. The Choose SQL Table dialog box appears.

6 Highlight a database in the SQL Databases list box. The SQL Tables 
list box displays all of the tables for the database you selected. 
Choose the table you would like to have included and click Add to 
add it to your dictionary.

7 Repeat Step 6 for each table you want to add to the dictionary.

2 Click SQL/ODBC.

3  Select an SQL or 
ODBC data source and 
click OK when finished.
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8 Click Done when finished.

NOTE: When an SQL or ODBC data source is added from the Tables Tab, 
the tables and fields from that data source will not necessarily appear to 
the user who opens the dictionary. The tables that appear on the Tables Tab 
are only the tables available to the creator of the dictionary, for adding to 
the dictionary. See How to select tables and fields for users, Page 494.

NOTE: Data files and ODBC data sources can be mixed together in the 
same dictionary file. However, to link data files and ODBC data sources 
together, you can only use string fields to perform the links.

How to link multiple tables 

1 If you have added more than one database table to your dictionary, 
click the Links Tab in the Crystal Dictionary Expert.

●   If a link is possible between two tables, you can create a new link 
by dragging a field name from one table to the other. The 
application will draw a new link arrow between the tables. See 
Indexed tables, Page 511.

●   If you select a link and click the Options button, the Link Options 
dialog box appears. You can use the controls in this dialog box to 
make any necessary changes to the highlighted link. Search for 
Link Options dialog box in Seagate Crystal Reports online Help.

●   If you click the Smart Linking button, the application will create 
logical links between tables in your Dictionary.

To create a link manually, drag a field 
name from one table to the other.
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How to select tables and fields for users  

After using the Tables Tab to add tables to the dictionary, those tables, 
and the fields in them, are not automatically available to users. The View 
Tab must be used to expose these fields. The View Tab lets you design the 
actual view of the data that the users will see.

1 While in the Crystal Dictionary Expert, click the View Tab to activate 
it.

NOTE: The following screenshot illustrates both a before and after state 
of the dialog box. Typically, any fields you move to the Headings and fields 
in View list box will no longer appear in the Tables and fields from database 
list box.

●   To make a table and all its fields available to users, select the table 
name from the Tables & fields from database list box, and click Add. 
The table name becomes a field heading in the Headings & fields in 
View list box. All fields from the table appear as fields under the 
new field heading.

●   To make a single field available to users, select the field in the 
Tables & fields from database list box and click Add. The field is 
added to the end of the list in the Headings & fields in View list box.

When adding and organizing tables and fields in the View Tab, keep in 
mind the following points:

●   Tables are not displayed to the dictionary user as database tables. 
Table names become field headings. These headings appear just 

2 Highlight the field you want to 
make available to users from this list.

...the field is added 
to this list.3 Click Add...
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like tables when the user designs a report based on your 
dictionary. However, field headings do not necessarily represent 
database tables that actually exist.

●   Field headings can be added anywhere in the Headings & fields in 
View list box to provide clearer organization of data for your users. 
See How to add a new field heading, Page 499.

●   Fields can be added to the View list box as many times as 
necessary. A field does not have to appear under a field heading 
that matches the table the field exists in. Organize fields in any 
order and under any field headings that will work best for your 
users.

●   Fields must be grouped under field headings. If you add a single 
field to the Headings & fields in View list box and no field heading 
appears in the list box (the list box is empty), the application will 
provide a default field heading for you and will add the field you 
selected underneath that heading.

●   Field names and field headings that appear in the Headings & fields 
in View list box can be renamed to anything you want. See How to 
rename fields, field headings, and formulas, Page 497.

How to add/create formulas  

1 While in the Crystal Dictionary Expert, click the View Tab to activate 
it.

The Insert Formula dialog box appears.

2 Click New Formula to create a formula.
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The Formula Editor appears.

4 Use the Formula Editor to create a formula for the Dictionary, just as 
you would create a formula for a report. See Introduction to Formulas, 
Page 291, or search for Formula Editor in Seagate Crystal Reports 
online Help.

5 Click Accept when finished. The new formula is added to the Tables & 
fields from database list box.

Next, you will need to add the formula to the view.

NOTE: The following illustrates both a before and after state of the dialog 
box. Typically, any fields you move to the Tables & fields in view list box 
will no longer appear in the Headings & fields in view list box.

3 Type a name for the formula 
and click OK when finished.

6 Highlight the formula you 
just created from this list.

...the field is added to 
this list.7 Click Add...

8 To modify a formula, highlight it and click the 
Edit button.
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NOTE: Normally, formulas are represented with an @ symbol. The 
formula name appears in the Headings & fields in View list box without 
the @ symbol to hide the fact that this is a formula.

How to rename fields, field headings, and formulas   

1 While in the Crystal Dictionary Expert, click the View Tab to activate 
it.

The Set Alias dialog box appears. 

●   If you chose a heading, the Set Table Alias dialog box appears.

●   If you chose a field, the Set Field Alias dialog box appears.

See Aliases, Page 509.

NOTE: This process does not actually rename tables or fields. Only the 
alias name that appears to the user opening the dictionary is changed. 
The original database file is not affected.

2 Highlight the heading or field you want
to rename from this list.

3 Click Alias.

4 Type the new name into this text 
box and click OK when finished.
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How to move fields/field headings within the list   

1 While in the Crystal Dictionary Expert, click the View Tab to activate 
it.

2 Highlight the heading or field you want to move from the Headings & 
fields in View list and drag it up or down to the desired position.

The order that the fields and field headings appear in this list box is 
the order that they will appear to users.

NOTE: When organizing fields and field headings, remember that field 
headings take the place of database tables. Because of this organization, 
the first item in the list box must be a field heading.

How to update the location of a database table  

1 While in the Crystal Dictionary Expert, click the Tables Tab to 
activate it.

NOTE: Remember, the table names that appear here are aliases rather 
than the actual database table names. See Aliases, Page 509.

●   If the table is from a data file, the Choose New Location dialog box 
appears.

2 Highlight the table or field that has changed 
name or location from this list.

3 Click Location.
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●   If the table is from an SQL server or other ODBC data source, the 
Choose SQL Table dialog box appears.

4 Highlight the new name or location of the database table from the 
dialog box that appears, and click OK.

How to add a new field heading 

1 While in the Crystal Dictionary Expert, click the View Tab to activate 
it.

 The Insert Field Heading dialog box appears.

2 Highlight the field that will be the first to appear under 
the new field heading from this list.

3 Click Heading.

4 Type the new name into this text 
box and click OK when finished.
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How to add Help text 

To maximize the efficiency of your dictionary, Seagate Crystal Reports 
allows you to add Help text. Whenever anyone needs clarification on 
what the elements of your dictionary are, they can point to the item in 
question and Help text will appear in a pop-up window to assist them.

1 While in the Crystal Dictionary Expert, click the View Tab to activate 
it.

The Edit Help Text dialog box appears.

The new field heading appears in this list, as specified.

2 Highlight the field that you want to add 
Help text to from this list.

3 Click Help Text.
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When the user selects a field or field heading and holds the cursor 
over the selected item, the Help text appears in a pop-up window.

How to add a graphic 

1 While in the Crystal Dictionary Expert, click the Graphic Tab to 
activate it.

The File Open dialog box appears.

3 Use the controls in the File Open dialog box to highlight a graphic 
image file, and click OK to add it to the dictionary.

Dictionaries support the Windows bitmap (.BMP), PC Paintbrush 
(.PCX), Tiff (.TIF), and TARGA (.TGA) graphic formats. The image file 
appears in the list box of the Graphic Tab.

You may now want to change the alias name, update the location, or 
delete a graphic. Simply highlight the desired graphic and click the 
appropriate button for your needs.

4 Enter the Help text and click OK 
when finished.

2 Click Add.
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●   If you clicked the Alias button, the Set Graphic Alias dialog box 
appears.

●   If you clicked the Location button to set the new location of the 
image, the Choose New Location dialog box appears. Use this 
dialog box to find the new name and/or location of the graphic 
file.

How to create sample data for users to browse  

The Sample Data Tab in the Dictionaries Expert lets you create a set of 
custom sample data that appears to users when they browse field data. 
The data they see may or may not reflect actual data in the database, 
depending on the sample data you design.

1 While in the Crystal Dictionary Expert, click the Sample Data Tab to 
activate it. 

4 Highlight the desired 
graphic in this list box.

5 Click the Alias button
to change the name...

...or click the Location button 
to change the location...

...or click Delete to delete
the graphic from the list.

6 Type a new name for the 
graphic in this text box and 
click OK when finished.
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If you clicked the Edit button, the Edit Value dialog box appears.

The new value appears in the Browsed data list box.

NOTE: Deleting and editing values in the Browsed data list box of the 
Sample Data Tab does not change the database file. It only changes the 
list of values that appears to a user whenever the Browse and Paste dialog 
box is opened. This allows you to customize the look of the data when 
users browse data, without actually changing the data that is reported on.

How to edit an existing dictionary 

1 Click the OPEN button on the toolbar. The File Open dialog box 
appears.

2 Use the Drives, Directories, and File Name controls to highlight the 
existing dictionary file and click OK. The Crystal Dictionary Expert 
appears.

2 Highlight the field you
want to make browseable

from this list.

3 Click this button...

Click the Delete button to delete a
highlighted field value from the list.

Click the Edit button to edit a
highlighted value from this list.

...the field values appear in
this list.

If the data has changed, click the Refresh 
button to retrieve a list of the new data.

4 Enter the new value in this text 
box and click OK when finished.
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3 Use the Expert to make changes to the dictionary file.

How to convert a 4.x or 5.x dictionary file

1 Click the OPEN button on the toolbar. The File Open dialog box 
appears.

2 Use the Drives, Directories, and File Name controls to highlight the old 
dictionary (*.DCT) file and click OK. The Select View dialog box 
appears, listing the names of all views from the old dictionary file. 

3 Highlight the view you want to convert to a new dictionary file, and 
click OK. The Crystal Dictionary Expert appears with the data from 
the view you selected.

NOTE: This version of Crystal Dictionaries provides an easier and more 
powerful method for controlling data access than older versions. 
However, each view from an older dictionary file is handled as a separate 
dictionary in this version. An older dictionary file, on the other hand, held 
several views. To convert an entire dictionary 4.x or 5.x file, you must 
open each view in the file separately and save it as a new dictionary file.

4 Use the Expert to make changes to the new file.

5 When the file is saved, it will be saved in the new dictionary format 
(*.DC5).

How to select a dictionary for a report 

When creating a new report in the Seagate Crystal Reports, you can 
specify a dictionary as your data source. By using a dictionary for your 
report, administrators can monitor company information being disclosed 
and users are not burdened by extra data they will not be using in their 
reports.

1 Click the NEW button on the standard toolbar in the Seagate Crystal 
Reports. The Report Gallery appears.
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An additional section is added to the dialog box, revealing custom 
report options.

5 Use the Drives, Directories, and File Name controls from the dialog box 
that appears to highlight the dictionary (*.DC5) file that you want to 
use, and click OK.

6 To add items from the dictionary to your report, click the INSERT 
FIELDS button on the standard toolbar, and use the Insert Fields 
dialog box to highlight fields and images for your report. 

●   Field headings from the dictionary appear as tables in the Insert 
Fields dialog box.

●   Fields from the dictionary appear as fields for each table.

NOTE: You can not use more than one dictionary file in a report at a 
time. Also, you can not link fields from dictionary files to fields in other 
database tables.

2 Click 
Custom.

3 Click the Custom Report, Custom Cross-
Tab, or Custom Multi-Column button.

4 Click Dictionary.
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25 Working With Databases

What you will find in this chapter...

Databases Overview, Page 508

Relational Database basics, Page 508

Aliases, Page 509

Locating files, Page 510

Indexed tables, Page 511

Linking tables, Page 513

Using SQL and SQL databases, Page 535

HANDS-ON (Working With Databases), Page 548

Server-side processing, Page 542

Remapping database fields, Page 545
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Databases Overview

Though there are hundreds of Database Management Systems (DBMS) 
available, Seagate Crystal Reports eliminates many of the differences 
once it connects to the actual database files. The process of working with 
database files, tables, fields, and records is much the same, regardless of 
the actual type of data being accessed.

This chapter discusses several concepts and tasks common to working 
with database files. Using database aliases, locating moved or renamed 
database files, working with indexed tables, and linking tables are 
subjects common to anyone who designs reports in Seagate Crystal 
Reports. The topic, Using SQL and SQL databases, Page 535, is especially 
important for anyone who accesses data in SQL databases and other 
database formats that are accessed through ODBC.

Relational 
Database basics

The most popular architecture for database files used in the corporate 
world is based on the relational model. Applications that allow you to 
create databases with the relational model are, therefore, often referred to 
as Relational Database Management Systems (RDBMS).

In a relational database, data is organized in a system of rows and 
columns. The rows are called records, and the columns are called fields. 
Each record contains a collection of related data, all information relating 
to a specific customer, for example. Each field refers to a common type of 
data that exists in all records, the names of the customers, for example. 
Records and fields are stored in a database table. The following diagram 
illustrates the basic relational database model:

Often, data in two different tables can be related by a common field. For 
example, a Customers table will have a Customer ID for each customer, 
and an Orders table will have the Customer ID of each customer who 
placed an order, demonstrating a relationship between tables. The two 
tables can be linked by a common field (see Linking tables, Page 513). The 
following diagram displays how two tables can have a relationship: 

Customer ID Customer Name Address 1

Customer Table

City Region Postal Code

Row

1
2
3
4
5
6
7
8
9
10

Bike-O-Rama
The Pedellars Inc.
Bikes 'R Us Enterprises
Cycle Sporin Corporation
Sporting Wheels Inc.
The Cytclists Company
Ride 'Em Cowboy Corp.
XYZ Enterprises
Trail Blazer's Place
The Cyclists Incorporated

7464 St. Georges Way
410 Eighth Avenue
7429 First Boulevard
8287 St Georges Way
480 Grant Way
1984 Sydney Street
8194 Pender Avenue
3802 Georgia Court
6938 Second Street
4861 Second Road

Sterling Heights
Dekalb
Blacklick
Huntsville
San Diego
Austin
Eden Prairie
Des Moines
Madison
Newbury Park

MI
IL
OH
AL
CA
TX
MN
LA
WI
CA

48358
60148
4300
35818
92160
78770
55360
5030
53795
9134

Column
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Aliases For a variety of reasons, database names and locations get changed. If you 
create a report, then change the name or location of a table or file, Seagate 
Crystal Reports must be able to find the new name or location. This is 
especially important when you create formulas in your report that access 
a table that has been renamed or moved. To fix the reference for a single 
field would not be difficult, but to find every formula that uses that field 
could be a difficult and time consuming task.

To solve this problem, Seagate Crystal Reports uses aliases to refer to 
database tables and files. Aliases are pointers, internal devices that tell the 
program where it should look for a database field. Now, if you change the 
name or location of the database, you simply reset the pointer. See 
Locating files, Page 510. The name of the alias does not change, so your 
formulas are not affected. Seagate Crystal Reports looks to the alias for 
the location and name, goes to the new location for the database field, and 
executes the formula without a problem.

Customer ID Customer Name Address 1

Customer Table

City Region Postal Cod

1
2
3
4
5
6
7
8
9
10

Bike-O-Rama
The Pedellars Inc.
Bikes 'R Us Enterprises
Cycle Sporin Corporation
Sporting Wheels Inc.
The Cytclists Company
Ride 'Em Cowboy Corp.
XYZ Enterprises
Trail Blazer's Place
The Cyclists Incorporated

7464 St. Georges Way
410 Eighth Avenue
7429 First Boulevard
8287 St Georges Way
480 Grant Way
1984 Sydney Street
8194 Pender Avenue
3802 Georgia Court
6938 Second Street
4861 Second Road

Sterling Heights
Dekalb
Blacklick
Huntsville
San Diego
Austin
Eden Prairie
Des Moines
Madison
Newbury Park

MI
IL
OH
AL
CA
TX
MN
LA
WI
CA

48358
60148
4300
35818
92160
78770
55360
5030
53795
9134

1
41
77
18
64
7
32
11
25
34
71
66
28
8
72
64
38
37
30
25

Customer ID Order ID Order Amount Order Data Ship Via

Order Table
Relationships

between tables
based on a

common field

1
1001
1003
1004
1005
1006
1007
1008
1009
1010
1011
1012
1013
1014
1015
1016
1017
1018
1019
1020

$41.90
$5,060.27
$186.86
$823.05
$0.00
$64.90
$49.50
$2,214.93
$29.00
$14,872.28
$0.00
$10,259.10
$1,142.12
$0.00
$0.00
$563.70
$72.00
$115.50
$0.00
$67.80

94/12/02
94/12/02
94/12/02
94/12/02
94/12/03
94/12/03
94/12/03
94/12/03
94/12/03
94/12/03
94/12/03
94/12/03
94/12/03
94/12/04
94/12/04
94/12/04
94/12/05
94/12/05
94/12/05
94/12/05

UPS
Pickkup
UPS
Pickup
Loomis
Purolater
Parcel Post
Purolator
Loomis
UPS
Purolator
Loomis
Parcel Post
Purolator
UPS
FedEx
Purolator
Loomis
Parcel Post
FedEx
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Seagate Crystal Reports automatically assigns default alias names to 
database tables when you first select the table or file. By default, an alias 
matches the original name of the table. In databases where the database 
table is a separate file (for instance, dBASE), the name of the database file 
is used without the file name extension. For example, if you are using the 
dBASE database file COMPANY.DBF, the program will assign a default 
alias name of COMPANY to the file. You can accept the default alias or 
assign a new one to the database table.

You can change an alias at any time using the SET ALIAS command on the 
Database Menu. However, if you have already created formulas in your 
report using the original alias name, you will need to edit the formulas to 
use the new alias.

Locating files When a database file is moved or renamed, Seagate Crystal Reports will 
not be able to find the data the next time the report is printed. On other 
occasions, a report may be created on one machine where all of the 
database data is stored in a certain directory, then the report is copied or 
moved to another machine that stores the same data in a different 
directory. In any of these events, you need to verify the location of the 
database files accessed by the report and reset the alias pointers to the 
new database location or name.

OLDNAME.DBF

MY_ALIAS

NEWNAME.DBF

MY_ALIAS

MY_ALIAS

NEWNAME.DBF
(in new location)
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The VERIFY DATABASE command on the Database Menu checks the alias 
pointers stored in a report file to verify that the database files expected are 
located in the indicated directories. If the databases are not found in the 
specified location, the program notifies you of the discrepancies. Search 
for Verify Database command in Seagate Crystal Reports online Help.

Use the SET LOCATION command on the Database Menu to change the 
alias pointers stored by Seagate Crystal Reports. The SET LOCATION 
command provides a simple way to indicate the new name or location of 
database files. In addition, the SET LOCATION command can be used to 
change the ODBC data source used by a report. See How to change the 
ODBC data source accessed by a report, Page 563, and search for Set Location 
command in Seagate Crystal Reports online Help.

Indexed tables Creating indexes for database tables can increase the speed of data access 
and reduce the time it takes for the program to evaluate data. Some DBMS 
applications automatically index your database tables, while others 
require that you create an index yourself. For the best report generation 
performance, make sure each of your database tables has a corresponding 
index.

MYFILE.DBF

ALIAS

ALIAS

ALIAS

Database file
in original
location.

MYFILE.DBF

Database file
has been
moved.

Use the Set
Location command
to change the
location pointed to
by the alias.

MYFILE.DBF
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NOTE: Some DBMS applications do not support indexed tables. Refer to 
the documentation for your DBMS to find out if it supports indexes and 
how to create them. If your DBMS documentation does not mention 
indexed tables, it may not support them, and you should link tables based 
on common fields. The Visual Linking Expert can also help you determine 
if your tables include indexes. Search for Visual Linking Expert in Seagate 
Crystal Reports online Help.

Indexes organize the records in a relational database table so that data can 
be located easier. For example, assume you have a table with the 
following data:
 

The information in this table is organized according to the Order# field. 
This is fine anytime you want to look up information in the table based 
on order numbers. However, what if you want to look up information 
specific to a certain customer?

Say you want to look up all orders made by Sierra Bicycle Group. The 
database engine must begin by looking at the first order number in the list 
and checking to see if the customer name matches the request. If not, it 
goes to the second order number, and checks that customer name. When 
an order number is reached that contains the correct customer name, the 
database engine retrieves the information, then continues to the next 
order number. Using this technique, both the Order# field and the 
Customer field must be read for every single record in the table. This 
takes a long time and a large amount of computer processing effort for 
examining extensive database tables with thousands, or even millions of 
records.

Instead, you can create an index for the table based on the Customer field. 
Such an index might look like this:

Order# Customer Amount

10444 Allez Distribution 25141.50

10470 BG Mountain Inc. 19164.30

10485 Sierra Mountain 8233.50

10488 Mountain Toad 24580.50

10495 SFB Inc. 7911.80

10501 La Bomba de Bicicleta 1956.20

10511 BG Mountain Inc. 1683.60

10544 Sierra Bicycle Group 19766.20

10568 Mountain Tops Inc. 29759.55

10579 Sierra Bicycle Group 12763.95
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In this index, information is organized by customers, not order numbers. 
Also, notice that the second column actually contains pointers to specific 
order numbers in the original table. By using this index, the database 
engine can search just the information in the Customer column until it 
finds the customer you are interested in, Sierra Bicycle Group.

For each correct customer entry the database engine finds in the index, it 
looks up the matching order in the table according to the pointer in the 
second column of the index. Only the orders for the correct customer are 
read. Finally, since information in the index is organized according to the 
customer names, the database engine does not need to continue searching 
through the index or the table as soon as it finds an index entry that does 
not match the requested customer.

The advantage of this highly organized search through a database table 
according to an index is speed. Using indexes speeds up data retrieval 
and report generation, important factors when reporting on large 
database files.

Linking tables You link tables so records from one table will match related records from 
another. For example, if you activate an Orders table and a Customers 
table, you link the tables so that each order (from the Orders table) can be 
matched up with the customer (from the Customer table) that made the 
order.

When you link, you are using a field that is common to both tables. 
Seagate Crystal Reports uses the link to match up records from one table 
with those from the other. In this example, the link assures that the data 
in each row of the report refers to the same order.

Customer Pointer to Order#

Allez Distribution 10444

BG Mountain Inc. 10470

BG Mountain Inc. 10511

La Bomba de Bicicleta 10501

Mountain Toad 10488

Mountain Tops Inc. 10568

SFB Inc. 10495

Sierra Bicycle Group 10544

Sierra Bicycle Group 10579

Sierra Mountain 10485
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Link from and link to

When you link two tables, you link from one table to another table. When 
linking tables, you must understand this concept. The from table is used 
as a primary table, while the to table acts as a lookup table where records 
are looked up by the primary table. In a simple link, Seagate Crystal 
Reports examines the first record in the primary table and finds all 
matching records in the lookup table. Once all matches have been found 
in the lookup table for the first record in the primary table, all matches in 
the lookup table for the next record in the primary table are found.

NOTE: Seagate Crystal Reports can link two records based on a partial 
match of string data. This is called a partial link. To enable partial linking 
in Seagate Crystal Reports, toggle the Allow partial text matches check box 
on using the Link Options dialog box. As an example of a partial link, a 
record with a field value of “Chris” can link to a record with a field value 
of “Christopher”. However, partial linking only works when the value in 
the lookup table is longer than the value in the primary table. In other 
words, the value “Chris” can link to the value “Christopher”, but the 
value “Christopher” can not link to the value “Chris”. Search for Link 
Options dialog box in Seagate Crystal Reports online Help.

Link relationships

When you link records from one table to another table, the records will 
typically fall under one of two relationship types:

1. one-to-one, or

2. one-to-many.

ONE-TO-ONE RELATIONSHIPS

In a one-to-one relationship between records in two linked tables, for 
every record in the primary table there is only one matching record in the 
lookup table (based on the linked fields). For example, in the xtreme.mdb 
database, the Employee table can be linked to the Employee Addresses 
table based on the Employee ID field in each table. The Employee table 
contains information about employees at the company, the positions they 
hold, their salaries, hiring information, etc. The Employee Addresses 
table contains each employee's home address. There is only one record for 
each employee in each of these tables. Therefore, if the Employee table is 
linked to the Employee Addresses table, only one record will be found in 
the Employee Addresses table for each record in the Employee table. This 
is a one-to-one relationship.
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ONE-TO-MANY RELATIONSHIPS

In a one-to-many relationship between records in two linked tables, for 
every record in the primary table, there may be more than one matching 
record in the lookup table, based on the linked fields. In the xtreme.mdb 
database, the Customer table can be linked to the Orders table based on 
the Customer ID field in each table. The Customer table contains 
information about each customer that has placed an order with the 
company. The Orders table contains information about orders that 
customers have placed. Since customers can place more than one order, 
there may be more than one record in the Orders table for each customer 
record in the Customers table. This is a one-to-many relationship.

Performance considerations in one-to-many links

The information provided in this section is intended to help you 
maximize processing time and minimize network traffic when you are 
running your reports. You will learn about the best ways to use selection 
formulas and indexes in one-to-many situations to make your reporting 
more efficient. If you do not use the information in this section, your 
reports may end up processing dozens or even hundreds more records 
than necessary. 

When a one-to-many situation exists between two database tables and the 
program matches up records from the tables, there are a number of 
factors that determine how many records the program reads and 
evaluates. Understanding this information will help you avoid those 
situations that require excessive processing time or that generate 
unnecessary network traffic.

The tables that follow show the effects of the different factors on the 
number of records the program ultimately has to read. The charts are 
based on these assumptions:

●   Table A contains 26 records (one for each letter in the alphabet).

●   Table B contains 2600 records (100 matching records for every 
record in Table A).

●   The scenario is to produce a report that finds two specific records 
in Table A and the 200 records (100+100) in Table B that match 
those two records in Table A.

   In a best case scenario, the program would only have to read 
about 200 records to accomplish the task.

   In a worst case scenario the program would have to read about 
67,600 records to accomplish the same task.
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NOTE: The performance considerations for data files are different from 
the considerations for SQL databases. A data file is any non-SQL database 
that is accessed directly from Seagate Crystal Reports. For the purpose of 
this discussion, an SQL database is any SQL database accessed directly 
from Seagate Crystal Reports or through ODBC as well as any other 
database types that are accessed through ODBC. For a better 
understanding of the difference between direct access databases and 
ODBC data sources, see Data Sources, Page 579.

EXTENDED DESCRIPTIONS OF CHART COLUMNS

The performance charts use the following columns:

●   Linking or Subreport
Are you creating a report from linked databases or are you 
inserting a subreport and binding it to the data in your primary 
report?

●   Selection Formula
Does your primary report include a record selection formula that 
sets range limits on the key (indexed) field in Table A?

●   Index A
Is Table A on the field you are going to use indexed to match up 
the records?

●   Index B
Is Table B on the field you are going to use indexed to match up 
the records?

●   Reads A
How many records does the program have to read out of Table A 
to find the two records it is looking for?

●   For each A reads in B
How many records does the program have to read in Table B to 
find the 200 records it is looking for?

●   Total Records Read
What is the total number of records the program has to process to 
complete the task?

PC Data

Linking/
Subreport

Selection 
Formula Index A Index B Reads A

For each 
A reads in 
B

Total 
Records 
Read

Linking No Yes or No Yes 26 100 
(26*100)

2600
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Data file considerations

When working with data files, one-to-many links can occur when you 
link tables in a single report or when you add a subreport to your report.

LINKING DATA FILES

When retrieving data from linked data files in one-to-many situations, the 
program uses the following process:

●   If there is a selection formula, the program parses the selection 
formula and passes what it can down to the database DLL. This is 
generally range limit information. Consider the following record 
selection formula:

Linking Yes No Yes 26 100 
(26*100)

2600

Linking Yes Yes Yes 2 100 
(2*100)

200

Subreport No No No 26 2600 
(26*2600)

67,600

Subreport No Yes No 2 2600 
(26*2600)

67,600

Subreport No Yes Yes 26 100 
(26*100)

2600

Subreport Yes No No 2 2600 
(2*2600)

5200

Subreport Yes No Yes 26 100 
(26*100)

2600

Subreport Yes Yes Yes 2 100 
(2*100)

200

PC Data

SQL Data

Linking/
Subreport

Selection 
Formula Reads A For each A reads 

in B
Total Records 
Read

Linking No 26 100 (26*100) 2600

Linking Yes 2 100 (2*100) 200

Subreport No 26 100 (26*100) 2600

Subreport Yes 2 100 (2*100) 200
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{customer.REGION} in “CA” to “IL” AND
Remainder ({customer.CUSTOMER ID},2)=0

In this formula, the part before the “and” operator contains range 
selection criteria for the Region field. The region must fall 
alphabetically between “CA” and “IL”. The program passes this 
kind of condition down to either the database DLL (for PC data) or 
the server (for SQL data). See Record and Group Selection, Page 227.

The second half of the selection formula, however, requires 
processing that must be done in the Report Engine. It uses a built-
in function to manipulate and evaluate a field value and it can not 
be done in the database DLL or the server. The program does not 
pass this condition to the database DLL.

●   If there is an index on Table A, and the range limit selection 
condition is based on the indexed field ({customer.REGION} in 
this example), the program goes directly to the record it is seeking 
in Table A (the first CA record) and reads it.

   For that record, the program locates the first matching record 
in Table B, using the Table B index.

   The program passes this merged record (A+B) back to Seagate 
Crystal Reports, which tests the record against the entire 
selection formula.

   The program then reads the second matching record and 
passes the merged record on, and then reads the third 
matching record, and so on, until it has read all of the 
matching records.

   The program then it returns to Table A and reads the next 
record. There is no need to test the record to see if it meets the 
CA condition; the field is indexed and the records are in 
alphabetic order. But the program tests the record to see if it 
goes beyond the “IL” condition (for example, could the next 
record be from Mississippi or Tennessee?). If the record is still 
within the specified range, the program begins the matching 
process again for that record.

   The program continues the process until it has located all 
targeted Table A records and the matching Table B records.

To find two records in Table A and the 100 records in Table B that 
match the Table A records, the program reads 200 records.

NOTE: The lookup table in a link (Table B) must always be indexed; 
otherwise, you will not be able to link the tables.
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●   If there is no index on Table A, or if there is an index but the range 
limit selection condition is not based on the indexed field, the 
program reads the first record it finds.

   For that record, the program uses the Table B index to locate 
the first matching record in Table B.

   The program passes this merged record (A+B) back to the 
Report Engine, which tests it against the entire selection 
formula.

   The program then locates the second matching record in Table 
B and passes that merged record back, then the third record, 
and so on, until it has located, merged, and passed back all the 
records in Table B that match the first record in Table A.

   The program then moves on to the next record in Table A and 
begins the matching and merging process all over again.

To find two records in Table A and the 100 records in Table B that 
match the Table A records, the program reads 2600 records.

SUBREPORTS AND DATA FILES

If your primary report is based on Table A, the subreport is based on 
Table B, and the records are linked, your primary considerations are as 
follows:

●   The number of subreports that are run by the program is 
determined by the index and the selection formula situation in the 
primary report.

   If Table A is indexed, and if the primary report has a selection 
formula that passes down range limit conditions for the 
indexed field, the program runs two subreports.

   If Table A is not indexed, or if Table A is indexed but the 
selection formula does not pass down range limit conditions 
for the indexed field, the program runs 26 subreports.

●   The number of records read for each subreport is determined by 
the index situation on Table B.

   If you have an index on Table B, the program will read only 
the matching records (100) when it runs a subreport.

   If you do not have an index on Table B, the program will 
always read every record in Table B (2600) when it runs a 
subreport.
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SQL database considerations

Since indexes are not critical with SQL data, the primary concern with 
both linked tables and subreports is whether or not there is a selection 
formula in the primary report that puts range limits on Table A. See 
LINKING DATA FILES, Page 517.

LINKED SQL TABLES

If there are range limit conditions in the selection formula, the program 
passes those conditions down to the server.

●   If there is a selection formula that puts range limits on Table A, the 
server locates the records in Table A that satisfy the selection 
criteria (2), matches them up with the appropriate records in Table 
B (100), and returns 200 merged records to the Report Engine.

●   If there is no selection formula, or if there is a selection formula 
that does not put range limits on Table A, the server matches up 
each record in Table A (26) with the appropriate records in Table B 
(100), and returns 2600 merged records to the Report Engine.

In either case, the Report Engine will then apply the entire selection 
formula to the merged records.

SUBREPORTS AND SQL DATABASES

If you are creating a primary report based on Table A and a subreport 
based on Table B:

●   The number of subreports that are run is determined by the 
selection formula situation in the primary report.

   If there is a selection formula and it passes down range limits 
on Table A, the program runs a subreport only for those 
records that satisfy range limit conditions (2).

   If there is no selection formula, or if the selection formula does 
not pass down range limits on Table A, the program runs a 
subreport for every record in Table A (26).

●   The number of records read by each subreport remains the same 
regardless of whether there was range limit selection on Table A. 
Each subreport will read only those records in Table B that match 
each record read in Table A (100).

Performance considerations for all reports

CONSIDERATION #1

With both data files and SQL databases, the program parses the entire 
selection formula and passes down whatever parts of the criteria it is able 
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to translate (pass), wherever they may physically appear in the formula. 
Thus, if the formula finds criteria it can pass, then criteria that it can not, 
then criteria that it can, it passes down the first part, skips the second, and 
then passes down the third.

●   In the case of data files, the program passes down the criteria that 
it can to the database translation layer.

●   In the case of SQL databases, the program passes down to the 
server the criteria that it can in the form of a WHERE clause.

While there are exceptions, as a general rule the program can pass down 
any part of the record selection formula that compares a field with a 
constant. Typically, this means that it can pass down any kind of record 
selection criteria that can be set up in the Select Expert (equal to, one of, less 
than, greater than, less than or equal, greater than or equal, between, starting 
with, or like constant).

There are two special selection formula situations that you need to 
consider. In these situations, the record selection formula includes 
multiple conditions, some of which can be passed down while others can 
not.

1. AND situations

{customer.REGION} = “CA” and
{customer.CUSTOMER ID}[3 to 5] = “777”)

In this situation, the program sees that it can pass down the condition 
before the And operator but not the condition after. Since the only 
records that will meet the second condition will have to meet the first 
as well, the program passes down the first condition, retrieves the 
data set that satisfies the condition, and then applies the second 
condition only to the retrieved data. The rule for AND situations is 
that the program passes down whatever conditions it can.

NOTE: If all of the conditions in an AND situation can be satisfied on the 
server or in the database DLL, the program passes them all down.

2. OR situations

{customer.REGION} = “CA” or
{customer.CUSTOMER ID}[3 to 5] = “777”)

In this situation, the program also sees that it can pass down the 
condition before the Or operator but not the condition after. Since 
there are records that can satisfy the second condition without 
satisfying the first, passing the first condition down does not make 
any sense because it will retrieve an incomplete data set. In other 
words, even if it retrieves all the data that satisfies the first condition, 
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it will still have to retrieve all the data in the table(s) before it can 
apply the second condition in Seagate Crystal Reports. Thus, instead 
of duplicating parts of the data retrieval, the program passes nothing 
down. It retrieves all the data and then runs both tests in Seagate 
Crystal Reports. The rule for OR situations is that the program either 
passes down all the tests, or none of the tests.

NOTE: If all the tests in an OR situation can be performed on the server 
or in the database DLL, the program passes them all down.

CONSIDERATION #2

To make certain the program can use the index on Table A to enhance 
performance, make certain that:

●   there is a selection formula,

●   there are range limits in the selection formula on the key (indexed) 
field in Table A, and

●   the Use Indexes option is toggled on in the Options dialog box. 
Search for Options dialog box in Seagate Crystal Reports online 
Help.

CONSIDERATION #3

If the fields you are using from Table A are not indexed, but there is an 
indexed field that you can use in your record selection request, use that 
field. For example, assume that you have three products (Product 1, 
Product 2, and Product 3) and you want to identify all sales of Product 2 
in the U.S. There is no index on the Product field but there is an index on 
the Order Date field. Since you know that Product 2 did not begin 
shipping until July of 1995, you can improve speed by limiting your 
report to orders placed in and after July 1995 using the selection formula. 
In such a case, the program uses the Order Date index to retrieve only 
those orders from July 1995 and afterward (a small subset of the entire 
database) and then searches for the occurrences of Product 2 in that 
subset, not in the entire database.

The Visual Linking Expert

The Visual Linking Expert lets you easily link two or more tables. When 
you choose the ADD DATABASE TO REPORT command from the Database 
Menu and select an additional database table, the Visual Linking Expert 
appears and displays that database table. Search for Visual Linking Expert 
and Add Database To Report command in Seagate Crystal Reports online 
Help.

The easiest way to link database tables is to click the Smart Linking button 
in the Visual Linking Expert. Smart Linking automatically chooses links 
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for your tables based on common fields in tables or indexed fields (if your 
database supports indexed fields).

Linking indexed tables 

When you are linking direct-access database tables, you must link from 
the primary table to an indexed field in the lookup table. The link field in 
the primary table can be indexed, but does not have to be. The link field 
in the lookup table, however, must be indexed.

In addition, the fields used to link two tables must have the same data 
type. For example, you can link a string field in one table to a string field 
in another table, or a numeric field in one table to a numeric field in 
another table, but you can not link a numeric field in one table to a string 
field in another table.

NOTE: Some DBMS applications allow you to convert the field value to 
another data type in the index. For instance, the field in the table can be 
numeric, while the index converts the field value to a string. However, if 
you choose to use that field to link to another table, you must link to a 
field of the original data type. You can not link a string value to a numeric 
field that has been converted to a string in the index.

NOTE: If you are linking tables from two different ODBC data sources, 
MS SQL Server and Oracle, for example, you can only use string fields to 
link the tables. String fields are stored in databases in the same manner, 
regardless of the data source. Other types of values, however, may not be 
stored the same way in different data sources, so you can not link 
different data sources in Seagate Crystal Reports using anything other 
than string values.

CHANGING THE INDEX USED IN LINKING

When using the Smart Linking feature to link tables using a field that is a 
component of multiple indexes (two or more), Seagate Crystal Reports 
selects one of the indexes for the link. That index may or may not be the 
one you want to use. To determine the index in use and to change it, use 
the Index section of the Link Options dialog box. 

To call up the dialog box, either:

●   double-click the link line of interest,

●   select the link line of interest and click the Options button at the 
bottom of the Visual Linking Expert, or 

●   right-click the link line of interest, and choose the OPTIONS 
command from the shortcut menu that appears.

The Index section of the Link Options dialog box has two parts:
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1. The Index In Use text box
This text box displays the index that is currently in use. If you click 
the arrow, it lists the other indexes that are available for the link, as 
well as the option No specific index. If you are using an indexed 
database table and you do not see a particular index that you would 
expect to see on this list, use the Add Index button.

2. The Fields in Index text box
This text box displays the fields that are included in the index that is 
currently selected in the Index In Use list box.

If you select the No specific index option, the program will select an index 
for you the next time you print the report to the Preview Tab.

NOTE: Not all DBMS applications support indexed tables. Verify that 
your database uses indexes before trying to select an index for linking. 
Refer to your DBMS documentation to find out if your DBMS can use 
indexes, and to learn how to create them.

Methods of looking up tables (direct access databases)

When a single table is linked to two or more tables, Seagate Crystal 
Reports needs to know in what order it should look up and link data from 
the primary table to data in the second, third, etc., lookup table. 

Seagate Crystal Reports offers three options for looking up records in two 
or more lookup tables from a single primary table:

1. LOOK UP BOTH AT THE SAME TIME, Page 525

2. LOOK UP ALL OF ONE, THEN ALL OF OTHERS (A TO B, A TO C), 
Page 525

3. LOOK UP ALL THE COMBINATIONS OF THE TWO FILES, Page 526

NOTE: These options are not available if you are using data from an 
ODBC data source.

These options are only available when you have a single table (a primary 
table) that is linked to two or more lookup tables. The primary table must 
be the link from table in each of the links. For instance, if you link from the 
Customer table to the Orders table and from the Customer table to the 
Credit table, these lookup options are available. However, if you link 
from the Customer table to the Orders table and from the Credit table to 
the Customer table, these options are not available.

In this example, for each method demonstrated three fields from three 
different linked tables will be shown. In each case, the Customer table is 
linked to the Credit table and the Orders table. The fields displayed are 
the Customer Name field from the Customer table, the Amount field 
from the Credit table, and the Order Amount field from the Orders table. 
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These are not necessarily actual link fields for the tables, but the data in 
these fields illustrates how data is retrieved using each of the three 
lookup methods.

LOOK UP BOTH AT THE SAME TIME

For each record in the Customer table, this option looks for a matching 
record in the Credit table and a matching record in the Orders table. Then 
it looks for the next matching record in the Credit table and the next 
matching record in the Orders table, etc. Once it finds all the matching 
records, it repeats the process with the next record in the Customer table.

Notice that for each line in the report, the value in the Amount field of the 
Credit table does not necessarily have any connection to the value in the 
Order Amount field of the Orders table. However, for each record in the 
Customer table, one record is selected from the Credit table, and one 
record is selected from the Orders table, at the same time.

Also notice that when the Credit table runs out of records for a given 
record in the Customer table, blanks are left in place of values until all 
related records from the Orders table are found. The same holds true if 
the Orders table runs out of records.

LOOK UP ALL OF ONE, THEN ALL OF OTHERS (A TO B, 
A TO C)

For each record in the Customer table, this option looks for all the 
matching records in the Credit table (Table B) and then looks for all the 
matching records in the Orders table (Table C). Then it repeats the 
process with the next record in the Customer table, and the next, etc.

Customer Table Credit Table Orders Table

Customer Name Amount Order Amount

Cyclists 
Incorporated

($1088.56) $1529.70

Cyclists 
Incorporated

($1260.12) $23.50

CyclePath Corp. ($1958.03) $49.50

CyclePath Corp. ($1076.43) $1702.60

CyclePath Corp. ($75.04)

The Great Bike Shop ($138.98) $3269.70

The Great Bike Shop $5219.55

The Great Bike Shop $1538.20
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NOTE: If you want Table C data (the Orders table in this example) to 
appear in the report before Table B data (Credit table), you will need to 
change the links so that the A to C link comes first, followed by the A to B 
link. You do this in the Visual Linking Expert. To change the order of the 
links, delete the existing links and set up new links in the desired order.

LOOK UP ALL THE COMBINATIONS OF THE TWO FILES

For each record in the Customer table, this option looks for a matching 
record in the Credit table, and then finds all the matching records in the 
Orders table. Once it finds all the matching records in the Orders table, it 
repeats the process with the next record in the Credit table, then the next, 
etc. When it finds matching Orders records for all the Credit records that 
match the first Customer record, it moves to the next Customer record 
and repeats the process.

Customer Table Credit Table Orders Table

Customer Name Amount Order Amount

Cyclists 
Incorporated

($1088.56)

Cyclists 
Incorporated

($1260.12)

Cyclists 
Incorporated

$1529.70

Cyclists 
Incorporated

$23.50

CyclePath Corp. ($1958.03)

CyclePath Corp. ($1076.43)

CyclePath Corp. ($75.04)

CyclePath Corp. $49.50

CyclePath Corp. $1702.60

The Great Bike Shop ($138.98)

The Great Bike Shop $3269.70

The Great Bike Shop $5219.55

The Great Bike Shop $1538.20
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NOTE: If you want the program to look up the first matching record in 
Table C (the Orders table in this example), and then find all matching 
records in Table B (Credit table), the reverse of the current process, you 
will need to change your links so that the A to C link comes first, followed 
by the A to B link. You do this in the Visual Linking Expert. To change the 
order of the links, delete the existing links and set up new links in the 
order you want.

SQL join types (ODBC data sources)

Seagate Crystal Reports enables you to specify the type of join you want 
to use when linking SQL tables. An SQL join indicates how linked fields 
in two SQL tables are compared when records are read. The SQL Join 
Type options can be specified in the Link Options dialog box.

NOTE: When you link fields using SQL joins, no indexed fields are required.

The join types are:

●   Equal [=] join, Page 528

●   Left Outer [=(+), *=] join, Page 529

Customer Table Credit Table Orders Table

Customer Name Amount Order Amount

Cyclists 
Incorporated

($1088.56) $1529.70

Cyclists 
Incorporated

($1088.56) $23.50

Cyclists 
Incorporated

($1260.12) $1529.70

Cyclists 
Incorporated

($1260.12) $23.50

CyclePath Corp ($1958.03) $49.50

CyclePath Corp ($1958.03) $1702.60

CyclePath Corp ($1076.43) $49.50

CyclePath Corp ($1076.43) $1702.60

CyclePath Corp ($75.04) $49.50

CyclePath Corp ($75.04) $1702.60

The Great Bike Shop ($138.98) $3269.70

The Great Bike Shop ($138.98) $5219.55

The Great Bike Shop ($138.98) $1538.20
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●   Right Outer [(+)=, =*] join, Page 529

●   Greater Than [>] join, Page 530Less Than [<] join, Page 531

●   Greater Than Or Equal [>=] join, Page 532

●   Less Than Or Equal [<=] join, Page 533

●   Not Equal [!=, <>] join, Page 534

Equal [=] join

The result set from an Equal join includes all the records where the linked 
field value in both tables is an exact match. In the following example, the 
Customer table is linked to the Orders table by the Customer ID field. 
When the program finds a Customer ID in the Orders table that matches 
a Customer ID in the Customer table, it displays information for the 
corresponding records in both tables.

SQL uses the following syntax to describe an Equal join:

SELECT Customer.’Customer ID’,
Customer.’Customer Name’,
Orders.’Order Amount’

FROM ’Customer’ Customer,
’Orders’ Orders

WHERE Customer.Customer ID =
Orders.Customer ID

This statement produces the following data:

Customer Table Customer Table Orders Table

Customer ID Customer Name Order Amount

52 Allez Distribution 25141.50

53 BG Mountain Inc. 19164.30

53 BG Mountain Inc. 1683.60

57 Hansen MTB Inc. 15716.40

58 La Bomba de 
Bicicleta

1956.20

60 Mountain Toad 24580.50

62 SFB Inc. 7911.80

63 Sierra Bicycle Group 19766.20

63 Sierra Bicycle Group 12763.95

64 Sierra Mountain 8233.50
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Left Outer [=(+), *=] join

The result set from a Left Outer join includes all the records in which the 
linked field value in both tables is an exact match. It also includes a row 
for every record in the primary (left) table for which the linked field value 
has no match in the lookup table. For instance, you can use a Left Outer 
join to view all customers and the orders they have placed, but you also 
get a row for every customer who has not placed any orders. These 
customers appear at the end of the list with blanks in the fields that would 
otherwise hold order information:

NOTE: Left Outer and Right Outer joins are handled differently in the 
SQL language from other join types. If the database is accessed through 
ODBC, Seagate Crystal Reports will use ODBC syntax in the SQL 
statement. If you are connecting to an SQL database directly (not through 
ODBC), Seagate Crystal Reports will use a syntax native to the database. 
For more information about what an Outer join looks like in an SQL 
statement, refer to Microsoft ODBC documentation or to the 
documentation for your SQL database.

Right Outer [(+)=, =*] join

The result set from a Right Outer join includes all the records in which the 
linked field value in both tables is an exact match. It also includes a row 
for every record in the lookup (right) table for which the linked field 
value has no match in the primary table. If you link the Customer table to 
the Orders table, you get one row in the table for each order a customer 

Customer Table Customer Table Orders Table

Customer ID Customer Name Order Amount

52 Allez Distribution 25141.50

53 BG Mountain Inc. 19164.30

53 BG Mountain Inc. 1683.60

57 Hansen MTB Inc. 15716.40

58 La Bomba de Bicicleta 1956.20

60 Mountain Toad 24580.50

62 SFB Inc. 7911.80

63 Sierra Bicycle Group 19766.20

63 Sierra Bicycle Group 12763.95

64 Sierra Mountain 8233.50

54 Bicicletas Aztecas

55 Deely MTB Inc.
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has placed, as with an Equal join. You also get a row for every order 
found that can not be linked to a customer. Theoretically, this should not 
happen, but if an inexperienced sales person forgot to assign a customer 
ID to an order, you can quickly locate that order with a Right Outer join. 
The resulting table leaves a blank in any of the Customer fields for the 
order without a customer:

NOTE: Left Outer and Right Outer joins are handled differently in the 
SQL language from other join types. If the database is accessed through 
ODBC, Seagate Crystal Reports will use ODBC syntax in the SQL 
statement. If you are connecting to a SQL database directly (not through 
ODBC), Seagate Crystal Reports will use a syntax native to the database. 
For more information about what an Outer join looks like in an SQL 
statement, refer to Microsoft ODBC documentation or to the 
documentation for your SQL database.

Greater Than [>] join

The result set from a Greater Than join includes all records in which the 
linked field value from the primary table is greater than the linked field 
value in the lookup table. As an example, a company may want to 
compare the salaries made by all their sales representatives to the salaries 
made by all their sales managers. The company executives want to make 
sure no sales representative is making more money than any manager. 
With this in mind, you can link the SalesRep table to the Manager table 
by the Salary field in each table using a Greater Than join:

Customer Table Orders Table Orders Table

Customer ID Order ID Order Amount

52 6 25141.50

53 11 19164.30

53 21 1683.60

57 4 15716.40

58 20 1956.20

60 16 24580.50

62 19 7911.80

63 28 19766.20

63 32 12763.95

64 14 8233.50

25 10320.87
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SELECT SalesRep.’Last Name’,
SalesRep.’Salary’,
Manager.’Last Name’,
Manager.’Salary’

FROM ’SalesRep’ SalesRep,
’Manager’ Manager

WHERE SalesRep.’Salary’ >
Manager.’Salary’

This SQL statement might produce data similar to this: 

In this table, there is no relationship established between sales 
representatives and sales managers. Since all managers have seniority 
over all sales representatives, a company might find it necessary to check 
if any representatives make more money than any managers, evidence of 
a salary problem that needs to be remedied.

Less Than [<] join

The result set from a Less Than join includes all records in which the 
linked field value in the primary table is less than the linked field value 
in the lookup table. Using the Less Than join, you can compare sales 
representative and manager salaries in a different direction. Once again, 
the Salary field in each table is used as the link field. This time, though, 
you link from the Manager table to the SalesRep table using a Less Than 
join on the linked Salary fields:

SELECT Manager.’Last Name’,
Manager.’Salary’,
SalesRep.’Last Name’,
SalesRep.’Salary’

FROM ’Manager’ Manager’,

SalesRep Table SalesRep Table Manager Table Manager Table

Last Name Salary Last Name Salary

Davolio $35,000.00 Fuller $32,000.00

Davolio $35,000.00 Brid $30,000.00

Davolio $35,000.00 Buchanan $29,500.00

Dodsworth $48,300.00 Hellstern $45,000.00

Dodsworth $48,300.00 Fuller $32,000.00

Dodsworth $48,300.00 Brid $30,000.00

Dodsworth $48,300.00 Buchanan $29,500.00

Dodsworth $48,300.00 Martin $35,000.00

Patterson $30,000.00 Buchanan $29,500.00
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SalesRep’ SalesRep
WHERE Manager.’Salary’ <

SalesRep.’Salary’

This SQL statement produces a slightly different table than that produced 
by the Greater Than join:

Greater Than Or Equal [>=] join

The result set from a Greater Than Or Equal join includes all records in 
which the linked field value in the primary table is greater than or equal 
to the linked field value in the lookup table. The example here is identical 
to the example for the Greater Than join, except that it uses the Greater 
Than Or Equal join:

SELECT SalesRep.’Last Name’,
SalesRep.’Salary’,
Manager.’Last Name’,
Manager.’Salary’

FROM ’SalesRep’ SalesRep,
’Manager’ Manager

WHERE SalesRep.’Salary’ >=
Manager.’Salary’

This statement might produce data such as this:

Manager Table Manager Table SalesRep Table SalesRep Table

Last Name Salary Last Name Salary

Fuller $32,000.00 Davolio $35,000.00

Fuller $32,000.00 Dodsworth $48,300.00

Brid $30,000.00 Davolio $35,000.00

Brid $30,000.00 Dodsworth $48,300.00

Buchanan $29,500.00 Davolio $35,000.00

Buchanan $29,500.00 Dodsworth $48,300.00

Buchanan $29,500.00 Patterson $30,000.00

Martin $35,000.00 Dodsworth $48,300.00

Hellstern $45,000.00 Dodsworth $48,300.00

SalesRep Table SalesRep Table Manager Table Manager Table

Last Name Salary Last Name Salary

Davolio $35,000.00 Fuller $32,000.00

Davolio $35,000.00 Brid $30,000.00
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Less Than Or Equal [<=] join

The result set from a Less Than Or Equal join includes all records in which 
the linked field value in the primary table is less than or equal to the 
linked field value in the lookup table. The example here is identical to the 
example for the Less Than join, except that it uses the Less Than Or Equal 
join:

SELECT Manager.’Last Name’,
Manager.’Salary’,
SalesRep.’Last Name’,
SalesRep.’Salary’

FROM ’Manager’ Manager’,
SalesRep’ SalesRep

WHERE Manager.’Salary’ <=
SalesRep.’Salary’

This SQL statement produces data similar to the following:

Davolio $35,000.00 Buchanan $29,500.00

Davolio $35,000.00 Martin $35,000.00

Dodsworth $48,300.00 Hellstern $45,000.00

Dodsworth $48,300.00 Fuller $32,000.00

Dodsworth $48,300.00 Brid $30,000.00

Dodsworth $48,300.00 Buchanan $29,500.00

Dodsworth $48,300.00 Martin $35,000.00

Patterson $30,000.00 Brid $30,000.00

Patterson $30,000.00 Buchanan $29,500.00

SalesRep Table SalesRep Table Manager Table Manager Table

Last Name Salary Last Name Salary

Manager Table Manager Table SalesRep Table SalesRep Table

Last Name Salary Last Name Salary

Fuller $32,000.00 Davolio $35,000.00

Fuller $32,000.00 Dodsworth $48,300.00

Brid $30,000.00 Davolio $35,000.00

Brid $30,000.00 Dodsworth $48,300.00

Brid $30,000.00 Patterson $30,000.00

Buchanan $29,500.00 Davolio $35,000.00
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Not Equal [!=, <>] join

The result set from a Not Equal join includes all records in which the 
linked field value in the primary table is not equal to the linked field value 
in the lookup table. This type of join can be used to find possible 
combinations of items when a table is joined to itself (a self-join). For 
example, a company can have a table listing all products they sell. When 
they decide to hold a sale where their customers buy one item and get the 
second item half price, they may need a list of all possible two item 
combinations:

SELECT Product1.’Product Name’,
Product2.’Product Name’,

FROM ’Product’ Product1
’Product’ Product2

WHERE Product1.’Product Name’ !=
Product2.’Product Name’

In this SQL statement, the Product table is opened twice. The first time, it 
is given the alias name Product1. The second time, it is given the alias 
name Product2. Then the Product Name field is used to link from the 
Product1 table to the Product2 table. This is the same table, but since it has 
been opened twice using different aliases, Seagate Crystal Reports will 
consider it two separate tables. A Not Equal join is used to link the tables 
by the Product Name field. As a result, each product is paired with every 
other product offered, but is not paired with itself: 

Buchanan $29,500.00 Dodsworth $48,300.00

Buchanan $29,500.00 Patterson $30,000.00

Martin $35,000.00 Davolio $35,000.00

Martin $35,000.00 Dodsworth $48,300.00

Hellstern $45,000.00 Dodsworth $48,300.00

Manager Table Manager Table SalesRep Table SalesRep Table

Last Name Salary Last Name Salary

Product1 Product2

Product Name (check names) Product Name

Xtreme Adult Helmet Xtreme Mtn Lock

Xtreme Adult Helmet InFlux Lycra Glove

Xtreme Adult Helmet Roadster Micro Mtn Saddle

Xtreme Mtn Lock Xtreme Adult Helmet

Xtreme Mtn Lock InFlux Lycra Glove
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NOTE: The symbol!= is used to represent a Not Equal join, if the ODBC 
data source driver for the data being accessed supports this symbol. If 
not, the default symbol <> is used to represent a Not Equal join. Search 
for Self join in Seagate Crystal Reports online Help.

Using SQL and 
SQL databases

Perhaps the most popular and most powerful database formats are 
DBMS applications based on the Structured Query Language (SQL). SQL 
databases usually work over a client/server network architecture, 
providing an SQL Server to create, store, and manipulate database files, 
tables, fields and records, and an SQL Client interface allowing 
workstation users not only to design and work with database files, but 
also to retrieve useful and meaningful data that will help them in their 
everyday work.

What is SQL?

SQL is a query language designed for organizing, managing, developing 
and querying large relational databases over computer networks. SQL is 
a common language in the Information Science (IS) and Information 
Management industry. The language has been standardized by the 
American National Standards Institute (ANSI) and the International 
Standards Organization (ISO), meaning that there are specific features 
that must be present in any version of SQL produced by a software 
company in order for that version to be officially called SQL. Many 
software vendors add more advanced features to their version of SQL in 
an effort to improve the language and attract customers, but it must retain 
the original standards established by ANSI and ISO.

You should realize that SQL is not a true computer language. It cannot be 
used to create stand-alone computer applications or operating systems. 
SQL is often referred to as a sub-language, since it can be used within 
other languages or applications. Most importantly, the purpose of the 
SQL language is specific to working with relational databases.

Xtreme Mtn Lock Roadster Micro Mtn Saddle

InFlux Lycra Glove Xtreme Adult Helmet

InFlux Lycra Glove Xtreme Mtn Lock

InFlux Lycra Glove Roadster Micro Mtn Saddle

Roadster Micro Mtn Saddle Xtreme Adult Helmet

Roadster Micro Mtn Saddle Xtreme Mtn Lock

Roadster Micro Mtn Saddle InFlux Lycra Glove

Product1 Product2

Product Name (check names) Product Name
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The syntax of the SQL language is built on a system of sending SQL 
statements to the SQL database server. Each statement is a request to 
perform a database operation, such as creating a database file, adding 
tables and fields to a database, adding records to tables, or retrieving data 
from databases. The SQL server analyzes the SQL statement and 
performs the required operation. For example, if the statement is a 
request for data, the server gathers the data and returns it to the client 
workstation for the user to view.

An SQL query is an SQL statement designed specifically to request data 
from one or more SQL databases. Some SQL applications require that you 
type in an SQL query directly using a text editor, while others provide 
graphical user interfaces that lead you through the process of querying an 
SQL database. In the latter case, the application must create an SQL 
statement based on the information you provide. This statement is the 
actual SQL query, and it is the SQL query that is used to request the data. 
Seagate Crystal Reports falls into this second category of SQL-compliant 
applications.

CLIENT/SERVER ARCHITECTURE

One of the most powerful features of SQL DBMS applications is their 
ability to efficiently use the client/server architecture of a network.

SQL statement executes
and queries database

SQL Statements

Create database table

Add data to a table

Return data set

Examples of executed SQL
statement results
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A simple network structure consists of one or more network servers that 
provide a common location where all users on the network can obtain 
data and applications. Many network servers also provide network 
security, automated services such as backing up data, and network 
resource monitoring to provide the best service possible to all 
workstations on the network. Because of the high processing demands 
required by a network server, the computer used as the server is often a 
high-powered, fast machine that may contain multiple processors, 
multiple hard drives, and multiple CD-ROM drives.

A network client is a single computer workstation that is used regularly 
by one or more company employees. A user works on the client and 
accesses data and applications from the server over the network. Large 
processing jobs that require a lot of time and resources are handled by the 
server, and the finished results are sent back to the client. This provides 
more efficient time management for users because the local workstation 
has less processing time and more “up” time available to the user.

Many modern computer applications are based on this client/server 
architecture. A simple client/server application has two parts: a server-
based application that is located on a network server machine, and a 
client-based application that is located on a user’s workstation. The server 
application handles complex, time-consuming, or power-demanding 
processes, taking advantage of the network server’s power and resources, 
while the client application provides an easy-to-use user interface 
designed to help get the work done faster and better than it could 
otherwise be done.

Workstation

Workstation

Workstation Workstation

Server
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Often, a client/server application will be available with a certain number 
of seats, depending on the cost of the application. Each seat represents 
either a single client workstation, or a single client user (depending on the 
software vendors’ specifications) that can be connected to the client/server 
software. Software vendors often sell additional seats for their applications, 
each seat coming with a complete set of client application software.

Do not confuse server applications with network server computers. Both 
are often referred to as servers. However, a server application resides on 
a network server, taking advantage of the hardware and operating 
system capabilities of the server machine. While a network server is a 
physical machine to which network clients are connected by cables or 
some other connection device.

SQL DBMS

An SQL Database Management System is a common example of a client/
server software package. A standard SQL DBMS will include an SQL 
server application that handles all the actual work of building and 
working with databases and database data. The DBMS will also include 
at least one set of SQL client software (one seat) that can connect to the 
SQL server over your network. SQL client software usually consists of, at 
the very least, an SQL statement editor that you can use to write and 
execute SQL statements, and an underlying communications layer that 
works with the SQL server application over the network.

When you execute an SQL statement, the client software passes the 
statement to the communications layer, which sends the statement over 
the network to the server software. The SQL server analyzes the 
statement, performs the requested operation, and returns any data 
requested to the client software. If the server returns any data, the client 
software displays the data to the user.

Client
Application

Client
Application

Client
Application

Client
Application

Server
Application
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STORED PROCEDURES

In addition to the common relational database attributes (tables, fields, 
records, etc.) many SQL DBMS systems support stored procedures. A 
stored procedure is a compiled SQL program, consisting of one or more 
SQL statements. A stored procedure can be used to define an SQL query 
that you can use over and over again. Furthermore, variables, conditional 
expressions, and variable arguments can be defined in the stored 
procedure so that you are prompted to provide information before the 
procedure is executed.

Since stored procedures can return a result set, they can provide a specific 
set of data when executed. In fact, Seagate Crystal Reports allows you to 
execute a stored procedure on an SQL database and use the returned data 
to design a report. If the stored procedure is designed to prompt a user 
for information to base its query on, Seagate Crystal Reports will prompt 
you for that information when you select the stored procedure for your 
report. See How to select a stored procedure from an SQL database and change 
stored procedure parameters, Page 566.

How does Seagate Crystal Reports use SQL?

When you connect to an SQL database, or to any ODBC database, Seagate 
Crystal Reports acts as an SQL client application, connecting to your SQL 
server through your network.

When you design a report that accesses SQL data, Seagate Crystal Reports 
builds an SQL query. This query can be edited if you know SQL and you 

Server
Appli-
cation

1.SQL statement
   executes

4.Data is returned
   to the client

2.Server queries
   database

3.Requested data
   is retrieved by the
   server

Client
Appli-
cation

Workstation running
SQL client application

Server system running
SQL server application

SQL Client communicating with SQL server

SQL database

Stored procedure
that contains one
or more SQL
statements

SQL
Statement

Executes Queries Database Returns Data Set

Data Set

Returns data set
based on the values
supplied by the user.

Dialog box that appears
to the user requesting
values for parameters in
the stored procedure.
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feel that the query can be further optimized. If you choose the SHOW SQL 
QUERY command from the Database Menu, the Show SQL Query dialog 
box displays the SQL query that Seagate Crystal Reports has built.

This SQL query is a representation of the SQL statement that Seagate 
Crystal Reports sends to the SQL server. By interpreting as much as 
possible from the report design into an SQL query, Seagate Crystal 
Reports can off-load much of the report processing onto the server 
machine. Rather than having to sift through an entire database to find the 
data you requested, Seagate Crystal Reports lets the server do the sifting 
and gets back a much smaller set of data, thus reducing the time and 
resources your workstation must use in order to finish the report.

The SQL language

Since Seagate Crystal Reports uses the SQL language to access client/
server databases through ODBC, you can better understand the report 
generating process by understanding some of the SQL clauses 
(commands) used:

SELECT

The SELECT clause indicates specific data items to retrieve from the 
database tables. The item retrieved may be the values in a database field 
(column), or it may be the result of a calculation performed while 
gathering the data. For example:

SELECT
TABLEA.’CUSTNAME’,
TABLEA.’STATE’

DISTINCT

The DISTINCT clause forces the query to retrieve only unique (distinct) 
sets of data. When using the DISTINCT clause, a row of results will only 
be retrieved once. The previous SELECT statement can be modified to use 
the DISTINCT clause:

SELECT DISTINCT
TABLEA.’CUSTNAME’,
TABLEA.’STATE’

FROM

The FROM clause indicates the sources of the database fields specified in 
the SELECT clause. FROM lists actual database tables that include the 
fields and records containing the requested data. The FROM clause 
generated by Seagate Crystal Reports precedes the name of each table 
with the alias it uses to identify the table in your report. The following 
example illustrates the FROM clause used with the SELECT clause:
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SELECT
TABLEA.’CUSTNAME’,
TABLEA.’STATE’

FROM
‘TABLEA’ TABLEA

WHERE

The WHERE clause has two purposes:

1. WHERE can specify record selection criteria.

2. WHERE can specify how two database tables are joined.

When WHERE is used to specify record selection criteria, it includes a 
search condition in order to determine which records (rows of data) are 
to be retrieved. For example:

SELECT
MYTABLE.’SALESPERSON’,
MYTABLE.’SALESTOTAL’

FROM
‘MYTABLE’ MYTABLE

WHERE
MYTABLE.’SALESTOTAL’ < 10000.00

If WHERE is used to specify how two tables are linked, an SQL join 
operator sits between the two table names. See SQL join types (ODBC data 
sources), Page 527. The following is an example of the WHERE clause 
joining two tables:

SELECT
CUSTOMER.’CUST_ID’,
CUSTOMER.’CUST_NAME’,
ORDERS.’AMOUNT’

FROM
‘CUSTOMER’ CUSTOMER,
‘ORDERS’ ORDERS

WHERE
CUSTOMER.’CUST_ID’ = ORDERS.’CUST_ID’

ORDER BY

The ORDER BY clause specifies that the database records retrieved be 
sorted according to the values in a specific field. If you do not use the 
ORDER BY clause, the program retrieves records in the order in which 
they appear in the original database. If you specify more than one field 
after the ORDER BY clause, the program sorts the records according to 
the values in the first field specified, then, within that sort, the program 
sorts the records by the values in the second field specified, and so on. 
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The following SQL statement uses the ORDER BY clause:

SELECT
MYTABLE.’COMPANY’,
MYTABLE.’CITY’,
MYTABLE.’STATE’

FROM
‘MYTABLE’ MYTABLE

ORDER BY
MYTABLE.’STATE’ ASC,
MYTABLE.’CITY’ ASC

NOTE: ASC indicates that the values in the field are sorted in ascending 
order rather than descending order (DESC). Ascending order sorts letters 
from A to Z and numbers from 0 to 9.

GROUP BY

The GROUP BY clause retrieves a set of summary data. Instead of 
retrieving the data itself, GROUP BY groups the data and summarizes 
each group with an SQL aggregate function. The server returns only the 
summarization information for each group to Seagate Crystal Reports. 
For example:

SELECT
MYTABLE.’STATE’,
MYTABLE.’ZIPCODE’,
SUM (MYTABLE.’SALES’)

FROM
‘MYTABLE’ MYTABLE

GROUP BY
MYTABLE.’STATE’,
MYTABLE.’ZIPCODE’

Server-side processing

Server-side allows you to set up a report that performs the majority of its 
processing on the server and pushes only relevant details to your 
computer. Server-side processing provides you with a number of 
benefits:

●   Less time connected to the server.

●   Less memory needed to process the report on your computer.

●   Lower transfer time from the server to the client.
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Here’s how server-side processing works: by using SQL pass-through 
technology to send an SQL statement to ODBC and retrieve an initial set 
of data, Seagate Crystal Reports off-loads much of the data retrieval and 
sorting work onto the server system, thus freeing up local memory and 
resources for more important tasks. That is why server-side processing 
only works for reports that have been sorted and grouped; if a report has 
not been sorted and grouped (for example, if it is a simple list report), 
then there is no processing to push to the server. You should also note 
that server-side processing only works for reports based on SQL data 
sources (you could not, for example, use server-side processing for a 
report based on a query, since a query is not an SQL data source).

Keep in mind that in order to perform the grouping on the server, your 
report must conform to the following conditions:

●   The Perform Grouping on Server option (in the Options dialog box) 
must be enabled. For more information, see How to enable server-
side processing, Page 574.

●   The report must use some form of grouping.

●   The report must be at least partially hidden (at the very least, the 
Details section must be hidden). Since the server will process those 
sections that are hidden, the greater the portion of the report that 
is visible, the greater the amount of processing that must take 
place on the client side. If the Details section is shown, server-side 
processing will not be possible.

●   In most cases, formula fields must be processed on the client side. 
If grouping is based on a formula field, or if a formula is used in a 
summary field or in record selection, then all the records must be 
transferred to the client side before the formula can be evaluated. 
This will increase the amount of time required to run the report. 
Therefore, you may want to use SQL expressions as an alternative 
to formulas.

●   In order for a report to be processed on the server, any running 
totals appearing in the report must be based on summary fields 
(since the data needed for the running totals will be pulled over to 
the client side).

●   In order for a report to be processed on the server, the report must 
not contain Average or Distinct count summaries.

●   The report must not contain Top N values.

●   The report must not contain specified value grouping.

NOTE: When a report contains Date and Time fields, server-side 
processing works if you group on day (for Date fields) or if you group on 
seconds (for Time fields). Server-side processing will not work if you 
group on month or year, or on minutes and hours.
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NOTE: When you drill-down on a hidden section of a report, with the 
processing being done on the server, connection to the server will be 
automatically initiated. If the client is disconnected from the server (for 
example, if you download a report onto your laptop and you work on it 
from a remote location), then drilling-down on data will produce an 
error.

NOTE: If you save a report that has been partially processed on the server 
using the Save Data with Report option, the program will save only those 
records that have been transferred to the client side. In other words, if 
you have drilled-down on the subreport data and there is a tab for that 
data in Seagate Crystal Reports, those records will be saved with the 
report.

How server-side 
grouping affects 
the SQL query

When a report pushes most of its processing to the server, this by 
necessity alters the SQL query. Thus, when the Perform Grouping on Server 
option is enabled, individual aspects of server-side processing will 
modify the SQL statement in different ways.

●   If you enable the Use Indexes Or Server For Speed option (in the 
Report Options dialog box), the program will add an ORDER BY 
clause to the SQL statement.

●   If you group on a linkable data type in the DBMS, the program will 
add a GROUP BY clause to the SQL statement. The program uses 
the GROUP BY clause to perform the grouping on the server.

●   If you summarize on a linkable data type, the program will add a 
summary field to the SELECT clause of the SQL statement.

●   If you drill-down on a linkable data type, the program will add a 
WHERE clause to the SQL statement.

●   If you group in descending order on a linkable data type, the 
program will add an ORDER BY clause to the SQL statement.

The statement also varies between tabs:

●   If you are working in the Preview Tab, the statement includes the 
GROUP BY clause, as well as any aggregates that the report is 
pushing to the server.

●   If you are drilling-down, the statement will vary depending on the 
underlying data and the level of drill-down. With each drill-down, 
the WHERE criteria changes. Also, if you drill-down to the details, 
the statement will not include a GROUP BY clause (since you no 
longer have any groups on that drill-down tab).

To view the current SQL statement for the active tab, choose the SHOW 
SQL QUERY command from the Database Menu. The Show SQL Query 
dialog box will appear, displaying the SQL statement. If you want, you 
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can edit the statement directly in this dialog box. You can also use the SQL 
Expression editor to edit SQL expression to be processed on the server.

Remapping database fields

The Map Fields dialog box allows you to link report fields to their 
corresponding database fields when you have made changes to the 
structure of the database, or when you have created a report based on one 
database from a template of another report based on some other database 
that has the same table and field structure. In this way, the dialog box 
helps you to make sure your reports print with the current version of the 
active database.

When you first create a report, the report draws its fields from the 
database as it exists at the time. If you change the structure of the database 
after you create the report, the program needs to adapt the report to the 
new structure.

If you make changes to the active database fields that require you to 
remap the corresponding report fields, you can display the Map Fields 
dialog box by choosing any of these commands from the Database Menu:

●   VERIFY DATABASE,

●   VERIFY ON EVERY PRINT,

●   SET LOCATION, and

●   CONVERT DATABASE DRIVER.

You can use each of these commands for a specific function; however, any 
of these commands will open the Map Fields dialog box if the program 
detects a mismatch between the field names in the report and the field 
names in the database. In order to detect any possible mismatches, the 
program checks each field name in the report against the field names in 
the database. If one of the field names does not match any of the field 
names in the database, the Map Fields dialog box will appear.

NOTE: Report fields that are left unmapped will be removed from the 
report.

Using the Verify 
Database 
process

When you choose the VERIFY DATABASE command from the Database 
menu, the program checks the active databases and reports whether it 
detected any changes. If it detects changes, the report must be adapted to 
prevent errors. If you click Yes, the program attempts to adapt the report 
to the new database structure.
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The program displays the Map Fields dialog box if it detects either of 
these types of changes to the database:

●   the name of a database field that is used in the report has changed, 
or

●   the database has been upsized from a PC data source to an SQL 
data source.

For a tutorial on the Map Fields dialog box, see How to remap database 
fields, Page 576. Seagate Crystal Reports automatically adapts the report 
(and does not display the Map Fields dialog box) if it detects any of these 
changes:

●   fields have been added to the database,

●   fields that are not used in the report have been deleted from the 
database,

●   field positions have changed in the database, or

●   data types have changed for fields in the database.

For more information, search for VERIFY DATABASE command in Crystal 
Reports online Help.

Using the Verify 
on Every Print 
process

The VERIFY ON EVERY PRINT command is a lock that triggers the VERIFY 
DATABASE command every time you print.

●   If there is a check mark beside the Verify on Every Print command, 
the command is active. It will trigger the Verify Database 
command every time you print. See Using the Verify Database 
process, Page 545.

●   If there is no check mark beside it, the command is inactive. By 
default the command is inactive.

Using the Set 
Location process

When you choose the SET LOCATION command from the Database Menu 
and specify a new location for the active database, the program checks the 
database for changes.

The Set Location command will display the Map Fields dialog box if it 
detects any of the following changes in the database structure:

●   a database field has been deleted,

●   a database field has been renamed, or

●   the database is a completely new database.

NOTE: The program will check for these changes only if the databases 
have different names or if the database name has changed. If the 
databases have the same name, the Map Fields dialog box will not appear, 
and you will need to verify the database when you have finished setting 
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the location. For more information, see Using the Verify Database process, 
Page 545.

For more information, search for SET LOCATION command in Seagate 
Crystal Reports online Help.

Using the 
Convert 
Database Driver 
process

When you choose the CONVERT DATABASE DRIVER command from the 
Database Menu and specify the database driver to use when running 
your report, the program checks the database for changes. It displays the 
Map Fields dialog box if it detects changes in the database structure. 
Search for CONVERT DATABASE DRIVER command in Seagate Crystal 
Reports online Help.

Using the Map 
Fields dialog box

The Map Fields dialog box contains four list boxes:

●   The upper left list box displays the names of all unmapped report 
fields (for which the program detects a change in the active 
database). The top name is selected by default.

●   The upper right list box displays the names of unmapped database 
fields (in which the program detects a change). Since the Match 
Type check box is toggled on by default, this list box displays only 
the names of unmapped database fields of the same type as the 
unmapped report field you selected in the upper left list box. To 
display all unmapped database fields, regardless of type, toggle 
the Match Type check box off.

●   The lower left list box displays the names of mapped report fields. 
When you map fields in the upper list boxes, they will appear in 
the lower list boxes.

●   The lower right list box displays the names of mapped database 
fields. When you map fields in the upper list boxes, they will 
appear in the lower list boxes.

For each database field that you have changed, select the report field and 
the database field in the upper sections and click Map. The field names 
will move from the upper list boxes to the lower list boxes.

You do not have to remap every report field. For example, if you delete a 
database field, it is not necessary to remap its corresponding report field, 
since you will not need that field in your report. You can click OK to close 
the dialog box without remapping each field listed in the upper left list 
box.

On some occasions, you might want to unmap or unlink report and 
database fields that you have already mapped. For example, you might 
mistakenly map the wrong fields or want to map a report field to a 
database field that you already mapped. In these cases, you can select a 
report field in the lower list boxes (the program then automatically selects 
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the database field) and click Unmap. The field names will move from the 
lower list boxes to the upper boxes.

NOTE: Seagate Crystal Reports does not automatically refresh the report 
data when you close the Map Fields dialog box. If you want to refresh 
your data, click the Refresh button on the standard toolbar.

For additional information

This chapter has only touched on some of the more important aspects of 
database access, relational databases, and SQL. If you are interested in 
learning more about database topics, refer to the documentation 
provided with your DBMS application.

In addition, there are hundreds of books available on the market that 
discuss database theory and design in depth. Look for the computer-
related section at your local bookstore.

HANDS-ON (Working With Databases)
This section provides step-by-step instructions for performing several 
common procedures related to accessing database files from within 
Seagate Crystal Reports. Use these procedures to get started working 
with the program quickly.

How to open Access queries through DAO

Microsoft Access queries can be used in Seagate Crystal Reports as 
separate data sets, just like Access tables. When you open an Access 
database through the DAO engine (Microsoft Access, Page 587), any 
queries in the database can automatically be read.

1 Click the NEW button on the standard toolbar. The Report Gallery 
appears.
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The Report Gallery expands.

The Choose Database File dialog box appears.

5 Locate and highlight the Microsoft Access database (*.MDB) file that 
contains the query you want to use in your report.

6 Click Open. When the selected database file contains more than one 
table, the Select Tables dialog box appears (if the database only 
contains one table, the Select Tables dialog box will not appear). 
Highlight the tables you want to include from the list and click OK. 
The Design Tab appears in the application window, with the Insert 
Fields dialog box active.

7 All of the tables and queries you selected from your Access database 
appear in the list box on the Database Tab of the Insert Fields dialog 
box. Queries appear at the end of the list, after tables. Locate your 
query on the Database Tab, and double-click the name of the query 
on the list. The query expands to display all the fields it contains.

8 Select any fields you want to use in your report, and add them to the 
Design Tab.

NOTE: You can not use Access action queries or update queries in 
Seagate Crystal Reports. However, you can use Access select queries and 
cross-tab queries.

2 Click Custom...

3 Click Custom Report. 4 Click Data File.
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How to open Access queries through ODBC

ODBC gives you more control over which parts of a database you can use. 
For this reason, using an Access query through ODBC requires a few 
extra steps.

1 Choose the OPTIONS command from the File Menu. The Options 
dialog box appears. Click the SQL Tab to display SQL and ODBC 
options.

●   Selecting the Views option automatically displays any available 
queries in your Access database.

●   Selecting the Prompt on every table option displays the Allow 
Reporting On dialog box every time you log on to an ODBC data 
source. This dialog box provides the same options as the Allow 
Reporting On section on the SQL Tab of the Options dialog box, but 
provides those options for every ODBC data source you log on to.

3 In addition, you can specify Table name LIKE and Owner LIKE 
options, if you wish.

2 Make sure either the Views or the Prompt 
on every table check box is toggled on.
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●   Table name LIKE is based on the SQL LIKE clause. This option 
allows you to specify the kinds of table names you want to appear 
in the Choose SQL Table dialog box. You can use the underscore�
character (_) or the percent sign character (%) as wildcards with 
this function. The underscore character specifies any single 
character, while the percent sign signifies any character string. For 
example, DAV_ matches DAVE only, while DAV% matches 
DAVE and DAVID. Table name LIKE C% would display only those 
tables that have a table name beginning with the letter C.

●   Owner LIKE is also based on the SQL LIKE clause. The Owner LIKE 
option allows you to select the Owner (or Creator or Alias) of the 
table, not the table name itself. For example Owner LIKE C% 
would display only those tables that have an owner beginning 
with the letter C.

4 Click OK to exit the Options dialog box.

5 Create a new report. When you choose SQL/ODBC as the source of 
your data, the Log On Server dialog box appears.

7 If you did not specify a particular Access database file with your 
Access ODBC data source, the Select Database dialog box appears. 
Locate and select the database that contains the Access query you 
want to use, and click OK.

8 If you selected the Prompt on every table check box in the Options 
dialog box, the Allow Reporting On dialog box now appears. 
Otherwise, skip to Step 10.

6 Choose the ODBC data
source for your Access

database, then click OK.
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The Choose SQL Table dialog box appears.

11 The Design Tab appears with the Insert Fields dialog box active. 
Your Access query, and all fields associated with that query, appear 
on the Database Tab of the Insert Fields dialog box.

NOTE: You can not use Access action queries or update queries in 
Seagate Crystal Reports. However, you can use Access select queries and 
cross-tab queries.

How to open Access parameter queries

Access parameter queries can only be opened when you open an Access 
database via ODBC. Make sure you have an ODBC data source set up for 
your Access database before attempting this procedure. See How to set up 
an ODBC data source, Page 556.

9 Make sure the Views check box is toggled on and then click OK.

10 Highlight your query in this list box, and then click OK.
552 Seagate Crystal Reports User’s Guide



NOTE: When you design a parameter query in Access, you must provide 
a prompt for the query and you must specify a data type for the 
parameter. First, with your query open in Design View in Microsoft 
Access, enter a prompt in the Criteria cell for the field that will act as a 
parameter. Then, choose the PARAMETERS command from the Query 
Menu in Access, and specify a data type for the parameter you just 
created. Make sure the prompt appears exactly as it does in the Criteria 
cell. For complete instructions, refer to your Access documentation. If 
you do not set up your parameter query correctly, Seagate Crystal 
Reports will not be able to use it.

1 In Seagate Crystal Reports, choose the OPTIONS command from the 
File Menu. The Options dialog box appears. Click the SQL Tab to 
activate it.

●   Selecting the Stored Procedures option automatically displays any 
available stored procedures when you log on to an ODBC data 
source. Seagate Crystal Reports treats Access parameter queries 
much like it treats SQL stored procedures. So, to use a parameter 
query, the Stored Procedures option must be toggled on.

●   Selecting the Prompt on every table option displays the Allow 
Reporting On dialog box every time you log on to an ODBC data 
source. This dialog box provides the same options as the Allow 

2 Make sure either the Stored Procedures or the 
Prompt on every table check box is toggled on.
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Reporting On section on the SQL Tab of the Options dialog box, but 
provides those options for every ODBC data source you log on to.

3 In addition, you can specify Table name LIKE and Owner LIKE options 
if you wish.

●   Table name LIKE is based on the SQL LIKE clause. This option 
allows you to specify the kinds of table names you want to appear 
in the Choose SQL Table dialog box. You can use the underscore 
character (_) or the percent sign character (%) as wildcards with 
this function. The underscore character specifies any single 
character, while the percent sign signifies any character string. For 
example, DAV_ matches DAVE only, while DAV% matches 
DAVE and DAVID. Table name LIKE C% would display only 
those tables that have a table name beginning with the letter C.

●   Owner LIKE is also based on the SQL LIKE clause. The Owner 
LIKE option allows you to select the Owner (or Creator or Alias) of 
the table, not the table name itself. For example Owner LIKE C% 
would display only those tables that have an owner beginning 
with the letter C.

4 Click OK to exit the Options dialog box.

5 Create a new report. When you choose SQL/ODBC as the source of 
your data, the Log On Server dialog box appears.

7 If you did not specify a particular Access database file with your 
Access ODBC data source, the Select Database dialog box appears. 
Locate and highlight the database that contains the Access parameter 
query you want to use, and then click OK.

8 If you toggled on the Prompt on every table check box in the Options 
dialog box, the Allow Reporting On dialog box now appears. 
Otherwise, skip to Step 11.

6 Choose the ODBC data
source for your Access

database, then click OK.
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10 The Choose SQL Table dialog box appears. Access parameter queries 
appear in the SQL Tables list box as follows:

Proc(QueryName)

The Stored Procedure Input Parameters dialog box appears.

The value displayed in the Name list box will be updated.

9 Make sure the Stored
Procedures check box is

toggled on, and then
click OK when finished.

11 Highlight your query in this list box, and then click OK.

12 Highlight a parameter in this list box.

13 Assign a value 
by typing it in the 
Parameter Value 
text box and click 
Update.
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14 Repeat Steps 12 and 13 for each parameter in your Access parameter 
query.

15 Click OK.

You can change parameter values at any time by choosing the STORED 
PROCEDURE PARAMETERS command from the Database Menu.

16 Create your report using the fields in the parameter query. Only the 
records that satisfy the parameter values you specified in the Stored 
Procedure Input Parameters dialog box are used in your report.

NOTE: You can not use Access action queries or update queries in 
Seagate Crystal Reports. However, you can use Access select queries and 
cross-tab queries.

How to set up an ODBC data source

To set up an ODBC data source, you must first have an ODBC driver 
installed for the type of data you want to use. Many DBMS applications 
automatically install and set up ODBC drivers. If you are not sure 
whether ODBC drivers have been installed for your data, refer to the 
documentation that came with your DBMS application.

1 From the Program Manager, double-click the ODBC Administrator 
icon in the appropriate program group. The ODBC Data Source 
Administrator dialog box appears.

 The Create New Data Source dialog box appears.

2 Click Add.
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If a driver does not appear for your data type, then the ODBC driver 
has not been correctly installed. Refer to the documentation for your 
DBMS application.

5 Click the Finish button. An ODBC Data Source Setup dialog box that 
is specific to the ODBC driver you selected appears.

NOTE: If an error message appears instead of the Setup dialog box, you 
do not have the correct ODBC drivers installed on your system for the 
type of data you selected.

NOTE: The dialog box that appears may look different from the one 
shown here, depending on the type of data you are using. This dialog box 
is specific to the Access 97 ODBC driver. For more information about 
using the dialog box that appears for your data, click the Help button.

3 Choose the ODBC 
driver appropriate for 
your data type from this 
list.

4 Click Finish.

6 Type the name for your new ODBC data source here.
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7 Click OK. The new ODBC data source appears in the ODBC Data 
Source Administrator dialog box.

How to check settings for an ODBC data source

1 From the appropriate program group or Windows 95 and Windows 
98 folder, run the ODBC Administrator application. The ODBC Data 
Source Administrator dialog box appears.

The ODBC Data Source Setup dialog box appears.

The new data
source now appears

in this list.

8 Click OK
when finished.

2 Highlight the appropriate
data source on this list.

3 Click 
Configure.
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4 The ODBC Data Source Setup dialog box that appears is specific to 
the data source you selected, and contains controls and information 
for setting up your data source. Check the settings in this dialog box 
to make sure the information matches your system and database.

NOTE: The dialog box that appears may look different from the one 
shown here, depending on the type of data you are using. This dialog box 
is specific to the Access 97 ODBC driver. For more information about 
using the dialog box that appears for your data, click the Help button.

5 Make any changes necessary, and then click OK.

6 Click OK to close the ODBC Data Source Administrator dialog box.

How to log on to an ODBC data source

1 Choose the LOG ON SERVER command from the Database Menu. The 
Log On Server dialog box appears.

2 Choose the ODBC data 
source for the database 
file you want to open, 
and then click OK.
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3 If the data source requires a user name and password, or any other 
log on information, a log on dialog box appears. Type in the log on 
information you usually use to access this database, and click OK.

●   If you did not specify a database with the ODBC data source, the 
Select Database dialog box appears. Use the Drives, Directories, and 
Database Name controls to select the database file, and then click 
OK.

4 The Choose SQL Table dialog box appears if the data source contains 
more than one table. Choose a database table from the SQL Tables list 
box and then click OK to add the table to your report.

How to add an ODBC database table to a report

1 Choose the ADD DATABASE TO REPORT command from the Database 
Menu. The Choose Database File dialog box appears.

The Log On Server dialog box appears.

2 Click
SQL Tables.

3 Choose the ODBC 
data source for the 
database file you
want to open, and 
then click OK.
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4 If the data source requires a user name and password, or any other 
logon information, the Login dialog box appears.

6 If the data source you selected includes a database file specification, 
or if you specified a database table in Step 3, skip to Step 8.

7 The Select Database dialog box appears. Use the Drives, Directories, 
and Database Name controls to select the database file, and then click 
OK.

8 The Choose SQL Table dialog box appears.

●   Choose a database table from the SQL Tables list and click OK to 
add the table to your report, or

●   Click the Log On Server button to log on to another ODBC data 
source.

How to log on to MS SQL Server via ODBC

NOTE: This section is intended as an example of how to log on to a 
Microsoft SQL Server data source from Seagate Crystal Reports. Your 
SQL server application or any other password-protected data source may 
require different steps. This is intended only as an example of one type of 
SQL database.

1 Verify the settings for the Microsoft SQL Server data source using 
ODBC Administrator. See How to check settings for an ODBC data 
source, Page 558.

2 From Seagate Crystal Reports, choose the LOG ON SERVER command 
from the Database Menu. The Log On Server dialog box appears.

5 Enter the required 
information and then 
click OK to log on.
Working With Databases 561



The ODBC - CRSS data source is automatically created during Seagate 
Crystal Reports setup procedure. This data source allows you to open 
MS SQL Server databases.

The SQL Server Login dialog box appears.

The Options section of the SQL Server Login dialog box appears.

7 Verify the name of the SQL Server database you want to open, the 
database language you want to use, the name of the application you 
are using (Seagate Crystal Reports), and the name of your computer 
workstation. Make any changes necessary.

8 Click OK, and the Choose SQL Table dialog box appears. Choose an 
SQL Server database table from the SQL Tables list box and then click 
OK to add the table to the report.

3 Choose the ODBC 
- CRSS data source 
and then click OK.

4 Type your MS 
SQL Server login 
ID and password.

5 Click Options.

6 Verify the settings 
for your SQL Server.
562 Seagate Crystal Reports User’s Guide



How to log off an ODBC data source

1 Choose the LOG OFF SERVER command from the Database Menu. The 
Log Off Server dialog box appears.

The ODBC data source is removed from the Logged On Servers list box.

4 Click Done when finished.

How to change the ODBC data source accessed by a report

1 Choose the SET LOCATION command from the Database Menu. The 
Set Location dialog box appears with a list of table aliases for the 
tables displayed in the report. The dialog box will display location 
and logon information for the table you select below the list of tables. 

2 Highlight the ODBC data
source you want to log off

from this list.
3 Click Log Off.
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4 Log on to the original ODBC data source, if you are not logged on 
already. You must log on to the old data source before you can 
modify a report to use a new data source. Since you must be logged 
on to the old data source, the old data source must be available on 
the local machine.

●   If the machine is no longer connected to the old server, you can 
install an ODBC data source with the name of the old data source 
and have it point to the new database server. Log on to this data 
source as you would log on to the “old” data source.

●   If you are using the same data source name to connect to a new 
server, you must configure that data source under ODBC Admin 
or the ODBC Control Panel, and make it point to the new server.

After you log on to the old data source, the Choose SQL Table dialog 
box appears with a list of tables in the SQL Tables list box, and with the 
old data source in the SQL Databases list box.

3 Click Set 
Location.

2 Highlight the first table in this 
list box.
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   You should now be logged on to both the old and the new data 
sources.

   The new data source should now appear in the SQL Databases 
list box of the Choose SQL Table dialog box. 

6 Click the new data source to display its tables, then select the 
appropriate table from this list. The table you choose should 
correspond to the first table you selected in the Set Location dialog 
box.

7 After clicking OK the program prompts you to change the location of 
all tables in the report to the location you specified for the first table.

9 Close the Set Location dialog box, and choose the VERIFY DATABASE 
command from the Database Menu to refresh the table definitions in 
the report.

10 Log off the old data source.

11 Save the report.

5 Click this 
button to log on 
to the new data 
source.

8 Click Yes to set the location of all 
tables in the report to the same database.
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How to select a stored procedure from an SQL database and 
change stored procedure parameters 

1 Choose the OPTIONS command from the File Menu. The Options 
dialog box appears. Click the SQL Tab to activate it.

●   Selecting the Stored Procedures option automatically displays any 
available stored procedures when you log on to an SQL database.

●   Selecting the Prompt on every table option displays the Allow 
Reporting On dialog box every time you log on to an ODBC data 
source. This dialog box provides the same options as the Allow 
Reporting On section on the SQL Tab of the Options dialog box, but 
provides those options for every ODBC data source you log on to.

3 In addition, you can specify Table name LIKE and Owner LIKE options 
if you wish.

2 Make sure either the Stored Procedures or the 
Prompt on every table check box is toggled on.
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●   Table name LIKE is based on the SQL LIKE clause. This option 
allows you to specify the kinds of table names you want to appear 
in the Choose SQL Table dialog box. You can use the underscore�
character (_) or the percent sign character (%) as wildcards with 
this function. The underscore character specifies any single 
character, while the percent sign signifies any character string. For 
example, DAV_ matches DAVE only, while DAV% matches 
DAVE and DAVID. Table name LIKE C% would display only those 
tables that have a table name beginning with the letter C.

●   Owner LIKE is also based on the SQL LIKE clause. The Owner LIKE 
option allows you to select the Owner (or Creator or Alias) of the 
table, not the table name itself. For example Owner LIKE C% 
would display only those tables that have an owner beginning 
with the letter C.

NOTE: For more information on the SQL LIKE clause, refer to your SQL 
documentation.

4 Click OK to exit the Options dialog box.

5 Create a new report based on the SQL database that contains the 
stored procedure you want to use. When you choose SQL/ODBC as 
the source of your data, the Log On Server dialog box appears.
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The Options section of the SQL Server Login dialog box appears.

6 Highlight the ODBC 
data source for your SQL 
Server on this list, and 
then click OK.

7 Enter required 
information and 
then click OK to 
log in.

8 Click Options.
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10 Click OK. If you toggled on the Prompt on every table check box in the 
Options dialog box, the Allow Reporting On dialog box now 
appears. Otherwise, skip to Step 12.

The Choose SQL Table dialog box appears.

13 The stored procedure is added to the report, and the Stored 
Procedure Input Parameters dialog box appears.

9 Verify the settings 
for your SQL Server.

11 Make sure the 
Stored Procedures 
check box is toggled 
on, and then click OK.

12 Select an SQL stored procedure 
from this list, and then click OK.
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NOTE: Under the native driver for MS SQL Server, stored procedure 
input parameters are limited to 64 characters, rather than 255.

The value displayed in the Name list box is updated.

14 Repeat Steps 14 and 15 for each parameter that appears in the Name/
Value list box.

15 Click OK when finished. You can change parameter values at any 
time by choosing the STORED PROCEDURE PARAMETERS command 
from the Database Menu.

How to set up an A to B, A to C link

NOTE: This tutorial demonstrates how to set up an A to B, A to C report 
using the Cust, Credit, and Orders tables in the ORDRCR.MDB sample 
database. The ORDRCR.MDB database is located in the \CRW16 
directory (16-bit), \Program Files\Seagate Software\Crystal Reports 
directory (32-bit), or in the directory in which the program resides. Use 
the instructions here as a guideline for creating A to B, A to C reports 
with your own database files.

1 Click the NEW button on the standard toolbar. The Report Gallery 
appears.

2 Click Custom, and the dialog box expands.

3 Select the type of custom report you want to create, and click Data 
File. The Choose Database File dialog box appears. 

4 Select the ORDRCR.MDB database file from the File Name list box, 
and then click OK.

14 Highlight a parameter from this list box.

15 Enter a value in 
the Parameter 
Value text box, and 
then click Update.
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The Select Tables dialog box appears.

5 Click Select All to include all tables, and then click OK.

The Visual Linking Expert appears.

6 Link the {credits.CUST} field to the {orders.CUSTOMER} field and 
the {cust.NUMBER} field.

NOTE: Linking will not occur if you click the Smart Linking button. For 
more information about linking, search for Visual Linking Topics Index in 
Seagate Crystal Reports online Help.

7 Select one of the link lines in the Visual Linking Expert, and click 
Options. The Link Options dialog box appears.

8 Click the Look up all of one, then all of others option button in the When 
linking to two files from this file section of the Link Options dialog box. 
This option establishes an A to B, A to C link.

9 Click OK to return to the Visual Linking Expert. The option you 
selected affected all links. To make sure this option is in effect, click 
the link line that you did not select in the last step.

10 Click Options, and verify the Look up all of one, then all of others setting 
in the Link Options dialog box.

11 Click OK in the Link Options dialog box, then click OK again back in 
the Visual Linking Expert. See LOOK UP ALL OF ONE, THEN ALL 
OF OTHERS (A TO B, A TO C), Page 525.

You have now established an A to B, A to C relationship among the three 
tables.

How to edit an SQL query

NOTE: This section is only valid for reports using ODBC data sources. 
Seagate Crystal Reports automatically generates an SQL query when you 
design a report based on one or more ODBC data source. This query is 
sent to the ODBC data source(s) as an instruction to gather the data 
needed by the report.

1 Choose the SHOW SQL QUERY command from the Database Menu. 
The Show SQL Query dialog box appears.
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2 Click anywhere inside the SQL Query edit box to begin making 
changes.

3 Use the ANSI SQL language to fine-tune the SQL query.

NOTE: You can not change the SELECT clause of the SQL statement.

You can cut, copy, or paste any part of the query to or from the 
Clipboard if needed. See The SQL language, Page 540.

4 Click OK when finished.

How to use an ACT! database

ACT! is a powerful Contact Management application that stores all your 
contact information in a database format similar to xBASE databases 
(dBASE, Clipper, and FoxPro). See ACT!, Page 595.

1 Click the NEW button on the standard toolbar. The Report Gallery 
appears.
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The Report Gallery expands.

The Choose Database File dialog box appears.

5 Use the controls in the Choose Database File dialog box to locate and 
highlight the file CRW.ACT. This file is located in the \CRW16 
directory(16-bit), \Program Files\Seagate Software\Crystal Reports 
directory (32-bit), or in the directory in which the program resides. 
Click OK when finished. The Choose File for ACT! dialog box 
appears.

6 Use the controls in this dialog box to locate and highlight your ACT! 
database.

7 Click OK. The Design Tab appears in the application window. Create 
your report using fields from your ACT! database.

How to open the NT Event Log

If you are using a Windows NT system, the 32-bit version of Seagate 
Crystal Reports gives you the ability to generate reports based on the NT 
Event Log. For your convenience, the program comes with a pre-
designed report that you can run using your own Event Log as a data 
source. The report, EVENTDTL.RPT, is located in the 
\REPORTS\101\NTEVENT\ directory.

2 Click Custom.

3 Click Custom Report. 4 Click Data File.
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NOTE: This report is only available with the Professional version of the 
program and is not available on floppy disks.

1 Open the EVENTDTL.RPT report file in Seagate Crystal Reports.

2 Click the REFRESH button on the standard toolbar. A dialog box will 
appear asking if you want to refresh data. 

●   If you click No, the original report will appear.

●   If you click Yes, the Select Current Event Log dialog box appears:

3 The computer referenced in the Computer(s) text box is the computer 
on which the sample report is based. To change the computer, click 
on the plus (+) sign to the left of Microsoft Windows Network. The 
directory structure will expand to display the network group to 
which your computer is connected. The Select Current Event Log 
dialog box now looks similar to the following:
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4 You can now click on the plus (+) sign to the left of the network 
group to display individual machines connected to the group. The 
Select Current Event Log dialog box now looks similar to the 
following:

5 From this point, you simply need to select the NT machine for which 
you would like to generate an NT Event Log Report. When you select 
a machine, that name will appear in the Computer(s) text box. 

NOTE: If you select a non-NT machine, the following error message 
appears: The RPC server is unavailable. You can run this report only from 
NT machines.

6 Click OK. A new NT Event Log Report appears. This report contains 
information for the machine you selected via the Select Current 
Event Log dialog box.

You can now print the report or review it in the Preview Tab. When 
you are ready to save the report, save the report to a new file name. 
When you want to update the report, simply refresh the report data. 
When you want to run a report on a different NT event log, open the 
original report (EVENTDTL.RPT) and repeat Steps 2-6.

How to enable server-side processing

1 Choose REPORT OPTIONS from the File Menu. The Report Options 
dialog box appears.

2 Toggle the Perform Grouping on Server check box on. Note that this 
check box will be inactive if Use Indexes or Server for Speed is toggled 
off.
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3 Click OK.

NOTE: You can also enable or disable this option quickly by toggling the 
check mark beside the PERFORM GROUPING ON SERVER command 
(Database Menu) on or off as needed. If Use Indexes or Server for Speed 
is toggled off in the Report Options dialog box, this command will be 
inactive.

How to remap altered database fields

Use the Map Fields dialog box to remap existing report fields in the active 
database if they have been altered.

1 With the report active in the Design Tab, choose VERIFY DATABASE 
from the Database Menu. The Verify Database message box appears.

●   If the program detects no changes in the active database, the 
message box displays this message: ”The database is up to date.“ 
In this case, simply click OK and return to your work.

●   If the program detects a change(s) in the active database, the 
message box displays this message: ”The database file [”database 
name”] has changed. Proceed to fix up the report?”

2 Click Yes. If the program detects that a field name has been altered in 
the active database, the Map Fields dialog box appears.

NOTE: The program automatically adapts the report to changes in other 
data within the database (number of fields, field position, data type, etc.). 
It is not necessary to remap fields in which these changes have been 
made. For more information, search for Verify Database command in 
Seagate Crystal Reports online Help.

3 Highlight the first report field that you want to remap in the upper 
left list box.

4 In the upper right list box, highlight the unmapped database field to 
which you want to remap the selected report field.

5 Click the Map button.

The highlighted report and database fields no longer appear in the 
upper list boxes. Instead, they appear in the corresponding lower list 
boxes.

6 Repeat Steps 3 through 6 for each unmapped report field you want 
remapped.
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NOTE: If the names of any report fields remain in the upper left list box 
when you exit the dialog box, the program removes them from your 
report.

7 Click OK. The program remaps the report fields to the altered 
database fields.

How to remap database fields

The following example is designed to help you understand how easy it is 
to adapt an existing report when you make changes in the active 
database. You must have Microsoft Access and Seagate Crystal Reports 
running on the same machine in order to complete this tutorial.

1 In Seagate Crystal Reports, create a report using the Customer Table 
of xtreme.mdb. Place the Customer Name field in the Details section 
of your report. See HANDS-ON (Report Creation and Design), Page 101.

2 In Microsoft Access, open the xtreme.mdb database and the 
Customer table.

3 Right-click the Customer Name field heading and choose RENAME 
COLUMN from the shortcut menu. The program highlights the field 
heading to indicate that it is ready for editing.

4 Type “Cust Name” (do not include the quotation marks) and press 
Enter. The new name appears in the field heading, replacing 
"Customer Name."

5 Save the database.

6 On the Design Tab in Seagate Crystal Reports, note that the field is 
still labelled "Customer Name."

7 Choose VERIFY DATABASE from the Database Menu. The Verify 
Database message box appears, asking you whether you want to fix 
the report.

8 Click Yes. The Map Fields dialog box appears, with the Customer 
Name report field is highlighted in the upper left section.

9 Click the Cust Name field in the upper right section. This will 
highlight that field name.

10 Click Map to remap the report field to the altered database table. The 
two field names will be removed from the upper sections and moved 
to the lower sections of the dialog box.

11 Click OK to return to the report.
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NOTE: On the Design Tab of Seagate Crystal Reports, notice that the 
field is still labelled "Customer Name." The label will not change until 
you refresh the data, activate the Preview Tab, or select the field in your 
report. You also have the option of changing the label manually.

12 Click the Customer Name field. Note that the field name changes to 
Cust Name.

13 Once again, choose VERIFY DATABASE from the Database Menu. The 
Verify Database message box appears, stating that the database is up 
to date. Click OK to return to your report.

You have successfully remapped a report field to an altered database 
table.

NOTE: Make sure to change your xtreme.mdb database back to its 
original state after completing this tutorial.
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Introduction

Seagate Crystal Reports can access data stored in almost any common 
database format, as well as many uncommon formats. In addition, 
Seagate Crystal Reports leverages the full benefits of query (.QRY) files 
and dictionaries (.DC5). See The Crystal SQL Designer, Page 465, and 
Dictionaries, Page 487.

This section discusses the many different types of data that Seagate 
Crystal Reports can access, and explains the data access layers involved 
in connecting to the data. If you are not sure what Database Management 
System (DBMS) your company uses, contact your IS manager or your 
network administrator.

Why you should 
read this

The principal purpose of Seagate Crystal Reports is simply to access data 
stored in databases and to produce reports on that data. This goal is one 
of the oldest uses of computers and remains one of the most common and 
most necessary. Seagate Crystal Reports is designed to make that task 
easier, less time-consuming, and more powerful.

This idea of accessing data remains at the root of every report produced. 
By understanding how Seagate Crystal Reports accesses data, you will 
gain a better knowledge of the reporting process, as well as a better 
knowledge of the type of data with which the program can work.

In addition, understanding the data access process will help you 
troubleshoot problems you may encounter while trying to open a 
particular database file. This is especially useful for IS managers, or for 
anyone who provides data access support for a group of users.

Most of the information in this chapter is designed for experienced 
Seagate Crystal Reports users and IS managers, and covers technical 
aspects of Database Management Systems (DBMS) and data storage 
techniques. A familiarity with computers; the Windows, Windows 95 and 
Windows 98, or Windows NT operating system; and at least one DBMS 
application is assumed.

A note to 
developers

This section concentrates on the principles of data access. However, most 
of the same concepts can be applied to any application that accesses data 
through Crystal Report Engine, or through any of the Crystal Report 
Engine development tools described in the Technical Reference. For that 
reason, the Seagate Crystal Reports, as used in this chapter, refers to both 
the application and the Report Engine unless otherwise specified.

NOTE: Most of the file names mentioned in this chapter are for the 16-bit 
version of the program unless otherwise specified. File names for the 32-
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bit version are similar, but will have some aspect indicating 32-bit. For 
example, PDSODBC.DLL is the 16-bit ODBC translation file, while 
P2SODBC.DLL is the 32-bit ODBC translation file.

Four types of data

The data that Seagate Crystal Reports can access falls into four general 
categories:

1. Direct access database files, Page 581

2. ODBC data sources, Page 601

3. Crystal SQL Designer files, Page 615

4. Crystal Dictionary files, Page 617

Each type of data must be accessed using a specific set of DLLs and other 
data access-related files. Once you understand the process the program 
uses to access each type of data, you will have a better understanding of 
the report creation process and the elements used to create powerful 
reports with your data. See The Crystal SQL Designer, Page 465 and 
Dictionaries, Page 487.

NOTE: When accessing any type of data, Seagate Crystal Reports relies 
on the database drivers to provide field names, field types, and field 
lengths. This information is provided by either the database engine or the 
ODBC database driver.

Direct access database files

Seagate Crystal Reports can access many of the most common PC 
database formats directly. In other words, the program has the built-in 
capabilities needed to directly open database files and tables designed in 
dBASE, FoxPro, Clipper, Btrieve, Paradox, and Microsoft Access, among 
others. This functionality exists as soon as you install Seagate Crystal 
Reports. Once the program is installed on your system, you can 
immediately begin creating reports based on these databases by selecting 
the appropriate file.

Advantages Accessing the database directly is the fastest way to read the data. Seagate 
Crystal Reports only needs to talk to a single data access layer that 
provides contact with the data. Report results can be obtained quickly in 
almost any system environment.
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In addition, data access is simple. Direct access database files are point-
and-click data sources. You need only select the required database files, 
and Seagate Crystal Reports will read all the stored data. 

Disadvantages When you access a database directly through Seagate Crystal Reports, 
only that database type can be used by the report. You can not switch to 
a different type of database or table without creating a new report.

For example, if you design a report based on Btrieve data, you can not 
change the tables accessed by the report to Paradox data. Seagate Crystal 
Reports communicates with Btrieve data using a Btrieve-specific syntax, 
a syntax that is not compatible with Paradox data.

If you access data through ODBC, on the other hand, the syntax used is 
always the SQL language, regardless of the actual database type. See 
ODBC data sources, Page 601.

Three layers Direct access of database files from Seagate Crystal Reports requires three 
layers: 

1. Seagate Crystal Reports, Page 583

2. Data Translation, Page 583

3. Database, Page 583

Seagate Crystal Reports uses the data translation layer to talk to the 
database and access its data.

Crystal Reports Layer

Data Translation Layer

Database Layer
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Seagate Crystal Reports

Seagate Crystal Reports operates as an interface through which you can 
format, arrange, select, and sort the data stored in database files. It obtains 
data by communicating with one or more files in the data translation 
layer that can actually read the database. Since Seagate Crystal Reports 
can work with many forms of data, it must rely on other files in order to 
work directly with the data. Seagate Crystal Reports can then use a native 
method of communication to talk to the translation files.

Data Translation

Data is translated through a set of DLLs specific to Seagate Crystal 
Reports. The program uses the DLLs specific to a certain data type to 
understand how data is organized for that type and to present it correctly 
when your report is printed, previewed, or exported.

NOTE: Seagate Crystal Reports comes with all the data translation files 
for each of the direct access database types that it supports. For complete 
information on all required files, refer to the Runtime File Requirements 
online Help (RUNTIME.HLP).

Database

The database file consists of one or more tables. Different DBMS 
applications store database information differently. For example, dBASE 
stores each database table as a separate file. Access, on the other hand, can 
store several tables, along with queries, macros, and other database 
elements, all in a single file.

When Seagate Crystal Reports accesses a database file directly, it 
automatically retrieves information about all of the tables and fields in 
that file. You may not use all of the tables or fields, but the program will 
make them available to you. In other words, when a dBASE file is opened, 
only one table in the dBASE file is available. However, when an Access 
file is opened, every table in that file is available, even if you never use 
them all.

NOTE: Seagate Crystal Reports will also open queries in an Access 
database through the DAO engine or ODBC and will allow you to report 
on query fields, as with table fields. See DAO, Page 589 and Access, Page 
606.

Common 
database formats

Although Seagate Crystal Reports uses the same three-tiered system for 
obtaining data from all direct access database file formats, each format 
requires a different set of Dynamic Link Libraries (DLLs). However, some 
formats expand the basic three-tiered structure.
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The following sections cover the systems used by Seagate Crystal Reports 
to access data from some of the most popular database formats.

dBASE, FoxPro, Clipper

The dBASE database format remains one of the most popular database 
management systems (DBMS) used in business. For that reason, Seagate 
Crystal Reports has been designed to open dBASE data simply and 
directly through the xBase engine (inside PDBXBSE.DLL). FoxPro and 
Clipper are dBASE compatible database formats, and Seagate Crystal 
Reports uses the same DLL to access files created by any of these three 
DBMS applications.

NOTE: The PDBXBSE.DLL translation layer supports FoxPro files up 
through version 2.5. See Visual FoxPro, Page 614.

The file PDBXBSE.DLL handles all translation between Seagate Crystal 
Reports and the dBASE, FoxPro, or Clipper files. Each database file 
contains only a single database table, but there is no limit to the number 
of files that can be accessed by a report.
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NOTE: dBASE data can also be accessed through the Borland Database 
Engine (BDE) using the translation file PDBBDE.DLL. To see how the BDE 
communicates with database data, see Paradox, Page 585. The BDE, 
however, does not support FoxPro or Clipper data.

Paradox

Files created with Paradox (.DB) are made available to other applications 
through the Borland Database Engine (BDE). The BDE is made up of 
several files installed by Seagate Crystal Reports in the \IDAPI directory 
by default:

●   ILD01.DLL

●   IDDBAS01.DLL

●   IDR10009.DLL

●   IDODBC01.DLL

●   IDASCI01.DLL

●   IDAPI01.DLL

●   IDBAT01.DLL

●   IDQRY01.DLL

The BDE does the actual work with the Paradox data, retrieving the 
requested tables and fields. Since the BDE works so closely with the 
actual data, it combines with the Paradox database file to create the 
database layer in the three layer data access model. Seagate Crystal 
Reports accesses the BDE through the PDBBDE.DLL translation file.
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The 32-bit version of the BDE uses different files. Otherwise, Seagate 
Crystal Reports uses 32-bit Paradox files in the same way it uses the 16-
bit Paradox files, accessing them through the P2BBDE.DLL 32-bit 
translation file.

The files that make up the 32-bit version of the BDE are:

●   BLW32.DLL

●   IDDR32.DLL

●   CEEUROPE.BLL

●   IDODBC32.DLL

●   CHARSET.BLL

●   IDPDX32.DLL

●   EUROPE.BLL

●   IDQBE32.DLL

●   IDAPI32.DLL

●   IDR20009.DLL

●   IDAPIINST.DLL

●   IDSQL32.DLL

●   IDASCI32.DLL

●   OTHER.BLL

Crystal Reports

Crystal Reports layer

Translation layer

Database layer

PDBBDE.DLL

Borland Database Engine
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●   IDBAT32.DLL

●   USA.BLL

●   IDDBAS32.DLL

●   CW3215.DLL

Microsoft Access

Microsoft Access provides several means for opening its database files. 
Each method has its advantages and disadvantages, and the technique 
that you should use may depend on how your data is set up. Below are 
descriptions of two techniques for opening Access data from Seagate 
Crystal Reports through the Jet engine and through the DAO engine. The 
third technique uses Microsoft’s Open Database Connectivity (ODBC) 
standard, and is described in Access, Page 606.

NOTE: You can maintain Access security when opening database files 
with Seagate Crystal Reports by running SYSDB32.EXE and select the 
Access SYSTM.MDW file. In this case, the program will look to 
SYSTM.MDW when opening an Access database and the user will be 
prompted for the Access password (as required) in Seagate Crystal 
Reports.

NOTE: When you open an Access database using the Jet or DAO engine, 
Seagate Crystal Reports opens the entire database and loads information 
about all tables and queries from the database. To do this, Seagate Crystal 
Reports must reserve a large section of your computer’s memory (called a 
buffer) in advance. Computer memory restrictions limit this buffer to 
65,536 bytes (64K). This restricts the size of your Access database to 
about 80 tables, depending on the number of fields in your tables.

Jet

The Microsoft Jet Database Engine is the part of the Microsoft Access 
Database Management System that actually handles your database data. 
As a user, you usually do not work directly with the Jet engine. It acts as 
a gateway through which Access data is made available to applications. 
For this reason, the Jet engine must be used regardless of the overall 
method used to access your Access data. You will see the Jet engine in 
other sections that discuss Access data.

Since the Jet engine is so closely tied to Access data, Seagate Crystal 
Reports considers it a part of the actual database. In the following 
diagram, the files for the Jet engine appear in the database layer. Seagate 
Crystal Reports uses three files to translate information to and from the 
Jet engine:
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1. PDBJET.DLL

2. PDIRJET.DLL

3. PDCTJET.DLL

Reading Access data through the Jet engine is the most direct route. 
Therefore, it is the fastest method for reading the data. However, Jet does 
not allow you to read Access queries. If you need to open Access queries 
from Seagate Crystal Reports, you should use the DAO engine (DAO, 
Page 589) or ODBC (Access, Page 606).

NOTE: If you toggle the Use Indexes check box on using the Database Tab 
of the Options dialog box, Seagate Crystal Reports can pass much of the 
data retrieval process, including simple selection formulas, down to the 
Jet engine, improving performance and speed. Search for Options dialog 
box in Seagate Crystal Reports online Help.

NOTE: Seagate Crystal Reports provides all the files necessary for reading 
Access tables through the Jet engine. For more information on required 
files, refer to the Runtime File Requirements online Help 
(RUNTIME.HLP).

Access MDB

Crystal Reports layer

Data Translation Layer

Database layer

PDBJET.DLL PDIRJET.DLL PDCTJET.DLL

Crystal Reports

THE MICROSOFT JET ENGINE

MSAJT200.DLL MSABC110.DLL MSAJT112.DLL
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DAO

Microsoft’s new Data Access Object (DAO) Engine for 32-bit versions of 
Access 2.0 and later, provides all the functionality of the Jet engine but 
also adds many new data access features. DAO uses Microsoft’s Object 
Linking and Embedding (OLE) technology (installed with Windows 95, 
Windows 98, and Windows NT) to provide access to Access data through 
an object-oriented approach.

In addition to Access database tables, Seagate Crystal Reports can open 
and use Access queries through DAO. If you are not familiar with Access 
queries, refer to your Access documentation. See also How to open Access 
queries through DAO, Page 548.

NOTE: Access Parameter queries and cross-tab queries can only be 
opened through an ODBC connection. See How to open Access parameter 
queries, Page 552. Access Action queries are not supported by Seagate 
Crystal Reports.

NOTE: When opening Access queries in a report, make sure the Views 
and Stored Procedures options are toggled on using the SQL Tab of the 
Options dialog box in Seagate Crystal Reports. This ensures that the 
queries will be visible when you open the Access database.

The DAO engine greatly broadens the possibilities available to Access 
database users. Because DAO expands and builds on the basic 
functionality of the Jet engine, while working primarily with the actual 
Access database data, DAO is also considered part of the database layer. 
To translate information and data to and from DAO, Seagate Crystal 
Reports uses the DAO translation files P2BDAO.DLL, P2CTDAO.DLL, 
and P2IRDAO.DLL. Compare these files to the translation layer for 
accessing MS Access data directly through the Jet engine. For more 
information, see Jet, Page 587.

NOTE: The Jet engine is incorporated into the DAO engine and does not 
appear as a separate engine in the diagram below.
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NOTE: Seagate Crystal Reports provides all the files necessary for reading 
Access data through the DAO engine. Because the program supports the 
most recent version of DAO, there is also native support for VSFoxPro 
(see Visual FoxPro, Page 614). For more information on required files, 
refer to the Runtime File Requirements online Help (RUNTIME.HLP).

Secured Microsoft Access Databases

If you will be using secured Access databases, the SystemDB parameter 
in the Windows Registry database (32-bit systems) or CRW.INI (16-bit 
systems) must be set to point at the path where the SYSTEM.MDA or 
SYSTEM.MDW (Access 95) file is located. On Windows 95, Windows 98, 
and Windows NT systems, the SystemDB parameter is located in the 
following Registry key:

\\HKEY_LOCAL_MACHINE\Software\Crystal 
Software\Jet\3.0\Engines\Jet

Seagate Crystal Reports includes two utilities that take care of setting this 
parameter for you: 

1. SYSDB16.EXE (16-bit systems changes CRW.INI)

2. SYSDB32.EXE (32-bit systems changes Registry key)

Crystal Reports

P2IRDAO.DLL P2CTDAO.DLL P2BDAO.DLL

OLE

DAO2532.TLB
DAO3032.DLL

VBAJET32.DLL
VEN2232.OLB

MSJINT32.DLL
MSJTER32.DLL
MJT3032.DLL
VBA232.DLL

MSRD2X32.DLL

DAO Engine

ACCESS DATA

Crystal Reports layer

Translation Layer

Database layer
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These utilities are installed in the \CRW16 directory (16-bit), \Program 
Files\Seagate Software\Crystal Reports directory (32-bit), or in the 
directory in which the program resides. Simply run the appropriate 
utility and point it at the location of the SYSTEM.MDA or SYSTEM.MDW 
file.

Btrieve

The 16-bit version of Seagate Crystal Reports uses two translation files to 
communicate with the 16-bit Btrieve engine:

1. PDBBTRV.DLL

2. PDCTBTRV.DLL

These files work with the Btrieve files WBTRVDEF.DLL, 
WBTRCALL.DLL, SBTRVDEF.DLL, and SEDTCONV.DLL for most data 
access operations.

The rest of the Btrieve engine is a complex collection of DLLs and EXEs 
that are specific to the version of Btrieve you are using. For more 
information on the different 16-bit Btrieve engine files, search for Btrieve 
in Seagate Crystal Reports online Help, and refer to your Btrieve 
documentation.

Crystal Reports

Database Layer

PDBBTRV.DLL PDCTBTRV.DLL

Btrieve Data

Crystal Reports layer

Translation layer

Database layer

WBTRCALL.DLL
WBTRVDEF.DLL
SEDTCONV.DLL
SBTRVDEF.DLL

Btrieve Engine
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NOTE: Btrieve must be configured correctly for Seagate Crystal Reports 
to read Btrieve databases. If Btrieve is already configured correctly on 
your system, Seagate Crystal Reports can use your Btrieve data 
immediately upon installation. Seagate Crystal Reports automatically 
installs the Btrieve files that it requires to read Btrieve data. Refer to your 
Btrieve documentation to make sure the Btrieve engine is configured 
correctly.

The 32-bit version of Seagate Crystal Reports connects to the 32-bit 
Btrieve engine through a similar set of Btrieve translation files:

The primary difference between 32-bit Btrieve and 16-bit Btrieve is the 
Btrieve engine itself. For more information on the Btrieve engine, refer to 
your Btrieve documentation.

NOTE: When you open a Btrieve database, Seagate Crystal Reports opens 
the entire database and loads information about all the tables in the 
database. To do this, Seagate Crystal Reports must reserve a large section 
of your computer’s memory, called a buffer, in advance. Computer 
memory restrictions limit this buffer to 65,536 bytes (64K). This restricts 
the size of your Btrieve database to about 80 tables, depending on the 
number of fields in each table.

Crystal Reports

Database Layer

PDBBTRV.DLL PDCTBTRV.DLL

Btrieve Data

Crystal Reports layer

Translation layer

Database layer

WBTRCALL.DLL
WBTRVDEF.DLL
SEDTCONV.DLL
SBTRVDEF.DLL

Btrieve Engine
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Btrieve DDF files

Seagate Crystal Reports does not determine the definitions of Btrieve data 
files directly from the data files themselves. It needs a set of Btrieve Data 
Dictionary Files (.DDF) that contain file, field, and index information. 
Seagate Crystal Reports uses WBTRVDEF.DLL and SBTRVDEF.DLL to 
parse these DDF files. The following are the required DDFs which must 
all reside in the same directory:

●   FILE.DDF

●   FIELD.DDF

●   INDEX.DDF

A set of DDFs normally contain definitions for multiple Btrieve data files. 
Once one of the DDFs is selected when creating a new report, Seagate 
Crystal Reports immediately adds all the data files defined in that DDF 
into the report. Seagate Crystal Reports also takes the path defined in the 
DDFs as the default path of the data files. The DDFs and data files can 
reside in different locations.

NOTE: Be sure to study your Btrieve documentation for more 
information on Btrieve DDFs and on configuring the Btrieve engine.

Exchange

Exchange is Microsoft’s successor to MS Mail. Exchange, however, 
includes not only e-mail, but also management of group scheduling, 
electronic forms, groupware, and Internet connectivity. An Exchange 
folder can contain standard notes (mail), files, and instances of Exchange 
forms. All of this data is stored in the Exchange Information Store.

Seagate Crystal Reports can report on data contained in the Exchange 
Information Store. Exchange data sources available for reporting include:

●   Message Tracking Logs (32-bit only)

●   Address Lists (32-bit only)

   Personal Address Books

   Global Address Lists

   Distribution Lists

●   Exchange Folder Contents (32-bit only)

   mail messages

   Exchange Form applications

   properties of OLE documents
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●   Exchange Administrator (32-bit only)

   properties of Exchange mailboxes on the Exchange Server

   properties of public folders on the Exchange Server

   replica list of public folders

   ACL (Access Control List) of public folders

You can use each Exchange data source like a database table and you can 
link each Exchange data source to other data sources. For example, you 
can join the Message Tracking Log to an Address List by using an e-mail 
address as the link field.

The data translation file used to access the Exchange data source depends 
on the data source that is being accessed. The following table lists each of 
the Exchange data translation files and describes their purpose:

File name Data source

P2STRACK.DLL Message Tracking Logs (32-bit only)

P2SMAPI.DLL / 
PDSMAPI.DLL

Exchange Folder Contents and Address 
Lists

P2SEXR.DLL Properties of Exchange Mailboxes and
Public Folders (32-bit only)

Crystal Reports

Exchange Data Source

Crystal Reports layer

Translation layer

Database layer

MAPI

P2STRACK.DLL
P2SREPL.DLL

Exchange Data Translation

P2MAPI.DLL
P2SEXR.DLL

P2MACL.DLL
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NOTE: PDSMAPI.DLL works with 16-bit Seagate Crystal Reports while 
P2SMAPI.DLL works with 32-bit Seagate Crystal Reports. Also, 
PDSMAPI.DLL is the only Exchange driver available for 16-bit Seagate 
Crystal Reports.

Exchange translation files work directly with the Microsoft Messaging 
API (MAPI). MAPI acts as a database engine for Exchange data.

 How Seagate Crystal Reports treats Exchange data 

Seagate Crystal Reports treats Exchange Administrator data (Public 
Folder Admin, Public Folder ACL, Public Folder Replica, and Mailbox 
Admin server types) as a physical database server. To access this data, 
you must log on using a SQL/ODBC server and select the appropriate 
tables from the Choose SQL Table dialog box.

When you log on to any of the Exchange Administrator servers, you must 
select a profile (or profiles). Each profile represents an Exchange Server.

NOTE: Refer to your Microsoft Exchange documentation for more 
information about how to set up and create Exchange profiles.

ACT!

Symantec’s ACT! contact management software stores information in a 
relational database format similar to the xBase format. See dBASE, FoxPro, 
Clipper, Page 584. Seagate Crystal Reports can read this data and lets you 
produce reports based on your contact information.

P2SREPL.DLL Replica Lists of Public Folders 
(32-bit only)

P2MACL.DLL Access Control Lists (ACL) of Public 
Folders (32-bit only)

File name Data source
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You open ACT! data by selecting the CRW.ACT file from Seagate Crystal 
Reports when you create a new report. CRW.ACT must be installed in the 
same directory as the program. This file forces Seagate Crystal Reports to 
load the PDBACT.DLL and PDIRACT.DLL translation files. This step is 
important because ACT! data looks like xBase data to Seagate Crystal 
Reports, so it will use the PDBXBSE.DLL translation file unless instructed 
otherwise. If this happens, the data will be translated as xBase data rather 
than ACT! data, and may not appear correctly in your report. See How to 
use an ACT! database, Page 571.

Oracle 7

This version of Seagate Crystal Reports supports direct access to Oracle 7 
SQL databases. This accessibility is provided by the PDSORA7.DLL 
translation file (installed with the program). This file can communicate 
with the Oracle 7 database driver ORA72WIN.DLL, which works directly 
with Oracle databases and clients, retrieving the data you need for your 
report.

NOTE: In order for Seagate Crystal Reports to use Oracle 7 SQL 
databases the Oracle client software must be installed on your system, 
and the location of the ORA72WIN.DLL file must be in the PATH 
statement of your AUTOEXEC.BAT file.

Crystal Reports

CRW.ACT

Database Layer

PDBACT.DLL PDIRACT.DLL

ACT! Database

Crystal Reports layer

Translation layer

Database layer
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Microsoft SQL Server 6.x

Seagate Crystal Reports provides direct access to databases created by 
Microsoft’s SQL Server, versions 6.0 and 6.5. The PDSSQL.DLL file 
installed with the program translates requests to the SQL server and then 
returns data from the server. It communicates directly with the Microsoft 
SQL Server driver MSDBLIB.DLL.

Crystal Reports

Oracle Data

Crystal Reports layer

Translation layer

Database layer

PDSORA7.DLL

ORA72WIN.DLL
and Oracle client
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NOTE: Network administrators and IS managers who run Microsoft’s 
Systems Management Server for BackOffice can run reports on Systems 
Management Server data. Systems Management Server uses SQL Server 
to store system data, so the files used to access that data are the same 
files shown here for SQL Server.

Sybase System 10/11

Seagate Crystal Reports opens SQL data created by Sybase System 10 or 
System 11 directly through the PDSSYB10.DLL, installed with Seagate 
Crystal Reports. This translation file works with the Sybase database 
drivers WCTLIB.DLL and WCSUB.DLL to read Sybase System 10/11 
data. If your Sybase server is correctly configured, you will be able to read 
Sybase data as soon as Seagate Crystal Reports is installed.

NOTE: The 32-bit Sybase drivers are LIBCT.DLL and LIBCS.DLL.

Crystal Reports

SQL Database

Crystal Reports layer

Translation layer

Database layer

PDSSQL.DLL

MSDBLIB.DLL
(SQL Server driver)
598 Seagate Crystal Reports User’s Guide



Hyperion Essbase

Essbase is a highly powerful database format based on the OLAP (On-
Line Analytical Processing) model. OLAP presents data in dimensions 
rather than tables. Users can look at relationships between data on an as-
needed basis, drilling-down on dimensions to find the exact data they 
need in a matter of seconds.

Seagate Crystal Reports opens Essbase data directly through the 
P2OESBSE.DLL translation file. This file works with the complex engine 
that drives Essbase. The power of OLAP is combined with the power of 
Seagate Crystal Reports to produce the most informative and 
comprehensive reports.

Sybase Database

Crystal Reports layer

Data Translation Layer

Database layer

PDSSYB10.DLL

Crystal Reports

WCTLIB.DLL
WCSUB.DLL
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NOTE: Essbase data can only be accessed from the 32-bit version of 
Seagate Crystal Reports.

NT Event Log

If using Windows NT version 3.51 or later, you can use Seagate Crystal 
Reports to report on the NT Event Log. The Event Log is a database used 
by network administrators to record and keep track of different types of 
events that can occur on a Windows NT Workstation or on a Windows 
NT server.

Seagate Crystal Reports provides the translation file P2SEVT.DLL for 
working with NT Event Log data. This file communicates with the Event 
Logging API in ADVAPI32.DLL, a part of the Windows NT operating 
system.

Crystal Reports

ESSAPIN.DLL
ESSBASE.MDB
ESSNET.DLL

Essbase Data

Crystal Reports layer

Translation layer

Database layer

Essbase drivers
ESSOTLN.DLL
ESSOTLS.MDB
ESSSHR.DLL

SH22W32.DLL

P20ESBSE.DLL
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NOTE: The NT Event Log can only be reported on with the 32-bit version 
of Seagate Crystal Reports.

ODBC data sources

Open Database Connectivity (ODBC) is a standard developed by the 
Microsoft Corporation through which many different types of data can be 
accessed by a single application. An application need only communicate 
with one set of files (ODBC) to be able to work with any source of data 
that can be accessed by ODBC.

There are hundreds of Database Management Systems (DBMS) available 
for personal computers, and thousands of applications that access DBMS 
data. Normally, a company that designs an application that accesses data, 
such as Seagate Crystal Reports, must develop a means for the 
application to communicate with each type of data that a customer might 
want to use. Seagate Crystal Reports does this with the databases that it 
can access directly.

On the other hand, if a DBMS simply provides a means by which ODBC 
can access its data, the DBMS data becomes an ODBC data source. Any 

Crystal Reports

NT Event Log

Crystal Reports layer

Translation layer

Database layer

P2SEVT.DLL

ADVAPI32.DLL
NT Event Logging API
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application that can communicate with ODBC (such as Seagate Crystal 
Reports), will instantly have access to any ODBC data source. With 
ODBC drivers available for most common DBMS products, the range of 
data types that Seagate Crystal Reports can use is almost unlimited.

Advantages Perhaps the biggest advantage to accessing data through ODBC is the 
ability to access a wide range of data with just one interface. Since most 
popular Database Management Systems now offer ODBC drivers, with 
more appearing every day, Seagate Crystal Reports can use any type of 
data you have.

Because of the extreme flexibility built into ODBC, you can use the same 
report file with different ODBC data sources. For example, you might 
design a report using an Oracle data source, and later, if your company 
switches to Microsoft SQL Server, you can simply change the ODBC data 
source used by your report. The only requirement is that the new data 
source must have the same structure (tables and fields) that the original 
data source had (although table names can be different). See How to 
change the ODBC data source accessed by a report, Page 563.

Experienced SQL (Structured Query Language) programmers also 
benefit from the ODBC standard. Since Seagate Crystal Reports uses SQL 
to communicate with ODBC, SQL programmers and Database 
Administrators can view and edit the SQL statements sent to ODBC, 
controlling exactly how data is retrieved from the data source.

Finally, by using SQL pass-through technology to send an SQL statement 
to ODBC and retrieve an initial set of data, Seagate Crystal Reports off-
loads much of the data retrieval and sorting work on to the server system, 
freeing up local memory and resources for more important tasks. In 
addition, only the data specified by the SQL statement is returned to 
Seagate Crystal Reports, reducing network traffic and the use of network 
resources. By working more efficiently with the original data, Seagate 
Crystal Reports saves you time and effort, and lets you concentrate on the 
design process and other more important work.

Disadvantages Because of the many layers involved in passing data through ODBC from 
a database to an application, ODBC data sources often take more time to 
return data than other directly accessed data sources. First, Seagate 
Crystal Reports must request some data. The request must be translated 
by the ODBC translation layer into a format that ODBC understands (an 
SQL statement). ODBC must determine where the requested data exists, 
and pass the request on to the ODBC data source. For more information, 
see DBMS Translation (ODBC data source) Layer, Page 605. The data source 
must analyze the request and translate it again into a format that can be 
understood by the DBMS. This complex process not only takes time, but 
it can also fail at any of several possible levels.
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In addition, ODBC data sources must be correctly configured and set up 
in the ODBC.INI and ODBCINST.INI files before they can be used. If you 
create a report on one system and try to open it on another system that 
does not have the same ODBC data source set up, Seagate Crystal Reports 
will not be able to connect to the data.

When working with ODBC, you should also be aware that the SQL 
language used by ODBC is based on the standards set for the SQL 
language by the American National Standards Institute (ANSI). Some 
SQL-based DBMS applications, however, provide additional features to 
the SQL language that are specific to that DBMS. If your data uses 
features unique to your DBMS, ODBC will not be able to translate those 
features (though in many cases it will still retrieve most of the data). See 
The SQL language, Page 540.

Five layers The process by which Seagate Crystal Reports accesses data from an 
ODBC data source consists of five layers:

1. Seagate Crystal Reports Layer, Page 604

2. ODBC Translation Layer, Page 604

3. ODBC Layer, Page 604

4. DBMS Translation (ODBC data source) Layer, Page 605

5. The Database Layer, Page 606

Database layer

DBMS Translation layer

ODBC

ODBC Translation layer

Crystal Reports layer
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By using the Structured Query Language (SQL), all five layers can 
conveniently pass data from the database to your report.

Seagate Crystal Reports Layer

When working with ODBC data, Seagate Crystal Reports generates an SQL 
statement that requests the appropriate data from ODBC. The powerful SQL 
generator built into Seagate Crystal Reports is designed to create an SQL 
statement that will let the ODBC data source or ODBC itself do as much of 
the report generation as possible, returning only the data needed to produce 
the report. This SQL statement can be viewed and fine-tuned by anyone 
familiar with the SQL language. See How to edit an SQL query, Page 570.

ODBC Translation Layer

Seagate Crystal Reports uses the Dynamic Link Library PDSODBC.DLL 
to communicate with ODBC. This file is unique to Seagate Crystal 
Reports environment and provides your report with access to any ODBC 
data source. This is the driver that actually passes data to and from 
ODBC.

ODBC Layer

ODBC is a set of several DLLs and INI files built into the Windows 
environment that act as a gateway through which database requests and 
data can pass. Any database file or format that is to be used via ODBC 
must be set up as an ODBC data source.

In 16-bit Windows (Windows 3.x), the primary DLLs that make up ODBC 
are:

●   ODBC.DLL, and

●   ODBCINST.DLL.

Information about ODBC data sources is stored in:

●   ODBC.INI, and

●   ODBCINST.INI.

ODBC uses these files to access information about the data source.

In 32-bit Windows (Windows 95, Windows 98, and Windows NT), the 
ODBC DLLs are:

●   ODBC32.DLL (32-bit version of ODBC.DLL),

●   ODBCCP32.DLL (32-bit version of ODBCINST.DLL), and

●   ODBCINT.DLL (ODBC 2.5 and later).
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Although information regarding data sources is still recorded in 
ODBC.INI and ODBCINST.INI, 32-bit ODBC uses the Windows Registry 
database to retrieve information about individual data sources.

NOTE: For more information on ODBC and the ODBC files, see the 
Microsoft ODBC documentation.

ODBC uses the SQL language for all transactions between Seagate 
Crystal Reports and ODBC. Even if the database does not normally use 
SQL to create and work with tables, the ODBC driver provided by the 
database (the DBMS translation layer) must communicate with ODBC 
using SQL. For most users, this feature of ODBC is transparent, but more 
advanced users often take advantage of the features of the SQL language 
used by ODBC.

DBMS Translation (ODBC data source) Layer

This layer consists of one or more drivers provided by a DBMS that allow 
ODBC to communicate with the database. Seagate Crystal Reports ships 
with several ODBC drivers for many of the most common database 
formats. If you are unsure whether you can use an ODBC driver to access 
the data in your database, refer to the documentation for your DBMS 
application. Most DBMS applications that run on a Windows-based 
platform offer an ODBC driver.

When a DBMS provides an ODBC driver, it must register the driver with 
ODBC on the machine on which it has been installed. It does this by 
assigning a name to the driver and recording the filename in the 
ODBCINST.INI file. Usually, this step is handled automatically when the 
DBMS application is installed on the system. However, your network 
system or DBMS application may require that you register the ODBC 
driver manually with the ODBC Setup application. For more information 
about registering an ODBC driver with ODBC, refer to the 
documentation for your DBMS.

Once an ODBC driver is registered, you need to establish an ODBC data 
source using that driver. The ODBC data source is the object that you 
connect to when accessing data from Seagate Crystal Reports through 
ODBC. Data sources are recorded in the ODBC.INI file. The data source 
keeps track of the DBMS translation files (ODBC drivers) and, sometimes, 
the database itself. An ODBC data source can specify just a database 
format, such as Oracle, Gupta, Sybase SQL, or MS SQL Server. Some 
users, however, prefer to actually specify a particular database. In this 
case, the ODBC data source extends across both the DBMS translation 
layer, and the database layer.

If you are using a client/server database, such as an SQL server, the 
ODBC drivers communicate with the database server through the 
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Database Communication Layer, the same layer that your database client 
uses to communicate with the database server.

NOTE: ODBC drivers find their specific DBMS client files on the local 
machine mainly through key directories that the DBMS client has 
installed in the search path (specified in AUTOEXEC.BAT). The important 
thing to remember is that a workstation client on a local PC must be able 
to connect to its server successfully. If you are not sure how to verify this, 
contact your IS manager.

For Seagate Crystal Reports and the ODBC drivers, it does not matter 
what kind of platform your database server exists on. It is the DBMS 
client that connects and communicates with the server; Seagate Crystal 
Reports and the drivers need only communicate with the DBMS client. 
For more information, see Using SQL and SQL databases, Page 535.

The Database Layer

The database file which the ODBC data source refers to can be located 
anywhere on a system. Once the ODBC data source is set up, Seagate 
Crystal Reports does not need to know the actual location and format of 
the data. Thus, the database can have any format and can be located 
anywhere on a network, as long as ODBC can communicate with it 
through the ODBC data source.

Common ODBC 
database formats

Access

Although Microsoft Access files can be opened directly by Seagate 
Crystal Reports (see Microsoft Access, Page 587), you may wish to use 
ODBC for these files instead. When communicating with Access 
databases, ODBC uses a translation file that communicates with the 
Microsoft Jet Database Engine. The Jet Database Engine is an example of 
a DBMS-specific ODBC driver.

The Jet engine is the part of the Access DBMS that does all of the actual 
work with an Access database. Jet is a required component for working 
with Access data. Since the Jet engine is an integral part of all Access 
databases, it is shown here as part of the database layer.

NOTE: The diagram shown here illustrates the files required by Seagate 
Crystal Reports to work with databases designed with the 16-bit version 
of Microsoft Access 2.0. If you are using a different version of Access, 
refer to the Runtime File Requirements online Help (RUNTIME.HLP) for 
information on the specific files required to open your Access data.
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Excel

You can convert Microsoft Excel spreadsheets into databases that can be 
read by Seagate Crystal Reports through ODBC. In Excel 4.0 and earlier, 
use the SET DATABASE command on the Data Menu. In Excel 5.0 and later, 
use the Define command on the Insert|Name Menu. Once converted, 
spreadsheet rows become records, and spreadsheet columns become 
fields. (For more information on converting your spreadsheets to 
database format, refer to your Excel documentation). Once the 
spreadsheet is converted, you can set up an ODBC data source for the file, 
and then select it from Seagate Crystal Reports.

NOTE: If you are using Excel 7 or later, you can export your spreadsheets 
as Access database tables, and read them from Seagate Crystal Reports as 
you would read any other Access tables. For more information, refer to 
your Excel documentation.

Seagate Crystal Reports reads Excel databases for 16-bit Windows 
environments through the CRXLS07.DLL translation file (for Excel 
version 4.0 and earlier) or through the CRXLS507.DLL (for Excel version 
5).

These drivers are installed by Seagate Crystal Reports. ODBC can 
communicate with the appropriate driver to read the converted Excel 
spreadsheet.
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If you are using a 32-bit Windows system, you can set up an ODBC data 
source for 32-bit Excel spreadsheets using the 32-bit DAO engine. The 
DAO engine is installed on your system when you install the 32-bit 
version of Seagate Crystal Reports. However, you must set up an ODBC 
data source manually for your Excel spreadsheet. See How to set up an 
ODBC data source, Page 556.

Crystal Reports

ODBC

Excel
Spreadsheet

CRXLS07.DLL or
CRXLS507.DLL

Crystal Reports layer

ODBC
Translation

layer

ODBCODBC.DLL
ODBCINST.DLL

PDSODBC.DLL

DBMS
Translation

layer

Database
layer

Crystal Reports

Excel
Spreadsheet

Crystal Reports layer

ODBC
Translation

layer

ODBC

ODEXL32.DLL

ODBC32.DLL
ODBCINT.DLL

ODBCCP32.DLL

DBMS
Translation

layer

Database
layer32-bit DAO Engine

ODBC

P29ODBC.DLL
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INFORMIX

Seagate Crystal Reports accesses INFORMIX databases through ODBC. 
The INFORMIX client, called INFORMIX-NET, should be installed on 
your machine. Otherwise, Seagate Crystal Reports will provide the driver 
that ODBC uses to communicate with the INFORMIX database engine.

NOTE: The 32-bit version of Seagate Crystal Reports provides the 32-bit 
ODBC driver CRINF509.DLL for reading 32-bit INFORMIX data.

SQL Databases through INTERSOLV DataDirect

There are many different SQL Database Management Systems available 
on the market, and most of them can be accessed through ODBC. Seagate 
Crystal Reports automatically installs and sets up several ODBC data 
sources, allowing you to access many of the most popular SQL databases, 
including:

●   Oracle

●   Sybase SQL Server

●   MS SQL Server

●   Gupta SQLBase

Crystal Reports

INFORMIX Database

Crystal Reports layer

Translation layer

Database layer

INFORMIX-NET

CRINF507.DLL

ODBC
ODBC,DLL

ODBCINST.DLL

PDSODBC.DLL

ODBC

DBMS Translation layer
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●   Scalable SQL

●   DB2/2

●   ASCII Text

NOTE: ASCII Text is not really an SQL database format, but Seagate 
Crystal Reports can read text files through ODBC in much the same way.

Seagate Crystal Reports provides the INTERSOLV DataDirect ODBC 
drivers for these SQL database formats. Not all SQL databases are 
accessed through these drivers, but as a convenience, the program 
automatically sets up these drivers for you during installation. Seagate 
Crystal Reports still communicates with ODBC through the 
PDSODBC.DLL translation file, but the DataDirect drivers provide 
ODBC with easy access to the actual databases.

NOTE: If you are using an SQL database not accessed by the INTERSOLV 
drivers, refer to your DBMS documentation for more information about 
the required ODBC drivers.

Do not confuse SQL databases with the SQL language. Structured Query 
Language (SQL) is a specialized computer language used to design, 
build, and read database files. See Using SQL and SQL databases, Page 535.

SQL databases are any collection of computer applications that depend 
on the SQL language for database creation and manipulation. SQL DBMS 
applications are usually designed to run as large client/server 
applications spread across a network.

To open an SQL database, ODBC uses a set of four DataDirect ODBC 
support drivers (these are the same for every SQL database format), a 
DataDirect ODBC driver specific to the database format, and the 
Database Communication Layer that actually communicates directly to 
the database file. The files provided for this DBMS translation layer are all 
INTERSOLV DataDirect drivers.

NOTE: ODBC does not have to use the INTERSOLV DataDirect drivers to 
access the SQL databases shown here. Most SQL DBMS applications 
provide their own ODBC drivers. However, Seagate Crystal Reports sets 
up the INTERSOLV drivers for you automatically. 
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NOTE: The 32-bit version of Seagate Crystal Reports provides 32-bit 
INTERSOLV drivers for accessing SQL databases. These 32-bit drivers are 
named CR*09.DLL instead of CR*07.DLL.

As mentioned previously, Seagate Crystal Reports automatically creates 
several ODBC data sources for the SQL database formats supported by 
INTERSOLV DataDirect. These data sources appear in the Log On Server 
dialog box:

●   ODBC-CRDBM supports DB2/2

●   ODBC-CRGUP supports Gupta

●   ODBC-CROR7 supports Oracle 7

●   ODBC-CRORA supports Oracle 6

●   ODBC-CRSS supports MS SQL Server and Sybase SQL Server

●   ODBC-CRXQL supports Scalable SQL

●   ODBC-CRSYB supports Sybase System 10

Database Communication layer

MS SQL
Server

Sybase Gupta DB2/2 Oracle Other databases
that use an ODBC
back-end driver.

INTERSOLV DataDirect Supporting ODBC Drivers
(DataDirect requires you to use all 4 of these)

CRBA507.DLL   CRFLT07.DLL
CRUTL07.DLL   CRMDS07.DLL

CRGUP07.DLL
CRORA07.DLL
CROR707.DLL
CRTXT07.DLL
CRSS07.DLL
CRXQL07.DLL
CRDB207.DLL
CRSYB07.DLL

INTERSOLV DataDirect ODBC Drivers

(For Gupta)
(Oracle 6)
(Oracle 7)
(Text/ASCII Files)
(SQL Server/Sybase SQL)
(Scalable SQL)
(DB2/2)
(Sybase System 10)

Back-End
Drivers.
Choose one of
these drivers as
per your database.
This layer can
be replaced by
other back-end
ODBC Drivers
if desired.

ODBC.DLL   ODBCINST.DLL

Microsoft ODBC API

Crystal Reports

PDSODBC.DLL Front-End Driver
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INTERSOLV DataDirect Library

Instead of communicating directly with ODBC through the 
PDSODBC.DLL file, Seagate Crystal Reports can use the INTERSOLV 
DataDirect Library that ships with Seagate Crystal Reports. This front-
end driver uses the ODBC standard as an underlying layer. However, 
instead of using PDSODBC.DLL to communicate with ODBC, Seagate 
Crystal Reports uses a specific PDS*.DLL file appropriate to the SQL 
database being accessed.

DataDirect Library vs. ODBC

The strength of the DataDirect Library over ODBC direct is mainly its 
ability to pass proprietary SQL syntax to specific servers. For example, 
because Oracle has its own PDS driver, an SQL developer working with 
Oracle data is sometimes able to pass more precise SQL statements to the 
server. With the Data Direct Library, a developer can pass SQL language 
features that are unique to a particular DBMS from Seagate Crystal 
Reports. When using ODBC direct, the PDSODBC.DLL is a common DLL 
that is used for all DBMS types, and the use of proprietary SQL syntax 
based on specific servers may not be entirely possible.

DataDirect Library structure

With the INTERSOLV DataDirect Library, Seagate Crystal Reports uses 
an ODBC translator specific to the SQL database format being accessed. 
This file, in turn, communicates with the DataDirect Library. The 
DataDirect Library makes the final translation of the SQL statement to 
ODBC.
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NOTE: The 32-bit version of Seagate Crystal Reports provides 32-bit 
INTERSOLV drivers for accessing SQL databases. These 32-bit drivers are 
named CR*09.DLL instead of CR*07.DLL.

INTERSOLV DataDirect Library databases

●   Oracle

●   Sybase SQL Server

●   MS SQL Server

●   Gupta SQLBase

●   Scalable SQL

●   DB2/2

Database Communication layer

MS SQL
Server

Sybase Gupta DB2/2 Oracle Other databases
that use an ODBC
back-end driver.

INTERSOLV DataDirect Supporting ODBC Drivers

CRBA507.DLL   CRFLT07.DLL
CRUTL07.DLL   CRMDS07.DLL

CRGUP07.DLL
CRORA07.DLL
CROR707.DLL
CRTXT07.DLL
CRSS07.DLL
CRXQL07.DLL
CRDB207.DLL
CRSYB07.DLL

INTERSOLV DataDirect ODBC Drivers

(For Gupta)
(Oracle 6)
(Oracle 7)
(Text/ASCII Files)
(SQL Server/Sybase SQL)
(Scalable SQL)
(DB2/2)
(Sybase System 10)

Back-End
Drivers.
Choose one of
these drivers as
per your database.
This layer can
be replaced by
other back-end
ODBC Drivers
if desired.

ODBC.DLL   ODBCINST.DLL

Microsoft ODBC API

Front-End Driver

Crystal Reports

PDSORACL.DLL PDSGUPTA.SDLL PDSNETW.DLL PDSDB22.DLL PDSSYBAS.DLL

INTERSOLV Datadirect Library

CRLIB.DLL
CRGUI07.DLL  CRUTL07.DLL  CRFLT07.DLL  CRSQL07.DLL  CRMDS07.DLL  CRBAS07.DLL
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NOTE: The ODBC data sources that Seagate Crystal Reports installs for 
the INTERSOLV DataDirect Library appear in the Log On Server dialog 
box without the “ODBC-” prefix, which is used by the data sources that 
go through ODBC direct.

Visual FoxPro

Microsoft Visual FoxPro data is accessed through ODBC, while FoxPro 
data from version 2.5 and earlier is accessed directly through the xBase 
engine. If you are using FoxPro version 2.5 or earlier, see dBASE, FoxPro, 
Clipper, Page 584.

Seagate Crystal Reports provides the ODBC driver VFPODBC.DLL, 
allowing ODBC to work with Visual FoxPro data.

NOTE: Because the program supports the latest version of DAO, there is 
native support for VSFoxPro 5.0 (For more information, see DAO, Page 
589).

Lotus Notes

A Lotus Notes database can be read by Seagate Crystal Reports through 
ODBC. The Lotus Notes DBMS translation layer consists of three files:

1. NOTESSQL.DLL

2. NSQLODBC.DLL

3. NSQLCFG.DLL

Visual FoxPro
Database

Crystal Reports layer

Database layer

Crystal Reports

ODBC.DLL
OBDCINST.DLL

VFPODBC.DLL

ODBC

PDSODBC.DLL ODBC
Translation layer

ODBC

DBMS
Translation

layer
614 Seagate Crystal Reports User’s Guide



These files use the drivers installed by the Lotus Notes Workstation to 
work with the Lotus Notes database. The Workstation component of 
Lotus Notes must be installed on the local machine.

Crystal SQL Designer files

The Crystal SQL Designer is a query which is simply a request for a 
specific set of data from a database. Once the data is gathered, it can be 
stored as a Crystal SQL Designer file (.QRY). The Crystal SQL Designer 
file can then be used much like a database table. The data it gathers from 
your SQL databases becomes a new data set that can be added to reports.

A Crystal SQL Designer file gathers data from ODBC data sources (such 
as SQL servers) by means of SQL (Structured Query Language). The SQL 
Designer sends an SQL statement with instructions to gather and return 
a specific set of data is sent directly to the SQL DBMS. The DBMS handles 
all of the actual data gathering, sorting, and grouping, according to the 
instructions in the SQL statement. Only the final set of data is returned to 
the SQL Designer and stored as a query file.

NOTE: If you are not familiar with SQL, see SQL join types (ODBC data 
sources), Page 527.

Lotus Notes Database

Crystal Reports

NOTESSQL.DLL
NSQLODBC.DLL
NSQLCFG.DLL

Crystal Reports layer

Translation layer

Database layer

Lotus Notes Workstation

ODBC
ODBC.DLL

ODBCINST.DLL

PDSODBC.DLL

ODBC

DBMS Translation layer
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First, you refine an SQL statement and create a query file that contains 
only the data you need. Then you design your reports based on the query 
file instead of on the original databases. Most of the data gathering 
process is done on the SQL server when you design the query. When you 
design your report, Seagate Crystal Reports only needs to work with a 
small set of data, saving you time and trouble. For more information, see 
How to create a new query, Page 470.

Advantages While there are many reasons for using the Crystal SQL Designer, the 
primary one is the ability to off-load most of the data retrieval process to 
a server and store the resulting data as a separate data set. By using this 
SQL pass-through technique, where data retrieval tasks are passed 
through to the server, you retrieve your data faster and more efficiently. 
Any time you are working with SQL data, you should consider building 
a query file before designing your report.

In addition, the Query Expert provides for more control over your data 
with the SQL language. Seagate Crystal Reports provides some SQL 
language features when accessing SQL or ODBC data, but the Query 
Expert is a powerful query tool that provides more powerful SQL data 
access features. The Query Expert allows aggregate functions in an SQL 
statement and supports all data query elements of the SQL language. If 
you know the SQL language, you can perform complex SQL tasks using 
UNION operations and sub-queries. See The SQL language, Page 540.

Disadvantages Since a query represents a complete data set, any records, fields, or tables 
that were not included when the query was created will not be available 
when using the query to build a report. A report can not be any more 
complex than the data it accesses, so by using a query, you limit your 
reporting options to the data in the query.

Crystal Reports
Query file
collects data
and stores as
new data set.

ODBC
Data Source
(SQL Server)

Crystal Reports
uses data stored
in query file.Crystal

query
file

Query
data
set
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In addition, a query can not be used with any other source of data. If you 
decide to use a query in your report, you can not include an additional 
data source, such as a database table or another query file, to use in the 
report.

Crystal Dictionary files 

A dictionary (.DC5) file is a structured and simplified view of 
organizational data that you can create for any of the individuals in your 
organization that are using Seagate Crystal Reports. With a dictionary, 
end users only see the subset of tables and fields they need.

NOTE: The application for creating dictionaries is only available with the 
Professional edition of Seagate Crystal Reports. This application is 
designed for IS and Database Managers who need to provide alternatives 
to accessing data for users. Both the Standard and Professional editions of 
Seagate Crystal Reports can open and use dictionary files.

A dictionary is an optional source of data for Seagate Crystal Reports. It 
provides a convenient filter, clarifying and simplifying complex data 
access techniques for end users, but the user can still access data directly 
from the database. Dictionaries simply provide all the convenience 
without the headaches.

If you choose to design a report by using a dictionary, you can not use any 
other data source in that report. This includes other dictionaries, Seagate 
Crystal Reports, ODBC data sources, direct access databases, and all 
other data sources. The purpose of a dictionary is to provide fast, easy to 
understand access to a particular set of data. Connecting to other sources 
of data within the same report would defeat this purpose. See How to 
create a new dictionary, Page 489.

Dictionaries allow you to:

●   design a single, dynamic view of all the data that is necessary to 
create organizational reports and queries,

●   create a dictionary that contains multiple data sources, tables, and 
links,

●   organize the data and rename tables and fields to make it easier for 
users to understand the content and purpose of the data, and

●   create complex data-manipulation formulas that users can access 
without the need to understand formula concepts.

Dictionaries reduce support cost and time, increase user productivity, 
and reduce data misuse, loss, and damage.
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Once created, the dictionary acts as a filter, providing a view of complex 
data that is clear and easy for any user to understand. The complexity of 
your data will not stop end users from creating powerful reports.

Seagate Crystal Reports reads the dictionary file by using the 
PDIXBSE.DLL file (P2IXBSE.DLL for 32-bit). This translation file is based 
on the xBase engine used to access dBASE, FoxPro and Clipper databases, 
but it provides all the flexibility needed to read dictionaries. See dBASE, 
FoxPro, Clipper, Page 584.

NOTE: If you upgraded from an earlier version of Seagate Crystal Reports 
that allowed dictionary files, the older dictionary files (.DCT) were based 
on the Btrieve engine. If you convert those older files to new dictionary 
files, the new files will use the xBase translation layer instead of Btrieve. 
However, the Btrieve engine installed by the earlier version of Seagate 
Crystal Reports must remain on your system for the new dictionary 
application to read the older dictionary files.

The Database Access Layer is the layer through which the dictionary file 
actually reads the original database data. Dictionaries must read database 
data using the same routes that Seagate Crystal Reports uses to read the 
data. The sections on direct access database layers and ODBC data 
sources describe the files dictionaries need for reading data.

The benefit of dictionaries is that this Database Access Layer is 
completely transparent to the user. The dictionary displays a view of data 
in Seagate Crystal Reports that may or may not match the actual data, but 
that is easily accessible and convenient for users.

PDIXBSE.DLL (16 bit) or
P2IXBSE (32 bit)

Crystal Reports

Dictionary

Database Access Layer
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Finally, dictionaries provide an easy means of changing the originally 
accessed data without changing the view of data seen by users. For 
example, your original database may contain Price, Quantity, and Cost 
fields, and you decide that Cost can be calculated from Price and 
Quantity, so you eliminate the Cost field. By simply updating the 
dictionary to calculate Cost instead of getting it directly from the 
database, your users never know the difference. This is also useful when 
the entire underlying database format is changed. Once again, just update 
the dictionary.

Dictionary files are often created by an IS manager who controls a 
company database. The IS manager can work with data that is organized 
and classified to create simple, easy-to-use dictionaries for company 
employees. In each dictionary file, the employees will find only the data 
they need, since the original data has been manipulated or customized by 
the IS manager for varying usage.
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A Report Processing Model

What you will find in this appendix...

Multi-pass reporting, Page 622

What is a “pass”?, Page 622

Pre-pass #1, Page 622

Pass #1, Page 622

Top/bottom N and group sorting, Page 623

Pass #2, Page 623
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Multi-pass reporting 

What is a 
“pass”? 

A pass is a process that Seagate Crystal Reports uses each time the data is 
“read” and manipulated. Therefore, if a report reads and manipulates the 
data twice, it is considered to be a two-pass report. This feature is one that 
is very powerful in the data access and reporting industry because it 
allows for complex reporting and formula manipulation. Therefore, 
percent of subtotal calculations are possible due to the two-pass reporting 
capabilities of Seagate Crystal Reports. Some reports can be one-pass, yet 
in most cases two-passes will be issued. The following section offers a 
brief overview of the two-pass reporting concept. Following the written 
description is a visual representation of this process.

Pre-pass #1 When previewing a report, the first elements to be evaluated are “flat” 
formulas. Flat formulas are those that do not contain database fields. For 
example, 100* 30 would be a flat formula. Flat formulas are evaluated at 
the beginning of the print preview process and are never evaluated again. 
This process is known as “BeforeReadingRecords”. If you were to place a 
flat formula field (i.e., 100*30) in the Details section, the result would be 
3000 for each record displayed.

Pass #1 Once the “BeforeReadingRecords” process has taken place, Seagate 
Crystal Reports will begin reading the database records. During the 
record reading process the following will occur:

1. Record Retrieval.

2. Evaluate “recurring” formulas. These formulas are those that contain 
database fields but do not contain references to subtotals or 
summary information that would require data manipulation in the 
second pass. This evaluation time is known as 
“WhileReadingRecords”.

3. Apply the record selection criteria. If the selection criteria is based on 
a database field that is indexed (i.e., {company.LASTNAME} = 
“SMITH”), then Seagate Crystal Reports rejects records not equal to 
SMITH immediately after evaluating the recurring formulas. The 
reason for this is that the selection criteria may include recurring 
formulas. (i.e., {table.FIELD} = {@Formula}).

4. Totaling. A typical report usually contains groups, sorts, and 
subtotals and Seagate Crystal Reports tries to process as many of 
these in the first pass as possible. As the records are processed they 
are divided into groups based on the group field specified in the 
report. Each of these groups is sent to an internal “totaler”. This 
counting mechanism stores a subtotal of each group, in memory, 
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which is then used later in the report process.

5. Store the saved records. After the totaling process is complete, all of 
the records and totals are stored into a “saved records” object. This 
object stores data in memory and on disk in the form of temporary 
files. Saved records are used during the report's second pass for two-
pass calculations, group sorting, etc. Therefore, the second pass of 
the report does not actually read the database again, instead it uses 
the saved records object.

Steps 1 to 5 are an iterative process that will repeat for each record being 
read.

Top/bottom N 
and group 
sorting

Top/Bottom N is a process that allows a user to select either the Top or 
Bottom N groups. N is the number you specify. Before you can use the 
Top N feature, your data must be subtotaled or summarized. The group 
sorting allows you to specify the order in which your “groups” are 
printed. This sort order is based on the subtotaled or summarized field, 
not the grouping field.

This process, an intermediate step between passes, actually occurs in 
between the first and second pass of the report process and does not 
actually require the records to be read. Instead it only looks at the 
grouping information stored in the saved records object and orders the 
groups as specified.

Pass #2 After completing the Top N/Group sort process, Seagate Crystal Reports 
enters into a second pass of the data. This means that the program will 
look at the saved records object for the current information and continue 
with the following elements of Pass #2.

1. Read records that are contained in the saved records object. These 
records are read one at a time along with their respective subtotals.

2. Once the subtotal or summary information is available, the group 
selection formula can be applied. The group selection formula allows 
the user to select groups based on the subtotaled or summary field, 
not the grouping field. For example, you may only want the groups 
that have a subtotal greater than X.

HINT: The Group Selection Formula Editor can be used for record 
selection formulas, however it is not recommended. If, for example, you 
chose to use a typical selection such as:

{company.LASTNAME} = “SMITH”

in the Group Selection Formula Editor, the records that are displayed on 
your report may be correct, however, the subtotals, summaries and grand 
totals will most likely be incorrect. All of the subtotal/grand total 
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information is calculated in Pass #1 and therefore, if you decide to filter 
out records in Pass #2 the subtotals will not be modified accordingly.

3. Evaluation of print time formulas. This process is known as 
“WhilePrintingRecords”. This would include formulas that have 
been explicitly defined as “WhilePrintingRecords” in the formula 
itself as well as formulas that refer to subtotals or summary fields. 
Examples of print-time formulas are:

●   % of subtotals

●   running totals or running averages

●   formulas explicitly marked “WhilePrintingRecords”

4. MetaPage Generation. These pages are generated to display your 
report to screen. MetaPages are similar to a standard Windows Meta 
File. Essentially each page is a “recording” of the individual report 
pages. Therefore, all of the lines, boxes, fields, etc., are stored in the 
MetaPages. This method of storing report pages is much more 
efficient than storing the pages as bitmaps. 

The following diagram is a flow-chart of the multi-pass report 
process:

Flat Formulas

BeforeReadingRecords

Database Records Recurring
Formulas

Record Selection
Formula

Totaling Saved Records

WhileReadingRecords

Total Page
Count

Group
Sorting/TopN

Saved Records Totals Group Selection
Formula

Print-Time
Formulas

MetaPages

WhilePrintingRecords

pre-pass

pass #1

pre-pass

pass #2

Final Pass
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B Product Support

What you will find in this chapter...

Product support, Page 626

Web support, Page 626

E-mail support, Page 627

Fax support, Page 627

Technical support, Page 628

Product registration, Page 629

Product return policy, Page 630

Product replacement policy, Page 631
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Product support

Seagate Crystal Reports is a powerful report writer for the Windows 
environment. Seagate Software, Inc. is proud of the quality of the product 
and has spent a great deal of time trying to make it intuitive to use. If, 
however, there is something you can not figure out how to do, you should 
consult the extensive online help system. The help system can be accessed 
by clicking on any Help button, by pressing the F1 key, or by choosing the 
commands provided in the Help Menu. The help system contains all of 
the information from the User’s Guide, as well as in-depth explanations 
and numerous examples of all the reporting concepts.

NOTE: Product support plans vary from region to region. Contact your 
local distributor for a list of product support plans available in your 
region. See README.HLP for a list of international distributors.

Web support

WEB SITE

The Seagate Software Web Page can be accessed through:

http://www.seagatesoftware.com/

Seagate Crystal Reports

The Crystal Reports Web Page can be accessed through:

http://www.seagatesoftware.com/crystalreports

The Crystal Reports Technical Support Page can be accessed through:

http://www.seagatesoftware.com/crystalreports/techsupp/

Technical Support Sites

Technical Support Questions can be submitted through the Web at:

http://webacd.seagatesoftware.com. 

Seagate Crystal Info

http://seagatesoftware.com/crystalinfo/techsupp/

Seagate Holos

http://seagatesoftware.com/holos/techsupp/
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E-mail support

E-MAIL

●   support@webacd.seagatesoftware.com

To submit a Technical Support issue by e-mail:

●   E-mail a "blank" message to the address above. Leave everything 
blank and the system will send you back a ’Main Form’ to fill in.

●   Once you have filled in and submitted the Main Form, a Product 
Form will be sent to you. The Product Form is used to gather the 
particulars of your question.

E-MAIL NOTIFICATION SERVICE

●   http://maillist.seagatesoftware.com/subscribe.asp

   Seagate Software’s E-mail Notification Service helps 
subscribers remain up-to-date on current events, latest patches 
and updates for their products, as well as new product 
releases. Please visit http://mailist.seagatesoftware.com/
subscribe.asp to select the type of information you would like 
to receive on the particular product(s) you want.

   Each product that you select will add your e-mail address to 
that particular topic’s notification group. You may select 
multiple products and you may select both marketing and 
technical information. You will then see a confirmation page 
that simply asks you to verify your information. If all of the 
information is correct, you may click the button to continue. If 
there is a problem, you will be able to return to this page and 
make any changes necessary. You may unsubscribe from any 
list at any time.

Fax support

Another efficient way to receive support on Seagate Crystal Reports is to 
fax in your technical support request. To do this, first fill in the bottom 
part of the Technical Support Request form in the product. This form 
appears when you choose the TECHNICAL SUPPORT REQUEST command 
from Seagate Crystal Reports Help Menu. When you have completed the 
form, click the Print button to print it.

Fax the completed form to Seagate Software 24 hours a day, Monday 
through Friday. After a technical support representative has had a chance 
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to review your fax, one of the support representatives will respond to you 
by return fax the next business day.

NOTE: Product support plans vary from region to region. Contact your 
local distributor for a list of product support plans available in your 
region. See README.HLP for a list of international distributors.

Seagate Fax Support (604) 681-7163

Technical support

Seagate Software offers several levels of telephone support for Seagate 
Crystal Reports.

●   Priority Support provides customers with toll-free access, priority 
queue handling, and extended calling hours. Details are outlined 
in Priority Support below.

●   All registered users of Seagate Crystal Reports are entitled to free 
telephone support as outlined below in Standard Technical 
Support.

Priority Technical Support

Priority Support packages are available for sale to registered users of 
Seagate Crystal Reports. This service gives customers:

●   A full year of unlimited toll-free access to Technical Support,

●   Priority call handling, and

●   Extended calling hours.

Please call (604) 681-3435 or (800) 877-2340 for more information.

Standard Technical Support

Registered users of Seagate Crystal Reports are entitled to free telephone 
support (subject to availability) for 60 days from the time of purchase. 
Telephone support is available from 8 a.m. to 4 p.m., P.S.T., Monday 
through Friday. If you are calling from outside the Vancouver, B.C. area, 
long distance charges apply.

Before you call technical support, make sure you do the following:

●   check the manual,

●   check the online help system, and

●   check the Internet (www.seagatesoftware.com).
628 Seagate Crystal Reports User’s Guide



Please have the 
following 
information 
available:

1. Serial number.

●   If you are registered, you can find the serial number by choosing 
the ABOUT CRYSTAL REPORT DESIGNER command on the Help 
Menu.

●   If you are not registered, you will need to register first to obtain 
your serial number.

2. Product name and version number.

3. Operating system you are using (i.e., Windows 95 and Windows 98, 
Windows NT, or Windows 3.1) and whether you are using a 16-bit or 
32-bit version of Seagate Crystal Reports.

4. Version of database and other software you are using with Seagate 
Crystal Reports (if required) - Btrieve, Sybase, Paradox, etc.

5. Technical Support Request form from the product.

6. Network information, if you are on a network.

7. Contents of AUTOEXEC.BAT and CONFIG.SYS files.

8. A list of steps necessary to recreate the problem.

9. The database type you are using.

10. The programming environment (if applicable).

NOTE: Product support plans vary from region to region. Contact your 
local distributor for a list of product support plans available in your 
region. See README.HLP for a list of international distributors.

Telephone Number (604) 669-8379

Knowledge Link

Access the same information Seagate Software’s Technical Support 
Agents use. Knowledge Link is a locally stored knowledge base that is 
updated every two weeks via e-mail. Contact Sales for more information.

Product registration

When using Seagate Crystal Reports for the first time, a dialog box will 
appear that asks for your name, address, and related information. Then 
the program will suggest that you register the program to receive your 
product Serial Number. The program will ask for the Serial Number the 
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next time you run Seagate Crystal Reports. When you enter the Serial 
Number, you have completed the registration process. You can register 
the program using four different methods:

1. If you have access to the Internet, fill out the Product Registration 
form on the Seagate Software web site at:

www.seagatesoftware.com/crystalreports/register/

You can also go directly to the Registration form by choosing the 
PRODUCT REGISTRATION command from the Help|Seagate 
Software on the Web Menu. The procedure will immediately transmit 
a registration number back to you so you can enter it into the product.

2. Print the Registration Form and then fax it to Seagate Software at 
(604) 681-5147.  Seagate will then fax back to you a registration 
number that can be entered into the product the next time it asks for 
it.

3. Fill out the enclosed Registration Form and mail it to Seagate 
Software. Seagate will mail a registration number back to you so you 
can enter it into the product.

Registering the program will ensure that you are kept up to date with all 
product advancements, and it will allow Seagate to provide quality 
technical support to people that are properly registered with Seagate 
Software.

Registration FAX Numbers

USA/Canada (604) 681-5147
United Kingdom +44 (0) 181 231 0649
Australia +6 2 9955 7682
Hong Kong +852 2893 2727
Singapore +65 777 8786

Product return policy

If you are not satisfied with Seagate Crystal Reports for any reason, you 
can return it to the original place of purchase for a refund within 30 days 
of the purchase date.
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Product replacement policy

If Seagate Crystal Reports diskettes or documentation are defective, then 
please contact Seagate Software, Inc., within 30 days of the purchase date. 
Fax the description of the problem and Seagate will solve it as quickly as 
possible. Please fax the description of the defect to (604) 681-2934.

NOTE: Replacement policies vary from region to region. Contact your 
local distributor for a list of replacement policies available in your region. 
See README.HLP for a list of international distributors.
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C Seagate Software International 
Office Directory

What you will find in this chapter...

North/South American Head Office, Page 634

USA and Latin America, Page 635

Asia/Pacific Offices, Page 635

Europe/Middle East/Africa Offices, Page 638

France – Southern European Head Office, Page 642

South Africa Regional Office (Southern & Central Africa), Page 644

Middle East Regional Office (ME & Northern Africa), Page 645
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North/South American Head Office

Canada

Seagate Software, Inc.

840 Cambie Street

Vancouver, BC V6B 4J2

Canada

Sales

Telephone: 604-681-3435

Toll-Free: 1-800-877-2340

Fax: 604-681-2934

E-Mail:sales@img.seagatesoftware.com

Product Support

Phone: 604-669-8379

Fax: 604-681-7163

E-Mail: support@webacd.seagatesoftware.com (Available in English 
only)

Web browser: http://webacd.Seagatesoftware.com (Available in English 
only)

Mailing Address: Please refer to the address of the Seagate Software 
office nearest you.

Product Registration

Seagate Crystal Reports Web Registration: http://
www.seagatesoftware.com/crystalreports/register 

Seagate Crystal Info Web Registration: http://
www.seagatesoftware.com/crystalinfo/register

Fax: 604-681-5147

Mailing Address: Please see addresses listed on the registration card 
included in your package.
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USA and Latin America
Seagate Software, Inc.

Suite 270 – 510 Thornall Street

Edison, NJ 08837

USA

Sales

Telephone: 732-321-6500

Fax: 732-321-6504

Product Support

Please see the Product Support section listed under Canada

Product Registration

Please see the Product Registration section listed under Canada

Asia/Pacific Offices

Australia

Seagate Software Pty Ltd

Level 9, 52 Alfred Street

Milsons Point

Sydney,  NSW  2061

Australia

Sales

Telephone: +61 2 9955 4088

Sales  +1-800-647-006

Fax: +61 2 9955 7682

Product Support

Please see the Product Support section listed under Canada

Product Registration

Fax: +61 2 9955 7692
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Mailing Address: please see addresses listed on the registration card 
included in your package.

On-line registrations: please see the product registration section listed 
under Canada.

Hong Kong

Seagate Software (HK)

20/F 83 Wanchai Road

Wanchai 

Hong Kong

Sales

Telephone: +852 2575 2576

Fax: +852 2893 2727

Product Support

Please see the Product Support section listed under Canada

Product Registration

Mailing Address: please see addresses listed on the registration card 
included in your package.

On-line registrations: please see the product registration section listed 
under Canada.

Japan

Seagate Software KK

Bridgestone Bldg. 2F

2-13-12 Hirakawa-cho,

Chiyoda-Ku, 

Tokyo 102-0093

Sales

Telephone: +81.3. 5226. 3601

Fax: +81. 3 .5226 .3606

E-Mail: sales_jp@img.seagatesoftware.com
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Product Support

Fax support: +81.3.5226.3605

Support E-Mail: support_jp@img.seagatesoftware.com

Product Registration

Fax Registration: +81.3.5226.3605

Seagate Crystal Reports Web Registration: http://
www.seagatesoftware.com/crystalreports/register 

Seagate Crystal Info Web Registration: http://
www.seagatesoftware.com/crystalinfo/register

Singapore

Seagate Software IMG

14 Science Park Drive 

03-02 The Maxwell 

Singapore Science Park 

Singapore 118226

Sales

Telephone: +65 777 0533

Fax: +65 777 8786

Product Support

Please see the Product Support section listed under Canada

Product Registration

Mailing Address: please see addresses listed on the registration card 
included in your package.

On-line registrations: please see the product registration section listed 
under Canada.
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Europe/Middle East/Africa Offices

United Kingdom - EMEA and Northern European Head Office

Seagate Software  

The Broadwalk 

54 The Broadway

Ealing, London

W5 5JN

UK

Sales 

Telephone: +44  (0) 181 566 2330

Fax: +44 (0) 181 231 0600

Product Support

Fax: +44 (0) 181 231 0600 (English, German, French)

E-Mail: support@webacd.seagatesoftware.com (available in English 
only).

Web browser: http://webacd.Seagatesoftware.com (available in English 
only).

Product Registration

Fax: + 44 (0) 181 231 0649

Country Telephone Language

UK +44 (0) 181 231 0638 English

Austria + 43 (0) 1 79 5672 85 German

Switzerland + 41 (0) 1 800 9134 German

Switzerland + 41 (0) 1 800 9130 French

Belgium + 32 (0) 2 713 12 35 French

Netherlands + 31 (0) 20 346 9201 English

Ireland + 353 (0) 1 407 30 30 English

Sweden + 46 (0) 85 87 711 45 English
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Seagate Crystal Reports Web Registration: http://
www.seagatesoftware.com/crystalreports/register 

Seagate Crystal Info Web Registration: http://
www.seagatesoftware.com/crystalinfo/register

Mailing Address: Please see addresses listed on the registration card 
included in your package.

Scotland

Seagate Software IMG

Ascada House

Garbett Road

Kirkton Campus

Livingston, West Lothian

EH54 7DL

Scotland

Sales

Telephone: +44 (0) 1506 410444

Fax: +44 (0) 1506 414994

Product Support

Please see the Product Support section listed under Northern European 
Head Office

Product Registration

Mailing Address: please see addresses listed on the registration card 
included in your package.

On-line registrations: please see the product registration section listed 
under Northern Europe.
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Sweden

Seagate Software

Kanalvagen 10C

194 61 Upplands Vasby

Sweden

Sales

Telephone: +46 8 590 04150

Fax: +46 8 590 04110

Product Support

Mailing Address: please see addresses listed on the registration card 
included in your package.

Product Registration

Please see the Product Registration section listed under Northern 
European Head Office.

On-line registrations: please see the product registration section listed 
under Northern Europe.

Netherlands

Seagate Software

Hojel City Center

Gebouw D, 4e etage

Graadt can Roggenweg 328

Postbox 19127

3501 DC Utrecht

The Netherlands

Sales

Telephone: +31 30 298 2124

Fax: +31 30 298 2125
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Product Support

Please see the Product Support section listed under Northern European 
Head Office

Product Registration

Mailing Address: please see addresses listed on the registration card 
included in your package.

On-line registrations: please see the product registration section listed 
under Northern Europe.

Germany – Central European Head Office

Seagate Software GmbH

2nd Floor 

Frankfurter Strasse 21-25

D-65760 Eschborn

Germany

Sales

Telephone: +49 (0) 6196 9559 0

Fax: +49 (0) 6196 9559 10

Product Support

Telephone: +49 (0) 699 509 6180

E-Mail: support@webacd.seagatesoftware.com (Available in English 
only)

Web browser: http://webacd.Seagatesoftware.com (Available in English 
only)

Product Registration

Fax: +49 (0) 6995 09 6182

Seagate Crystal Reports Web Registration: http://
www.seagatesoftware.com/crystalreports/register 

Seagate Crystal Info Web Registration: http://
www.seagatesoftware.com/crystalinfo/register

Mailing Address: Please refer to the addresses listed on the registration 
card included in your package.
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Switzerland

Seagate Software GmbH

World Trade Center

PO Box 112

Leutschenbachstrasse 95

CH-8050 Zurich

Switzerland

Sales

Telephone: +41 1 308 3922

Fax: +41 1 308 3500

Product Support

Please see the Product Support section listed under Central European 
Head Office

Product Registration

Fax: +49 (0) 6995 09 6182

Mailing Address: please see addresses listed on the registration card 
included in your package.

On-line registrations: please see the product registration section listed 
under Central Europe.

France – Southern European Head Office
Seagate Software 

62 bis, avenue Andre Morizet

F-92643 Boulogne Billancourt

Cedex

France

Sales

Telephone: +33  (0) 1 41 10 1600

Fax: +33 (0) 1 46 04 7419
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Product Support

Telephone: +33 (0) 141 918630 

Fax +44 (0) 181 231 0600

E-Mail: support@webacd.seagatesoftware.com (Available in English 
only)

Web browser: http://webacd.Seagatesoftware.com (Available in English 
only)

Product Registration

Fax: ++ 33 (0) 1 41 91 86 27

Seagate Crystal Reports Web Registration: http://
www.seagatesoftware.com/crystalreports/register 

Seagate Crystal Info Web Registration: http://
www.seagatesoftware.com/crystalinfo/register

Mailing Address: Please refer to the addresses listed on the registration 
card included in your package.

Spain

Seagate Software IMG

Paseo de la Castellana 93 -4a

28046, Madrid

Spain

Sales

Telephone: +341 555 5198 

Fax: +341 555 9957

Product Support

Please see the Product Support section listed under Southern European 
Head Office

Product Registration

Mailing Address: please see addresses listed on the registration card 
included in your package.

On-line registrations: please see the product registration section listed 
under Southern Europe.
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Italy

Seagate Software S.r.l.

Via Conservatorio 22

Milan 20122

Italy

Sales

Telephone: +39 02 7729 310

Fax: +39 02 7729 40

Product Support

Please see the Product Support section listed under Southern European 
Head Office

Product Registration

Mailing Address: please see addresses listed on the registration card 
included in your package.

On-line registrations: please see the product registration section listed 
under Southern Europe.

South Africa Regional Office (Southern & Central 
Africa)

Seagate Software IMG Ltd

Lower Ground Floor

Block F, Pin Mill Farm

164 Katherine Street

Sandton

PO Box 786050

Sandton, 2146

Republic of South Africa

Sales

Telephone: +27 11 448 2080

Fax: +27 11 448 1960
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Product Support

Run Locally in Johannesburg. 

Telephone: +27 11 448 2080

Fax: +27 11 448 1960.  Contact: Ross Harrison

E-Mail: rossh@seagatesa.co.za

E-Mail: support@webacd.seagatesoftware.com (Available in English 
only)

Web browser: http://webacd.Seagatesoftware.com (Available in English 
only)

Product Registration

Mailing Address: please see addresses listed on the registration card 
included in your package.

On-line registrations: please see the product registration section listed 
under Northern Europe.

Middle East Regional Office (ME & Northern Africa)
Seagate Software

PO Box 8687

Dubai

United Arab Emirates

Sales

Telephone: +971 4 523888

Fax: +971 4 519056

Product Support

Run Locally in Dubai.

Telephone: +971 4 523888 Contact : Katia Boueiri

Fax: +971 4 519056  Contact : Katia Boueiri

E-Mail: kboueiri@img.seagatesoftware.com

E-Mail: support@webacd.seagatesoftware.com (Available in English 
only)

Web browser: http://webacd.Seagatesoftware.com (Available in English 
only)
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Product Registration

Mailing Address: please see addresses listed on the registration card 
included in your package.

On-line registrations: please see the product registration section listed 
under Northern Europe.
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Glossary

Absolute 
formatting

Formatting that is always applied to an object. See also Conditional 
Formatting.

Access To access data means to retrieve data.

Acrobat Reader An application used to review and print online manuals.

Active database An active database is a database that has been selected for use in a report. 
You activate databases with the NEW command on the File Menu and the 
ADD DATABASE TO REPORT command on the Database Menu.

Active Server 
Page

Active Server Pages are web pages that run under Microsoft’s Internet 
Information Server (IIS) version 3.0 and later. Active Server Pages 
combine HTML, VBScript or JScript, and ActiveX controls to create 
dynamic web pages that can be viewed from any of the most popular web 
browsers. The Quik Reports for Windows Engine Automation Server, the 
Crystal Design-Time ActiveX Control, and the Crystal Active Data Driver 
can be combined to create active web sites in Microsoft Visual InterDev 
that display reports from an Internet or intranet site.

ActiveX Control A Custom Control for Visual Basic 4.0 and above that incorporates the 
Object Linking and Embedding (OLE) technology. Formerly known as an 
OLE Control (OCX).

Aggregate 
functions

An operation that summarizes data (sums, calculates an average, 
identifies a maximum value, etc.). The term “Aggregate functions” is 
often associated with SQL data sources.

Alias An alias is an alternative name assigned to a database. If a database is 
called CUSTOMER.DB, for example, you can assign the alias customer, 
cust, company, DB1, or any other name that suits your needs. Aliases 
make it easier for you to use a report created with a database whose name 
and/or location has changed since the report was created.
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Area An area is a group of related sections (i.e., Details A and Details B) that all 
share the same characteristics but can be formatted differently.

Argument An argument is an item, or one of a group of items, that receives the 
action of a function. It provides information that the function needs in 
order to operate. The Truncate function, for example, can not operate by 
itself. It needs an argument that identifies the item to be truncated. Thus, 
in the formula:

Truncate ({orders.ORDER AMOUNT})

«where Truncate is the function and {orders.ORDER AMOUNT} is 
the argument, the value of the {orders.ORDER AMOUNT} field is the 
item that needs to be truncated.»

Array An array is a group of values, separated by commas. Arrays are used with 
a variety of Seagate Crystal Reports functions: Average ([array]), 
Maximum ([array]), etc. In these functions, the array is the argument for 
the function. The function works on the items in the array. Items in an 
array can be constants, data fields, or formula results. 

Arrowhead A symbol to show that a field is indexed.

Attribute An attribute is a quality applied to an object (i.e., font size, color, etc.).

Auto arrange When you place a field on your report, the program allocates a space 
equal to the field width as specified in your database. Often that field 
width is far larger than the values that actually appear in each of the 
fields. To create neat-looking reports, it is often necessary to resize the 
fields so that the space allotted more closely matches the size of the field 
values. Once you have resized the fields you often need to reposition 
them for proper balance. Auto Arrange will do this for you. Simply 
choose the AUTO ARRANGE REPORT command from the Format Menu.

Bitmap A graphic file that can be added to a report.

BLOB field A BLOB field is a field containing BLOB data. A BLOB (Binary Large 
Object) is simply a bitmapped graphic that has been entered into a 
database. Placing a BLOB field on your report allows you to access these 
graphics as you would other data types.

Boolean 
expression

A Boolean expression is an expression that defines a logical relationship 
between two or more items. A Boolean expression is either TRUE or 
FALSE. A>5 And B<10 is a Boolean expression that uses the Boolean 
operator And. For the expression to be TRUE, both conditions (joined 
with the And operator) must be true. The value of A must be greater than 
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5 and the value of B must be less than 10. If the values do not fall into 
those ranges, then the expression is FALSE. Boolean expressions are 
useful in If-Then-Else formulas. For example:

If A>5 And B<10 Then 
“In Range” 

Else 
“” 

This formula says: if the Boolean expression A>5 and B<10 is TRUE, print 
“In Range” otherwise (if the Boolean expression is FALSE), print nothing 
(as designated by the empty string“” ). 

Boolean 
formulas

Boolean formulas are formulas that return a Yes/No (TRUE/FALSE) 
value. For example, the Boolean formula {orders detail.QUANTITY} > 6 
compares the value in the {orders detail.QUANTITY} field to 6. If the 
value is greater than 6 it returns a Yes; if it is 6 or less, it returns a No. 
Contrast this with a non-Boolean formula like {orders detail.QUANTITY} 
* 6. In this case the program returns a number, the value of {orders 
detail.QUANTITY} multiplied by 6. All record selection formulas and 
group selection formulas must be Boolean.

Browser A browser is an application that enables viewing of documents in HTML 
format.

Calculated data 
field

A calculated data field is a field that holds a value that comes from a 
calculation rather than coming directly from a database. For example, if 
the database you are using includes a {file.SALES} field and a {file.COST} 
field but no Gross Profit field, you can still show gross profit on your 
report by using a calculated data field. To create a calculated data field, 
you create a formula that subtracts {file.COST} from {file.SALES}. The 
formula calculates a Gross Profit value for each row and prints that value 
wherever you place the formula field.

Case-sensitive Case-sensitive means that a program differentiates between uppercase 
and lowercase letters when evaluating a text string. Thus, a case-sensitive 
search for the word “house” will return only the value “house,” but a 
non-case-sensitive search will return “house,” “House,” “HOUSE,” and 
similar mixed-case strings. Seagate Crystal Reports operators (Equal, In 
string, etc.) are case-sensitive.

Column A column is the display of data from a single field or formula. Columns 
run up and down the page. The words column and field are sometimes 
used interchangeably in the documentation. Compare with Row.
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Comments Comments are blocks of descriptive text that accompany formulas. 
Seagate Crystal Reports ignores comments when it runs the formula.

Concatenate To concatenate is to join two or more text strings together to form a single 
contiguous string.

Condition In an If-Then-Else formula, the condition is the If part of the formula, the 
set of circumstances that must take place (be true) to trigger the Then (or 
consequence) part of the formula. In the formula If x<5 Then x Else 5, the 
expression x<5 is the condition.

Conditional 
formatting

Conditional formatting is formatting that applies only if certain situations 
occur. For example, you can conditionally format numeric database fields 
to display in red when negative.

Conditional 
formatting 
formulas

Conditional formatting formulas are expressions that apply specific 
attributes to objects or sections only if certain criteria is met.

Conditional 
properties

Conditional properties are properties that are performed on an object 
only if a comparison statement returns a value of True.

Confidence 
threshold

A percentage (C) used when the Seagate Document Import Tool converts 
a report. If fewer than C percent of the fields are located correctly, the 
conversion will fail.

Consequence In an If-Then-Else formula, the consequence is the Then part of the 
formula; the action that takes place if the If condition is met. In the 
formula If x<5 Then x Else 5, the expression Then x is the consequence.

Constant A constant is a value that is fixed and unchanging as opposed to a 
variable value, which can take on various values depending on the 
circumstances. 

The value 5 is a constant; the value of the Quantity field (which may be 5 
sometimes, but may be a different number at other times) is a variable 
value. For example, in the formula for converting pounds to ounces 
(Ounces = Pounds * 16), 16 is a constant while Ounces and Pounds are 
variables. In the formula (Today - January 1, 1900), January 1, 1900, is a 
constant, while Today is a variable that changes whenever the current 
date changes. In Seagate Crystal Reports, constants can be numbers, text 
strings, dates, dollar amounts, time, date/time, or the result of a formula 
that itself contains no variables (i.e., 14-9).
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Container 
document

A file that contains an embedded or linked OLE object.

Conversion 
interface file

A conversion interface file (.cif extension) is the file in which the program 
saves the formatting and highlighting from the Document Import Tool. 
When you highlight something in the Document Import Tool and set 
properties for database fields, these settings are saved in the .cif file. This 
file can be used to quickly format the same report later, without 
highlighting.

Cross-tab A cross-tab is a report that summarizes and presents data in a 
compact row and column format that makes it easy to compare 
data and identify trends.

Database A database is a bank of related data. Each unit (record) of the database is 
typically organized in a fixed format to make it easier to retrieve selected 
portions of the data on demand. Each record is made up of one or more 
data fields, and each data field can hold one piece of data (known as a 
value).

Data field A data field (or field) is the basic building block of a record. Each record 
is made up of one or more data fields, and each data field can hold one 
piece of data (known as a value). A customer record in a typical customer 
mailing list database might contain data fields similar to these: Name, 
Address, City, State, Zip, Phone, Fax. A data field can be empty or contain 
a value. Data field data is generally displayed or printed in columns in the 
Details section of a report.

Data source A data source is a database, table, query, dictionary, or stored procedure 
result set that provides the data for a report.

Data types A data type is a classification of the data that appears in a field or formula. 
Each piece of data used in a report or formula has one of the following 
data types: string, currency, number, date, date/time, time, or Boolean 
(TRUE/FALSE). It is important to understand data types because each 
function and operator works with only a limited number of data types 
(often as few as one). For some operators (+ and - for example), the 
program uses a different set of calculation rules for one type of data than 
it uses for another.

Debug Eliminating errors that occur when you run a formula.

Default A default is a pre-loaded response to a software request for data. It is the 
response the computer accepts automatically if you do not enter different 
data.
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Details area A collection of one or more Details sections (i.e., Details A, Details B, etc.).

Details section The Details section of a report is the core section of the report. You 
structure the report in this section by inserting data fields, formulas, and 
other report elements.

Dictionary A one-stop, ready-to-use source of data that is usually created for end 
users by computer professionals within the organization. The dictionary 
takes away the need for the end user to search multiple databases, 
struggle with links, build formulas, and decode cryptic field names. The 
user just selects the data he or she needs from the dictionary and builds 
the report.

Divide by zero 
protection

PCs will not allow you to divide a number by zero. If you attempt such a 
division, you will get a system error message. To prevent a system error, 
the program refuses to print a report which contains a formula that 
divides a value by zero.

Document 
Import Tool

The Seagate Document Import Tool is a conversion utility that converts 
ASCII text reports to Seagate Crystal reports by means of a simple 
highlighting procedure. By highlighting the appropriate sections of the 
text report, you can identify the Report Header and Footer, the Page 
Header and Footer, the Group Headers and Footers, the Details section, 
the database fields, etc. The Tool can then use this information to generate 
a Seagate Crystal report.

Drag Drag can mean different things, depending on the context in which the 
word is used:

●   When referring to moving a field, drag means to click the field 
frame and, while keeping the mouse button pressed, move the 
frame to a new position. You release the mouse button when the 
field is in the desired position. 

●   When referring to resizing a field, drag means to click one of the 
field frame handles and, while keeping the mouse button pressed, 
make the field bigger or smaller. You release the button when the 
field is the desired size.

●   When referring to formatting text, drag means to highlight text by 
moving the I-beam cursor across it while the mouse button is 
pressed. You release the button when you have finished 
highlighting.

Dynamic Link 
Library (DLL)

A Dynamic Link Library (DLL) is a special kind of file that contains 
Windows functions. DLLs are used by developers to extend the 
capabilities of Windows applications. The library is activated whenever 
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an application or another DLL calls a function in the library. DLLs link on 
the fly, at runtime, whenever an included function is called. DLL 
functions are available on an as-needed basis to any program that can call 
DLLs; they do not need to be linked to the program via the compiler. The 
Crystal Report Engine can be called as a DLL by developers for use with 
applications they are developing.

Element The word element is used in the documentation to describe individual 
report components such as database fields, formulas, and group fields. 
The Design Tab uses rectangular frames to represent fields.

Embed, 
Embedded 
object

An embedded object contains a presentation of the object, all of the data 
pertaining to the object, and information about the application used to 
create it. When you modify the original object in the server document, 
nothing happens to the embedded object unless you specifically update 
that object.

Empty date An empty date [designated as Date (0, 0, 0)] is a date that contains neither 
month, day, or year, and thus does not print. Use an empty date in If-
Then-Else formulas that either return a date or not. For example, the 
formula:

If PageNumber = 1 Then
PrintDate 

Else 
Date(0,0,0)

«Prints the print date on the first page and prints nothing on every 
other page.»

Since the Then part of the formula is a date (PrintDate), the Else part of 
the formula must be a date as well, but a non-printing date. To create a 
non-printing (empty) date use the Date function and the arguments (0, 0, 
0).

Empty number An empty number [designated as zero (0)] is a field value that is typically 
printed when a value does not meet a specific condition in a numeric If-
Then-Else formula. Use an empty number to specify that 0 be printed. For 
example, in the formula:

If {file.FIELD} = 3.5 Then
{file.FIELD}

Else 
0

you are specifying that the numeric Gradepoint be printed (Then) if the 
grade point is 3.5 or higher. You are using the empty number 0 to indicate 
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that 0 is to be printed (Else) if the grade point is below 3.5. Often a user 
will format the field that contains this formula to be suppressed if 0. In 
this event, nothing gets printed in the case of a zero value.

Empty string An empty string (designated as ““) is a string that contains no characters. 
Use an empty string to specify that nothing be printed. For example, in 
the formula:

If {file.FIELD} = 3.5, Then
“Cum Laude”

Else 
““

you are specifying that the words Cum Laude be printed (Then) if the 
grade point is 3.5 or higher. You are using the empty string ““ to indicate 
that nothing is to be printed (Else) if the grade point is below 3.5.

Evaluation time Evaluation time refers to the stage in the reporting process when a 
formula gets evaluated. The three evaluation time functions are:

1. BeforeReadingRecords

2. WhileReadingRecords

3. WhilePrintingRecords

For a complete discussion of the Evaluation Times, see Advanced 
Formulas, Page 315.

Expert Seagate Crystal Reports offers you several Experts. Experts are tools 
designed to take you step-by-step through various aspects of report 
creation. In most cases Experts have a series of numbered tabs. Simply 
begin at step one and proceed through the steps. When you have 
completed the final step, the Expert will do the rest of the work.

NOTE: The term “Expert” in Seagate Crystal Reports is equivalent to the 
term “wizard” in Microsoft Access.

Export To export is to distribute your report to a disk file or through e-mail. 
Seagate Crystal Reports allows you to export your reports in many 
popular spreadsheet, database, word processor, HTML, and data 
interchange formats.

Field A field is the basic building block of a record. Each record is made up of 
one or more fields, and each field can hold one piece of data (known as a 
value). A customer record in a typical customer mailing list database 
might contain fields similar to these: Name, Address, City, State, Zip, 
Phone, Fax. A field can be empty, or it can contain a value. Field data is 
typically displayed/printed in columns in the Details section of a report.
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Field value 6HH�9DOXH�GHILQLWLRQ�

Field width Field width is the size of the field in the originating database. A field 
width is generally fixed, and values in the field may take up all or only a 
part of the allotted width. The program includes Trim functions for 
removing excess white space from field values that do not fill their 
respective fields.

File A file is a collection of related data stored under one name. In Seagate 
Crystal Reports, each report is stored as a single file.

Fixed properties Properties that will always be performed on the object.

Flag A flag is a character or group of characters used to highlight or identify 
items of interest to call them to the user’s attention. For example, in an 
accounts receivable report, the words “past due” might be printed as a 
flag beside every past due account.

Flat formula A formula that does not reference any database field. For example: 1+1.

Footer The footer is the text that appears at the bottom of a report page. Footer 
text frequently includes page numbers, and may include other 
information that describes or identifies the report. Seagate Crystal 
Reports gives you the option of printing the footer on all pages or on only 
selected pages of your report.

Formatting 
Toolbar

This toolbar displays buttons that you can click to perform many 
common formatting tasks.

Form letter In Seagate Crystal Reports, a form letter is a letter that can be reproduced, 
personalized, and customized using the program’s powerful text object 
capabilities. Form letters generally include both text and field values. You 
create the letter, and the program runs it each time inserting values from 
a different record in the database.

Formula A formula is a symbolic statement of the modifications you want 
performed on certain data before it is printed on your report.

For example, if your report is to contain a {file.SALES} field and a 
{file.COST} field, you may want to create a GrossProfit field and 
designate its value as {file.SALES} - {file.COST}. This is a simple formula 
that tells the program to subtract the value of the {file.COST} field from 
the value of the {file.SALES} field and then to print the result.

You can use formulas to calculate numeric values, compare one value to 
another and select alternative actions based on the comparison, join 
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multiple text strings into a single string, and to perform a multitude of 
other operations. Creating a formula in Seagate Crystal Reports is much 
like creating a formula in your favorite spreadsheet.

NOTE: The term “formula” in Seagate Crystal Reports is equivalent to the 
term “expression” in Microsoft Access.

Formula Editor The Formula Editor is used to create and edit formulas. It contains tools 
for inserting fields, functions and operators into the formula, for checking 
formula syntax and for typing in formula components and arguments. 
Modified versions of the Formula Editor are used for creating Record and 
Group Selection formulas.

Formula 
language

The formula language is a powerful, easy-to-use, programming language 
designed for creating formulas.

Formula syntax Formula syntax is the set of grammar rules you are required to follow 
when creating formulas using the formula language.

Free form Free form implies that placement of objects is not limited to grids (vertical 
or horizontal).

Function A function is a built-in procedure or subroutine used to evaluate, make 
calculations on, or transform data. When you specify a function, Seagate 
Crystal Reports performs the set of operations built into the function 
without needing each operation specified separately. In this way, a 
function is a kind of shorthand that makes it easier and less time 
consuming for you to create reports.

Seagate Crystal Reports comes with a wide range of functions, and it also 
includes tools that allow you to build and save additional functions for 
yourself.

Grand total A grand total is the summary of all values in a column, for the entire 
report.

Grid In Seagate Crystal Reports, the grid is an underlying network of “lines” 
that are similar to the lines on graph paper. You can use these lines to help 
align fields and graphics. If you have the Snap to Grid option toggled on 
in the Options dialog box, Seagate Crystal Reports will automatically 
align any fields you insert or resize to the nearest grid coordinate.

Group A group is a set of records that are related to each other in some way. In 
a customer list, for example, a group might consist of all those customers 
living in the same Zip Code, or in the same Region. In a sales report, a 
group might consist of all the orders placed by the same customer, or all 
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of the orders generated by a particular sales representative. Seagate 
Crystal Reports offers you a great deal of flexibility in the way you group 
the data on a report.

Group Footer A Group Footer is a section created by the program whenever you insert 
a group, a summary, or a subtotal. The Group Footer section is typically 
used to display the summary or subtotal.

Group Header A Group Header is a section created by the program whenever you insert 
a group, a summary, or a subtotal. The Group Header section is typically 
used to display the name of the group or some other identifying 
information.

Guidelines Guidelines are non-printing lines that you can use to align, move, and 
resize objects with precision. Guidelines allow you to work in a free form 
environment (without a grid), while retaining absolute control over the 
placing of objects in your report.

Header A header is text that appears at the top of a report page, above the body 
of the report. While a header can contain virtually any information, it 
often contains such items as the report title, company name, date, range 
of dates covered by the report, etc. Seagate Crystal Reports gives you the 
option of printing the header on all pages or on only selected pages of a 
report.

Highlighting 
Expert

The Highlighting Expert is most commonly used for highlighting number 
or currency field values that are in some way distinguished from the 
other values in the report. The Highlighting Expert offers a wide range of 
conditional formatting, including font color, background color, and 
border style.

You can think of the Highlighting Expert as an advanced formula editor 
that runs the following equation: If Condition is True, Then Apply These 
Formatting Specifications.

HTML The language used by the World Wide Web to publish linked web pages 
on the Internet.

Index An index is a small file that identifies the location of each record in a 
database. Since a tiny index file can be searched or sorted much quicker than 
a large database, Seagate Crystal Reports uses index files to speed up the 
report generation process. In a search, for example, Seagate Crystal Reports 
searches the index for the correct field location. Once found, the program 
goes directly to the database field. Such a search does away with the need for 
searching every field of every record in a database. A database may have 
several indexes, each based on a specific field (or fields).
Glossary 657



Indexed fields Fields in the database that are in a specific order to speed up the retrieval 
of particular records. Instead of searching through all the data in all the 
records, the program goes first to the index, and finds a pointer that direct 
it to the specific record it is looking for. Indexed fields are tagged with 
arrowheads in the Select Expert and Visual Linking Expert.

In-place editing The ability to change an OLE object’s properties while in Seagate Crystal 
Reports. The menu items change to provide the editing tools from the 
server application so that you can make changes easily.

In-place ruler The ruler that appears when you are editing a text object. This ruler 
enables you to set tabs, and position objects with precision.

Insertion point The insertion point is a vertical line that indicates the point at which 
Seagate Crystal Reports will insert any text that you type in. You set the 
insertion point by moving the I-beam cursor to the position you want to 
insert text and click. When typing text for the first time in a Design Tab 
section, the program sets the insertion point flush left in the section, 
regardless of where you click the I-beam cursor.

Integer An integer is a positive or negative whole number or zero. Integers have 
no decimal places.

Link A link is a field that is common to two or more databases and that serves 
as a connecting point between those databases. Seagate Crystal Reports 
uses the link to match up records from one database with those from the 
other(s). For example, if the databases each contain a customer number 
field (even though the fields might have different names), Seagate Crystal 
Reports can use those fields to electronically connect all records in one 
database with corresponding records in the other(s). When you create a 
single report based on multiple databases, the link assures that all the 
data in each row on that report refers to the same customer (transaction, 
invoice, etc.).

NOTE: The term “link” in Seagate Crystal Reports is equivalent to the 
term “relationship” in Microsoft Access.

Linked object A linked object contains a presentation of the object, and a pointer to a 
defined part of the server document. When you modify the original object 
in the server document, the links assure that the object in your report is 
modified automatically as well. Conversely, if you modify the object in 
the container document, the original object file is modified as well.

Live header A live header is a header that changes dynamically with the content of a 
field. If you group your data by region, for example, a typical live group 
header would print the name of the region at the beginning of each group.
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Map Expert The Map Expert is a powerful tool for better organizing your data by 
placing geographic maps on a report. You can drill-down on these maps 
to see the underlying data.

Microsoft 
Foundation Class 
(MFC)

The Microsoft Foundation Class is an object-oriented programming 
interface that encapsulates many related function calls into one object.

Nesting In Seagate Crystal Reports, nesting means to use one If-Then-Else 
expression inside another. For example, If employee’s degree is not Ph.D. 
Then (if employee's sex is male, use the salutation Dear Mr. Else use the 
salutation Dear Ms.) Else use the salutation Dear Dr. In this example, the 
nested If-Then-Else statement is surrounded by parentheses. The 
example says, check the degree field on the employee record to verify that 
the employee is not a Ph.D. If that condition is true (the employee is not 
a Ph.D.), then use a letter salutation based on the sex indicated on the 
employee record. (If the sex is male, Then use a male salutation. Else [if 
the sex is female] use a female salutation.) Else (that is, if the employee is 
a Ph.D.), use a Dr. salutation. By using this type of formula construction, 
you can create a wider set of conditions and a wider set of consequences 
easier than you could without nesting.

Null Null means there is no value within a database field for a given record. It 
does not mean zero because zero is a value.

Null string A null string is an empty string. It contains no characters. If you were to 
use the Count function to count the string, it would return a length of 
zero. “” is used to designate a null string.

Numeric Numeric data is data on which you can perform arithmetic. The 
designation numeric refers to the way the data is treated by Seagate Crystal 
Reports and database programs, not to the way the data looks to you. 

For example, a serial number 12345 looks numeric, that is, every character 
is a number. But a serial number is not the kind of data on which you 
would want to perform arithmetic, so you would probably store a serial 
number as text instead of as numeric data. 

Numeric is one of several data types. Database programs require you to 
designate a data type when you create a field for use in a database. The 
data type you select determines the rules the program follows when 
dealing with the values stored in that field.

Object An object is one of several kinds of report elements that generally contain 
data and have specific properties that define their behavior or 
appearance. The program uses the following kinds of objects:
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●   field,

●   text,

●   cross-tab,

●   graph,

●   subreport,

●   picture, and

●   OLE.

Each of these objects can be individually formatted, moved, resized, 
duplicated, and so on.

Object frame An object frame is a rectangular cursor that appears as an aid to placing 
database fields and formulas on your report. Once you have selected a 
field or created a formula, the object frame appears. When you move the 
frame to the place in the report you want the field or formula to appear 
and click the button, the program inserts the item at the point specified.

ODBC ODBC stands for Open Database Connectivity. It is an interface that gives 
applications the ability to retrieve data in data management systems 
using SQL for accessing the data. Such an interface allows a developer to 
develop, compile, and ship applications without targeting specific 
database management systems. Also called interoperability.

OLE OLE is an acronym for Object Linking and Embedding. It refers to the 
ability to create compound reports, that is, reports that contain elements 
from other applications and that can be edited using the original 
application.

OLE container 
application

An OLE container application is an application that can contain and 
process OLE objects created elsewhere (like Paint or Paintbrush). Seagate 
Crystal Reports is a container application.

OLE server 
application

An OLE server application is an application that can create OLE objects 
that can then be placed in documents created by container applications. 
Seagate Crystal Reports is a container application, whereas Microsoft 
Word and Excel are examples of server applications.

One-to-many One-to-many refers to a situation occurring in linked databases in which 
one record in one database can be matched with many records in another 
database. An example of a one-to-many link would occur when linking a 
customer table to an orders table. In such a case, for every one customer 
in the primary database, there would typically be many orders in the 
second (lookup) database.
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Operators Operators are special symbols that describe an operation or an action to 
take place between two or more values.

The symbol / for example, is an operator that means divide. A/B means 
Divide A by B. Seagate Crystal Reports reads the operators in a formula 
and performs the actions specified. Seagate Crystal Reports contains 
arithmetic, string, comparison, Boolean, conversion, date, and range 
operators, among others.

Order of 
precedence

The order of precedence is a set of rules that determines the order in 
which arithmetic operations take place in a formula that involves 
multiple arithmetic operations. Multiplication (*) and division (/) are 
performed first (first tier operations), followed by addition (+) and 
subtraction (-) (second tier operations). When there are multiple 
operations involving the same tier, the order of precedence dictates that 
the operations are performed from left to right. You can use parentheses, 
if you wish, to alter the normal order.

Out of place 
subreport

A subreport that remains hidden, or "out of place," when the report is 
viewed. An object frame appears in its place. You can drill-down on the 
frame to view the subreport data.

Page Footer A section that prints at the bottom of each page. Page footers are typically 
used for page numbers, chapter names, and other identifying 
information.

Page Header A section that prints at the top of each page. Page headers are typically 
used for titles and other identifying information.

Parameter field A special kind of field that prompts the user for a value. You can use 
parameter fields for report titles, record selection, sorting, and a variety 
of other uses. Using parameter fields enables you to create a single report 
that you can modify quickly to fit a variety of needs.

NOTE: The term “parameter field” in Seagate Crystal Reports is 
equivalent to the term “parameter queries” in Microsoft Access.

Paste Paste means to retrieve and place data from the Clipboard into a report 
or formula. The data may have been cut from the same report or formula 
or from a different one.

Perspective 
Editor

The third party tool to change charts that are plotted off the summaries in 
a report (also called PG Editor.)

Population A population is the entire set of values that might be tested statistically, 
as opposed to a sample which is a subset of the population. A population 
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does not necessarily refer to a group of people; it can refer to the number 
of automobiles produced on an assembly line or the number of 
construction companies bidding on a project.

For example, a real estate agent might sell 20 houses in one year. The 
population of houses sold by that agent in that year is 20.

Population 
standard 
deviation

Population standard deviation is a statistical test of how the values in an 
entire population (all values) deviate from the mean or average value for 
that population. Population standard deviation is most often used when 
all values are being evaluated as opposed to just a sample of those values 
(StdDev).

NOTE: This comparison simply suggests typical usage. In practice, some 
users prefer a calculation based on N values (PopulationStdDev) while 
others prefer a calculation based on N-1 values (StdDev). Both forms of 
standard deviation are provided by the program.

Population 
variance

Population variance is the square of the population standard deviation. It 
is a measure of the amount by which the values in an entire population 
vary from the mean (average) value for that population.

Population variance is typically used when all values are being evaluated 
as opposed to just a sample of those values (Variance).

NOTE: This comparison simply suggests typical usage. In practice, some 
users prefer a calculation based on N values (Population-Variance) while 
others prefer a calculation based on N-1 values (Variance). Both forms of 
variance are provided by the program.

Properties Properties are qualities that define the appearance or action of an object 
or a section. There are two kinds of properties in Seagate Crystal Reports:

1. On/Off
A property that can only be toggled on or off.

2. Attribute
A property for which you have to supply a value.

Range A range is a set of values that fall between and include a defined upper 
and lower limit. For example, the range 10 to 20 includes 10, 20, and all 
the numbers that fall between. Also, the range January 1, 1991 to January 
30, 1991, includes January 1, January 30, and all the dates that fall 
between. In Seagate Crystal Reports, a range can consist of numbers, 
dollar amounts, or dates. 

Record In a database, a record is a complete unit of related information, an 
electronic file folder that holds all of the data on a given entity. Each 
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record contains one or more fields that contain the specific pieces of data 
of interest. In a customer database, for example, a record would store all 
of the data on a single customer. In an inventory database, a record would 
store all of the data on a single inventory item. Data from an individual 
record is displayed or printed as a row of data on a columnar report. 

Report A report is simply an organized presentation of data. As a management 
tool, a report is used to provide management with the insight it needs to 
run an organization effectively. Seagate Crystal Reports allows you to 
create comprehensive, customized, attractive management reports 
quickly and easily. But report in Seagate Crystal Reports also refers to 
invoices, form letters, mailing labels, and other related items that require 
the organization and output of data.

Report Footer The Report Footer section is the last section of a report in the Design Tab. 
You can place a summary in this section that you want to appear only on 
the last page of a report.

Report Gallery The Report Gallery is a special dialog box that appears when you click the 
NEW button on the standard toolbar or choose the NEW command from 
the File Menu. The Report Gallery serves as a gateway to all the report 
creation experts and to the graphical interface for selecting the report and 
data type for creating custom reports.

Report Header The Report Header section is the first section of your report in the Design 
Tab. You can place a title in this section, or any data you want to appear 
only on the first page of your report.

Request A request is a set of criteria that specifies the subset of data that you want 
to use for your report. For example, if you want your report to contain 
only California data, you can create a record selection request that 
retrieves only California records for your report. You create record and 
group selection requests using the Select Expert.

Returns The word “returns” refers to the result of a function, an operation, or a 
formula. For example:

●   When using a function, it performs a calculation or manipulation 
that results in a data change of some kind. The data that results is 
what the function returns. For example, Average(1, 2, 3, 4, 5) 
returns the average of the array 1, 2, 3, 4, 5. Truncate(1.2345) 
returns the integer (whole number) portion of the number 1.2345.
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●   When using an operator, the result of the operation using that 
operator is what the operation returns. For example, 5*6 equals 30. 
You can say that the operation 5*6 returns 30. Also, the operation 
100<200 compares the two values and returns True; 200<100 
compares the two values and returns False.

●   When using a formula that contains functions or operators, each 
function or operation within the formula returns a result, but the 
formula taken as a whole returns a result too. When talking about 
a formula, it is the result of the formula that is of interest, not the 
result of individual functions or operations. For example, in the 
following formula: 

If {file.QTY} < {file.REORDERAMOUNT} Then
“Reorder “

Else 
““

an internal operation compares the value of the {file.QTY} field 
with the value of the {file.REORDERAMOUNT} field. If {file.QTY} 
is less than {file.REORDERAMOUNT}, that individual operation 
returns the value True, but that is not what the formula taken as a 
whole returns. The formula, taken as a whole, returns the flag 
“Reorder” when the operation internally returns the value True.

Row A row is the display of data from a single record. Rows run horizontally 
across the page. The words row and record are sometimes used 
interchangeably in this manual. Contrast with column.

Ruler The ruler provides a visual reference for positioning and resizing fields, 
graphs, lines, boxes, and bitmaps. The increments on the ruler are based 
on your measurement settings in the International section of the 
Windows control panel. The ruler also enables you to change page 
margins while immediately seeing the results of your changes on the 
report itself.

The Ruler is visible in both the Design Tab and Preview Tab when their 
respective check boxes are toggled on in the Options dialog box.

Running totals Running totals are totals that are displayed generally on a record by 
record basis. They total all records (in the report, in the group, and so 
forth) up to and including the current record. For example, if your first 
three records have values of 2, 4, and 6, the running total for each of the 
three records would be 2, 6, and 12, respectively.

Sample A sample, as used in statistics, is a subset of a population used to 
represent the entire population. Researchers frequently do not have the 
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option of testing an entire population before forming conclusions based 
on their tests. In such cases, they use a sample to represent the whole.

For example, political polling before elections is often based on 
questioning only four or five hundred people. From the answers given by 
this sample, predictions can be made on how an entire nation will vote.

Scroll bars, 
scrolling

Sometimes a window can display only a portion of a document. In such 
a case, the window includes scroll bars that you can use to move other 
parts of the document into the window for your review.

Scroll bars also appear with lists that are longer than the available 
window. The scroll bars allow you to move back and forth through the 
list. The process of moving through a list or document using scroll bars is 
called scrolling. In Seagate Crystal Reports, the screen automatically 
scrolls whenever you move the cursor outside the window and press and 
hold down the button.

Section A section is a part of the report design environment. The program divides 
the design environment into several sections, each of which has different 
printing characteristics. You place objects in the various sections to build 
a report.

Select ●   With regard to a report element (data field, formula, etc.), select 
means to point to the element and then click to choose the element 
as the object of the next menu selection.

●   With regard to text, select means to highlight the text by dragging 
the I-beam cursor over it.

●   With regard to records, select means to identify and choose those 
records of interest while disregarding all others.

●   With regard to groups, select means to identify and choose those 
groups of interest while disregarding all others.

Selection 
formula

A selection formula is a formula that specifies the records, or groups of 
records, you want included in your report.

Server document A server document is a file that stores the original OLE object.

Server-side 
processing

Server-side processing is a feature that allows you to set up reports that 
perform the majority of their processing on the server. These reports push 
only relevant details to your computer, thus saving you time and 
memory.

Shortcut menu A dynamic menu available in the Design and Preview Tabs. Access the 
shortcut menu by highlighting an object and right-clicking.
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Smart Processing 
Cache

The Crystal Web Report Server stores requested reports in the Smart 
Processing Cache directory. When a user requests a report through a web 
browser, the report is generated and stored in the cache. If another user 
requests the same report, the Crystal Web Report Server retrieves the 
report from the cache rather than generating it all over again.

Cached reports that remain unused for a long period of time are 
invalidated by the Crystal Web Report Server. Periodic clean up 
processes delete invalid reports from the cache to make room for more 
recent or more popular reports. This process of caching frequently used 
reports and deleting unused reports provides an efficient use of web 
server and network resources, reducing repetitive report generation and 
network traffic.

Snap property Snap is a “magnetic” property that attracts nearby objects. Seagate 
Crystal Reports uses two facilities that have the snap property: 
Guidelines and the Grid. Whenever an object is moved close to a 
guideline or a grid coordinate, the program snaps it into position for 
accurate placement and alignment.

Sort-and-group-
by field

A sort-and-group-by field is a field that triggers the printing of a subtotal 
(or a group field value) whenever its own value changes.

For example, you may have a customer report that contains the 
{customer.CUSTOMER ID} and {orders.ORDER AMOUNT} fields. If you 
want to subtotal by customer (total the orders for each customer), click 
the {orders.ORDER AMOUNT} field as the field to subtotal and the 
{customer.CUSTOMER ID} field as the sort-and-group-by field. Seagate 
Crystal Reports sorts the data by customer, so that all orders from the 
same customer are grouped together. Then, whenever the value in the 
{customer.CUSTOMER ID} field changes (when it changes from one 
customer to a different customer), Seagate Crystal Reports prints a 
subtotal of the values in the {orders.ORDER AMOUNT} field (a total of 
orders for the individual customer). You can also use sort-and-group-by 
fields to trigger summaries. See Sorting, Grouping, and Totaling, Page 
245.

Sort direction Sort direction describes the way records or groups are printed in your 
report. They are printed either in ascending (A to Z, 0 to 9), or descending 
(Z to A, 9 to 0) order.

Sort field A sort field is a data field on which the sort procedure is based. A mailing 
list, for example, could be sorted, in ascending order, on the 
{customer.POSTAL CODE} field; that is, the customers would be sorted 
so that those with the lowest postal codes would appear first and those 
with the highest postal codes would appear last. The report could also be 
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sorted in ascending alphabetic order, on the {customer.CONTACT LAST 
NAME} field; that is, customers with last names beginning with A would 
appear first and those with last names beginning with Z would appear 
last.

Sort order Sort order is an indicator of the direction in which you want your data to 
be presented once it is sorted. Data is typically printed in one of two sort 
orders: ascending (lowest to highest, earliest to latest, first to last, A to Z, 
etc.) or descending (highest to lowest, latest to earliest, last to first, Z to A, 
etc.).

Sorting Sorting is a method of organizing the order in which data appears on 
your report. Seagate Crystal Reports provides you with powerful tools 
for sorting your report data.

SQL SQL stands for Structured Query Language; a system for managing, 
organizing, and retrieving data stored on a computer database. 
Structured Query Language is a computer language that enables you to 
interact with a specific type of database called a relational database.

SQL
pass-through

The ability to get the SQL Server to process the data retrieval criteria in 
order to pass the smallest possible result set back to Seagate Crystal 
Reports for final processing. When processing can be passed-through to 
the server, it makes the reporting process more efficient and it minimizes 
network traffic.

Standard 
deviation

Standard deviation is the square root of the variance. It is a statistical test 
of how various values in a set of values deviate from the mean or average 
value for that set. You can use standard deviation, for example, for 
assessing the relative difficulty of tests given to students, for evaluating 
and projecting customer purchase patterns, or for comparing the results 
delivered by two or more products under evaluation (laboratory blood 
tests, smoke detectors, radar detectors, etc.). The uses are endless.

Standard deviation (as opposed to population standard deviation) is 
typically used to project the standard deviation for an entire population 
(all values) based on testing only a small sample of that population. For 
example, a company producing batteries with a new manufacturing 
process might want to test the batteries to determine how long they will 
last before they go dead. If the company tested all of its batteries, it would 
have no product left to sell. As an alternative, the company might test 
thirty batteries selected at random and project the mean burn out time 
and standard deviation for all batteries based on the results from that 
thirty battery sample. 
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NOTE: This comparison simply suggests typical usage. In practice, some 
users prefer a calculation based on N values (PopulationStdDev) while 
others prefer a calculation based on N-1 values (StdDev). Both forms of 
standard deviation are provided by the program. 

Static OLE object A static OLE object is a picture of an object that is stored in a document 
when it is saved. The picture can be displayed or printed by a user who 
does not have the application in which the original object was created. 
The object can not be edited in place, however, without first converting it 
to an editable type of object. Static OLE objects offer better online and 
print performance than do standard bitmaps.

String A string is a series of connected characters (letters, numbers, symbols, 
spaces) stored and used as text. The word “hello” is a text string as is the 
phrase “Order # 2453“ and the customer number “B30-124-777”. Strings 
are sometimes referred to as text strings or character strings.

Subreports A subreport is a report within a report. It has all of the characteristics of a 
report with one exception: it can not itself include a subreport. Subreports 
can be free-standing or they can be linked to the data in the primary 
report. Seagate Crystal Reports enables you to insert as many subreports 
as you wish.

Substring A substring is simply a part of a larger string. “Columbia” is a substring 
of the string “British Columbia”, “1040” is a substring of the customer 
number “B-1040-0032456”, and “B” is a substring of the string “President 
Bill Clinton”. 

Subtotal A subtotal is a partial total, a total of a specific, limited group of data in a 
field. For example, given the following data: 

1, 2, 3, 4, 5, 6, 7

a subtotal after the 3 produces the value 6 (1 + 2 + 3). A second subtotal 
after the 6 produces the value 15 (4 + 5 + 6).

A subtotal is the sum of all values from a single field, from all the records 
in a group. In a sales report, for example, if you subtotal the amount 
ordered by sales representative, Seagate Crystal Reports gathers all the 
records that belong to the sales representative and totals the amounts 
ordered from all the records. 

Summary A summary is the value generated as the result of an evaluation, a tally, 
or a calculation performed on data from a single group. 

In a group average, Seagate Crystal Reports averages the values in a 
group of records; in a group count, it counts the values in a group of 
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records, and so forth. Summary values are important tools for creating 
powerful reports.

Summary field A summary field is a field that determines the sum of the values, the 
average value, the maximum value, the minimum value, or count of 
values in a group of values in a given field. Much like a subtotal, a 
summary field groups data to your specifications and then performs the 
requested calculation/determination.

Syntax Syntax, in Seagate Crystal Reports, is a set of rules that specifies the 
proper way to use functions and operators in formulas.

Tabs Tabs are used in many dialog boxes and Experts in Seagate Crystal 
Reports. Tabs resemble the tabs on common file folders. Tabs always 
have text on them to indicate what you will find on the Tab.

Template A template is a copy of a report used as the starting point for creating a 
new report. When a template is used, your original report remains 
unchanged.

Text object A text object is a specialized object that can contain text, database fields, 
and formula fields. It contains its own mini word processor that can be 
used for anything from adding a label to creating an entire document.

Text string A text string is text that is entered directly onto the report itself instead of 
being entered via a data field or formula.

Toolbar A bar at the top of a Seagate Crystal Reports application window which 
contains a number of buttons that you can click to activate the most 
frequently used commands.

Total A total is a sum of values. Subtotals and grand totals are different 
varieties of totals.

Truncate Truncate means to cut off or eliminate all data that comes after the 
decimal point. Thus, if you truncate 1.2345, you get the value 1. If you 
truncate the value 1.9999 you also get the value 1. Truncate does not 
round data, it simply cuts off unwanted data.

Two pass 
formula/function

A two pass formula is a formula that requires two passes through the data 
for completion. The first pass performs some calculation or selection and 
the second pass performs a calculation or selection that uses the result 
generated by the first pass. 

An example of a two pass formula is one that calculates the sales for each 
sales representative as a percent of total company sales. The first pass 
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sums the sales for each representative to arrive at total company sales. 
The second pass divides the sales per representative by total company 
sales to calculate the percent of total sales.

Underlay The ability of an object (a bitmap, a graph, etc.) to print beneath multiple 
sections which follow the section in which it was placed. For example, 
you can place a bitmap in one section, format the section to underlay the 
following sections and then expand the bitmap so it appears as a 
background for the entire page of your report.

Value A value is the data found in a field. In a field called {customer.CONTACT 
FIRST NAME}, for example, John or Mary might be the value. In a field 
called {orders.ORDER AMOUNT}, 1234.55 or $200 might be the value.

Variance Variance is the square of the standard deviation. It is a measure of the 
amount by which all values in a group vary from the mean (average) 
value in the group. It is a statistical test that can be used to evaluate the 
variability in a group of values (for example, the amount bid by each of 
the bidders on a construction project).

Variance (as opposed to PopulationVariance) is most often used to project 
the variance for an entire population (all values) based on testing only a 
small sample of that population. For example, with a limited number of 
bids in on a construction project, you might want to project the variance 
for all bids based on the sample already in. Or, based on sales figures for 
the first three months of the year, you might want to project the variance 
for orders for the entire year (including the nine months yet to come). 

NOTE: These comparisons simply suggest typical usage. In practice, some 
users prefer a calculation based on N values (PopulationVariance) while 
others prefer a calculation based on N-1 values (Variance). Both forms of 
variance are provided by the program. For a more thorough discussion on 
the use of variance, consult any reliable statistics text.

Verify In Seagate Crystal Reports terms, verify does not mean to repair and 
compact the database (MDB file) in Access. It means to let the report 
understand the changes made to the database structure (fields and tables, 
NOT records).

Wildcard A wildcard is a character that represents any character (?) or any group of 
characters (*) in a search string. For example, if you are searching for 
Dan*, the search string will return strings like Danny and Daniel.

Word wrap Word wrap is a word processor-type property of a text object that 
automatically moves a word to the following line when the word is too 
long to fit the remaining space on the current line.
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